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Järjestelmän määritys

UWP-D21 
UWP-D22 
UWP-D26 
Langaton 
mikrofoni-
paketti

URX-P03D 
Langaton 
mikrofoni-
vastaanotin

SMAD-P3D 
Moniliitäntäkenkä

SMAD-P5 
Moniliitäntä-
kenkä

LA-EA3 
LA-EA4 
A-pidikkeellinen 
sovite

E-pidikkeellinen 
objektiivi

ECM-VG1 
ECM-MS2 
Mikrofoni

RM-30BP 
Kauko-ohjainyksikkö

MCX-500 
Videomikseri

Kauko-ohjainkahva 
(mukana)

ILME-FX6V/ILME-FX6VK 
ILME-FX6T/ILME-FX6TK

XLR-K2M 
XLR-K3M 
XLR-sovitinsarja

HVL-LBPC 
Videovalo

CFexpress Type A  
-muistikortit

SDXC-  
muistikortit

BC-CU1  
Akkulaturi 
(mukana)

BP-U35, BP-U60, 
BP‑U60T, BP-U70, 
BP‑U90, BP-U100 
Akku

Verkkovirtalaite 
(mukana)

CFexpress Type A -kortin lukulaite /  
SD-kortin lukulaite

BC-U1A, BC-U2A 
Akkulaturi

1. Yleistä

ECM-B1M  
Haulikkomikrofoni



4 1. Yleistä

Osien sijainti ja toiminta

Vasen puoli ja etupuoli

11
1

2

4
5
6
7
8

9

12

13

14

3

16

15

10

1.	 Mittanauhakoukku
Mittanauhakoukku on samalla tasolla kuin 
kuvakenno. Käytä koukkua kiintopisteenä, 
kun haluat mitata tarkasti videokameran ja 
kohteen välisen etäisyyden. Voit kiinnittää 
mittanauhan pään koukkuun mitataksesi 
etäisyyden kohteesta.

2.	 Etsimen liitin (sivu 19)

3.	 Tuuletusaukko

[Huomautus]
Älä peitä tuuletusaukkoa.

4.	 TC IN/OUT -valintakytkin (sivu 34, 
115)

5.	 Kauko-ohjainkahvan liitin (sivu 20)

6.	  (N-merkki) (sivu 60)
ˎˎ Muodosta langaton yhteys laitteeseen 
koskettamalla sitä NFC-toiminnolla 
varustetulla älypuhelimella.  
Jotkut langatonta maksamista tukevat 
älypuhelimet eivät ehkä tue NFC-
toimintoa. Lisätietoja saat älypuhelimen 
käyttöoppaasta.
ˎˎ NFC (Near Field Communication, 
lähikenttäviestintä) on kansainvälinen 
yhteyskäytäntö toisiaan lähellä sijaitsevien 
esineiden väliseen langattomaan 
tiedonsiirtoon.

7.	 Kauko-ohjainkahvan liitäntä (sivu 20)

8.	 Kauko-ohjainkahvan vapautuspainike 
(sivu 20)

9.	 Wi-Fi-antenni

10.	Tallennuksen merkkivalo (edessä) 
(sivu 34)

Vilkkuu, kun tietovälineen tai akun jäljellä 
oleva kapasiteetti on vähissä.

11.	FOCUS-kytkin (sivu 37)

12.	Kuvakenno

13.	PUSH AUTO FOCUS -painike (sivu 40)

14.	Objektiivin signaalikoskettimet

[Huomautus]
Älä kosketa suoraan käsin.

15.	WB SET (valkotasapainon asetus) -painike 
(sivu 46)

16.	Objektiivin vapautuspainike (sivu 22)
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Oikea puoli (edestä/yläpuolelta/alta)
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1.	 Clip Flag -painike (sivu 53, 70)

2.	 HOLD-kytkin (sivu 99)

3.	 Tallennuksen START/STOP-painike 
(sivu 34)

Aloita tallennus painamalla tallennuksen 
START/STOP-painiketta. LED-valo palaa 
punaisena tallennuksen aikana.

4.	 ND VARIABLE -säädin (sivu 44)

5.	 ND PRESET/VARIABLE -kytkin (sivu 44)

6.	 ND FILTER POSITION -painikkeet ylös/alas 
(sivu 44)

7.	 ND CLEAR -ilmaisin (sivu 44)

8.	 ND VARIABLE AUTO -painike (sivu 44)
Aloita ND-suodattimen automaattinen 
tiheydensäätö painamalla ND VARIABLE 
AUTO -painiketta. LED-valo palaa vihreänä, 
kun toiminto on käytössä.

9.	 Monitoimisäädin (sivu 49)
Paina, kun katselet kuvaa etsimessä ja haluat 
tarkastella ja käyttää suoravalikkoa.
Kun valikko näkyy etsimessä, siirrä kohdistinta 
ylöspäin/alaspäin rullaamalla valitsinta, 
jotta voit valita valikkokohteita tai asetuksia. 
Vahvista valittu kohde painamalla.
Kun valikko ei ole näkyvissä, valitsin voi toimia 
myös nimettävänä valitsimena.

10.	IRIS-toimintopainike (sivu 43)

11.	CANCEL/BACK-painike (sivu 69)

12.	THUMBNAIL-painike (sivu 68)

13.	MENU-painike (sivu 14, 73)
Näytä tilanäyttö painamalla MENU-painiketta. 
Näytä koko valikkonäyttö painamalla pitkään 
MENU-painiketta. Palaa edelliseen näyttöön 
painamalla painiketta tilanäytössä tai koko 
valikon näytössä.

14.	ISO/GAIN-toimintopainike (sivu 43)

15.	ISO/GAIN (herkkyysvahvistuksen 
valinta) -kytkin (sivu 43)

16.	WHT BAL 
(valkotasapaino) -toimintopainike 
(sivu 46)

17.	WHT BAL (valkotasapainon 
muistiasetuksen valinta) -kytkin 
(sivu 46)

18.	SHUTTER-toimintopainike (sivu 44)

19.	Kuulokeliitäntä (sivu 34)

20.	POWER-kytkin (sivu 34)

Oikea puoli (takaa) (sivu 6)
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Alapuoli oikealta ja korttipaikka
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1.	 Wi-Fi-antenni

2.	 AUDIO LEVEL (CH1) -säädin (sivu 47)

3.	 CH1 (AUTO/MAN) -kytkin (sivu 47)

4.	 ASSIGN (nimettävät) 1–3 -painikkeet 
(sivu 49)

5.	 Sisäinen mikrofoni (sivu 47)
Selostusmikrofoni ympäröivän äänen 
tallentamiseen. 

[Vinkki]
Mikrofoni on pois päältä, kun yläkahva on asennettuna, 
ja yläkahvan sisäinen mikrofoni aktivoituu (sivu 7).

6.	 DISPLAY-painike (sivu 11)

7.	 Sisäinen kaiutin (sivu 34)

8.	 POWER-ilmaisin (sivu 34)

9.	 SLOT SELECT (muistikorttipaikan (A)/(B) 
valinta) -painike (sivu 34)

10.	CH2 (AUTO/MAN) -kytkin (sivu 47)

11.	AUDIO LEVEL (CH2) -säädin (sivu 47)

12.	Käytön ilmaisin A (sivu 26)

13.	CFexpress Type A- / SD-korttipaikka (A) 
(sivu 26)

14.	CFexpress Type A- / SD-korttipaikka (B) 
(sivu 26)

15.	Käytön ilmaisin B (sivu 26)
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Yläkahva, takaosa ja liitäntäyksikkö
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1.	 Yläkahvan HOLD-kytkin (sivu 99)
Estä yläkahvan säätimien toiminta.

[Vinkki]
Voidaan myös määrittää vain yläkahvan tallennuksen 
START/STOP-painikkeelle.

2.	 Yläkahvan tallennuksen START/STOP-
painike

3.	 Yläkahvan sisäinen mikrofoni

4.	 Moniliitäntäkenkä

Tietoja moniliitäntäkenkään sopivista 
tarvikkeista saat ottamalla yhteyttä 
myyntiedustajaan.

5.	 Yläkahvan nimettävä säädin (sivu 49)

6.	 Yläkahvan zoomausvipu (sivu 99)

7.	 ASSIGN (nimettävät) 7–8 -painikkeet 
(sivu 49)

8.	 Monivalitsin (8-suuntainen ohjainpainike 
ja käytä-painike)

9.	 Lisälaiteliitäntä (sivu 7)

10.	Lisälaiteliitännän ruuvien reiät 
(1/4 tuumaa)

Yhteensopiva 1/4–20 UNC -ruuvien kanssa 
(pituus enintään 6 mm).

[Huomautus]
Yli 6 mm pitkien ruuvien käyttäminen saattaa vaurioittaa 
ulkopuolisia osia.

11.	Tallennuksen merkkivalo (takana) 
(sivu 34)

12.	BATT RELEASE -painike (sivu 17)

13.	Ilmantuloaukko

[Huomautus]
Älä peitä ilmantuloaukkoa.

14.	Akun liitäntä (sivu 17)

15.	USB-C-liitin (sivu 63)

16.	INPUT2 (äänitulo 2) -liitin (sivu 47)

17.	 INPUT1 (äänitulo 1) -liitin (sivu 47)

18.	INPUT2 (LINE/MIC/MIC+48V) -kytkin 
(sivu 47)

19.	INPUT1 (LINE/MIC/MIC+48V) -kytkin 
(sivu 47)

20.	Ruuvien reiät ulkoisille laitteille
Yhteensopiva M3-ruuvien kanssa (pituus 
enintään 4 mm).

[Huomautus]
Yli 4 mm pitkien ruuvien käyttäminen saattaa vaurioittaa 
ulkopintaa.

21.	HDMI OUT -liitin (sivu 114)

22.	SDI OUT -liitin (sivu 114)

23.	TC IN/TC OUT (aikakoodin tulo/
lähtö) -liitin (sivu 115)

24.	REMOTE-liitin
Yhteyden muodostus yleisellä LANC-liitännällä 
varustettuun lisälaitteeseen.

25.	USB-/multiliitin (sivu 116)

26.	DC-IN-liitin (DC-vakioliitäntä) (sivu 18)

Lisälaiteliitännän kiinnittäminen

1	 Nosta liitäntäjousen etureunaa ja vedä 
jousta jouseen kaiverretun nuolen 
suuntaan nähden vastakkaiseen 
suuntaan.

Liitäntäjousi

Lisälaiteliitäntä

1

2	 Aseta lisälaiteliitäntä kiinnikkeeseensä 
kohdistaen liitännän aukot kiinnikkeen 
vastaaviin kohtiin ja kiristä neljä ruuvia.
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3	 Aseta liitäntäjousi paikalleen nuolen 
suuntaisesti siten, että U-kirjaimen 
muotoinen osa sopii lisälaiteliitännän 
päähän.

Liitäntäjousi

Lisälaiteliitäntä

2 32 3

Lisälaiteliitännän irrottaminen

Irrota liitäntäjousi kohdan ”Lisälaiteliitännän 
kiinnittäminen” vaiheessa 1 kuvatulla tavalla, 
avaa neljä ruuvia ja irrota lisälaiteliitäntä.

Yläkahvan kiinnittäminen

Kohdista yläkahvan liitin ja ruuvien reiät 
toisiinsa, työnnä yläkahvan kiinnitysruuvit 
paikoilleen ja kierrä niitä myötäpäivään, jotta 
yläkahva kiinnittyy laitteeseen.
Voit myös kiristää yläkahvan kaksi 
kiinnitysruuvia kiertämällä niitä myötäpäivään 
kuusiokoloavaimella (4 mm).

[Huomautus]
Varmista ennen yläkahvan käyttöä, että sen kaksi 
kiinnitysruuvia on kunnolla kiristetty. Yläkahva voi irrota 
videokamerasta, jos ruuveja ei ole kiristetty kunnolla.

Yläkahvan irrottaminen

Irrota toimimalla päinvastoin kuin 
kiinnitettäessä.

Yläkahvan liittimen suojuksen (mukana) 
kiinnittäminen

Kun käytät videokameraa ilman yläkahvaa, 
suojaa liitin mukana toimitettavalla 
suojuksella.

[Vinkki]
Kun kiinnität yläkahvan, pane suojus talteen yläkahvan 
alaosaan.

Liitinnapojen suojaaminen

Kiinnitä suojus käyttämättömiin liittimiin 
napojen suojaamiseksi.

Yläpuoli

1

2 2

2

2

1.	 Yläkahvan liitin

2.	 Lisälaiteliitännän ruuvien reiät 
(1/4 tuumaa)

Yhteensopiva 1/4–20 UNC -ruuvien kanssa 
(pituus enintään 6 mm).

[Huomautus]
Yli 6 mm pitkien ruuvien käyttäminen saattaa vaurioittaa 
ulkopuolisia osia.
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Alapuoli

1 2
1.	 Jalustan ruuvien reiät (1/4 tuumaa, 

3/8 tuumaa)
Yhteensopiva 1/4–20 UNC -ruuvien ja 3/8–16 
UNC -ruuvien kanssa. Kiinnitys jalustaan 
(lisävaruste, ruuvin pituus enintään 5,5 mm).

2.	 Ilmanpoistoaukko

[Huomautus]
Älä peitä ilmanpoistoaukkoa.

Etsin

Tietoja etsimen (mukana) kiinnittämisestä, ks. 
sivu 19.

1
2
3

4 5

1.	 PEAKING-painike

2.	 ZEBRA-painike

3.	 ASSIGN (nimettävä) 9 -painike (sivu 49)

4.	 Kosketuspaneeli
Kosketustoiminnot voidaan kytkeä pois 
päältä nimettävällä painikkeella tai valikosta 
(sivu 10).

5.	 MIRROR-kytkin

Kauko-ohjainkahva

Tietoja kauko-ohjainkahvan (mukana) 
kiinnittämisestä, ks. sivu 20.

4

3
2

1

7
8

6
5

1.	 Zoomausvipu

2.	 ASSIGN (nimettävä) 4 -painike (sivu 49)

3.	 Kauko-ohjainkahvan nimettävä säädin 
(sivu 49)

4.	 ASSIGN (nimettävä) 6 -painike (sivu 49)

5.	 Kauko-ohjainkahvan kääntövipu 
(sivu 21)

6.	 Tallennuksen START/STOP-painike

7.	 Monivalitsin (8-suuntainen ohjainpainike 
ja käytä-painike)

8.	 ASSIGN (nimettävä) 5 -painike (sivu 49)
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Kosketuspaneelin käyttäminen

Kosketuspaneelin käyttöä 
koskevat varoitukset

Laitteen etsin on kosketuspaneeli, jota 
käytetään suoraan sormen kosketuksella.
ˎˎ Kosketuspaneeli on suunniteltu toimimaan 
kevyellä sormen kosketuksella. Älä paina 
paneelia voimakkaasti äläkä kosketa sitä 
teräväreunaisella tai -kärkisellä esineellä 
(kynsi, kuulakärkikynä tms.).
ˎˎ Kosketuspaneeli ei välttämättä toimi 
seuraavissa olosuhteissa. Huomaa myös, 
että ne voivat aiheuttaa toimintahäiriön.
ˎˎ 	Käyttö kynsien kärjillä
ˎˎ 	Käyttö, kun jokin muu esine koskettaa 
pintaa
ˎˎ 	Käyttö, kun suojakalvo tai -tarra on 
kiinnitettynä
ˎˎ 	Käyttö, kun näytöllä on vesipisaroita tai 
kondensoitunutta vettä
ˎˎ 	Käyttö märin tai hikisin sormin

Kosketuspaneelin eleet

Napauta
Kosketa kohdetta, kuten kuvaketta tai 
valikkokohdetta, kevyesti sormella ja irrota 
kosketus saman tien.

Vedä
Kosketa näyttöä ja liu’uta sormesi näytössä 
haluamaasi kohtaan. Irrota sitten sormesi 
näytöstä.

Sipaise/pyyhkäise
Kosketa näyttöä ja sipaise/pyyhkäise 
sormellasi nopeasti ylös, alas, vasemmalle tai 
oikealle.

[Vinkki]
Jos näytön sisältö jatkuu näytön reunojen yli, voit 
vierittää näytön sisältöä vetämällä tai sipaisemalla.

Kosketuspaneelin määrittäminen

Kosketuspaneeli voidaan ottaa käyttöön 
/poistaa käytöstä käyttämällä Touch 
Operation -toimintoa (sivu 99) Technical-
valikosta.
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Näyttö
Kuvaamisen (tallentaminen/valmiustila) ja toiston aikana videokameran tila ja asetukset näkyvät 
etsimen näyttämän kuvan päällä.
Voit näyttää/piilottaa tiedot DISPLAY-painikkeella. Myös piilotettuna ne tulevat näkyviin, kun 
suoritetaan suoravalikon (sivu 49) toimintoja.
Voit näyttää/piilottaa kunkin kohteen myös erikseen (sivu 93).

Näytöllä kuvaamisen aikana näkyvät tiedot

3 42

6
8

9 1075

11
13 12

14
15

16
17
18

19 20 21 22 23 24 25 26 27 28 29

30

31
32
33
34
35
36
37

138

1.	 Verkon tilan ilmaisin (sivu 13)
Näyttää verkkoyhteyden tilan kuvakkeena.

2.	 Latauksen ilmaisin / jäljellä olevien 
tiedostojen ilmaisin (sivu 65)

3.	 Tarkennusalueen ilmaisin (sivu 38)
Näyttää tarkennusalueen 
automaattitarkennusta varten.

4.	 Tallennustilan, A-/B-paikan, Interval 
Rec -tallennusvälin ilmaisin (sivu 50)

Näyttö Merkitys

Rec Tallentaminen

Stby Tallentamisen 
valmiustila

5.	 Terävyysalueen ilmaisin

6.	 Kuvakennon käyttötilan ilmaisin 
(sivu 24)

-merkki tulee näkyviin, jos objektiivin 
piirtoympyrän koon ja kuvakennon käyttötila-
asetuksen todellisen kuvakoon välillä on 
ristiriita.
Kun kuvakennon käyttötilan asetuksena on FF, 
”C”-merkki näkyy tiloissa, joiden kuvakulma on 
kapeampi (rajattu).
Rajaaminen on käytettävissä seuraavissa 
tiloissa.
ˎˎ Kun tallennusmuotona on 3840×2160 ja S&Q 
Motion -kuvataajuus on 100 fps tai 120 fps
ˎˎ Kun Codec-asetuksena on RAW tai RAW & 
XAVC-I ja RAW-lähtömuoto on 3840×2160

7.	 RAW-lähdön toimintatilan ilmaisin 
(sivu 59)

Näyttää RAW-signaalin lähtötilan.

8.	 UWP-D-sarjan tilan ilmaisin (sivu 13)
Näyttää RF-tason signaalin voimakkuuden 
kuvakkeena, kun UWP-D-sarjan laite on liitetty 
digitaalista äänensiirtoa varten määritettyyn 
moniliitäntäkenkään.

9.	 Hidastetun ja nopeutetun kuvaamisen 
kuvataajuuden ilmaisin (sivu 50)

10.	Jäljellä olevan akkukapasiteetin / DC 
IN -jännitteen ilmaisin (sivu 17)

11.	Tarkennustilan ilmaisin (sivu 41)

Merkitys Näyttö

Focus Hold -tila Focus Hold

MF-tila MF

AF-tila AF

Reaaliaikaisen seurannan AF 
-tila

Kasvojen-/silmientunnistuksen AF (AF/ /
Only/ / )

Kasvojen-/
silmientunnistus-kuvake

Kasvojen-/
silmientunnistuksen 
AF -kuvake

Only

Tallennettujen 
seurantakasvojen kuvake

AF keskeytetty -kuvake 
kasvojen-/
silmientunnistuksen AF:n 
aikana1)

1)	 Näkyvissä, kun tallennettuja seurantakasvoja ei ole 
eikä järjestelmä tunnista niitä tai kun seurantakasvot 
on tallennettu mutta järjestelmä ei tunnista 
seurattavan kohteen kasvoja.

12.	Tarkennuskohdan ilmaisin
Näyttää tarkennuskohdan.

13.	Zoomausasennon ilmaisin (sivu 36)
Näyttää zoomausasennon alueella 0 
(laajakulma) – 99 (tele) (jos liitettynä on 
objektiivi, joka tukee zoomausasetuksen 
näyttöä).

Näyttöä voidaan muuttaa palkki-ilmaisimeksi 
tai tarkennusetäisyyden ilmaisimeksi 
(sivu 100).
Näytössä näkyvät lisäksi seuraavat kohteet, 
kun Clear Image Zoom on käytössä.

Näyttö Merkitys

Clear Image Zoom on 
käytössä

Suurennusarvo Kun Clear Image 
Zoom -zoomausta käytetään

14.	Kuvanvakautustilan ilmaisin

15.	SDI-lähdön/HDMI-lähdön Rec 
Control -tilan ilmaisin (sivu 114)

Näyttää REC-ohjaussignaalin lähdön tilan.

16.	Tarkennuksen ilmaisin (sivu 37)

17.	Tietovälineen jäljellä olevan kapasiteetin 
ilmaisin

Näyttö Merkitys

Käyttöönotto/käyttötila 
(tietoväline A)

Käyttöönotto/käyttötila 
(tietoväline B)

Käyttöönotto/käyttötila 
(tietoväline B)1)

(vilkkuu)

Käyttötila (ei tallennettava) 
(tietoväline B)1) 2)

1)	 Vain tallennuksen välityspalvelintiedot
2)	Tietovälineen virhe, tietoväline täynnä tai muu virhe 

tallennuksen alussa tai aikana

-kuvake tulee näkyviin, jos muistikortti on 
kirjoitussuojattu.

18.	Valkotasapainotilan ilmaisin

Näyttö Merkitys

Automaattitila

 Hold Automaattitila keskeytetty

W:P Esiasetettu tila
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Näyttö Merkitys

W:A Muisti A -tila

W:B Muisti B -tila

19.	Aikakoodin ulkoisen lukituksen ilmaisin / 
aikatiedon näyttö (sivu 34)

Näytössä näkyy ”EXT-LK”, kun lukittu ulkoisen 
laitteen aikakoodiin.

20.	ND-suodattimen ilmaisin (sivu 44)

Näyttö Merkitys

Automaattitila

Boken hallintatila (sivu 53)

21.	Kohtaustiedoston ilmaisin (sivu 56)

22.	Himmentimen ilmaisin
Näyttää himmentimen sijainnin (F-arvo) 
(jos liitettynä on objektiivi, joka tukee 
himmenninasetuksen näyttöä).

23.	Videotason varoituksen ilmaisin

24.	Herkkyysvahvistuksen ilmaisin 
(sivu 43)

Näyttää EI-arvon, kun järjestelmä on Cine 
EI -tilassa (sivu 24).

Näyttö Merkitys

Automaattitila

H Esiasetettu H-tila

M Esiasetettu M-tila

L Esiasetettu L-tila

Tilapäinen säätö -tila

Boken hallintatila 
(sivu 53)

25.	Leikkeen nimen näyttö (sivu 91)
Näyttää tallennettavana olevan tai seuraavaksi 
tallennettavan leikkeen nimen.

26.	Sulkimen ilmaisin (sivu 44)

27.	AE-tilan/AE-tason ilmaisin (sivu 43)

28.	Vaakatason ilmaisin
Näyttää vaakatason ±1°:een lisäyksin aina 
±15°:een saakka.

29.	Äänitasomittari
Näyttää CH1:n–CH4:n äänitason.

30.	Videosignaalin näyttö (sivu 52)
Näyttää aaltomuodon, vektoriskoopin ja 
histogrammin.
Oranssi viiva ilmaisee seepratasolle määritetyn 
arvon.
Cine EI -tilassa (sivu 24) se näyttää 
tarkkailtavan signaalin LUT-tyypin.

31.	Perusherkkyyden ilmaisin / ISO-
herkkyyden perustason ilmaisin 
(sivu 43)

Custom-tilassa (sivu 24) se näyttää 
perusherkkyyden, joka on määritetty Main 
Status -näytön kohdassa Base ISO/Sensitivity 
tai koko valikon Shooting-valikossa kohdassa 
ISO/Gain/EI > Base Sensitivity.
Cine EI -tilassa (sivu 24) se näyttää ISO-
herkkyyden perustason, joka on määritetty 
Main Status -näytön kohdassa Base ISO/
Sensitivity tai koko valikon Shooting-valikossa 
kohdassa ISO/Gain/EI > Base ISO.

32.	Gammanäytön avustuksen / näytön 
LUT-asetuksen ilmaisin

Näyttää gammanäytön avustuksen tilan. 
Gammanäytön avustustoiminto voidaan 
kytkeä päälle / pois päältä nimeämällä 
Gamma Display Assist -toiminto nimettävälle 
painikkeelle (sivu 49).
Cine EI -tilassa (sivu 24) se näyttää näytön 
LUT-asetuksen (sivu 81).

33.	Perusulkoasun ilmaisin (sivu 56)
Näyttää perusulkoasun asetuksen.
Cine EI -tilassa (sivu 24) se näyttää 
muistikorteille tallennettavan videosignaalin 
(sivu 81).

34.	Välityspalvelintilan ilmaisin

Näyttö Merkitys

Välityspalvelimelle 
tallentaminen käytössä

Välityspalvelimelle 
tallentaminen

 
(vilkkuu)

Välityspalvelimelle 
tallentaminen ei valmis

Muistiyksikön tallentaminen 
välityspalvelimelle käytössä

Muistiyksikön tallentaminen 
välityspalvelimelle

 
(vilkkuu)

Muistiyksikön tallentaminen 
välityspalvelimelle ei valmis

35.	Tallennusmuodon (koodekki) ilmaisin 
(sivu 82)

Näyttää muistikorteille tallennuksen muodon 
nimen.

36.	Tallennusmuodon (kuvataajuus ja 
hakumenetelmä) ilmaisin

37.	Tallennusmuodon (kuvakoko) ilmaisin 
(sivu 82)

Näyttää muistikorteille tallentamisen 
kuvakoon.

38.	Reaaliaikaisen seurannan AF 
-pysäytyspainike (sivu 42)
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Näytöllä toiston aikana näkyvät tiedot

Seuraavat tiedot näkyvät toistettavan kuvan päällä.

1

9 10 11 12 13 14

2 3 4 5 6 7 8

1.	 Verkon tilan ilmaisin

2.	 Latauksen ilmaisin / jäljellä olevien 
tiedostojen ilmaisin

3.	 Leikkeen numero / leikkeiden 
kokonaismäärä

4.	 Toiston tilan ilmaisin

5.	 Toistomuodon (kuvataajuus ja 
hakumenetelmä) ilmaisin

6.	 Toistomuodon (kuvakoko) ilmaisin

7.	 Jäljellä olevan akkukapasiteetin / DC 
IN -jännitteen ilmaisin

8.	 Toistomuodon (koodekki) ilmaisin

9.	 Tietovälineen ilmaisin
-kuvake tulee näkyviin, jos muistikortti on 

kirjoitussuojattu.

10.	Aikatietojen näyttö

11.	Leikkeen nimen näyttö

12.	Gammanäytön avustuksen ilmaisin

13.	Äänitasomittari
Näyttää toiston äänitason.

14.	Base Look -ilmaisin

Kuvakenäyttö

Verkkoyhteyden kuvakenäyttö

Verkkotila Yhteyden tila Kuvake

Tukiasematila Toimii tukiasemana

Virhe tukiasematoiminnassa

Asematila Wi-Fi-yhteys
Kuvake muuttuu signaalin vahvuuden 
mukaan (4 vaihetta)

   

Wi-Fi-yhteys katkennut (myös yhteyden 
muodostamisen aikana)

Wi-Fi-yhteysvirhe

USB-yhteydenjako USB-yhteydenjako muodostettu

USB-yhteydenjako katkennut

USB-yhteydenjakovirhe

UWP-D-sarjan kuvakenäyttö

Lähettimen tila Vastaanottotila Kuvake

Virta pois päältä Ei vastaanota

Normaali lähetystila Vastaanottaa
 –   

(vastaanottotaso [4 vaihetta])

Mykistyksen tila Vastaanottaa (mykistetty)

Jäljellä olevan akkukapasiteetin 
varoituksen tila

Vastaanottaa
 (Kuvake vilkkuu)

Mykistyksen ja jäljellä olevan 
akkukapasiteetin varoituksen tila

Vastaanottaa
 (Kuvake vilkkuu)
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Tilanäyttö

Tilanäytöstä voit tarkistaa videokameran 
asetukset ja tilan. Asteriskilla (*) merkittyjen 
kohteiden asetuksia voidaan muuttaa.
Tilanäyttö tukee kosketustoimintoja.

Tilanäytön näyttäminen
ˎˎ Paina MENU-painiketta.

[Vinkki]
Saat kunkin tilanäytön näkyviin/piiloon käyttämällä 
Technical-valikon Menu Page On/Off -valintaa 
(sivu 100).

Tilanäytön vaihtaminen
ˎˎ Käännä monitoimisäädintä.
ˎˎ Työnnä monivalitsinta ylös/alas.
ˎˎ Pyyhkäise tilanäyttöä ylös/alas.

Tilanäytön piilottaminen
ˎˎ Paina MENU-painiketta.

Asetuksen muuttaminen
Kun tilanäyttö on näkyvissä, ota sivun 
määritettävien kohteiden valikoima 
käyttöön painamalla monitoimisäädintä tai 
monivalitsinta. Vaihda sivua valitsemalla 
sivunumero ja painamalla sitä.
Voit valita kohteita myös suoraan 
koskettamalla.

[Huomautus]
Voit poistaa tilanäytössä tehtävät muutokset käytöstä 
määrittämällä koko valikon Technical-valikossa kohdan 
Menu Settings >User Menu Only (sivu 99) asetukseksi 
On.

Main Status -näyttö

Näyttää kameran päätoiminnot ja 
tietovälineen vapaan tilan.

Näyttökohde Kuvaus

S&Q Frame Rate* Hidastuksen ja nopeutuksen 
kuvaus- ja 
kuvataajuusasetukset

Frequency/Scan* Järjestelmän taajuuden ja 
hakumenetelmän asetukset

Imager Scan* Kuvakennon käyttötila

Media Remain 
(A)

Paikan A tietovälineessä 
jäljellä oleva tila

ND Filter ND-suodattimen asetus

ISO/Gain/EI ISO/Gain/Exposure 
Index -asetus

Base ISO/
Sensitivity*

Base ISO/Base 
Sensitivity -asetus

Codec* Tallennuksen 
koodekkiasetus

Media Remain (B) Paikan B tietovälineessä 
jäljellä oleva tila

Scene File* Käytössä oleva 
kohtaustiedosto ja sen 
tiedostotunnuksen asetus

Base Look/LUT* Base Look- / LUT-asetus

Shutter Suljinaika tai suljinkulman 
asetus

Iris Himmenninasetus

Video Format* Kuvakoko tallennettaessa 
muistikorteille

RAW Output 
Format*

RAW-lähdön kuvakoko

White Balance Valkotasapainoasetus

Camera Status -näyttö

Näyttää kameran eri esiasetusten tilan.

Näyttökohde Kuvaus

White Switch<B> Valkotasapainon muisti 
B -asetus

White Switch<A> Valkotasapainon muisti 
A -asetus

White Switch<P> Preset White -asetus

ND<Preset> ND-suodattimen 
Preset1–3 -asetukset

ISO / Gain1)<L>* ISO/Gain1)<L>-asetus

ISO / Gain1)<M>* ISO/Gain1)<M>-asetus

ISO / Gain1)<H>* ISO/Gain1)<H>-asetus

Base ISO/
Sensitivity*

Base ISO/Base 
Sensitivity -asetus

Zebra1* Zebra1 On/Off-asetus ja taso

Zebra2* Zebra2 On/Off-asetus ja 
taso

VF Gamma/
Gamma

Gammakategoria ja -käyrä

Scene File* Käytössä oleva 
kohtaustiedosto ja sen 
tiedostotunnuksen asetus

1)	 Exposure Index, kun kohdan Shooting Mode 
asetuksena on Cine EI.

Audio Status -näyttö

Näyttää tuloasetuksen, äänitasomittarin ja 
äänenvoimakkuuden tarkkailuasetuksen 
kullekin kanavalle.

Näyttökohde Kuvaus

CH1 Level 
Control

Automaattisäätö 
käytössä / ei käytössä -tila

Level Meter Äänitasomittari

Source* Tulolähde

Ref./Sens.* Tulon viitetaso

Wind 
Filter*

Mikrofonin tuulimelun 
vähennys -suodatinasetus

CH2 Level 
Control

Automaattisäätö 
käytössä / ei käytössä -tila

Level Meter Äänitasomittari

Source* Tulolähde

Ref./Sens.* Tulon viitetaso

Wind 
Filter*

Mikrofonin tuulimelun 
vähennys -suodatinasetus

CH3 Level 
Control*

Automaattisäätö 
käytössä / ei käytössä -tila

Level 
Meter*

Äänitasomittari

Source* Tulolähde

Ref./Sens.* Tulon viitetaso

Wind 
Filter*

Mikrofonin tuulimelun 
vähennys -suodatinasetus

CH4 Level 
Control*

Automaattisäätö 
käytössä / ei käytössä -tila

Level 
Meter*

Äänitasomittari

Source* Tulolähde

Ref./Sens.* Tulon viitetaso

Wind 
Filter*

Mikrofonin tuulimelun 
vähennys -suodatinasetus

Audio Input 
Level*

Äänen tulotason (master-
äänenvoimakkuus) asetus

HDMI Output CH* HDMI-lähdön äänikanavan 
asetus
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Näyttökohde Kuvaus

Volume* Kuulokkeiden / sisäisen 
kaiuttimen 
äänenvoimakkuuden asetus

Monitor CH* Näytön kanavan asetus

Project-tilanäyttö

Näyttää kuvausprojektiin liittyvät 
perusasetukset.

Näyttökohde Kuvaus

Frequency/Scan* Järjestelmän taajuuden ja 
hakumenetelmän asetukset

Codec* Tallennuksen 
koodekkiasetus

Rec Function* Erikoistallennustoiminnon 
käytössä / ei käytössä -tila ja 
pääasetukset

Simul Rec* 2 paikan samanaikaisen 
tallennustoiminnon 
käytössä / ei käytössä -tila ja 
asetus

Title Prefix Leikkeen nimen otsikon 
osuus

Imager Scan* Kuvakennon käyttötila

Video Format* Kuvakoko tallennettaessa 
muistikorteille

Picture Cache 
Rec*

Kuvavälimuisti-
tallennustoiminnon 
käytössä / ei käytössä -tila ja 
välimuistin kokoasetus

Number Leikkeen nimen 
numeropääte

Shooting Mode* Kuvaustilan asetukset

RAW Output 
Format*

RAW-lähdön kuvakoko

Proxy Rec* Proxy-tallennustoiminnon 
käytössä / ei 
käytössä -asetus

Monitoring Status -näyttö

Näyttää SDI- ja HDMI-lähdön asetukset.

Näyttökohde Kuvaus

SDI Signal* Lähdön kuvakoko

Info. 
Disp.*

Lähdön näyttö käytössä / ei 
käytössä -asetus

Color 
Gamut*

Väriavaruuden asetus / 
Näytön LUT -tila

HDMI Signal* Lähdön kuvakoko

Info. 
Disp.*

Lähdön näyttö käytössä / ei 
käytössä -asetus

Color 
Gamut*

Väriavaruuden asetus / 
Näytön LUT -tila

Stream Signal Lähdön kuvakoko

Info. 
Disp.

Lähdön näyttö (ei käytössä 
[pysyvä])

Color 
Gamut*

Väriavaruuden asetus / 
Näytön LUT -tila

VF Color 
Gamut*

Gammanäytön avustusasetus / 
Väriavaruuden asetus / Näytön 
LUT -tila

Base Look/LUT* Base Look- / LUT-asetus

Gamma Display 
Assist*

Gamma Display Assist 
käytössä / ei käytössä -asetus

Assignable Button Status -näyttö

Näyttää kullekin nimettävälle painikkeelle 
nimetyt toiminnot.

Näyttökohde Kuvaus

1 ASSIGN 1 -painikkeelle 
nimetty toiminto

2 ASSIGN 2 -painikkeelle 
nimetty toiminto

3 ASSIGN 3 -painikkeelle 
nimetty toiminto

4 ASSIGN 4 -painikkeelle 
nimetty toiminto

5 ASSIGN 5 -painikkeelle 
nimetty toiminto

6 ASSIGN 6 -painikkeelle 
nimetty toiminto

7 ASSIGN 7 -painikkeelle 
nimetty toiminto

8 ASSIGN 8 -painikkeelle 
nimetty toiminto

9 ASSIGN 9 -painikkeelle 
nimetty toiminto

Focus Hold 
Button

Objektiivin Focus 
Hold -painikkeelle nimetty 
toiminto

Multi Function 
Dial

Monitoimisäätimelle nimetty 
toiminto

Grip Dial Kauko-ohjainkahvan 
nimettävälle säätimelle 
nimetty toiminto

Handle Dial Yläkahvan nimettävälle 
säätimelle nimetty toiminto

Battery Status -näyttö

Näyttää tietoja akusta ja DC IN -lähteestä.

Näyttökohde Kuvaus

Detected Battery Akkutyyppi

Remaining Jäljellä oleva kapasiteetti (%)

Charge Count Latausten lukumäärä

Capacity Jäljellä oleva kapasiteetti 
(Ah)

Voltage Akkujännite (V)

Manufacture 
Date

Akun valmistuspäivä

Video Light 
Remaining

Näyttää videovalon akun 
jäljellä olevan kapasiteetin.

Power Source Virtalähde

Supplied Voltage Virtalähteen jännite
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Media Status -näyttö

Näyttää tallennusvälineen jäljellä olevan 
kapasiteetin ja jäljellä olevan tallennusajan.

Näyttökohde Kuvaus

Tietoväline A:n 
tiedot

Näyttää 
tietovälinekuvakkeen, kun 
paikkaan A on asetettu 
tallennusväline.

Tietoväline A:n 
jäljellä olevan 
kapasiteetin 
mittari

Näyttää paikkaan A asetetun 
tallennusvälineen jäljellä 
olevan kapasiteetin 
esitettynä prosenttiosuutena 
pylväskaaviossa.

Tietoväline A:n 
jäljellä oleva 
tallennusaika

Näyttää arvion paikkaan A 
asetetun tallennusvälineen 
jäljellä olevasta 
tallennusajasta minuutteina 
nykyisissä 
tallennusolosuhteissa.

Tietoväline B:n 
tiedot

Näyttää 
tietovälinekuvakkeen, kun 
paikkaan B on asetettu 
tallennusväline.

Tietoväline B:n 
jäljellä olevan 
kapasiteetin 
mittari

Näyttää paikkaan B asetetun 
tallennusvälineen jäljellä 
olevan kapasiteetin 
esitettynä prosenttiosuutena 
pylväskaaviossa.

Tietoväline B:n 
jäljellä oleva 
tallennusaika

Näyttää arvion paikkaan B 
asetetun tallennusvälineen 
jäljellä olevasta 
tallennusajasta minuutteina 
nykyisissä 
tallennusolosuhteissa.

Network Status -näyttö

Näyttää verkkoyhteyden tilan.

Näyttökohde Kuvaus

Wireless LAN Langattoman verkon 
asetukset ja yhteyden tila

Wired LAN Lankaverkon asetukset ja 
yhteyden tila

Modem Langattoman verkon 
asetukset ja USB-jaetun 
yhteyden tila

File Transfer Status -näyttö

Näyttää tiedostonsiirron tiedot.

Näyttökohde Kuvaus

Auto Upload Auto Upload -toiminto 
käytössä / ei käytössä -tila

Auto Upload 
(Proxy)

Auto Upload (Proxy) 
-toiminto käytössä / ei 
käytössä / Chunk -tila

Total Transfer 
Progress

Kaikkien töiden siirron 
eteneminen

Default Upload 
Server

Auto Upload 
(Proxy) -kohdepalvelimen 
nimi

Job Status 
(Remain / Total)

Jäljellä olevien töiden 
lukumäärä ja töiden 
kokonaismäärä

Current File 
Transfer Progress

Nykyisen tiedostonsiirron 
siirtotapahtuman 
eteneminen

Current 
Transferring File 
Name

Parhaillaan siirrettävän 
tiedoston nimi

Server Address Tiedostonsiirron 
kohdepalvelimen osoite

Destination 
Directory

Tiedostonsiirron 
kohdepalvelimen 
kohdehakemisto

Kosketuksella toimivien asetusnäyttöjen käyttäminen

Näytön rakenne

Kohde

Nykyistä asetusta osoittava 
merkki

Set (käytä) -painike

Asetuksen valinnan kohdistin 
(oranssi kehys)

Kohteen nimi

Valittavat vaihtoehdot

Toiminta

1	 Napauta määritettävää kohdetta.

Napauta

Näkyviin tulee kyseiselle arvolle 
valittavissa olevat vaihtoehdot.

2	 Valitse arvo vetämällä tai sipaisemalla 
asetusta.

Sipaise

3	 Napauta Set-painiketta tai arvon valinnan 
kohdistinta.
Arvo otetaan käyttöön ja näyttö palaa 
edelliseen näkymään.

[Vinkkejä]
ˎˎ Palaa edelliseen arvoon painamalla CANCEL/BACK-

painiketta.
ˎˎ Voit käyttää myös monitoimisäädintä tai 

monivalitsinta.
ˎˎ Kosketustoiminnot voidaan myös kytkeä pois päältä 

(sivu 99).
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Virtalähde
Voit käyttää joko akkua tai vaihtovirtaa 
verkkovirtalaitteella.
Käytä turvallisuussyistä vain alla lueteltuja 
Sonyn akkuja ja verkkovirtalaitteita.

Litiumioniakut
BP-U35 (mukana)
BP-U60
BP-U60T
BP-U70
BP-U90
BP-U100

Akkulaturit
BC-CU1 (mukana)
BC-U1A
BC-U2A

Verkkovirtalaite (mukana)
[HUOMIO]

Älä säilytä akkuja paikoissa, jotka altistuvat 
suoralle auringonpaisteelle, tulelle tai korkeille 
lämpötiloille.

[Huomautuksia]
ˎˎ Kun käytät vaihtovirtalähdettä, käytä mukana 

toimitettua verkkovirtalaitetta.
ˎˎ Aseta POWER-kytkin aina Off-asentoon ennen kuin 

liität akun tai verkkovirtalaitteen. Jos se liitetään silloin 
kun POWER-kytkin on On-asennossa, videokamera 
ei joissakin tapauksissa välttämättä käynnisty. Jos 
videokamera ei käynnisty, aseta POWER-kytkin Off-
asentoon ja irrota akku tai verkkovirtalaite noin 30 
sekunnin ajaksi ennen kuin liität sen uudelleen. (Jos 
verkkovirtalaite liitetään silloin kun videokameraa 
käytetään akulla, sen liittäminen onnistuu ongelmitta, 
vaikka POWER-kytkin on On-asennossa.)

Akun käyttäminen

Kiinnitä akku työntämällä se liitäntään 
(sivu 7) niin pitkälle kuin se menee, ja 
lukitse se sitten paikalleen liu’uttamalla 
alaspäin.

Irrota akku painamalla pitkään BATT 
RELEASE -painiketta (sivu 7), liu’uttamalla 
akku ylös ja vetämällä se irti liitännästä.

BATT 
RELEASE -painike

[Huomautuksia]
ˎˎ Ennen kuin kiinnität akun, lataa se siihen tarkoitetulla 

BC‑CU1-, BC-U1A- tai BC‑U2A-akkulaturilla.
ˎˎ Jos akkua ladataan lämpimänä (esimerkiksi heti 

käytön jälkeen), se ei välttämättä lataudu täyteen.

Jäljellä olevan kapasiteetin 
tarkistaminen

Kun kuvaat/toistat käyttäen akkua, sen jäljellä 
oleva kapasiteetti näkyy etsimessä (sivu 11).

Kuvake Merkitys

91%–100%

71%–90%

51%–70%

31%–50%

11%–30%

0%–10%

Videokamera ilmaisee jäljellä olevan 
kapasiteetin laskemalla akulla käytettävissä 
olevan ajan, jos käyttöä jatketaan nykyisellä 
virrankulutuksella.

Jos akun varaus on vähäinen

Jos akun jäljellä oleva varaus laskee käytön 
aikana tietyn tason alle (Low Battery -tila), 
näkyviin tulee alhaisesta varauksesta 
ilmoittava viesti ja tallennuksen merkkivalo 
alkaa vilkkua varoitukseksi.
Jos akun jäljellä oleva varaus laskee 
alle tason, jossa käyttöä ei voida jatkaa, 
(Battery Empty -tila), näkyviin tulee akun 
tyhjenemisestä ilmoittava viesti.
Vaihda tilalle ladattu akku.

Varoitustasojen muuttaminen

Low Battery -tasoksi on tehtaalla oletuksena 
määritetty 10% akun täydestä varauksesta ja 
Battery Empty -tasoksi on määritetty 3%. Voit 
muuttaa varoitustasoja koko valikon Technical-
valikossa kohdassa Camera Battery Alarm 
(sivu 101).

Akun lataaminen mukana toimitetulla 
akkulaturilla (BC‑CU1)

1	 Liitä verkkovirtalaite (mukana) akkulaturiin 
ja kytke virtajohto (mukana) 
vaihtovirtalähteeseen.

2	 Paina akkua ja liu’uta se nuolen suuntaan.
Oranssi CHARGE-valo syttyy ja lataaminen 
alkaa.

CHARGE-valo

Verkkovirtalaite

Virtajohto

CHARGE-valo (oranssi)
Palaa: �Lataa
Vilkkuu: �Latausvirhe, tai lämpötila on toiminta-

alueen ulkopuolella ja lataaminen on 
keskeytynyt

ˎˎ Kun akku on ladattu täyteen, akkulaturin 
CHARGE-valo sammuu.
ˎˎ Käytä aina alkuperäisiä Sony-akkuja.
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Latausaika
Arvioitu aika (minuutteina), jonka täysin 
tyhjentyneen akun lataaminen täyteen kestää.

Akku Latausaika täyteen

BP-U35 120 minuuttia

[Huomautus]
Jos verkkovirtalaite irtoaa akkulaturista ja akku on yhä 
kytkettynä akkulaturiin, akun varaus alkaa purkautua.

Verkkovirran käyttäminen

Liittämällä videokameran 
vaihtovirtalaitteeseen käyttäjän ei tarvitse 
huolehtia akun lataamisesta.

DC IN -liitin

Verkkovirtalaite

Virtajohto

Liitä verkkovirtalaite videokameran DC 
IN -liittimeen ja kytke virtajohto (mukana) 
vaihtovirtalähteeseen.

Jos verkkovirtalaitteen lähtöjännite 
laskee

Jos verkkovirtalaitteen lähtöjännite laskee 
käytön aikana tietyn tason alle (DC Low 
Voltage1 -tila), näkyviin tulee viesti, joka 
ilmoittaa, että verkkovirtalaitteen lähtöjännite 
on laskenut, ja tallennuksen merkkivalo alkaa 
vilkkua.
Jos verkkovirtalaitteen lähtöjännite laskee 
alle tason, jossa käyttöä ei voida jatkaa (DC 
Low Voltage2 -tila), näkyviin tulee viesti, joka 
ilmoittaa, että verkkovirtalaitteen lähtöjännite 
on liian alhainen.
Jos näin käy, verkkovirtalaite saattaa olla 
viallinen. Tarkista verkkovirtalaite tarpeen 
mukaisesti.

Varoitusjännitteiden muuttaminen

DC Low Voltage1 -tasoksi on tehtaalla 
oletuksena määritetty 16,5 V ja DC Low 
Voltage2 -tasoksi on määritetty 15,5 V. Voit 
muuttaa varoitustasoja Technical-valikon 
kohdassa Camera DC IN Alarm (sivu 101).

Verkkovirtalaite

ˎˎ Älä liitä ja käytä verkkovirtalaitetta ahtaissa 
tiloissa, kuten seinän ja huonekalun välissä.
ˎˎ Liitä verkkovirtalaite lähimpään 
vaihtovirtalähteeseen. Jos käytön aikana 
ilmenee ongelmia, irrota virtajohto 
välittömästi vaihtovirtalähteestä.
ˎˎ Älä aiheuta oikosulkua verkkovirtalaitteen 
pistokkeen metalliosiin. Se voi aiheuttaa 
toimintahäiriön.
ˎˎ Akkua ei voida ladata, kun se on 
kiinnitettynä videokameraan, edes silloin, 
kun verkkovirtalaite on liitetty.
ˎˎ Kun irrotat verkkovirtalaitteen kamerasta, 
tartu pistokkeeseen ja vedä se suoraan 
ulos. Johdosta vetäminen voi aiheuttaa 
toimintahäiriön.
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Laitteiden kiinnittäminen

Mikrofonin kiinnittäminen 
(myynnissä erikseen)

1	 Aseta mikrofoni mikrofonitelineeseen.

2	 Liitä mikrofonin johto INPUT1- tai INPUT2-
liittimeen.

INPUT

1
LINE MIC

+48VMIC

2
LINE MIC

+48VMIC

1

2

Mikrofoni

Mikrofoni-
teline

INPUT1 INPUT2

3	 Aseta mikrofonin johto johdonpitimeen 
kaaviossa esitetyllä tavalla.

Johdonpidin

[Vinkkejä]
ˎˎ Jos et saa kiinnitettyä mikrofonia kunnolla, käytä 

mikrofonin mukana toimitettua holkkia.
ˎˎ Kiinnitetyn objektiivin tyypistä riippuen mikrofonin 

kärki voi näkyä videokameran kuvassa. Säädä 
mikrofonin asentoa.

Etsimen kiinnittäminen

[Huomautus]
Kiinnitä/irrota etsin, kun videokamera on sammutettuna.

Etsimen kiinnittäminen yläkahvan eteen

1	 Aseta etsimen asennuskiinnikkeen sovitin 
yläkahvassa olevaan etsinliitäntään () ja 
lukitse se paikalleen kääntämällä ruuvia 
(mukana) myötäpäivään ().
Asennuskiinnikkeen sovitin voidaan 
kiinnittää vapaasti 45 asteen askelin, 
mutta suositeltavin on asento, jossa 
liitäntäkohta on suoraan ruuvin 
yläpuolella.

Ruuvi
Etsimen 
asennuskiinnikkeen 
sovitin

2	 Asenna etsimen kiinnike etsimen 
asennuskiinnikkeen sovittimeen () ja 
lukitse se paikalleen kääntämällä 
lukitusnuppia myötäpäivään ().

[Huomautus]
Kun käytät etsintä, varmista, että lukitusnuppi on 
kunnolla kiristetty. Etsin saattaa irrota, jos lukitusnuppia 
ei ole kiristetty kunnolla.

3	 Kohdista videokameran -merkki etsimen 
liittimen -merkkiin ja aseta johto 
paikalleen.
Varmista ennen liittimen asettamista, että 
-merkki näkyy ulkopuolella.

4	 Aseta johto johdonpitimeen kaaviossa 
esitetyllä tavalla.

Johdonpidin
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Etsimen kiinnittäminen yläkahvan 
taakse

Laitteessa on etsimen kiinnittämistä varten 
kaksi liitäntäkohtaa sekä yläkahvan takana 
() että videokameran takana (). Kiinnitä 
etsin samalla tavoin kuin on kuvattu kohdassa 
”Etsimen kiinnittäminen yläkahvan eteen”.

Etsimen asennon säätäminen

Säädä etsimen kulmaa kallistamalla sitä ylös/
alas/eteenpäin/taaksepäin.
MIRROR-kytkimellä voit kääntää kuvan, 
kun esimerkiksi katselet sitä videokameran 
etupuolelta.

[Vinkki]
Kun laitetta ei käytetä tai sitä kuljetetaan, etsin on 
suositeltavaa suojata siirtämällä se seuraavassa 
kaaviossa esitettyyn asentoon.

Etsimen irrottaminen

Löysää etsimen lukitusnuppia ja toimi 
päinvastoin kuin etsintä kiinnitettäessä.

Etsimen suojuksen kiinnittäminen

1	 Avaa etsimen suojuksen 
metallikiinnikkeet.

2	 Kiinnitä etsimen suojuksen yläosassa 
sijaitseva metallikiinnike etsimen yläosan 
koukkuun ja kiinnitä etsimen suojuksen 
alaosassa sijaitseva metallikiinnike 
etsimen alaosan koukkuun.

Liitäntäkoukut

3	 Lukitse etsimen suojus paikalleen 
työntämällä etsimen suojuksen alaosassa 
sijaitsevaa lukituslevyä nuolen suuntaan.

Lukituslevy

Etsimen suojuksen avaaminen

Vedä etsimen suojuksen alaosan keskikohtaa 
itseäsi kohti ja avaa suojus nostamalla se ylös.

[Huomautus]
Kun liikutat etsintä, pitele samalla kiinni etsimen 
rungosta. Älä tartu etsimen suojukseen.

Etsimen suojuksen irrottaminen

Avaa etsimen suojuksen lukitus ja irrota 
etsimen suojus etsimestä.

Kauko-ohjainkahvan 
kiinnittäminen

[Huomautus]
Kiinnitä/irrota kauko-ohjainkahva, kun videokamera on 
sammutettuna.

1	 Liitä johto kauko-ohjainkahvan liittimeen.

2	 Kohdista videokamerassa oleva kauko-
ohjainkahvan liitäntä kahvassa olevaan 
asennusmerkkiin (), kiinnitä kahva 
videokameraan ja käännä sitä hitaasti 
vastapäivään ().
Paikalleen lukittumisesta kuuluu 
napsahdus.
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Asennusmerkki

[Huomautus]
Jos et saa kiinnitettyä sitä oikein, kiinnitä se uudelleen 
kohdistamatta liikaa voimaa kauko-ohjainkahvaan tai 
videokameraan.

3	 Aseta vaiheessa 2 liitetty johto kauko-
ohjainkahvan uurteen alle kaavion 
mukaisesti.

[Huomautus]
Jos johto ei kulje uurteen alta, kahvaliitännän kulman 
muuttaminen voi kohdistaa johtoon likaa voimaa tai 
johto saattaa juuttua kääntömekanismiin.

Kauko-ohjainkahvan kulman 
säätäminen

Voit säätää kauko-ohjainkahvan kulmaa 
seuraavassa kaaviossa esitetyillä tavoilla 
kuvaustyyliisi sopivasti.

Vakioasento

Käännetty objektiivia kohti (enint. 90°)

Käännetty takaosaa kohti (enint. 83°)

1	 Siirrä kauko-ohjainkahvan kääntövipu 
kaaviossa esitettyyn asentoon ja käännä 
kahvaa samalla kun painat vipua.

2	 Vapauta sormesi kauko-ohjainkahvan 
kääntövivulta, kun kahva on lähellä 
haluamaasi asentoa.

3	 Liikuta kauko-ohjainkahvaa hieman, 
kunnes kuulet napsahduksen, joka 
ilmaisee, että kahva on lukittunut 
paikalleen.
Kun kauko-ohjainkahva on lukittunut, 
kahvan kääntövipu palaa alkuperäiseen 
asentoonsa.

[Huomautuksia]
ˎˎ Tarkista aina asennon muuttamisen jälkeen, että 

kauko-ohjainkahva on lukittunut paikalleen.
ˎˎ Kulmaa ei voida säätää säätöalueen yli. Älä käytä 

kauko-ohjainkahvan kääntämiseen liikaa voimaa.

Kauko-ohjainkahvan piteleminen 
(suositeltava menetelmä)

Kauko-ohjainkahvan pitelemiseen ei ole 
sääntöjä, mutta seuraavassa esimerkissä 
näkyy helppo tapa käyttää kahvaa.

Kun käytät ASSIGN 5 -painiketta tai 
monivalitsinta

A: Käytä kauko-ohjainkahvan nimettävää 
säädintä etusormella.
B: Käytä monivalitsinta ja ASSIGN 5 -painiketta 
peukalolla.
C: Pitele kauko-ohjainkahvasta tukevasti 
keskisormella, nimettömällä ja pikkusormella.

Zoomin käyttäminen

A: käytä zoomausvipua etu- ja keskisormella.
B: Pitele kauko-ohjainkahvasta tukevasti 
peukalolla.
C: Pitele kauko-ohjainkahvasta tukevasti 
nimettömällä ja pikkusormella.
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Kauko-ohjainkahvan irrottaminen

[Huomautus]
Kun irrotat kauko-ohjainkahvaa, aseta videokamera 
tasaiselle pinnalle, kuten työpöydälle.

1	 Irrota johto kauko-ohjainkahvan 
liittimestä.

2	 Pidä videokamerassa sijaitsevaa kauko-
ohjainkahvan vapautuspainiketta 
painettuna ja käännä kahvaa 
myötäpäivään, kunnes se irtoaa.

Kauko-ohjainkahvan vapautuspainike

[Vinkki]
Rosettekiinnike voidaan kiinnittää sekä laitteessa 
olevaan kauko-ohjainkahvan liitäntään että vastaavaan 
kauko-ohjainkahvassa olevaan liitäntäkohtaan.
Tietoja rosettekiinnikkeiden ostamisesta saat Sonyn 
jälleenmyyjältä.
–– Videokameran puoli: 4-546-932- (lisävaruste)
–– Kauko-ohjainkahvan puoli: 4-547-089- (lisävaruste)
–– Kiinnitysruuvit* 

Videokameran puoli: 7-627-556- (lisävaruste) 
Kauko-ohjainkahvan puoli: 7-627-556- (lisävaruste)

*	 Kuhunkin rosettekiinnikkeeseen tarvitaan neljä ruuvia 
(ruuvien reiät on ympyröity seuraavassa kaaviossa). 
Muiden kuin määrättyjen ruuvien käyttäminen saattaa 
vaurioittaa ulkoisia osia.

Videokameran 
puoli

Kauko-ohjainkahvan 
puoli

Objektiivin kiinnittäminen

[HUOMIO]

Älä suuntaa objektiivia kohti aurinkoa. Suora 
auringonvalo voi kulkeutua objektiivin läpi, 
kohdistua videokameraan ja aiheuttaa 
tulipalon.

[Huomautuksia]
ˎˎ Kiinnitä/irrota objektiivi, kun videokamera on 

sammutettuna.
ˎˎ Objektiivi on tarkkuuskomponentti. Älä aseta 

objektiivia millekään pinnalle siten, että objektiivin 
pidike on alaspäin. Kiinnitä mukana toimitettu 
objektiivinpidikkeen suojus.

[Vinkki]
Lisätietoja videokameraan soveltuvista objektiiveista 
saat ottamalla yhteyttä Sonyn palveluedustajaan.

E-pidikkeellisen objektiivin 
kiinnittäminen

1	 Irrota objektiivinsuojus ja pidikkeensuojus 
videokamerasta ja objektiivista.

2	 Kohdista objektiivin asennusmerkki 
(valkoinen) videokameraan, aseta 
objektiivi varovasti paikalleen ja käännä 
sitä myötäpäivään.
Paikalleen lukittumisesta kuuluu 
napsahdus.

Asennusmerkit (valkoinen)

[Huomautus]
Älä paina objektiivin vapautuspainiketta, kun kiinnität 
objektiivia.

A-pidikkeellisen objektiivin 
kiinnittäminen
Jos haluat käyttää A-pidikkeellistä objektiivia, 
kiinnitä ensin objektiivin asennussovite 
(lisävaruste) ja sitten A-pidikkeellinen 
objektiivi.

[Huomautus]
Kun käytät A-pidikkeellistä objektiivia, himmennin 
määrittyy manuaalisesti ja tarkennukseksi määrittyy MF.

Objektiivin irrottaminen
Irrota objektiivi seuraavan menettelyn 
mukaisesti.

1	 Pidä objektiivin vapautuspainiketta 
painettuna ja käännä objektiivia 
vastapäivään pidellen sitä samalla 
tukevasti.

2	 Irrota objektiivi vetämällä sitä eteenpäin.

[Huomautuksia]
ˎˎ Kun irrotat objektiivia, kohdista objektiivin 

lukitusrenkaassa oleva asennusmerkki 
videokamerassa olevaan asennusmerkkiin.
ˎˎ Tartu objektiiviin tukevasti, jotta se ei putoa.
ˎˎ Jos tilalle ei saman tien kiinnitetä toista objektiivia, 

kiinnitä aina rungon suojus.

Himmentimen säädöt objektiiveissa, 
joissa on Auto Iris -kytkin

ˎˎ Kun objektiivin Auto Iris -asetukseksi 
on määritetty AUTO, himmennin säätyy 
automaattisesti ja sitä voidaan säätää 
videokamerasta myös käsin.
ˎˎ Kun objektiivin Auto Iris -asetukseksi on 
määritetty MANUAL, himmennintä voidaan 
säätää vain objektiivista. Himmentimen 
käytöllä videokamerasta ei ole vaikutusta.
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Tarkennuksen säädöt objektiiveissa, 
joissa on tarkennuskytkin

ˎˎ Kun objektiivin tarkennuskytkimen 
asetukseksi on määritetty AF/MF tai AF, 
tarkennus säätyy automaattisesti ja sitä 
voidaan säätää kauko-ohjaimesta myös 
käsin.
ˎˎ Kun objektiivin tarkennuskytkimen 
asetukseksi on määritetty MF, tarkennusta 
säädetään objektiivista ja sitä voidaan 
säätää kauko-ohjaimesta myös käsin.

	 [Huomautus]
Kun käytetään A-pidikkeellistä objektiivia, käsisäätö 
kauko-ohjaimesta ei ehkä ole käytettävissä.

ˎˎ Kun objektiivin tarkennuskytkimen 
asetukseksi on määritetty Full MF, 
tarkennusta voidaan säätää vain 
objektiivista. Tarkennuksen käytöllä 
videokamerasta ei ole vaikutusta.

Kiinnittäminen jalustaan
Käytä jalustan kiinnittämiseen videokamerassa 
olevia jalustan ruuvien reikiä. Objektiivissa 
olevan jalustapidikkeen käyttäminen voi 
aiheuttaa vaurion.
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Videokameran perustoimintojen määrittäminen
Etsimessä näkyy alkuasetusnäyttö, kun 
videokamera kytketään päälle ensimmäistä 
kertaa tai kun vara-akku on tyhjentynyt täysin.
Määritä sisäisen kellon päiväys ja kellonaika 
tässä näytössä.

Time Zone
Time Zone ‑asetus määrittää aikaeron 
koordinoituun maailmanaikaan (UTC) nähden. 
Muuta asetusta tarvittaessa.

Päivämäärän ja kellonajan 
määrittäminen

Valitse kohteita ja asetuksia monivalitsimella 
(sivu 7) tai monitoimisäätimellä 
(sivu 5), ota sitten asetukset käyttöön 
painamalla monivalitsimen käytä-painiketta 
tai monitoimisäädintä ja käynnistä kello.
Kun asetusnäyttö sulkeutuu, voit muuttaa 
päivämäärää, kellonaikaa ja aikavyöhykettä 
käyttämällä Maintenance-valikon Clock 
Set -asetusta (sivu 106).

[Huomautuksia]
ˎˎ Jos kellon asetus katoaa sen vuoksi, että vara-akku 

on täysin tyhjä virran oltua katkaistuna pitkän aikaa 
(ei akkua eikä DC IN -virtalähdettä), alkuasetusnäyttö 
tulee näkyviin, kun seuraavan kerran kytket 
videokameran päälle.
ˎˎ Kun alkuasetusnäyttö on näkyvissä, mikään muu 

toiminto paitsi virrankatkaisu ei onnistu, ennen kuin 
tämän näytön asetukset on tehty.
ˎˎ Videokamerassa on sisäinen ladattava akku, jotta 

päivämäärä, kellonaika ja muita asetuksia pysyy 
tallessa silloinkin, kun videokamera on pois päältä.

Määritä videokameran perustoiminnot ennen 
kuvaamista Project-tilanäytössä käyttökohteen 
mukaisiksi.

Kuvaustila

Voit vaihtaa kuvaustilaksi joko ”Custom-tilan”, 
jossa voit luoda kuvia joustavasti paikan 
päällä, tai ”Cine EI -tilan” (jossa videokameraa 
käytetään samalla tavalla kuin filmikameraa ja 
kuva-aineisto kehittyy myöhemmin).
Määritä kuvaustila käyttämällä Project-
tilanäytön Shooting Mode -asetusta 
(sivu 15).

[Vinkki]
Voit määrittää kuvaustilan myös koko valikon Project-
valikossa kohdassa Base Setting >Shooting Mode 
(sivu 82).

Custom-tila

Custom-kuvaustilassa voit valita 
videostandardin.
Voit määrittää videostandardin koko valikon 
Project-valikossa kohdassa Base Setting > 
Target Display (sivu 82).
ˎˎ SDR(BT.709): Kuvaaminen HD-
lähetysstandardin mukaan
ˎˎ HDR(HLG): Kuvaaminen seuraavan 
sukupolven 4K-lähetysstandardin mukaan

Lisätietoja saat kohdasta sivu 56.

Cine EI -tila

Kun kuvaustilaksi on määritetty Cine EI -tila, 
valitse perusväriavaruus tallennussignaalille 
ja lähtösignaalille. Tässä valittu väriavaruus 
on videolähdön väriavaruus, kun MLUT-
asetuksena on Off.
Voit määrittää väriavaruuden koko valikon 
Project-valikossa kohdassa Cine EI Setting > 
Color Gamut (sivu 83).
ˎˎ S-Gamut3.Cine/SLog3: Helposti säädettävä 
värialue digitaaliseen elokuvaan (DCI-P3).
ˎˎ S-Gamut3/SLog3: Sonyn laaja värialue, joka 
kattaa ITU-R BT.2020 -väriavaruuden.

Lisätietoja saat kohdasta sivu 58.

[Huomautuksia]
ˎˎ Cine EI -tilassa on seuraavat rajoitteet.

ˎˎ Toiminnot, joita ei voida säätää automaattisesti 
(seuranta)
–– Valkotasapaino
–– Herkkyysvahvistus
–– Suljin

ˎˎ Toiminnot, joita ei voida määrittää
–– ISO-herkkyys/herkkyysvahvistus (ISO-herkkyys 

asetettu perustasolle [pysyvä])
–– Paint/Look-valikkoasetukset (paitsi Base Look)
–– Scene File (ei käytössä)

ˎˎ Seuraavat toiminnot ovat saatavilla vain Cine 
EI -tilassa (sivu 58).

ˎˎ Exposure Index
ˎˎ Näytön LUT

Järjestelmän taajuus

Määritä järjestelmän taajuus käyttämällä 
Project-tilanäytön Frequency/Scan-asetusta 
(sivu 15). Videokamera voi vaihtamisen 
jälkeen käynnistyä automaattisesti uudelleen 
valitusta arvosta riippuen.

[Vinkki]
Voit määrittää järjestelmän taajuuden myös koko valikon 
Project-valikossa kohdassa Rec Format > Frequency 
(sivu 82).

[Huomautus]
Järjestelmän taajuutta ei voida vaihtaa tallennuksen tai 
toiston aikana.

Kuvakennon käyttötila

Voit määrittää kuvakennon todellisen 
kuvakoon ja tarkkuuden.
Määritä käyttötila Project-tilanäytön Imager 
Scan -asetuksella (sivu 15).
ˎˎ FF: Täysikokoinen.
ˎˎ S35: Super 35mm -koko.

[Vinkki]
Voit määrittää käyttötilan myös koko valikon Project-
valikossa kohdassa Rec Format > Imager Scan Mode 
(sivu 82).

[Huomautuksia]
ˎˎ Kuvakennon käyttötilaa ei voida vaihtaa tallennuksen 

tai toiston aikana.
ˎˎ Kun asetuksena on S35, videomuodoksi on rajoitettu 

1920×1080.

Koodekki

Määritä koodekki käyttämällä Project-
tilanäytön Codec-asetusta (sivu 15).

[Vinkki]
Voit määrittää koodekin myös koko valikon Project-
valikossa kohdassa Rec Format > Codec (sivu 82).

[Huomautus]
Koodekkia ei voi vaihtaa tallennuksen tai toiston aikana.
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Videomuoto

Voit määrittää tallennuksen videomuodon. 
Määritä videomuoto käyttämällä Project-
tilanäytön Video Format -asetusta (sivu 15).

[Vinkki]
Voit määrittää videomuodon myös koko valikon 
Project-valikossa kohdassa Rec Format > Video Format 
(sivu 82).

[Huomautuksia]
ˎˎ Videomuotoa ei voida vaihtaa tallennuksen tai toiston 

aikana.
ˎˎ SDI OUT- ja HDMI OUT -liittimien signaaleihin voi 

kohdistua rajoitteita videomuotoasetuksesta riippuen.
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Videokamera tallentaa ääntä ja videokuvaa korttipaikkoihin asetetuille CFexpress Type 
A -muistikorteille (saatavilla erikseen) tai SDXC-muistikorteille (saatavilla erikseen). Muistikortteja 
käytetään myös välityspalvelimelle tallentamiseen ja asetusten tallentamiseen/lataamiseen sekä 
ohjelmiston päivitykseen.

Tietoa CFexpress Type A -muistikorteista

Käytä videokamerassa Sony CFexpress Type A -muistikortteja*, jotka on lueteltu kohdassa 
”Suositeltavat tietovälineet” (sivu 27).
Tietoja muiden valmistajien tietovälineiden toiminnasta saat kyseisen tietovälineen 
käyttöohjeesta tai tutustumalla valmistajan antamiin tietoihin.
* �Viitataan tässä asiakirjassa nimityksellä ”CFexpress-kortit”.

Tietoa SDXC-muistikorteista

Käytä videokamerassa SDXC-muistikortteja*, jotka on lueteltu kohdassa ”Suositeltavat 
tietovälineet” (sivu 27).
* �Viitataan tässä asiakirjassa nimityksellä ”SD-kortit”.

Muistikorttien käyttäminen
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Suositeltavat tietovälineet

Taatut käyttöolosuhteet vaihtelevat Rec Format- ja Recording-asetuksista riippuen.
Kyllä: toimintaa tuetaan
Ei: normaalia toimintaa ei taata

Tallennusmuoto CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

RAW Out &  
XAVC-I

4096×2160
Class300

Normaalitila 59.94P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

50P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

29.97P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

25P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

24P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

23.98P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

3840×2160
Class300

Normaalitila 59.94P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

50P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

29.97P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

25P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

23.98P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

S&Q (enintään 60fps) 59.94P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

50P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

29.97P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

25P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

23.98P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

S&Q (100fps, 120fps) 59.94P Kyllä Ei Ei Ei Ei Ei Ei Ei

50P Kyllä Ei Ei Ei Ei Ei Ei Ei

29.97P Kyllä Ei Ei Ei Ei Ei Ei Ei

25P Kyllä Ei Ei Ei Ei Ei Ei Ei

23.98P Kyllä Ei Ei Ei Ei Ei Ei Ei
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Tallennusmuoto CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-I 4096×2160
Class300 

Normaalitila 59.94P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

50P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

29.97P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

25P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

24P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

23.98P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

S&Q (enintään 60fps) 59.94P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

50P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

29.97P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

25P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

24P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

23.98P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

3840×2160
Class300 

Normaalitila 59.94P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

50P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

29.97P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

25P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

23.98P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

S&Q (enintään 60fps) 59.94P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

50P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

29.97P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

25P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

23.98P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

S&Q (100fps, 120fps) 59.94P Kyllä Ei Ei Ei Ei Ei Ei Ei

50P Kyllä Ei Ei Ei Ei Ei Ei Ei

29.97P Kyllä Ei Ei Ei Ei Ei Ei Ei

25P Kyllä Ei Ei Ei Ei Ei Ei Ei

23.98P Kyllä Ei Ei Ei Ei Ei Ei Ei
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Tallennusmuoto CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-I 1920×1080
Class100

Normaalitila 59.94P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

50P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

29.97P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

25P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

23.98P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

S&Q (enintään 60fps) 59.94P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

50P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

29.97P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

25P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

23.98P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

S&Q (100fps, 120fps) 59.94P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

50P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

29.97P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

25P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

23.98P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

S&Q (150fps, 180fps) 59.94P Kyllä Ei Ei Ei Ei Ei Ei Ei

50P Kyllä Ei Ei Ei Ei Ei Ei Ei

29.97P Kyllä Ei Ei Ei Ei Ei Ei Ei

25P Kyllä Ei Ei Ei Ei Ei Ei Ei

23.98P Kyllä Ei Ei Ei Ei Ei Ei Ei

S&Q (200fps, 240fps) 59.94P Kyllä Ei Ei Ei Ei Ei Ei Ei

50P Kyllä Ei Ei Ei Ei Ei Ei Ei

29.97P Kyllä Ei Ei Ei Ei Ei Ei Ei

25P Kyllä Ei Ei Ei Ei Ei Ei Ei

23.98P Kyllä Ei Ei Ei Ei Ei Ei Ei
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Tallennusmuoto CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 3840×2160
420 

Normaalitila 59.94P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

50P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

29.97P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

25P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

23.98P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

S&Q (enintään 60fps) 59.94P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

50P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

29.97P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

25P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

23.98P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

S&Q (100fps, 120fps) 59.94P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

50P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

29.97P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

25P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

23.98P Kyllä Ei Ei Ei Ei Ei Ei Ei

1920×1080
HD50

Normaalitila 59.94P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

50P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

29.97P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

25P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

23.98P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

S&Q (enintään 60fps) 59.94P Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä

50P Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä

29.97P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

25P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

23.98P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

S&Q (100fps, 120fps) 59.94P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

50P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

29.97P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

25P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

23.98P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä
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Tallennusmuoto CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 1920×1080
HD50

S&Q (150fps, 180fps) 59.94P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

50P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

29.97P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

25P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

23.98P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

S&Q (200fps, 240fps) 59.94P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

50P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

29.97P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

25P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

23.98P Kyllä Ei Ei Ei Ei Ei Ei Kyllä

1920×1080
HD35

Normaalitila 59.94P Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä

50P Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä

29.97P Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä

25P Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä

23.98P Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä

S&Q (enintään 60fps) 59.94P Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä

50P Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä Kyllä

29.97P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

25P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

23.98P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

S&Q (100fps, 120fps) 59.94P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

50P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

29.97P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

25P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

23.98P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

S&Q (150fps, 180fps) 59.94P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

50P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

29.97P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

25P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

23.98P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

S&Q (200fps, 240fps) 59.94P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

50P Kyllä Ei Ei Kyllä Ei Kyllä Kyllä Kyllä

29.97P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

25P Kyllä Ei Ei Ei Ei Ei Kyllä Kyllä

23.98P Kyllä Ei Ei Ei Ei Ei Ei Kyllä
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Muistikortin asettaminen

1	 Avaa muistikorttiosion tietovälinekansi.

2	 Aseta muistikortti.
ˎˎ CFexpress-korteissa tarrapuoli tulee 
vasemmalle.

Tarra

ˎˎ SD-korteissa tarrapuoli tulee oikealle ja 
viistetty kulma alaspäin.

Viistetty kulma

Käytön ilmaisin (sivu 6) palaa 
punaisena ja muuttuu sitten vihreäksi, jos 
kortti on käytettävissä.

	 [Huomautus]
Jos käytön merkkivalo vilkkuu punaisena 
katkottomasti eikä muutu vihreäksi, sammuta 
videokamera hetkeksi, poista muistikortti ja aseta 
se takaisin.

3	 Sulje tietovälinekansi.

[Huomautuksia]
ˎˎ Muistikortti, muistikorttipaikka ja muistikortin 

kuvatiedot voivat vaurioitua, jos kortti pakotetaan 
aukkoon väärinpäin.
ˎˎ Kun tallennat molempiin CFexpress Type A- / SD-

korttipaikkoihin A ja B asetetuille tietovälineille, aseta 
molempiin paikkoihin tietoväline, jota suositellaan 
käytettäväksi kyseisellä tallennusmuodolla.

Muistikortin poistaminen

Avaa muistikorttiosion tietovälinekansi ja 
paina muistikorttia kevyesti, jotta se poistuu.

[Huomautuksia]
ˎˎ Jos videokamera sammutetaan tai muistikortti 

poistetaan, kun muistikortti on käytössä, kortin 
tietojen eheyttä ei voida taata. Kaikki kortille 
tallennettu tieto voi hävitä. Varmista aina, että käytön 
ilmaisin palaa vihreänä tai on sammunut, ennen kuin 
sammutat videokameran tai poistat muistikortin.
ˎˎ Kun poistat muistikortin heti tallentamisen päätyttyä, 

muistikortti voi olla kuuma, mutta se ei ole merkki 
ongelmasta.

Muistikorttien formatoiminen 
(alustaminen)

Jos laitteeseen asetetaan formatoimaton 
muistikortti tai eri määrityksillä formatoitu 
muistikortti, etsimeen ilmestyy viesti ”Media 
Needs to be Formatted”.
Formatoi kortti seuraavan menettelyn 
mukaisesti.

1	 Valitse koko valikon TC/Media-valikosta 
Format Media (sivu 92).

2	 Valitse Media(A) (paikka A) tai Media(B) 
(paikka B) ja valitse sitten 
formatointimenetelmä (Full Format tai 
Quick Format).
Näkyviin tulee vahvistusviesti.
ˎˎ Full Format: Alustaa tietovälineen 
kokonaan, mukaan lukien tietoalueeseen 
ja tiedonhallintaan liittyvät tiedot.
ˎˎ Quick Format: Alustaa vain tietovälineen 
tiedonhallintaan liittyvät tiedot.

3	 Valitse Execute.
Kun formatointi on meneillään, näkyvissä 
on viesti ja käytön ilmaisin palaa 
punaisena.
Kun formatointi on valmis, näkyviin tulee 
viesti päättymisestä. Hylkää viesti 
painamalla monitoimisäädintä.

[Huomautuksia]
ˎˎ Muistikortin formatointi pyyhkii kaikki tiedot, 

mukaan lukien tallennettujen videoiden tiedot ja 
asennustiedostot.
ˎˎ Suorituksen aikana voi tulla näkyviin viestejä 

formatointiprosessin kestosta riippuen.

Jos formatoiminen epäonnistuu

Muistikortteja, joita videokamera ei tue, ei 
voida formatoida.
Näkyviin tulee varoitusviesti. Vaihda kortti 
tuettuun muistikorttiin noudattamalla ohjeita.

Videokamerassa formatoidun kortin 
käyttäminen toisessa laitteessa

Tee kortista ensin varmuuskopio ja formatoi 
kortti uudelleen käytettävässä laitteessa.

Jäljellä olevan tallennusajan 
tarkistaminen

Kuvaamisen (tallentaminen/valmiustila) 
aikana voit tarkkailla kuhunkin korttipaikkaan 
asetetun muistikortin jäljellä olevaa 
kapasiteettia käyttämällä etsimessä olevia 
paikan A/B tietovälineen jäljellä olevan 
kapasiteetin ilmaisimia (sivu 11).
Jäljellä oleva tallennusaika lasketaan 
kunkin paikan tietovälineen jäljellä olevan 
kapasiteetin ja käytössä olevan videomuodon 
(tallennuksen bittinopeus) perusteella, ja se 
näytetään minuutteina.

Muistikortin vaihdon ajoittaminen

ˎˎ Kun kahden muistikortin jäljellä oleva 
tallennusaika on yhteensä alle 5 minuuttia, 
näkyviin tulee viesti ”Media Near Full” 
(tietoväline lähes täynnä), tallennuksen 
merkkivalo alkaa vilkkua ja kuuluu varoittava 
merkkiääni (kuulokelähtö).  
Vaihda tietovälineeseen, jossa on tyhjää 
tilaa.
ˎˎ Jos jatkat tallentamista siihen saakka, että 
jäljellä oleva tallennusaika saavuttaa nollan, 
viestiksi muuttuu ”Media Full” (tietoväline 
täynnä) ja tallentaminen pysähtyy.

[Huomautus]
Yhdelle muistikortille voidaan tallentaa enintään noin 
600 leikettä.
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Muistikorttien palauttaminen

Jos muistikortissa jostakin syystä ilmenee 
virhe, kortti on palautettava ennen käyttöä.
Kun lataat muistikortin, joka on palautettava, 
etsimen näytölle ilmestyy viesti, jossa 
kysytään, haluatko palauttaa sen.

Kortin palauttaminen

Valitse Execute kääntämällä ja painamalla 
monitoimisäädintä (sivu 5).
Kun formatointi on meneillään, näkyvissä on 
viesti ja etenemisen tila (%), ja käytön ilmaisin 
palaa punaisena.
Kun palauttaminen on tehty, näkyviin tulee 
viesti päättymisestä.

Jos palauttaminen epäonnistuu

ˎˎ Muistikortteja, joissa on ilmennyt 
muistivirheitä, ei voida palauttaa. Näkyviin 
tulee varoitusviesti. Vaihda muistikorttia 
noudattamalla ohjeita.
ˎˎ Muistikortit, joissa on ilmennyt 
muistivirheitä, voidaan saada 
käyttökelpoisiksi formatoimalla ne 
uudelleen.
ˎˎ Joissakin tapauksissa jotkut leikkeet voidaan 
palauttaa ja joitakin ei. Palautettuja leikkeitä 
voidaan toistaa normaalisti.

[Huomautuksia]
ˎˎ Tällä videokameralla tallennettujen tietovälineiden 

palauttamiseen on käytettävä tätä videokameraa.
ˎˎ Muilla laitteilla kuin tällä videokameralla 

tallennettujen tai eri videokameraversiolla 
(vaikka kyse olisi samasta mallista) tallennettujen 
tietovälineiden palauttaminen ei välttämättä onnistu 
tällä videokameralla.
ˎˎ Alle 2 sekunnin mittaisia leikkeitä ei voida palauttaa.
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Perusmenettely
Peruskuvaaminen tapahtuu seuraavan 
menettelyn mukaisesti.

1	 Kiinnitä tarvittavat laitteet ja tarkista, että 
laite saa virtaa.

2	 Aseta muistikortti (-kortit).

3	 Siirrä POWER-kytkin On-asentoon.
POWER-ilmaisin syttyy ja kameran kuva 
näkyy etsimessä.

4	 Paina tallennuksen START/STOP-
painiketta (sivu 5).
Tallennuksen merkkivalo syttyy ja 
tallentaminen alkaa.

5	 Lopeta tallentaminen painamalla 
tallennuksen START/STOP-painiketta 
uudelleen.
Tallentaminen päättyy ja videokamera 
siirtyy STBY-tilaan (valmiustila).

[Huomautus]
Jos tallennuksen START/STOP-painiketta painetaan 
muutaman sekunnin kuluessa videokameran 
käynnistyksestä, tallennuksen merkkivalo syttyy 
merkkinä siitä, että laite on tallennustilassa, mutta 
tallentaminen tietovälineelle ei välttämättä ala vielä 
muutamaan sekuntiin valitusta tallennusmuodosta 
riippuen.

Vaihtaminen muistikorttien välillä

Kun asetettuna on kaksi muistikorttia, vaihda 
korttia painamalla SLOT/SELECT-painiketta 
(sivu 6).
Laite alkaa tallentaa automaattisesti toiselle 
muistikortille juuri ennen kuin ensimmäisen 
kortin jäljellä oleva kapasiteetti laskee nollaan 
(vuorotallennus). Voit jatkaa tallentamista 
katkottomasti muistikorttien vaihtuessa 
korvaamalla täyttynyt muistikortti uudella 
muistikortilla.

[Huomautuksia]
ˎˎ Muistikorttia ei voi vaihtaa toistotilassa. Lisäksi paikan 

A ja paikan B tietovälineille tallentuneen leikkeen 
katkotonta toistamista ei tueta.
ˎˎ Kun toiseen muistikorttipaikkaan asetetaan 

tallennuskelpoinen muistikortti, muistikortteja ei 
vaihdeta, jos kyseiselle kortille tallennetaan vain 
välityspalvelintietoja.

Leikkeet (tallennetut tiedot)
Kun lopetat tallentamisen, video, ääni ja niihin 
liittyvät tiedot tallennuksen alusta loppuun 
saakka tallennetaan yhdeksi ”leikkeeksi” 
muistikortille.

Leikkeiden nimet
Jokainen videokameran tallentama leike 
saa automaattisesti nimen koko valikon TC/
Media-valikossa kohdassa Clip Name Format 
(sivu 91) määritetyn muodon mukaisesti.

Leikkeen enimmäispituus
Enintään 6 tuntia leikettä kohti.
Jatkuvan tallennuksen enimmäispituus 
on sama kuin leikkeen enimmäispituus. 
Jos tallennuspituus ylittää leikkeen 
enimmäispituuden, järjestelmä luo 
automaattisesti uuden leikkeen ja 
tallentaminen jatkuu. Uusi leike näkyy 
pikkukuvanäytössä erillisenä leikkeenä.

Vuorotallennuksen aikana tallennetaan useita 
leikkeitä peräkkäin, mutta tallentaminen 
päättyy automaattisesti noin 24 tunnin 
kuluttua.

[Huomautuksia]
ˎˎ Älä poista muistikorttia silloin kun siihen juuri 

tallennetaan. Tallentamisen aikana voi vaihtaa 
muistikorttia vain siitä korttipaikasta, jossa käytön 
merkkivalo ei pala.
ˎˎ Kun tallennettavan muistikortin jäljellä oleva 

kapasiteetti on alle yksi minuutti ja toiseen 
korttipaikkaan on asetettu tallennuskelpoinen 
muistikortti, näkyviin ilmestyy viesti ”Will Switch Slots 
Soon” (korttipaikka vaihtuu pian). Viesti poistuu sen 
jälkeen, kun käytettävä korttipaikka on vaihtunut.
ˎˎ Vuorotallennus ei ehkä toimi, jos tallentaminen alkaa 

silloin kun muistikortin jäljellä oleva kapasiteetti on 
alle yksi minuutti. Jotta vuorotallennus onnistuisi, 
tarkista ennen tallennuksen aloittamista, että 
muistikortin jäljellä oleva kapasiteetti on enemmän 
kuin yksi minuutti.
ˎˎ Videokameran vuorotallennustoiminnolla 

luotua videota ei voida toistaa katkottomasti 
videokamerassa.
ˎˎ Yhdistä videokameran vuorotallennustoiminnolla 

luotu video ”Catalyst Browse” -ohjelmistolla.

Äänen tarkkaileminen

Voit tarkkailla tallennettavaa ääntä 
kuulokkeilla.
Liittämällä kuulokkeet kuulokeliitäntään 
(sivu 5) voit tarkkailla tallennettavaa 
ääntä. Voit tarkkailla myös toistettavaa ääntä 
(sivu 69) käyttämällä sisäistä kaiutinta 
(sivu 6) tai kuulokkeita.
Voit säätää tarkkailtavan äänen voimakkuutta 
Audio Status -näytön kohdassa Volume 
(sivu 14) tai koko valikon Audio-valikossa 
kohdassa Audio Output > Volume (sivu 97).
Voit valita tarkkailtavan kanavan Audio 
Status -näytön kohdassa Monitor CH 
(sivu 14) tai koko valikon Audio-valikossa 
kohdassa Audio Output > Monitor CH 
(sivu 97).

Aikatietojen määrittäminen

Aikakoodin asettaminen

Määritä tallennettava aikakoodi koko valikon 
TC/Media-valikossa kohdassa Timecode 
(sivu 91).

Nimitietojen asettaminen

Voit lisätä tallennettuun kuvaan nimitiedoksi 
8 merkkiä pitkän heksadesimaalinumeron. 
Voit asettaa nimitietoihin myös nykyisen 
kellonajan. Määritä TC/Media-valikon 
kohdassa Users Bit (sivu 91).

Aikatietojen näyttäminen

Aseta näytettävä aikakoodi TC/Media-valikon 
kohdassa TC Display (sivu 91) > Display 
Select.
Painamalla nimettävää painiketta (sivu 49), 
jolle on nimetty DURATION/TC/U-BIT, näytöllä 
vaihtuu järjestyksessä aikakoodi, nimitiedot ja 
kesto.

Aikakoodin tulon/lähdön vaihtaminen

Voit vaihtaa aikakoodin tulon/lähdön 
käyttämällä TC IN/OUT -valintakytkintä 
(sivu 4).
Lisätietoja saat kohdasta sivu 115.
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Tallennuksen tarkasteleminen 
(Rec Review)

Voit tarkastella viimeisimpänä tallennettua 
leikettä näytöllä (tallennuksen tarkastelu).

[Huomautus]
Rec Review -toimintoa ei tueta, jos videomuotoa on 
muutettu leikkeen tallentamisen jälkeen.

Tallennuksen tarkastelun menetelmä

Nimeä Rec Review etukäteen jollekin 
nimettävistä painikkeista.
Kun tallentaminen on päättynyt, paina sitä 
nimettävää painiketta (sivu 49), jolle Rec 
Review on nimetty. Viimeisimpänä tallennetun 
leikkeen toistaminen alkaa.
Leike toistetaan loppuun saakka, Rec Review 
päättyy ja videokamera palaa STBY-tilaan 
(valmiustila).

Rec Review -toiminnon lopettaminen

Paina sitä nimettävää painiketta, jolle Rec 
Review on nimetty, tai paina CANCEL/BACK-
painiketta.

Tallennuksen tarkastelun asetukset

Voit määrittää toistamisen alkamiskohdaksi 
jonkin seuraavista käyttämällä Technical-
valikon Rec Review -asetusta (sivu 99).
ˎˎ Leikkeen viimeiset 3 sekuntia
ˎˎ Leikkeen viimeiset 10 sekuntia
ˎˎ Leikkeen alku

[Vinkki]
Jos haluat tarkastella tiettyä leikettä sen jälkeen, kun 
olet tallentanut useita leikkeitä, näytä pikkukuvanäyttö 
painamalla THUMBNAIL-painiketta ja valitse leike, jonka 
toisto aloitetaan.
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Voit säätää zoomia kuvausolosuhteiden 
mukaan.

Kun moottorizoom-objektiivi on 
kiinnitettynä, voit säätää zoomia joko kauko-
ohjainkahvan tai yläkahvan zoomausvivulla. 
Zoomausnopeus vaihtelee vipuun kohdistetun 
paineen mukaan.
Videokamerassa on kuvasignaalin käsittelyä 
hyödyntävä zoomaustoiminto nimeltään 
Clear Image Zoom. Kun Clear Image 
Zoom on käytössä, zoomausta tuetaan 
kiinteäpolttovälisissä objektiiveissa. Sitä 
voidaan käyttää myös moottorizoom-
objektiivin optisen alueen pidentämiseen.
Clear Image Zoom -toimintoa hyödyntävä 
suurin zoomaussuhde vaihtelee 
tallennustarkkuuden mukaan.
ˎˎ QFHD/4K-tallennustarkkuus: 1,5×
ˎˎ HD-tallennustarkkuus: 2×

Zoomityypin valitseminen

Määritä zoomityyppi koko valikon Technical-
valikossa kohdassa Zoom > Zoom Type 
(sivu 99).
Zoomityyppi vaihtelee kiinnitetyn 
objektiivityypin mukaisesti.

Kiinnitetty 
objektiivi

Zoom Type -asetus

Optical 
Zoom Only

On(Clear 
Image Zoom)

Kiinteäpolttoväli-
nen objektiivi / 
manuaalinen 
zoom-objektiivi

Zoomaus 
vivulla ei ole 
tuettu.

Clear Image 
Zoom on 
tuettu.

Moottori-
zoom-objektiivi

Vain optinen 
zoomi

Optinen 
zoomi ja Clear 
Image Zoom 
ovat tuettuja.

[Huomautuksia]
ˎˎ Clear Image Zoom ei ole saatavilla seuraavissa 

tapauksissa.
–– Kun koko valikon Shooting-valikossa kohdan 

S&Q Motion > Frame Rate (sivu 81) asetus on 
suurempi kuin 60fps

–– Kun koko valikon Project-valikossa kohdan Rec 
Format > Codec (sivu 82) asetuksena on RAW tai 
vaihtoehto, johon sisältyy RAW

ˎˎ SERVO/MANUAL-valintakytkimen käyttö objektiivissa 
palauttaa Clear Image Zoomin asetukseksi 1×. 
ˎˎ Kun tilapäinen automaattitarkennus (AF-S) 

suoritetaan Clear Image Zoom -toiminnon aikana, 
automaattitarkennus tarkentaa ensisijaisesti näytön 
keskellä olevaan alueeseen.

Yläkahvan zoomin määrittäminen

Määritä yläkahvan zoomin asetus koko valikon 
Technical-valikossa kohdassa Handle Zoom 
(sivu 99).

Zoomausrenkaan suunnan 
määrittäminen

Joissakin E-pidikkeellisissä objektiiveissa 
zoomausrenkaan kiertosuuntaa voidaan 
vaihtaa.
Määritä kiertosuunta koko valikon Technical-
valikossa kohdassa Lens > Zoom Ring 
Direction (sivu 100).

Zoomin säätäminen
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Tarkennuksen säätäminen
Voit säätää tarkennusta automaattisesti tai 
käsin kuvausolosuhteiden mukaan.

Tarkennuksen säätäminen käsin 
(Manual Focus)

Säädä tarkennusta käsin siirtämällä FOCUS-
kytkin (sivu 4) ”MAN”-asentoon.
Näin voit säätää tarkennusta käsin 
kuvausolosuhteiden mukaan.
Manuaalinen tarkennus on hyödyllinen 
seuraavien kohdetyyppien kuvaamisessa.
ˎˎ Kohteet, jotka sijaitsevat vesipisaroiden 
peittämän ikkunan toisella puolella
ˎˎ Kohteet, joilla on pieni kontrasti taustaa 
vasten
ˎˎ Kohteet, jotka sijaitsevat lähellä olevia 
kohteita kauempana

[Vinkki]
Voit käyttää seuraavissa tilanteissa myös 
automaattitarkennusta, vaikka manuaalinen säätö on 
pääasiallinen käyttömenetelmä.
ˎˎ Kun automaattitarkennuksen 

kohteenvaihtumisherkkyydeksi on määritetty 
1(Locked)
ˎˎ Kun FOCUS-kytkin on siirretty ”AF”-asentoon
ˎˎ Kun käytetään tarkennusrengasta (AF Assist, sivu 

40)

Tarkennus koskettamalla (Spot Focus)

Manuaalisessa tarkennustilassa voit määrittää 
säädettävän tarkennuskohdan koskettamalla.
Kun haluat käyttää pistetarkennustilaa, 
määritä Shooting-valikossa kohdan Focus > 
Touch Function in MF (sivu 81) asetukseksi 
Spot Focus.
Pistetarkennusmerkki näkyy, kun napautat 
säädettävää tarkennuskohtaa.

[Vinkkejä]
ˎˎ Painamalla pistetarkennustilassa nimettävää 

painiketta (sivu 49), jolle Push AF/Push MF on 
nimetty, voit pysäyttää pistetarkennuksen hetkellisesti 
ja ottaa käyttöön automaattitarkennuksen painikkeen 
painamisen ajaksi. Kun vapautat painikkeen, 
tarkennus palaa manuaalitilaan.
ˎˎ Spot Focus -toiminto ei toimi, jos objektiivi on 

asetettu manuaalitarkennukselle.
ˎˎ Pistetarkennuskohtaa ei voi määrittää, kun 

tarkennusta on suurennettu tai Technical-valikossa 
kohdan Touch Operation (sivu 99) asetuksena on 
Off.

Automaattitarkennuksen käyttäminen 
tilapäisesti (Push Auto Focus (AF))

Kun koko valikon Shooting-valikossa  
kohdan Focus > Push AF Mode (sivu 81)  
asetukseksi on määritetty AF, paina 
manuaalitarkennustilassa PUSH AUTO 
FOCUS -painiketta (sivu 4) tarkentaaksesi 
automaattisesti painikkeen ollessa painettuna.
Järjestelmä tarkentaa tarkennusalueella, joka 
on määritetty koko valikon Shooting-valikossa 
kohdassa Focus > Focus Area (sivu 80).
Kun vapautat painikkeen, tarkennus palaa 
manuaalitilaan.
Toiminto on hyödyllinen, kun haluat siirtää 
tarkennusta hitaasti yhdestä kohteesta toiseen 
manuaalitarkennuksen aikana.

[Vinkki]
Samaa toimintoa tuetaan nimetyllä painikkeella 
(sivu 49), jolle Push AF/Push MF on nimetty.

[Huomautus]
Push Auto Focus -toiminto ei toimi, jos objektiivi on 
asetettu manuaalitarkennukselle.

Yksittäisen automaattitarkennuksen 
käyttäminen (Push Auto Focus (AF-S))

Määritä koko valikon Shooting-valikossa 
kohdan Focus > Push AF Mode (sivu 81) 
asetukseksi Single-shot AF(AF-S) ja määritä 
sitten tarkennusalue koko valikon Shooting-
valikossa kohdassa Focus > Focus Area(AF-S) 
(sivu 81).
Paina manuaalitarkennustilassa PUSH 
AUTO FOCUS -painiketta tarkentaaksesi 
automaattisesti suurella nopeudella. 
Tarkentaminen päättyy heti kun vapautat 
painikkeen.
Tarkennuksen ilmaisin osoittaa tarkennuksen 
tilan.
ˎˎ Palaa: Tarkennus lukittunut 
tarkennuskohtaan.
ˎˎ Vilkkuu: Ei tarkennusta. Koska tarkennus 
ei ole automaattinen, muuta kuvan 
sommittelua ja tarkennusasetuksia, jotta 
tarkentaminen onnistuu.

Kun vapautat painikkeen, tarkennus palaa 
manuaalitilaan.
Toiminto on hyödyllinen, kun haluat tarkentaa 
nopeasti kohteeseen ennen kuvaamisen 
aloittamista.

[Vinkkejä]
ˎˎ Samaa toimintoa tuetaan nimetyllä painikkeella 

(sivu 49), jolle Push AF/Push MF on nimetty.
ˎˎ Voit myös nimetä Push AF Mode -toiminnon 

nimettävälle painikkeelle (sivu 49).
ˎˎ Voit myös nimetä Focus Area(AF-S) -toiminnon 

nimettävälle painikkeelle (sivu 49).
ˎˎ Voit näyttää/piilottaa tarkennusalueen kehyksen koko 

valikon Monitoring-valikossa kohdassa Display On/Off 
> Focus Area Ind.(AF-S) (sivu 93).
ˎˎ Tarkennuksen suurentamisen aikana tarkennus säätyy 

siten, että se sopii suurennetulle näytölle.

[Huomautuksia]
ˎˎ Push Auto Focus -toiminto ei toimi, jos objektiivi on 

asetettu manuaalitarkennukselle.

ˎˎ Tarkennusalueen kehystä ei piiloteta, kun käytetään 
DISPLAY-painiketta.
ˎˎ 	Focus Area(AF-S) -kehyksen paikkaa ei voi asettaa 

Clear Image Zoom -toiminnon aikana. Myös Push AF-S 
-toiminnon aikana automaattitarkennus tarkentaa 
ensisijaisesti keskiosaan.

Tarkentaminen kuvaa suurentamalla 
(Focus Magnifier)

Tehdasoletuksena Focus Magnifier 
×3/×6 -toiminto on nimetty kauko-
ohjainkahvan ASSIGN 4 -painikkeelle ja 
yläkahvan ASSIGN 7 -painikkeelle (sivu 49).
Vaihda etsimeen 
tarkennuksensuurennusnäyttö painamalla 
ASSIGN 4 -painiketta tai ASSIGN 
7 -painiketta, niin keskikohta suurenee noin 
kolminkertaiseksi. Lisää suurennusta noin 
kuusinkertaiseksi painamalla painiketta 
uudelleen. Toiminto on hyödyllinen 
tarkennuksen tarkistamista varten.
Palaa normaalinäyttöön painamalla painiketta 
uudelleen.
Voit siirtää suurennettavaa kohtaa 
tarkennuksen suurennuksen aikana 
monivalitsimella (sivu 7). Monivalitsinta 
painamalla tarkennus palaa kuvan 
keskikohtaan.
Kun tilapäistä automaattitarkennusta (AF) 
käytetään tarkennuksen suurennuksen aikana, 
järjestelmä tarkentaa tarkennusalueelle, joka 
on määritetty koko valikon Shooting-valikossa 
kohdassa Focus > Focus Area (sivu 80).
Jos tilapäistä automaattitarkennusta (AF-S) 
käytetään tarkennuksen suurennuksen aikana, 
tarkennus säätyy suurennetulle näytölle.

[Huomautuksia]
ˎˎ Tallennettu kuva tai SDI/HDMI-lähtökuva ei ole 

suurennettu, vaikka tarkennusta on suurennettu.
ˎˎ Tarkennuksen suurennuksen aikana MENU-painike ja 

muut toiminnot ovat poissa käytöstä.
ˎˎ Suurennus palaa näytön keskikohtaan, kun 

videokamera sammutetaan.
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Tarkennuksen säätäminen 
automaattisesti (Auto Focus)

Videokamera käyttää vaiheentunnistukseen 
perustuvaa automaattitarkennusta 
nopeaan tarkentamiseen ja kontrastiin 
perustuvaa automaattitarkennusta tarkkaan 
tarkentamiseen.
Näiden kahden 
automaattitarkennusmenetelmän yhdistelmä 
mahdollistaa automaattisen tarkennuksen 
sekä nopeasti että tarkasti.
Säädä tarkennusta automaattisesti siirtämällä 
videokameran FOCUS-kytkin (sivu 4) 
”AUTO”-asentoon. Jos kiinnitettynä on 
objektiivi, jossa on tarkennuksen valintakytkin, 
siirrä kytkin joko ”AF/MF”- tai ”AF”-asentoon. 
Jos kytkin on siirretty ”Full MF”- tai ”MF”-
asentoon, objektiivin tarkennustoimintoa ei 
voida käyttää videokamerasta (sivu 23).

[Vinkki]
Kun koko valikon Shooting-valikossa kohdan Focus 
> AF Assist (sivu 81) asetuksena on On, voit 
käyttää objektiivissa olevaa tarkennusrengasta 
automaattitarkennuksen aikana tarkennuksen 
säätämiseen.

[Huomautuksia]
ˎˎ Automaattitarkennusta tukeva objektiivi vaaditaan.
ˎˎ Tarkkuutta ei välttämättä saavuteta 

kuvausolosuhteista riippuen.
ˎˎ Tarkennusta ei voida säätää automaattisesti 

A-pidikkeellisissä objektiiveissa.

Automaattitarkennusalueen/-kohdan 
määrittäminen (Focus Area)

Voit määrittää automaattitarkennuksen 
tavoitealueen koko valikon Shooting-valikossa 
kohdassa Focus > Focus Area (sivu 80).

Flexible Spot:
Tarkentaa kuvan tiettyyn kohtaan.
Kun tämä on valittuna, määritä kohta 
monivalitsimella (sivu 7).
Voit palauttaa tarkennuksen keskikohtaan 
painamalla monivalitsinta pitkään.

Zone:
Hakee automaattisesti tarkennuskohdan 
määritetyltä alueelta.
Kun tämä on valittuna, määritä kohta 
monivalitsimella (sivu 7).
Voit palauttaa tarkennuksen keskikohtaan 
painamalla monivalitsinta pitkään.

Wide:
Hakee kohdetta tarkennettaessa kuvan 
laajakulmasta. Kehystä ei näy.

[Vinkki]
Samaa toimintoa tuetaan nimettävällä painikkeella 
(sivu 49), jolle Focus Area on nimetty.
Voit näyttää/piilottaa tarkennusalueen kehyksen koko 
valikon Monitoring-valikossa kohdassa Display On/Off > 
Focus Area Indicator (sivu 93).

[Huomautus]
Tarkennusalueen kehystä ei piiloteta, kun käytetään 
DISPLAY-painiketta.

Tarkennusalueen vaihtaminen nopeasti 
(Focus Setting)

Voit vaihtaa automaattitarkennusalueen 
sijaintia ja kokoa nopeasti kuvaamisen 
aikana nimeämällä Focus Setting -toiminnon 
nimettävälle painikkeelle (sivu 49).
Toiminta vaihtelee tarkennusalueasetuksesta 
riippuen.

Kun koko valikon Shooting-valikossa kohdan 
Focus > Focus Area (sivu 80) asetukseksi on 
määritetty Flexible Spot tai Zone
Voit vaihtaa tarkennusalueen sijaintia 
painamalla nimettävää painiketta, jolle 
Focus Setting on nimetty, ja säätämällä 
monivalitsimella (sivu 7).
Monivalitsinta painamalla voit palauttaa 
tarkennusalueen keskikohtaan, kun säädät 
kohtaa.
Voit muuttaa tarkennusalueen kokoa 
painamalla pitkään nimettävää painiketta, jolle 
Focus Setting on nimetty.
Koon muuttamisen jälkeen voit määrittää 
tarkennusalueen sijainnin painamalla 
monivalitsinta.
Kun olet valmis, palaa alkuperäiseen näyttöön 
painamalla nimettävää painiketta, jolle Focus 
Setting on nimetty.

Kun koko valikon Shooting-valikossa kohdan 
Focus > Focus Area (sivu 80) asetukseksi on 
määritetty Wide
Voit muuttaa vain tarkennusalueen kokoa 
painamalla pitkään nimettävää painiketta, 
jolle Focus Setting on nimetty. Myös sijaintia 
voidaan muuttaa vaihtamalla asetukseksi 
ensin Flexible Spot tai Zone.

[Vinkkejä]
ˎˎ Kun koko valikon Shooting-valikossa kohdan Focus > 

Push AF Mode (sivu 81) asetukseksi on määritetty 
Single-shot AF(AF-S) ja FOCUS-kytkin (sivu 4) on 
siirretty MF-asentoon, voit muuttaa Focus Area(AF-S) 
(sivu 81) -tarkennusalueen sijaintia.
ˎˎ Tarkennusalueen kehys näkyy oranssina, kun 

tarkennusalueen sijaintia voidaan muuttaa.

Tarkennusalueen kehyksen siirtäminen 
kosketustoiminnoilla 
(kosketustarkennusalue)

Voit vaihtaa kosketusalueen sijaintia 
painamalla nimettävää painiketta (sivu 49), 
jolle Focus Setting on nimetty, jotta 
tarkennusalueen näyttö muuttuu oranssiksi, ja 
siirtää sitä sitten kosketustoiminnoilla.
Napauta näyttöä, niin tarkennusalueen 
keskikohta siirtyy napautuskohtaan. Vedä 
tarkennusalue sormella haluamaasi kohtaan 
näytöllä (sivu 10).

[Vinkki]
Voit ottaa kuvausnäytön kosketustoiminnot käyttöön tai 
poistaa ne käytöstä käyttämällä nimettävää painiketta, 
jolle Focus Setting on nimetty.
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Napauta mitä tahansa kohtaa

Tarkennusalue liikkuu keskitettynä 
napautettuun kohtaan.

Siirrä tarkennusaluetta vetämällä, se seuraa 
sormeasi

[Huomautuksia]
ˎˎ Jos napautat näyttöä tai vedät tarkennusalueen 

kohtaan, joka on asetusalueen ulkopuolella, 
tarkennusalueeksi määrittyy asetusalueen ylä-/ala-/
oikea/vasen reuna.
ˎˎ Toiminto ei ole saatavilla seuraavissa olosuhteissa.

–– Kun koko valikon Technical-valikossa kohdan Touch 
Operation (sivu 99) asetukseksi on määritetty 
Off

–– Kun tarkennusalue näkyy harmaana tai ei näy 
lainkaan

Automaattitarkennustoimintojen 
säätäminen (automaattitarkennuksen 
siirtymisnopeus, 
automaattitarkennuksen 
kohteenvaihtumisherkkyys)

Automaattitarkennuksen siirtymisnopeus
Voit määrittää tarkennusnopeuden tilanteisiin, 
joissa kohde vaihtuu, käyttämällä koko valikon 
Shooting-valikossa asetusta Focus > AF 
Transition Speed (sivu 80).
Kun asetus on määritetty pienelle nopeudelle, 
tarkennus siirtyy hitaasti, kun tarkennettava 
kohde vaihtuu, mikä mahdollistaa vaikuttavien 
kuvien ottamisen.
Kun se on määritetty suurelle nopeudelle, 
tarkennus kohteiden välillä vaihtuu nopeasti. 
Kamera tarkentaa välittömästi kehykseen 
saapuvaan kohteeseen, joten tämä asetus 
sopii erinomaisesti nopeaa tarkennusta 
edellyttävään dokumentaariseen kuvaukseen.

Vaihtumisen aikana:
1(Slow): tarkennus toimii hitaasti
.
.
.
7(Fast): tarkennus toimii 
nopeasti

Tarkennettu kaukana olevaan kohteeseen

Tarkennettu lähellä olevaan kohteeseen

Automaattitarkennuksen 
kohteenvaihtumisherkkyys
Voit määrittää kohteenvaihtumisherkkyyden 
käyttämällä asetusta Focus > AF Subj. Shift 
Sens. (sivu 80) koko valikon Shooting-
valikossa.
Kun asetus on määritetty matalalle 
herkkyydelle, tarkennus ei siirry herkästi, 
vaikka toinen kohde saapuu tarkennettavan 
kohteen eteen. Kun se on määritetty korkealle 
herkkyydelle, tarkennus siirtyy etualalle 
saapuvaan kohteeseen.

[Vinkki]
Jos AF Speed/Sens. on nimetty nimettävälle painikkeelle, 
arvojen säätöpalkit tulevat näkyviin seuraavassa 
järjestyksessä aina kun painiketta painetaan, jotta voit 
muuttaa automaattitarkennuksen siirtymisnopeuden ja 
automaattitarkennuksen kohteenvaihtumisherkkyyden 
asetuksia.
Automaattitarkennuksen siirtymisnopeus  
Automaattitarkennuksen kohteenvaihtumisherkkyys  
Ei näyttöä…
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AF Subj. Shift Sens.: 1(Locked On) AF Subj. Shift Sens.: 5(Responsive)

Tarkennus vaihtuu hitaasti toiseen 
kohteeseen

Tarkennus vaihtuu nopeasti toiseen 
kohteeseen

Tarkennuskohteen muuttaminen käsin 
(AF Assist)

Kun koko valikon Shooting-valikossa kohdan 
Focus > AF Assist (sivu 81) asetuksena on 
On, voit säätää tarkennuksen kohteeseen 
automaattitarkennuksenkin aikana käyttämällä 
objektiivissa olevaa tarkennusrengasta.
Kun lopetat tarkennusrenkaan käyttämisen, 
automaattitarkennus tarkentaa edelleen 
siihen kohteeseen, johon tarkennusrenkaalla 
tarkennettiin (automaattitarkennuksen 
avustustila).
Tarkennusrenkaan käyttämisen jälkeen 
tarkennuksen siirtäminen toiseen kohteeseen 
on hieman hankalampaa huolimatta kohdan 
Focus > AF Subj. Shift Sens. (sivu 80) 
asetuksesta koko valikon Shooting-valikossa.
Automaattitarkennuksen avustustila 
peruuntuu seuraavasti.
ˎˎ Kun tarkennusrenkaalla tarkennettu kohde 
ei ole enää näkyvissä
ˎˎ Kun siirrytään manuaalitarkennukseen
ˎˎ Kun reaaliaikaisen seurannan AF 
käynnistetään

[Vinkkejä]
ˎˎ Automaattitarkennuksen avustustoiminto voidaan 

peruuttaa nopeasti nimettävällä painikkeella 
(sivu 49), jolle Push AF/Push MF on nimetty.
ˎˎ Reaaliaikaisen seurannan AF pysähtyy, kun 

tarkennusrengasta käytetään.
ˎˎ Face/Eye Only AF -tilassa automaattitarkennus 

tarkentaa tarkennusrenkaan tarkennuskohtaa 
lähimpänä oleviin kasvoihin.

Manuaalitarkennuksen käyttäminen 
tilapäisesti (Push Manual Focus)

Paina automaattitarkennustilassa PUSH AUTO 
FOCUS -painiketta (sivu 4) tarkentaaksesi 
manuaalisesti silloin kun painike on 
painettuna.
Kun vapautat painikkeen, tarkennus palaa 
automaattitilaan.
Näin voit tilapäisesti pysäyttää 
automaattitarkennuksen ja tarkentaa käsin, 
kun jokin kulkee kuvauskohteen edestä.

[Vinkki]
Samaa toimintoa tuetaan nimettävällä painikkeella 
(sivu 49), jolle Push AF/Push MF on nimetty.
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Tarkentaminen käyttämällä 
kasvojen-/silmientunnistusta 
(Face/Eye Detection AF)

Videokamera voi tunnistaa ihmisten kasvot 
ja silmät seurattavaksi kohteeksi ja säätää 
sitten tarkennuksen tarkennusalueella oleviin 
kasvoihin tai silmiin.
Toiminto on saatavilla vain tarkennuksen 
ollessa AF-tilassa tai tilapäisen 
automaattitarkennuksen aikana.
Kun järjestelmä tunnistaa kasvot, 
näkyviin tulevat harmaat kasvojen-/
silmientunnistuksen kehykset. Kun 
automaattinen tarkentaminen on mahdollista, 
kehykset muuttuvat valkoisiksi ja seuranta 
alkaa. Kun järjestelmä tunnistaa silmät 
ja tarkennus on säätynyt, kasvojen-/
silmientunnistuksen kehykset näkyvät silmien 
kohdassa. Kun järjestelmä havaitsee useita 
henkilöitä, pääasiallinen kohde määrittyy 
automaattisesti.

[Vinkkejä]
ˎˎ Kun tarkennusalueeksi on asetettu Zone tai Flexible 

Spot ja kasvot tai silmät osuvat määritetylle 
tarkennusalueelle, kasvojen-/silmientunnistuksen 
kehykset muuttuvat valkoisiksi ja videokamera 
tarkentaa kyseisiin kasvoihin/silmiin.
ˎˎ Kun käytetään tilapäistä automaattitarkennusta 

(AF-S), tarkennettaviin kasvoihin/silmiin kohdistuvat 
kasvojen-/silmientunnistuksen kehykset muuttuvat 
vihreiksi.

Määritä kasvojen-/silmientunnistuksen 
automaattitarkennustoiminto Shooting-
valikon kohdassa Focus > Face/Eye Detection 
AF (sivu 81).

Face/Eye Only AF:
Kamera tunnistaa kohteiden (ihmisten) 
kasvot/silmät ja seuraa vain niitä / tarkentaa 
vain niihin. Kun järjestelmä ei havaitse kasvoja 
tai silmiä, automaattitarkennus keskeytyy 

väliaikaisesti ja näkyviin tulee  (Face/
Eye Only AF -tilan automaattitarkennus 
keskeytetty) -kuvake (sivu 11). Tämä tila on 
kätevä, kun haluat tarkentaa automaattisesti 
vain kasvoihin/silmiin ja seurata niitä.

Face/Eye Priority AF:
Kamera tunnistaa kohteiden (ihmisten) 
kasvot/silmät ja priorisoi kasvojen/silmien 
tarkennuksen/seurannan. Kun järjestelmä ei 
havaitse kasvoja/silmiä, tarkennus on AF-
tilassa (oletusasetus).

Off:
Kasvojen-/silmientunnistuksen 
automaattitarkennus on poissa käytöstä.

[Huomautuksia]
ˎˎ Tilapäisen automaattitarkennuksen aikana Face/Eye 

Priority AF -asetus on aktiivisena, vaikka valittuna olisi 
parhaillaan Face/Eye Only AF -asetus.
ˎˎ Kun FOCUS-kytkin on siirretty MAN-asentoon, 

kasvojen-/silmientunnistuksen automaattitarkennus 
on poissa käytöstä (paitsi tilapäisen 
automaattitarkennustoiminnon aikana).
ˎˎ Jos sammutat videokameran, kun valittuna on Face/

Eye Only AF -asetus, tilaksi vaihtuu automaattisesti 
Face/Eye Priority AF, kun videokamera seuraavan 
kerran kytketään päälle.

Kasvojen-/silmientunnistuksen 
kehysten piilottaminen

Voit näyttää/piilottaa kasvojen-/
silmientunnistuksen kehykset koko valikon 
Monitoring-valikossa kohdassa Display On/Off 
> Face/Eye Detection Frame (sivu 93).

[Huomautus]
Vihreät kasvojen-/silmientunnistuksen kehykset 
näkyvät tilapäisen automaattitarkennuksen (AF-S) 
tarkentamille kasvoille ja silmille eikä niitä piiloteta 
DISPLAY-painikkeella tai kun Face/Eye Detection 
Frame -asetuksena on Off.

Kasvojen-/silmientunnistuksen 
automaattitarkennuksen vaihtaminen 
nimettävällä painikkeella

Nimeä Face/Eye Detection AF nimettävälle 
painikkeelle (sivu 49). Voit tämän jälkeen 
vaihtaa kasvojen-/silmientunnistuksen 
automaattitarkennuksen asetukseksi Face/Eye 
Priority AF, Face/Eye Only AF tai Off jokaisella 
painikkeen painalluksella tässä järjestyksessä.

Asettaminen käyttämällä suoravalikkoa

Voit asettaa kasvojen-/silmientunnistuksen 
automaattitarkennuksen myös suoravalikon 
kautta (sivu 49).

Määritetyn kohteen seuraaminen 
(Realtime Tracking AF)

Voit pitää tarkennuksen kohteessa 
määrittämällä kohteen koskettamalla tai 
valitsemalla kasvojentunnistuskehyksen.
Kun kohde on valittu, näkyviin tulee valkoinen 
seurantakehys ja seuranta alkaa.

[Vinkkejä]
ˎˎ Kohdetta seurataan koko kuva-alalla 

tarkennusalueasetuksesta riippumatta.
ˎˎ Kun Shooting-valikossa kohdan Focus > Touch 

Function in MF (sivu 81) asetuksena on Tracking 
AF, reaaliaikaisen seurannan AF:ää tuetaan myös 
tarkennuksen ollessa MF-tilassa.

Seurantakohdetta käsitellään seuraavasti 
kasvojen ja kasvojen-/silmientunnistuksen 
automaattitarkennustilan mukaan.

Face/Eye Only AF, Face/Eye Priority AF:
Käytetään määritetyn kohteen tarkentamiseen 
ja seurantaan.
Jos seurantakohde on ihminen ja kamera 
tunnistaa kasvot/silmät, kamera tarkentaa 
niihin.
Kun seurantakasvot/-silmät tunnistetaan, 
seurantakasvot tallennetaan. Kun 
kasvot on tallennettu,  (tallennettujen 
seurantakasvojen kuvake) (sivu 11) tulee 
näkyviin.

[Huomautus]
Jos seuranta-AF aloitetaan manuaalisen tarkennuksen 
aikana, tarkennuskasvoja ei tallenneta.
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Off:
Määritetyn kohteen tarkennus ja seuranta.
Kasvoja/silmiä ei tunnisteta vaikka 
seurantakohde olisi ihminen.

[Huomautus]
Realtime Tracking AF -toiminto ei toimi, jos objektiivi on 
asetettu manuaalitarkennukselle.

Reaaliaikaisen seurannan AF:n 
aloittaminen

Kun tietty kohde määritetään 
seurantakohteeksi, sen seuraaminen alkaa.

Määrittäminen koskettamalla
Napauta seurattavaa kohdetta jossakin 
seuraavista tiloista:
ˎˎ Kun tarkennus on MF-tilassa tai tilapäisessä 
manuaalitarkennustilassa ja Shooting-
valikossa kohdan Focus > Touch Function in 
MF (sivu 81) asetuksena on Tracking AF
ˎˎ Kun tarkennus on AF-tilassa tai tilapäisessä 
automaattitarkennustilassa (AF)

[Huomautus]
Kohdetta ei voi määrittää koskettamalla, kun Technical-
valikossa kohdan Touch Operation (sivu 99) 
asetuksena on Off.

Määrittäminen kasvojentunnistuskehyksen 
valinnalla
Siirrä kasvojenvalintakohdistin (oranssi 
alleviivaus) seurattavaan kohteeseen 
monivalitsimella (sivu 7) ja paina 
monivalitsinta.

Muut kasvojentunnistuksen 
kehykset (harmaa) Seurantakehys

Kasvojenvalintakohdistin (oranssi)

[Vinkkejä]
ˎˎ Seurattavaa kohdetta voi myös vaihtaa reaaliaikaisen 

seurannan AF -tilassa.
ˎˎ Jos reaaliaikaisen seurannan AF -tilassa painetaan 

nimettävää painiketta (sivu 49), jolle Focus 
Magnifier -toiminto on nimetty, seurantatila säilyy ja 
tarkennusta suurennetaan. Seurattavaa kohdetta ei 
kuitenkaan voi määrittää tarkennuksen suurennuksen 
aikana.

[Huomautus]
Manuaalisen tarkennuksen aikana seurantaa ei voi 
aloittaa kasvojentunnistuskehyksen valinnalla.

Reaaliaikaisen seurannan AF:n 
pysäyttäminen

Pysäyttäminen koskettamalla
Napauta  (reaaliaikaisen seurannan 
AF:n pysäytys) -painiketta kosketuspaneelin 
vasemmassa yläkulmassa.

[Vinkkejä]
ˎˎ Reaaliaikaisen seurannan AF pysähtyy seuraavissa 

tapauksissa:
–– Kun objektiivin FOCUS-kytkintä tai AUTO/MAN-

säädintä käytetään
–– Kun tarkennustilaa vaihdetaan
–– Kun käytetään automaattitarkennuksen 

avustustoimintoa

–– Kun tarkennusalueasetusta tai kasvojen/
silmientunnistuksen automaattitarkennustoimintoa 
vaihdetaan

–– Kun painetaan nimettävää painiketta, jolle Push 
AF/Push MF on nimetty

–– Kun seurantakohde ei ole kuvausnäytössä tai 
kohde ei ole tarkennettuna muutamaan sekuntiin

ˎˎ Kun tarkennuskasvot tallennetaan (kun  
(tallennettujen seurantakasvojen kuvake) näkyy), 
reaaliaikaisen seurannan AF jatkuu, kun tallennetut 
seurantakasvot tulevat kuva-alueelle. Jos haluat 
tyhjentää seurantakasvot, pysäytä reaaliaikaisen 
seurannan AF edellä kuvatulla tavalla.
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Kirkkauden säätäminen

B

C
D
E

F
H

I

A

Voit säätää kirkkautta säätämällä 
himmennintä, herkkyysvahvistusta 
ja suljinaikaa sekä ND-suodattimilla 
valon määrää. Säädöt voi tehdä myös 
automaattisesti.
Automaattisen kirkkaussäädön tavoitetaso 
määritetään koko valikon Shooting-valikossa 
kohdassa Auto Exposure (sivu 78) > Level. 
Voit nimetä Auto Exposure Level -toiminnon 
nimettävällä painikkeelle tai nimettävälle 
säätimelle (sivu 49).

[Huomautus]
Herkkyysvahvistusta ei voida säätää Cine EI -tilassa. 
Perusherkkyys on pysyvä. Kirkkautta ei voida säätää 
automaattisesti myöskään suljinajan avulla. Kirkkauden 
automaattista säätämistä himmentimellä ja ND-
suodattimella tuetaan.

Perusherkkyyden valitseminen

Voit valita haluamasi videokameran kahdesta 
perusherkkyydestä.
Custom-tilassa voit määrittää 
perusherkkyydeksi High tai Low Main 
Status -näytön (sivu 14) tai Camera 
Status -näytön (sivu 14) kohdassa Base ISO/
Sensitivity tai koko valikon Shooting-valikossa 
kohdassa ISO/Gain/EI > Base Sensitivity 
(sivu 77). 
Cine EI -tilassa voit määrittää ISO-herkkyyden 
perustasoksi ISO 12800 tai ISO 800 Main 
Status -näytön (sivu 14) tai Camera 
Status -näytön (sivu 14) kohdassa Base ISO/
Sensitivity tai koko valikon Shooting-valikossa 
kohdassa ISO/Gain/EI >Base ISO (sivu 77).
On suositeltavaa valita normaalissa 
valaistuksessa asetus Low tai ISO 800 ja 
vähäisessä valaistuksessa asetus High tai 
ISO 12800.

*	 Voidaan määrittää myös tilanäytössä.

[Vinkki]
Voit myös nimetä Base ISO/Sensitivity -toiminnon 
nimettävälle painikkeelle (sivu 49).

Himmentimen säätäminen

Voit säätää kirkkautta säätämällä 
himmennintä.

Himmentimen säätäminen 
automaattisesti

Toiminto säätää kirkkautta kohteen mukaisesti. 
Automaattista himmennintä tukeva objektiivi 
vaaditaan.

1	 Jos kameraan kiinnitetään Auto 
Iris -kytkimellä varustettu objektiivi, siirrä 
kytkin AUTO-asentoon.

2	 Näytä suoravalikko (sivu 49) painamalla 
pitkään IRIS-toimintopainiketta (E) ja 
valitse Auto.

	 [Vinkki]
Voit myös nimetä Auto Iris -toiminnon nimettävälle 
painikkeelle (sivu 49).

	 [Huomautus]
Himmennintä ei voida säätää automaattisesti 
A-pidikkeellisissä objektiiveissa.

Himmentimen säätäminen käsin

1	 Näytä suoravalikko (sivu 49) painamalla 
pitkään IRIS-toimintopainiketta (E) ja 
valitse Manual.

2	 Paina IRIS-toimintopainiketta (E), jotta 
himmentimen arvo näkyy valkoisella 
taustalla.

3	 Säädä arvoa kääntämällä 
monitoimisäädintä.

	 [Vinkkejä]
ˎˎ Voit käyttää monitoimisäädintä myös IRIS-

säätimenä (sivu 49) nimeämällä IRIS-
toiminnon monitoimisäätimelle.
ˎˎ Voit myös nimetä IRIS-toiminnon nimettävälle 

säätimelle (sivu 49).

Automaattinen säätäminen tilapäisesti
Paina nimettävää painiketta (sivu 49), 
jolle Push Auto Iris -toiminto on nimetty, 
säätääksesi automaattisesti silloin kun painike 
on painettuna.
Kun vapautat painikkeen, himmennin palaa 
aikaisempaan asetukseen.

[Huomautuksia]
ˎˎ Kun objektiivin Auto Iris -kytkin on asennossa 

MANUAL, videokameran Auto Iris- ja Push Auto 
Iris -toiminnoilla ei ole vaikutusta. Myöskään 
videokameran manuaalisilla himmenninsäädöillä ei 
ole vaikutusta.
ˎˎ Push Auto Iris -toimintoa ei voi suorittaa, kun 

Shooting-valikossa kohdan Iris > Bokeh Control 
(sivu 78) asetuksena on On.

Herkkyysvahvistuksen säätäminen

Custom-tilassa voit säätää kirkkautta 
säätämällä herkkyysvahvistusta.

Herkkyysvahvistuksen säätäminen 
automaattisesti

Näytä suoravalikko (sivu 49) painamalla 
pitkään ISO/GAIN-toimintopainiketta (H) ja 
valitse Auto.

[Vinkkejä]
ˎˎ Voit suorittaa saman toimenpiteen myös Shooting-

valikossa määrittämällä kohdan Auto Exposure 
(sivu 78) > AGC asetukseksi On.
ˎˎ Voit myös nimetä AGC-toiminnon nimettävälle 

painikkeelle (sivu 49).

Herkkyysvahvistuksen säätäminen käsin

Voit hallita herkkyysvahvistusta, kun haluat 
säätää valotusta himmenninasetuksen 
ollessa lukittu tai kun haluat estää 
herkkyysvahvistuksen suurenemista AGC-
toiminnon vuoksi.

1	 Näytä suoravalikko (sivu 49) painamalla 
pitkään ISO/GAIN-toimintopainiketta (H) 
ja valitse Manual.

2	 Siirrä ISO/GAIN-kytkin (I) asentoon H, M 
tai L.

[Vinkkejä]
ˎˎ Voit muuttaa kunkin kytkinasennon esiasetettua 

arvoa Camera Status -näytön kohdassa ISO/
Gain<L>/<M>/<H> (sivu 14) tai koko valikon 
Shooting-valikossa kohdassa ISO/Gain/EI > ISO/
Gain<H>/<M>/<L> (sivu 77).
ˎˎ Voit myös nimetä Push AGC -toiminnon nimettävälle 

painikkeelle ja määrittää AGC-asetukseksi tilapäisesti 
On painamalla painiketta pitkään.

[Huomautus]
Push AGC -toimintoa ei voi suorittaa, kun koko valikon 
Shooting-valikossa kohdan Iris > Bokeh Control 
(sivu 78) asetuksena on On.
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Herkkyysvahvistuksen hallinta 
(hienosäätäminen)

1	 Paina ISO/GAIN-toimintopainiketta (H), 
jotta herkkyysvahvistuksen arvo näkyy 
valkoisella taustalla.

2	 Säädä arvoa kääntämällä 
monitoimisäädintä.

[Vinkki]
Muuta herkkyysvahvistuksen esiasetettua arvoa ISO/
GAIN-kytkimen (I) asetuksen mukaan.

Herkkyysvahvistuksen hallinta 
tilapäisesti (hienosäätäminen)

Säädä ISO/GAIN-kytkimen (I) määrittämää 
herkkyysvahvistuksen arvoa kääntämällä 
nimettävää säädintä (sivu 49), jolle ISO/
Gain/EI-toiminto on nimetty.
Tämä on hyödyllinen, kun haluat säätää 
valotusta vähän kerrallaan muuttamatta 
terävyysaluetta.
Säädetty herkkyysvahvistuksen arvo 
peruutetaan siirtämällä ISO/GAIN-kytkintä (I), 
muuttamalla perusherkkyyttä, määrittämällä 
AGC-asetukseksi On tai sammuttamalla 
laitteen virta.

[Vinkkejä]
ˎˎ Voit myös nimetä tämän toiminnon 

monitoimisäätimelle (sivu 49).
ˎˎ Voit myös nimetä Push AGC -toiminnon nimettävälle 

painikkeelle ja määrittää AGC-asetukseksi tilapäisesti 
On painamalla painiketta pitkään.

[Huomautus]
Push AGC -toimintoa ei voi suorittaa, kun koko valikon 
Shooting-valikossa kohdan Iris > Bokeh Control 
(sivu 78) asetuksena on On.

Valotusindeksin säätäminen

Cine EI -tilassa oletuksena on, että MLUT-
asetuksen ollessa Off-tilassa videolähtö 
tallennetaan pääsignaalina. Muuttamalla 
kuvan kirkkautta MLUT-asetuksen ollessa 
On-tilassa vastaamaan EI-arvoa voit tarkistaa 
jälkikäsittelyn valotuksen herkkyyssäädön 
tuloksen kuvaamisen aikana.
Voit muuttaa EI-arvoa siirtämällä ISO/GAIN-
kytkimen (I) asentoon H, M tai L.

[Vinkki]
Voit muuttaa kunkin kytkinasennon EI-arvoa Camera 
Status -näytön kohdassa ISO/Gain/EI (sivu 14) tai 
koko valikon Shooting-valikossa kohdassa ISO/Gain/EI > 
Exposure Index<H>/<M>/<L> (sivu 77).

Valotusindeksin hienosäätäminen

1	 Paina ISO/GAIN-toimintopainiketta (H), 
jotta EI-arvo näkyy valkoisella taustalla.

2	 Säädä arvoa kääntämällä 
monitoimisäädintä.

[Vinkki]
Muuta esiasetettua EI-arvoa ISO/GAIN-kytkimen (I) 
asetuksen mukaan.

Sulkimen säätäminen

Voit säätää kirkkautta säätämällä suljinta.

Sulkimen säätäminen automaattisesti

Näytä suoravalikko (sivu 49) painamalla 
pitkään SHUTTER-toimintopainiketta (F) 
ja valitse Auto, niin voit säätää suljinaikaa 
ja suljinkulmaa automaattisesti kuvan 
kirkkauden mukaan.

[Vinkki]
Voit suorittaa saman toimenpiteen myös koko valikon 
Shooting-valikossa määrittämällä kohdan Auto Exposure 
> Auto Shutter (sivu 79) asetukseksi On.

Sulkimen säätäminen käsin

1	 Näytä suoravalikko (sivu 49) painamalla 
pitkään SHUTTER-toimintopainiketta (F) ja 
valitse Speed tai Angle.

2	 Paina SHUTTER-toimintopainiketta (F), 
jotta sulkimen arvo näkyy valkoisella 
taustalla.

3	 Säädä suljinaikaa kääntämällä 
monitoimisäädintä.

[Vinkkejä]
ˎˎ Säädä valotusaika vastaamaan kuvaväliä valitsemalla 

vaiheessa 1 asetukseksi Off.
ˎˎ Voit myös määrittää kulman ja säätää taajuutta 

(sivu 77).

Valon määrän säätäminen  
(ND-suodatin)

Liian kirkkaasti valaistuissa olosuhteissa voit 
määrittää sopivan kirkkauden muuttamalla 
ND-suodatinta.
Videokamerassa on kaksi ND-suodatintilaa. 
Voit siirtyä eri tilojen välillä ND PRESET/
VARIABLE -kytkimellä.

Säätäminen esiasetetussa tilassa

Siirrä ND PRESET/VARIABLE -kytkin (A) 
PRESET-asentoon ja aseta ND FILTER 
POSITION -painikkeet ylös/alas (B) johonkin 
seuraavista asetuksista.
Clear: Ei ND-suodatinta
1: Koko valikon Shooting-valikossa kohdassa 
ND Filter > Preset1 (sivu 77) määritetty 
läpäisykerroin.
2: Koko valikon Shooting-valikossa kohdassa 
ND Filter > Preset2 (sivu 77) määritetty 
läpäisykerroin.
3: Koko valikon Shooting-valikossa kohdassa 
ND Filter > Preset3 (sivu 77) määritetty 
läpäisykerroin.

Säätäminen muuttuvassa tilassa

Siirrä ND PRESET/VARIABLE -kytkin (A) 
VARIABLE-asentoon. Vaihda asetusten 
CLEAR ja On välillä käyttämällä ND FILTER 
POSITION -painikkeita ylös/alas (B).

Valon määrän säätäminen automaattisesti
Voit ottaa käyttöön automaattisen 
valotuksensäädön ND-suodattimella 
määrittämällä Auto ND Filter -asetukseksi On.

1	 Kytke ND-suodatin päälle painamalla 
[+]-painiketta käyttäen ND FILTER 
POSITION -painikkeita ylös/alas (B).
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2	 Paina pitkään ND VARIABLE 
AUTO -painiketta (C), kunnes valittuna on 
Auto.

Valon määrän säätäminen käsin

1	 Kytke ND-suodatin päälle painamalla 
[+]-painiketta käyttäen ND FILTER 
POSITION -painikkeita ylös/alas (B).

2	 Paina pitkään ND VARIABLE 
AUTO -painiketta (C), kunnes valittuna on 
Manual.

3	 Säädä suodattimen läpäisykerrointa 
kääntämällä ND VARIABLE -säädintä (D).

[Vinkki]
Voit myös nimetä ND Filter -toiminnon nimettävälle 
säätimelle (sivu 49).

Automaattinen säätäminen tilapäisesti
Voit nimetä Push Auto ND -toiminnon 
nimettävälle painikkeelle (sivu 49) ja 
määrittää Auto ND Filter -asetukseksi 
tilapäisesti On painamalla painiketta 
pitkään. Kun vapautat painikkeen, Auto ND 
Filter -asetus palaa takaisin Off-tilaan.
Kytke ND-suodatin päälle painamalla 
[+]-painiketta käyttäen ND FILTER 
POSITION -painikkeita ylös/alas (B).

[Huomautus]
ˎˎ Kun ND-suodatin kytketään kuvaamisen aikana joko 

CLEAR-tilaan tai siitä muuhun tilaan, kuvassa näkyy 
ND-suodattimen kehys ja äänen tallennukseen 
sisältyy käytön merkkiääni.
ˎˎ Push Auto ND -toimintoa ei voi suorittaa, kun 

Shooting-valikossa kohdan Iris > Bokeh Control 
(sivu 78) asetuksena on On.

[Vinkkejä]
ˎˎ Voit määrittää asetukseksi CLEAR kääntämällä ND 

VARIABLE -säätimen (D) alas kohdasta ND1/4. Kun 
säädin käännetään ylös kohdasta CLEAR, asetukseksi 
tulee ND1/4. Voit poistaa toiminnon käytöstä koko 
valikon Technical-valikossa kohdassa ND Dial > CLEAR 
with Dial (sivu 99).

ˎˎ Voit myös nimetä ND Filter Position -toiminnon 
nimettävälle painikkeelle (sivu 49) ja muuttaa 
asetusta painamalla painiketta sen sijaan, että 
käyttäisit ND FILTER POSITION -painikkeita ylös/alas.  
Esiasetettu tila: Clear  Preset1  Preset2  Preset3 
 Clear… 
Muuttuva tila: Clear  On  Clear…
ˎˎ Voit myös nimetä Auto ND Filter -toiminnon 

nimettävälle painikkeelle (sivu 49) ja vaihtaa 
painiketta painamalla Auto ND -suodattimen On-
tilasta Off-tilaan ja päinvastoin.
ˎˎ Kun kuvataan kirkkaasti valaistua kohdetta, liiallinen 

himmentimen sulkeminen voi aiheuttaa diffraktiota, 
jolloin tarkennus muuttuu epäselväksi (yleinen 
ilmiö videokameroissa). Voit estää ilmiön ja saada 
paremman kuvaustuloksen käyttämällä ND-
suodatinta.
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G

J

Voit valita säätötilan kuvausolosuhteiden 
mukaan.

ATW (automaattinen 
valkotasapainon säätäminen)

Toiminto säätää valkotasapainon 
automaattisesti sopivalle tasolle.
Valkotasapaino säätyy automaattisesti, kun 
valonlähteen värilämpötila muuttuu.
Näytä suoravalikko (sivu 49) painamalla 
pitkään WHT BAL -toimintopainiketta (G) ja 
valitse ATW.
Voit valita säätymisnopeuden (viisi vaihetta) 
koko valikon Shooting-valikossa kohdassa 
White Setting > ATW Speed (sivu 80).

[Vinkki]
Voit lukita nykyisen valkotasapainoasetuksen 
nimeämällä ATW Hold -toiminnon nimettävälle 
painikkeelle (sivu 49) ja keskeyttää ATW-tilan 
tilapäisesti painamalla nimettävää painiketta.

[Huomautuksia]
ˎˎ ATW-toimintoa ei voida käyttää Cine EI -tilassa.
ˎˎ Sopivan värisävyn säätäminen ATW-toiminnolla 

ei ehkä onnistu valaistuksesta ja kohteen tilasta 
riippuen.  
Esimerkkejä:
–– Kun jokin yksittäinen väri hallitsee kohdetta, kuten 

taivas, meri, maa tai kukat.
–– Kun värilämpötila on erittäin suuri tai pieni.

	 Jos sopivaa vaikutusta ei voida saada, koska ATW-
toiminnon automatiikka on hidas tai jostakin muusta 
syystä, suorita automaattinen valkotasapaino.

Valkotasapainon säätäminen 
käsin

1	 Kun valkotasapaino on asetettu ATW-
tilaan, näytä suoravalikko (sivu 49) 
painamalla pitkään WHT 
BAL -toimintopainiketta (G) ja valitse W:P, 
W:A tai W:B.

2	 Valitse WHT BAL -kytkimellä (J) joko B, A 
tai PRESET.
B: Muisti B -tila
A: Muisti A -tila
PRESET: Esiasetettu tila

[Vinkki]
ATW voidaan ottaa käyttöön muistiin B määrittämällä 
koko valikon Shooting-valikossa kohdan White Setting > 
White Switch<B> (sivu 80) asetukseksi ATW.

Muisti A- / Muisti B -tila
Tämä tila säätää valkotasapainon muistiin 
A tai B tallennettuun asetukseen, tässä 
järjestyksessä.

Esiasetettu tila
Tämä tila säätää värilämpötilan esiasetettuun 
arvoon (tehdasoletus on 3200K).

Esiasetetun oletusarvon muuttaminen

Esiasetetussa tilassa voit muuttaa suoraan 
nykyistä esiasetettua arvoa.
Paina pitkään WHT BAL -toimintopainiketta (G) 
ja valitse suoravalikosta jokin seuraavista.
Custom-tila:  3200K,  4300K,  5600K, 

 6300K
Cine EI -tila:  3200K,  4300K,  5500K

[Vinkki]
Voit myös nimetä Preset White Select -toiminnon 
nimettävälle painikkeelle (sivu 49) ja muuttaa 
asetusta painamalla painiketta.
Custom-tila: 3200K  4300K  5600K  6300K  
 3200K…

Cine EI -tila: 3200K  4300K  5500K  3200K…

Värilämpötilan muuttaminen

1	 Paina WHT BAL -toimintopainiketta (G), 
jotta värilämpötila-arvo näkyy valkoisella 
taustalla.

2	 Säädä arvoa kääntämällä 
monitoimisäädintä.

[Vinkkejä]
ˎˎ Esiasetetussa tilassa voit määrittää arvon 

100 kelvinyksikön välein.
ˎˎ Muistitilassa voit määrittää arvon 20 kelvinin välein 

asteikolla 2000K–5600K. Arvon 5600K ylittävät arvot 
voidaan määrittää värimuutoksen määrää (mired) 
vastaavin välein välillä 5580K–5600K. Voit myös 
säätää sävyn arvoa koko valikon Shooting-valikossa 
kohdassa White (sivu 79) > Tint.

Automaattisen valkotasapainon 
suorittaminen

Muisti A- / Muisti B -tilaan tallennettava 
valkotasapaino määrittyy automaattisesti.

1	 Valitse joko muisti A -tila tai muisti B -tila.

2	 Aseta valkoinen paperi (tai muu esine) 
paikkaan, jossa on sama valaistus ja 
samat olosuhteet kuin kohteella, ja 
zoomaa sitten paperiin, jotta näytössä 
näkyy valkoista.

3	 Säädä kirkkautta.
Säädä himmennintä kohdassa 
”Himmentimen säätäminen käsin” 
(sivu 43) esitetyllä tavalla.

4	 Paina WB SET -painiketta (sivu 4).
ˎˎ Jos automaattinen valkotasapaino 
suoritetaan muistitilassa, automaattisen 
säädön tulos tallentuu vaiheessa 1 
valittuun muistiin (A tai B).
ˎˎ Jos automaattinen valkotasapaino 
suoritetaan ATW-tilassa, tulos periytyy 
ja ATW jatkuu automaattisen säädön 
päätyttyä. Tästä on hyötyä, kun 
valkotasapainoa halutaan säätää hyvin 
nopeasti riippumatta ATW Speed 
-asetuksesta.

[Huomautus]
Jos säätäminen ei onnistu, näyttöön ilmestyy virheviesti 
noin kolmen sekunnin ajaksi. Jos virheviesti ilmestyy 
edelleen toistuvien valkotasapainonsäätöyritysten 
jälkeen, ota yhteyttä Sonyn palveluedustajaan.

Värin säätäminen luonnolliseen sävyyn (valkotasapaino)
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Voit määrittää tallennettavan äänen 
käyttämällä videokameran tuloliittimiä, 
kytkimiä ja säätimiä.

Ulkoiset äänen tuloliittimet ja 
valintakytkimet

INPUT1-liitin (sivu 7)
INPUT2-liitin (sivu 7)
Moniliitäntäkenkä (sivu 7)
INPUT1 (LINE/MIC/MIC+48V) -kytkin 
(sivu 7)
INPUT2 (LINE/MIC/MIC+48V) -kytkin 
(sivu 7)

Kytkimet äänitason määrittämiseen

CH1 (AUTO/MAN) -kytkin (sivu 6)
CH2 (AUTO/MAN) -kytkin (sivu 6)
AUDIO LEVEL (CH1) -säädin (sivu 6)
AUDIO LEVEL (CH2) -säädin (sivu 6)

Audio Status -näyttö

Äänen tulolähteen valitseminen

1	 Määritä äänitulo joko valitsemalla Audio 
Status -näytössä CH1/CH2/CH3/CH4 > 
Source (sivu 14) tai koko valikon Audio-
valikossa kohdassa Audio Input > CH1 
Input Select – CH4 Input Select 
(sivu 96).
Jos käytät moniliitäntäkenkään 
kytkettävää mikrofonia tai XLR-sovitinta, 
määritä asetukseksi joko Shoe CH1 tai 
Shoe CH2. Tietoja XLR-sovittimesta, ks. 
”Äänen tuloliittimien lisääminen” 
(sivu 48).

	 [Huomautuksia]
ˎˎ Ääntä ei tallenneta Interval Rec -tilassa eikä 

hidastus- ja nopeutustilassa.
ˎˎ Videokamerassa on sisäinen selostusmikrofoni 

ympäröivän äänen tallentamiseen. Sitä voidaan 
käyttää ajoituksen synkronointiin muiden 
laitteiden kanssa. Tällöin on asetukseksi on 
määritettävä Internal MIC.
ˎˎ Kun yläkahva on kiinnitettynä, vain yläkahvan 

sisäinen mikrofoni (sivu 7) aktivoituu äänen 
tallentamiseen. Kun yläkahvaa ei ole kiinnitetty, 
selostusmikrofoni (sivu 6) ympäröivän äänen 
tallentamiseen on käytettävissä.
ˎˎ Kun kohtien CH1 Input Select ja CH2 Input Select 

asetuksiksi on määritetty Internal MIC, sekä CH1- 
että CH2-kanavien äänitystasoa voidaan säätää 
AUDIO LEVEL(CH1) -säätimellä (sivu 6). Kun 
kohtien CH3 Input Select ja CH4 Input Select 
asetuksiksi on määritetty Internal MIC, sekä CH3- 
että CH4-kanavien äänitystasoa voidaan säätää 
CH3 Input Level -asetuksella (sivu 96).

2	 Valitse äänen tulolähde.
Siirrä INPUT1- / INPUT2 (LINE/MIC/
MIC+48V) -kytkimet INPUT1-/INPUT2-
liittimiin liitettyihin laitteisiin, tässä 
järjestyksessä.

Liitetty laite Kytkimen 
asento

Ulkoinen äänilähde (esim. 
mikseri)

LINE

Dynaaminen mikrofoni, 
akkukäyttöinen mikrofoni

MIC

+48 V phantom-
jännitteinen mikrofoni

MIC+48V

ˎˎ Jos valitset asetuksen MIC+48V ja 
liitetty mikrofoni ei ole yhteensopiva 
+48V-lähteen kanssa, liitetty laite voi 
vaurioitua. Tarkista asetus ennen laitteen 
liittämistä.
ˎˎ Jos kohina on ongelmana liittimissä, 
joihin ei ole liitetty laitetta, siirrä 
kyseiset INPUT1-/INPUT2 (LINE/MIC/
MIC+48V) -kytkimet asentoon LINE.

Äänitystason säätäminen 
automaattisesti

Siirrä automaattisesti säädettävien kanavien 
CH1- / CH2 (AUTO/MAN) -kytkimet AUTO-
asentoon.
Määritä kanavien CH3/CH4 äänitason hallinta 
Audio Status -näytössä (sivu 14) tai koko 
valikon Audio-valikossa kohtien Audio Input 
> CH3 Level Control ja CH4 Level Control 
asetukseksi Auto (sivu 96).

Äänitystason säätäminen käsin

Säädä kanavien CH1/CH2 äänitystasoa 
seuraavan menettelyn mukaisesti.

1	 Siirrä käsin säädettävien kanavien CH1-/
CH2 (AUTO/MAN) -kytkimet MAN-
asentoon.

2	 Säädä äänitasoa kuvaamisen tai 
valmiustilan aikana kääntämällä 
vastaavien kanavien AUDIO LEVEL (CH1)/
(CH2) -säätimiä.
ˎˎ Määritä kanavien CH3/CH4 äänitason 
hallinta Audio Status -näytössä kohdassa 
CH3/CH4 (sivu 14) tai koko valikon 
Audio-valikossa kohtien Audio Input > 
CH3 Level Control ja CH4 Level Control 
asetukseksi Manual, ja säädä sitten 
äänitystaso kohdassa CH3 Input Level tai 
CH4 Input Level.
ˎˎ Voit säätää kanavien CH1–CH4 tasoja 
ryhmänä. Voit säätää tallennustasoa 
käyttämällä nimettävää säädintä 
(sivu 49), jolle Audio Input 
Level -toiminto on nimetty, tai Audio 
Status -näytössä tai koko valikon Audio-
valikossa kohdassa Audio Input > Audio 
Input Level.

[Vinkki]
Audio Status -näyttö on kätevä äänen tulotason 
(sivu 14) tarkistamiseen.

[Huomautuksia]
ˎˎ Audio Input Level -asetukset voivat olla poissa 

käytöstä Audio-valikon asetusyhdistelmästä riippuen. 
Lisätietoja saat kaaviosta, sivu 132.
ˎˎ Videokamera tukee eri asetusten yhdistelmiä. 

Lisätietoja saat kaaviosta, sivu 132.

Tallennettavan äänen määrittäminen
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Äänen tuloliittimien lisääminen

Voit liittää videokameraan samanaikaisesti 
enintään neljä XLR-äänilaitteen kanavaa 
käyttämällä XLR-K2M XLR -sovitinta (ei 
mukana) tai XLR-K3M XLR -sovitinta (ei 
mukana).
Kiinnitä XLR-sovitin moniliitäntäkenkään ja 
määritä Audio Status -näytössä kohdan CH3 
> Source asetukseksi Shoe CH1 ja kohdan CH4 
>Source asetukseksi Shoe CH2 (sivu 14). Tai 
määritä koko valikon Audio-valikossa kohdan 
Audio Input > CH3 Input Select asetukseksi 
Shoe CH1 ja kohdan CH4 Input Select 
asetukseksi Shoe CH2.
Päällekkäiset videokameran toiminnot 
poistuvat käytöstä niiden kanavien osalta, 
joissa tuloksi on valittu XLR-sovitin. Tee 
säätöjä käyttämällä XLR-sovittimen kytkimiä ja 
säätimiä.

[Huomautuksia]
ˎˎ Videokamera tukee XLR-K3M-sovittimen 2-kanavaista 

digitaalista ääniliitäntää.
ˎˎ Jos Audio-valikon kohdassa Audio Input > CH3 

Level ja CH4 Level asetuksena on Audio Input Level, 
videokameran Audio Input Level kerrotaan XLR-
sovittimessa säädetyllä tasolla.  
Audio Input Level on käytössä myös, kun XLR-
sovittimen kytkin on asennossa AUTO.  
Kun määritettynä on ”Through”, ääntä tallennetaan 
XLR-sovittimessa säädetyllä tasolla (sivu 133).
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Hyödyllisiä toimintoja

 Suoravalikon toiminnot

Voit tarkistaa videokameran tilan ja asetukset 
etsimen näytöltä sekä valita ja muuttaa 
asetuksia suoraan näytöllä.
Seuraavat kohteet ovat määritettävissä.
ˎˎ Face/Eye Detection AF
ˎˎ SteadyShot
ˎˎ White Mode
ˎˎ Color Temp
ˎˎ Scene File
ˎˎ ND Filter Position / Auto ND Filter
ˎˎ ND Filter Value
ˎˎ Auto Iris
ˎˎ Iris Value
ˎˎ AGC
ˎˎ Gain Value
ˎˎ ISO Value
ˎˎ Exposure Index Value
ˎˎ Auto Shutter / ECS
ˎˎ Shutter Value
ˎˎ Auto Exposure Mode
ˎˎ Auto Exposure Level
ˎˎ S&Q Motion Frame Rate

1	 Paina monitoimisäädintä tai nimettävää 
painiketta, jolle Direct Menu -toiminto on 
nimetty.
Vain näytöllä näkyvät kohteet, joita 
voidaan määrittää käyttämällä 
suoravalikkoa, ovat valittavissa oranssin 
kohdistimen avulla.

2	 Siirrä kohdistin käytettävään 
valikkokohteeseen monitoiminsäätimellä 
ja paina säädintä.
Joko valikko tai kohde näkyy valkoisella 
taustalla.

3	 Valitse asetus kääntämällä ja painamalla 
monitoimisäädintä.
Valikko tai valkoinen tausta häviää ja 
näkyviin tulee uusi asetus ja oranssi 
kohdistin.
Poistu suoravalikosta painamalla 
uudelleen nimettävää painiketta, jolle 
Direct Menu on nimetty, tai odottamalla 
3 sekuntia tekemättä mitään.

	 [Vinkkejä]
ˎˎ Suoria asetuksia voidaan määrittää myös 

painamalla pitkään kutakin toimintopainiketta 
(sivu 5).
ˎˎ Kun kohteet näkyvät valkoisella taustalla. 

monitoimisäädintä voidaan käyttää kuten 
nimettävää säädintäkin.
ˎˎ Valintaan voidaan käyttää myös monivalitsinta 

(sivu 9).

Nimettävät painikkeet/säätimet

Videokamerassa on yhdeksän nimettävää 
painiketta (sivu 6, 7, 9), joihin voit 
nimetä toimintoja.
Voit nimetä toimintoja myös videokameran 
monitoimivalitsimelle (sivu 5), yläkahvan 
nimettävälle säätimelle (sivu 7) ja 
kauko-ohjainkahvan nimettävälle säätimelle 
(sivu 9).

Painikkeen toiminnon vaihtaminen

Käytä koko valikon Project-valikossa kohtaa 
Assignable Button (sivu 85).
Voit tarkastella nimettyjä toimintoja 
Assignable Button Status -näytössä 
(sivu 15).

Kullekin nimettävälle painikkeella 
tehdasoletuksena nimetyt toiminnot
Painike 1	 S&Q Motion
Painike 2	 AF Speed/Sens.
Painike 3	 Focus Setting
Painike 4	 Focus Magnifier x3/x6
Painike 5	 Direct Menu
Painike 6	 Off
Painike 7	 Focus Magnifier x3/x6
Painike 8	 Direct Menu
Painike 9	 Video Signal Monitor
Focus Hold -painike	Focus Hold

Nimettävät toiminnot
ˎˎ Off
ˎˎ Base ISO/Sensitivity
ˎˎ AGC
ˎˎ Push AGC
ˎˎ ND Filter Position
ˎˎ Auto ND Filter
ˎˎ Push Auto ND
ˎˎ Auto Iris
ˎˎ Push Auto Iris
ˎˎ Bokeh Control
ˎˎ Auto Shutter
ˎˎ Auto Exposure Level
ˎˎ Backlight
ˎˎ Spotlight
ˎˎ Preset White Select
ˎˎ ATW
ˎˎ ATW Hold
ˎˎ AF Speed/Sens.
ˎˎ Focus Setting
ˎˎ Focus Area
ˎˎ Focus Area(AF-S)
ˎˎ Face/Eye Detection AF
ˎˎ Push AF Mode
ˎˎ Push AF/Push MF
ˎˎ Focus Hold
ˎˎ Focus Magnifier x3/x6
ˎˎ Focus Magnifier x3
ˎˎ Focus Magnifier x6
ˎˎ S&Q Motion
ˎˎ SteadyShot

ˎˎ Rec
ˎˎ Picture Cache Rec
ˎˎ Rec Review
ˎˎ Clip Flag OK
ˎˎ Clip Flag NG
ˎˎ Clip Flag Keep
ˎˎ Color Bars
ˎˎ Tally [Front]
ˎˎ DURATION/TC/U-BIT
ˎˎ Display
ˎˎ Lens Info
ˎˎ Video Signal Monitor
ˎˎ Marker
ˎˎ VF Adjust
ˎˎ VF Mode
ˎˎ Gamma Display Assist
ˎˎ Peaking
ˎˎ Zebra
ˎˎ Volume
ˎˎ Thumbnail
ˎˎ Touch Operation
ˎˎ Handle Zoom
ˎˎ NFC
ˎˎ Auto Upload (Proxy)
ˎˎ Direct Menu
ˎˎ User Menu
ˎˎ Menu

Säätimen toiminnon vaihtaminen

Voit vaihtaa videokameran 
monitoimisäätimen, kauko-ohjainkahvan 
nimettävän säätimen ja yläkahvan nimettävän 
säätimen toimintoa.

Määritä monitoimisäädin Project-valikon 
kohdassa Multi Function Dial (sivu 88) > 
Default Function.
Off on nimetty tehdasoletuksena.
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Monitoimisäätimelle nimettävät toiminnot
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level

[Huomautus]
Asetus on poissa käytöstä, kun valikko on näkyvissä.

Määritä nimettävä säädin koko valikon 
Project-valikossa kohdassa Assignable Dial 
(sivu 87).
IRIS on nimetty kaikkiin tehdasoletuksena.

[Vinkki]
RM-30BP-laitteen (lisävaruste) nimettävän säätimen 
asetus on aina sama kuin Grip/Remote Dial -asetus.

Ylä-/kauko-ohjainkahvan nimettävälle 
säätimelle nimettävät toiminnot
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ ND Filter
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level
ˎˎ Multi Function Dial

Voit tarkastella nimettyjä toimintoja 
Assignable Button Status -näytössä 
(sivu 15).

Hidastus ja nopeutus

Kun tallennusmuodolle (sivu 82) on asetettu seuraavat arvot, voit määrittää eri arvoja 
kuvaamisen kuvataajuudelle ja toiston kuvataajuudelle.

Tallennusmuoto Kuvataajuus

Järjestelmän 
taajuus

Kuvakennon 
käyttötila

Koodekki Videomuoto

59.94/50/29.97/ 
25/23.98

FF RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I 4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 
180, 200, 240

XAVC-L 3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 
180, 200, 240

S35 XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

24 FF XAVC-I 4096×2160P 1–60

Voit ottaa hidastus- ja nopeutustilan 
käyttöön ja poistaa sen käytöstä painamalla 
nimettävää painiketta (sivu 49), jolle S&Q 
Motion -toiminto on nimetty.
Voit määrittää kuvaamisen kuvataajuuden 
painamalla painiketta pitkään.

[Vinkki]
Voit määrittää tilan myös Main Status -näytön kohdassa 
S&Q Frame Rate, Project-tilanäytön kohdassa Rec 
Function ja koko valikon Shooting-valikossa kohdassa 
S&Q Motion.

[Huomautuksia]
ˎˎ Hidastusta ja nopeutusta ei voida määrittää 

tallennuksen tai toiston aikana eikä pikkukuvanäytön 
näkyessä.
ˎˎ Äänitystä ei tueta hidastus- ja nopeutustilassa.
ˎˎ Automaattitarkennus-, automaattihimmennin- 

ja automaattisuljintoiminto ovat hidastus- 
ja nopeutustilassa poissa käytöstä. 
Automaattitarkennustoimintoa voidaan kuitenkin 
käyttää, kun kuvataajuus on määritetty seuraavasti.

Järjestelmän taajuus Kuvataajuus

59.94/29.97/23.98 30, 60, 120, 240

50/25 25, 50, 100, 200

ˎˎ Tietoja RAW-lähdön käyttämisestä, ks. sivu 59.

Videon tallentaminen 
jaksottaisesti (Interval Rec)

Videokameran Interval Rec -toiminnolla voit 
kuvata intervallivideokuvaa videokameran 
sisäiseen muistiin. Toiminto on tehokas keino 
kuvata hitaasti liikkuvia kohteita.
Kun aloitat tallentamisen, videokamera 
tallentaa automaattisesti määrätyn määrän 
kuvia määrätyn ajanjakson aikana.

Kuvausväli (Interval Time)

Kuvien lukumäärä yhdellä kuvauskerralla
(Number of Frames)

Interval Rec on käytössä, HVL-LBPC-
videovalo (lisävaruste) syttyy automaattisesti 
ennen tallennuksen alkamista, joten voit 
tallentaa kuvaa vakaassa valaistuksessa ja 
värilämpötilassa (esivalaistustoiminto).

[Huomautuksia]
ˎˎ Kerrallaan voidaan käyttää vain yhtä 

erikoistallennustoimintoa, kuten Interval 
Rec -tallennusta.
ˎˎ Jos jokin toinen erikoistallennustila otetaan käyttöön, 

kun Interval Rec on käytössä, Interval Rec poistuu 
automaattisesti käytöstä.
ˎˎ Interval Rec -tila poistuu automaattisesti käytöstä, 

kun muutetaan järjestelmäasetuksia, kuten 
videomuotoa.
ˎˎ Interval Rec -asetuksia ei voida muuttaa tallennuksen 

tai toiston aikana eikä pikkukuvanäytön näkyessä.



3. Kuvaaminen: Hyödyllisiä toimintoja51

Interval Rec -toiminnon määrittäminen

Valitse Project-tilanäytössä Rec Function > 
Interval Rec. ja määritä asetukset Number of 
Frames ja Interval Time.
Jos käytät HVL-LBPC-videovaloa (lisävaruste), 
määritä Project-valikon kohdassa Interval Rec 
> Pre-Lighting tarpeen mukaan aikaväli, kuinka 
paljon ennen tallentamisen aloitusta videovalo 
kytketään päälle.

[Vinkki]
Voit määrittää tilan myös koko valikon Project-valikossa 
kohdassa Interval Rec (sivu 84).

[Huomautuksia]
ˎˎ Jos haluat kytkeä videovalon päälle ennen 

tallennuksen aloittamista, siirrä videovalon kytkin 
asentoon AUTO. Videovalo syttyy ja sammuu 
automaattisesti Technical-valikon Video Light 
Set -asetuksen (sivu 100) mukaisesti.
ˎˎ Jos siirrät videovalon kytkimen On-asentoon, 

videovalo palaa aina (videovalo ei syty/sammu 
automaattisesti).
ˎˎ Jos videovalo määritetään siten, että se sammuu 

5 sekunniksi tai sitä lyhyemmäksi ajaksi, videovalo ei 
sammu.

Videokamera poistuu Interval Rec -tilasta, 
kun sen virta on sammutettu, mutta Number 
of Frames-, Interval Time- ja Pre-Lighting-
asetukset säilyvät. Niitä ei tarvitse määrittää 
uudelleen seuraavalla kerralla, kun kuvaat 
Interval Rec -tilassa.

Kuvaaminen Interval Rec -tilassa

Aloita tallennus painamalla tallennuksen 
START/STOP-painiketta. Etsimessä näkyy 
vuorotellen ”Int Rec” ja ”Int Stby”.
Jos käytät esivalaistustoimintoa, videovalo 
syttyy ennen kuin tallentaminen alkaa.

Kuvaamisen lopettaminen

Lopeta tallentaminen.

Kun kuvaaminen päättyy, siihen mennessä 
muistiin tallennettu videodata tallentuu 
tietovälineeseen.

Interval Rec -tilasta poistuminen

Tee jokin seuraavista.
ˎˎ Siirrä POWER-kytkin Off-asentoon.
ˎˎ Määritä tallentamisen valmiustilassa Project-
tilanäytön Rec Function -asetukseksi jokin 
muu kuin Interval Rec.

Lisäksi Interval Rec -tila poistuu 
automaattisesti käytöstä, kun videokamera 
käynnistetään uudelleen.

Rajoitukset tallentamisen aikana

ˎˎ Ääntä ei tallenneta.
ˎˎ Tallennuksen tarkasteleminen (Rec Review) 
ei ole mahdollista.

Jos videokamera sammutetaan 
tallentamisen aikana

ˎˎ Jos videokameran POWER-kytkin siirretään 
Off-asentoon, tietoväline on käytössä 
useita sekunteja muistiin siihen mennessä 
tallennettujen kuvien tallentamista varten, ja 
sitten virta sammuu automaattisesti.
ˎˎ Jos virta katkeaa siksi, että akku on 
irrotettu, virtajohto on irrotettu tai virta on 
sammutettu verkkovirtalaitteesta, siihen 
mennessä kuvattu video- ja äänidata 
voi hävitä (enintään 10 sekuntia). Akun 
vaihtamisessa on oltava huolellinen.

Kuvien tallentaminen välimuistiin 
(Picture Cache Rec)

Picture Cache Rec -toiminnolla voit tallentaa 
videota takautuvasti kuvauksen alussa 
ylläpitämällä tietyn pituista sisäistä välimuistia 
kuvauksen aikana.
Määritä Project-tilanäytössä kohdan Picture 
Cache Rec asetukseksi On ja määritä sitten 
välimuistin koko.

Cache Size -asetus Välimuistin kesto 
(arvioitu)

Short 5 sekuntia

Medium 10 sekuntia

Long 20 sekuntia

Max Kunkin tallennusmuodon 
enimmäisarvo

[Vinkkejä]
ˎˎ Välimuistin kesto voi olla lyhyempi tietyillä 

kuvauksen kuvataajuuksilla ja tallennusmuodoilla. 
Tarkista välimuistin koon määritysnäytön oikeassa 
alakulmassa oleva ilmaisin.
ˎˎ Voit määrittää tilan myös koko valikon Project-

valikossa kohdassa Picture Cache Rec (sivu 84).
ˎˎ Voit kytkeä Picture Cache Rec -tilan päälle tai pois 

päältä myös nimettävällä painikkeella (sivu 49).

[Huomautuksia]
ˎˎ Picture Cache Rec -tilaa ei voi käyttää yhdessä 

Interval Rec- toiminnon, 2 paikan samanaikaisen 
tallennustoiminnon tai välityspalvelimelle 
tallentamisen kanssa. Kun Picture Cache Rec on 
päällä, nämä muut tallennustoiminnot pakotetaan 
pois käytöstä.
ˎˎ Picture Cache Rec -tilaa ei voi valita tallennuksen tai 

Rec Review -toiminnon aikana.
ˎˎ Kun Picture Cache Rec on päällä, aikakoodi 

tallennetaan Free Run -tilassa, vaikka asetuksena olisi 
Regen tai Rec Run (sivu 91).
ˎˎ Output Format -asetusta ei ehkä voi määrittää Picture 

Cache Rec -tilassa. Jos näin tapahtuu, kytke Picture 
Cache Rec tilapäisesti pois päältä ja muuta sitten 
asetusta.

Picture Cache Rec -tilan käynnistäminen

Kun Picture Cache Rec -tila kytketään päälle, 
etsimeen tulee ”Cache” ( on vihreä).
Kun painat tallennuksen START/STOP-
painiketta, tallennus alkaa ja video kirjoitetaan 
muistikorteille aloittaen välimuistiin 
tallennetusta videosta.

Picture Cache Rec -tilan peruuttaminen

Määritä Project-tilanäytössä Picture Cache 
Rec -asetukseksi Off tai paina nimettävää 
painiketta, jolle Picture Cache Rec -toiminto on 
nimetty.

[Huomautuksia]
ˎˎ Tallennusmuodon tai perusulkoasun vaihtaminen 

poistaa välimuistiin siihen asti tallennetun videon 
ja aloittaa uuden videon tallennuksen välimuistiin. 
Tämän vuoksi kuvien tallennus välimuistiin ennen 
muodon vaihtamista ei ole mahdollista vaikka kuvaus 
aloitettaisiin välittömästi muodon vaihtamisen 
jälkeen.
ˎˎ Jos Picture Cache Rec kytketään päälle tai pois päältä 

heti muistikortin asettamisen jälkeen, välimuistin 
tiedot eivät ehkä tallennu kortille.
ˎˎ Video tallennetaan välimuistiin, kuin Picture Cache 

Rec -toiminnon asetukseksi valitaan On. On-tilan 
valintaa edeltävää videota ei tallenneta välimuistiin.
ˎˎ Videota ei tallenneta välimuistiin, kun muistikortti on 

käytössä, esimerkiksi toiston, Rec Review -toiminnon 
tai pikkukuvanäytön aikana. Videon kuvien tallennus 
välimuistiin ei ole mahdollista tänä aikana.
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Muistikorteille A ja B 
tallentaminen samanaikaisesti 
(2 paikan Simul Rec)

Voit tallentaa samanaikaisesti sekä 
muistikortille A että muistikortille B 
määrittämällä Project-tilanäytössä kohdan 
Simul Rec (sivu 15) tai koko näytön 
Project-valikossa kohdan Simul Rec > Setting 
(sivu 84) asetukseksi On.

Muistikorteille A ja B tallentaminen 
erikseen

Tallennus kummallekin muistikortille voidaan 
aloittaa ja lopettaa erikseen videokameran 
ja yläkahvan tallennuksen START/STOP-
painikkeilla.
Tehdasoletuksena molemmat painikkeet 
on määritetty aloittamaan/lopettamaan 
samanaikainen tallennus muistikorteille A ja B.
ˎˎ ”Rec Button:[SlotA SlotB] Handle Rec 
Button:[SlotA SlotB]”

Kun painikkeet määritetään ohjaamaan 
tallennusta eri muistikorteille, SDI/HDMI Rec 
Control -toiminnon (sivu 85) tallennuksen 
alkamisen/päättymisen ohjaus seuraa paikan 
A tallennustilaa.

Asetuksen muuttaminen

Valitse Project-valikossa Simul Rec > Rec 
Button Set (sivu 84).

Rec Button Set Painikkeet ja 
muistikortit

”Rec Button:[SlotA 
SlotB] Handle Rec 
Button:[SlotA SlotB]”

Aloittaa/lopettaa 
tallennuksen 
muistikorteille A ja B 
samanaikaisesti 
kummalla tahansa 
painikkeella.

”Rec Button:[SlotA] 
Handle Rec Button: 
[SlotB]”

Tallennuksen START/
STOP-painike aloittaa/
lopettaa tallennuksen 
muistikortille A, ja 
yläkahvan 
tallennuksen START/
STOP-painike aloittaa/
lopettaa tallennuksen 
muistikortille B.

”Rec Button:[SlotB] 
Handle Rec 
Button:[SlotA]”

Tallennuksen START/
STOP-painike aloittaa/
lopettaa tallennuksen 
muistikortille B, ja 
yläkahvan 
tallennuksen START/
STOP-painike aloittaa/
lopettaa tallennuksen 
muistikortille A.

[Vinkki]
Kauko-ohjainkahvan tai LANC-kauko-ohjaimen 
tallennuspainike toimii samalla tavalla kuin laitteen 
tallennuksen START/STOP-painike.

Yläkahvan tallennuksen START/STOP-
painikkeen tahattoman käytön 
estäminen

Siirrä yläkahvan HOLD-kytkin HOLD-asentoon.

[Huomautus]
Yläkahvan HOLD-kytkin ei toimi, kun koko valikon 
Technical-valikossa kohdan HOLD Switch Setting 
(sivu 99) > with Rec Button asetuksena on Off. Kun 
asetuksena on On, määritä kohdan Handle HOLD Switch 
asetukseksi Rec Button Only.

Jos haluat ottaa käyttöön zoomausvivun ja 
muut painikkeet kuin yläkahvan tallennuksen 
START/STOP-painikkeen, määritä kohdan 
HOLD Switch Setting > Handle HOLD Switch 
asetukseksi Rec Button Only.

Videosignaalin näyttö

Voit määrittää videosignaalin tyypin 
näkymään etsimen näytössä aaltomuotona, 
vektoriskooppina tai histogrammina 
Monitoring-valikon kohdassa Display On/Off > 
Video Signal Monitor (sivu 94).
Oranssi viiva ilmaisee seepratasolle määritetyn 
arvon.
Voit myös nimetä Video Signal 
Monitor -toiminnon nimettävälle painikkeelle 
(sivu 49).

Tavoitenäytön tarkkaileminen

Cine EI -tilassa väriavaruuden asetuksen 
(sivu 24) tai näytön LUT-asetuksen 
(sivu 81) tieto videosignaalin näytön 
oikeassa yläkulmassa osoittamassa seurannan 
tavoitetta.
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Gamma Display Assist -toiminto

Kun kohdan Target Display asetuksena 
on HDR(HLG) Custom-tilassa (sivu 24), 
määritä Monitoring Status -näytössä kohdan 
Gamma Display Assist* asetukseksi On, niin 
näet etsimessä apunäytön, joka helpottaa 
kuvaamista HDR-tilassa.
*	 Voit määrittää toiminnon myös koko valikon 

Monitoring-valikossa kohdassa Gamma Display Assist 
> Setting (sivu 95).

Etsimen näytön valinta gammanäytön 
avustustoiminnon ollessa käytössä

HDR-kuvia voidaan näyttää etsimessä kahdella 
tavalla gammanäytön avustustoiminnon 
ollessa käytössä.

HDR-näyttö säilyttäen kontrastin alhaisen ja 
korkean luminanssin alueiden välillä
Tämä menetelmä hyödyntää HDR:n 
ilmaisuvoimaa näyttäen kuvan etsimessä 
aiheuttamatta mustien sävyjen puuroutumista 
tai liioittelematta kirkkaita kohtia myös 
kirkkaalla tai tummalla valotuksella 
kuvattaessa. Kontrasti on kuitenkin hieman 
heikompi.
Jos haluat käyttää tätä menetelmää, aseta 
koko valikon Project-valikossa kohdan 
HDR Setting > VF SDR Preview (sivu 83) 
asetukseksi Off.

SDR-näyttö HDR:n yksinkertaisella muunnolla 
SDR:ksi
Tällä menetelmällä voit saada kameraa 
käyttäessäsi tavanomaisen SDR:n tunnun.
Voit säätää HDR-kuvan kontrastia asettamalla 
HDR:n ja SDR:n välisen herkkyysvahvistuseron 
SDR Gain -asetuksella.
Jos haluat käyttää tätä näyttömenetelmää, 
määritä se seuraavasti.

1	 Määritä koko valikon Project-valikossa 
kohdan HDR Setting > VF SDR Preview 
(sivu 83) asetukseksi On.

2	 Säädä SDR:n herkkyysvahvistusarvoa 
HDR-tilassa koko valikon Project-valikon 
kohdassa HDR Setting > SDR Gain 
(sivu 84).

[Vinkki]
Kun HDR muunnetaan SDR:ksi SR Live Metadatan avulla 
kuvauksen jälkeen, SDR Gain -asetusta sovelletaan 
muunnossa siten, että SDR-kuvanäytön valotus on sama 
kuin etsimessä kuvaushetkellä.

Leikeliput

Voit lisätä OK-leikelipun leikkeeseen 
painamalla Clip Flag -painiketta (sivu 5) ja 
valitsemalla Add OK.
Voit poistaa OK-leikelipun painamalla 
painiketta kahdesti ja valitsemalla Delete Clip 
Flag.

[Vinkkejä]
ˎˎ Voit lisätä leikelippuja myös käyttämällä nimettävää 

painiketta, jolle leikelipputoiminto on nimetty 
(sivu 49).
ˎˎ Lisäksi voit lisätä leikelipun koko valikon Thumbnail-

valikossa (sivu 70) kohdassa Set Clip Flag 
(sivu 98).
ˎˎ Pikkukuvanäyttö voidaan lajitella leikkeen lipun tyypin 

mukaan (suodatettu leikkeiden pikkukuvanäyttö). 
Lisätietoja saat kohdasta ”Leiketoiminnot” (sivu 70).

Hengityksen kompensaatio

Koko valikon Technical-valikossa kohdassa 
Lens > Breathing Compensation (sivu 100) 
voit määrittää, käytetäänkö objektiivin kanssa 
hengityksen kompensaatiota.
Tämä toiminto korjaa ilmiön, jossa kuvakulma 
vaihtelee tarkennuskohdan muuttuessa.
Kun hengityksen kompensaatiota käytetään, 
osa kuvasta rajataan elektronisesti vakaan 
kuvakulman säilyttämiseksi siten, ettei 
hengitysilmiötä esiinny.

[Huomautuksia]
ˎˎ Kun hengityksen kompensaatio on käytössä, 

kuvakulma ja kuvanlaatu voivat muuttua hieman.
ˎˎ Joillakin objektiiveilla kuvakulman muutosta ei ehkä 

ole mahdollista korjata hengityksen kompensaation 
ollessa käytössä.
ˎˎ Kompensaatio ei ole mahdollista käytettäessä 

objektiivia, joka ei tue hengityksen kompensaatiota.

ˎˎ Tämä toiminto on kytkettynä pois päältä (pysyvästi) 
seuraavissa tilanteissa.
–– Kun Technical-valikon kohdan Lens > Distortion 

Comp. asetuksena on Off
–– Kun Shooting-valikon kohdan S&Q Motion > Setting 

asetuksena on On
–– Kun Project-valikon kohdan Rec Format > Codec 

asetuksena on RAW tai RAW-muodon sisältävä 
vaihtoehto

Boken hallinta (Bokeh Control 
-toiminto)

Voit säätää boken määrää helposti 
linkittämällä ND-suodattimen ja 
herkkyysvahvistuksen himmentimen 
toimintaan.

Boken hallintatoiminnon kytkeminen 
päälle / pois päältä

Tämän toiminnon voi ottaa käyttöön vain, 
kun valotusta säädetään manuaalisesti. Aseta 
ND-suodatin muuttuvaan tilaan ja aseta sitten 
himmennin, herkkyysvahvistus, suljin ja ND-
suodatin manuaaliseen säätötilaan.
Voit kytkeä boken hallintatoiminnon päälle / 
pois päältä koko valikon Shooting-valikossa 
kohdassa Iris > Bokeh Control (sivu 78).
Kun boken hallintatoiminto on päällä, 
ND-suodattimen ja herkkyysvahvistuksen 
ilmaisimessa näkyy kuvake . 

[Vinkki]
Voit myös nimetä Bokeh Control -toiminnon 
nimettävälle painikkeelle (sivu 49) ja kytkeä boken 
hallintatoiminnon päälle / pois päältä painikkeella.

Boken määrän säätäminen

1	 Kytke boken hallintatoiminto päälle.
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2	 Määritä valotus säätämällä ND-suodatinta 
ja herkkyysvahvistusta.

3	 Säädä himmennintä.
Boken määrä muuttuu.

[Vinkkejä]
ˎˎ Kun boken hallintatoiminto on päällä, ND-suodatin 

ja herkkyysvahvistus kompensoivat yhdessä 
himmentimen säädön aiheuttamia valotusmuutoksia 
mahdollistaen näin boken määrän muuttamisen.
ˎˎ Boken hallinta linkitetään ensin ND-suodattimeen 

reaktiona himmentimen toimintaan. Kun ND-
suodatinta ei voida muuttaa enempää, linkitetään 
herkkyysvahvistus.
ˎˎ MF-tilassa on suositeltavaa avata ensin himmennin ja 

säätää sitten tarkennusta.
ˎˎ Jos käytät automaattista ND-suodatinta boken 

hallintatoiminnon sijaan, ND-suodatin noudattaa 
kohteen kirkkauden muutoksia.

Näyttö herkkyysvahvistuksen 
linkitystoiminnon aikana

Kun boken hallintatoiminto on päällä, 
herkkyysvahvistus saattaa muuttua 
himmennintä säädettäessä.
Kun herkkyysvahvistuksen linkitys on 
käytössä ja herkkyysvahvistus muuttuu, 
näytön yläosaan tulee ilmoitus ja 
herkkyysvahvistuksen ilmaisimen -kuvake 
vilkkuu. 

[Huomautuksia]
ˎˎ Tämä toiminto on käytössä vain E-pidikkeellisissä 

objektiiveissa, jotka voivat viestiä laitteen kanssa.
ˎˎ Toiminnon täysi vaikutus saadaan käyttämällä Sonyn 

E-pidikkeellisen objektiivin himmenninrengasta.
ˎˎ Ulkoasu voi vaihdella toiminnon nopeuden, 

objektiivin, kuvausasetusten ja kohteen mukaan, 
ja myös kirkkaus voi muuttua. On ehdottoman 
suositeltavaa tehdä koekuvaus kameralla ennen 
kuvaamista.
ˎˎ Kirkkaus voi muuttua, kun himmentimen käyttösuunta 

muuttuu, esimerkiksi kun se avataan sulkemisen 
jälkeen tai suljetaan avaamisen jälkeen. Säädä tässä 
tapauksessa ensin hieman tarvetta enemmän ja 
palaa hieman takaisin, tarkista kirkkaus ja aloita sitten 
kuvaus.  
Jos esimerkiksi haluat avata himmentimen F8-

aukkoon ja sumentaa taustan, sulje aukkoa ensin F8:n 
ohi ja palaa sitten F8:aan, tarkista kirkkaus ja aloita 
kuvaus.
ˎˎ Tee boken hallintatoiminnot hitaasti. Jos haluat 

nopeuttaa toimintoa, yritä tehdä säädöt asteittain 
tarkistaen samalla kuvan muutokset.
ˎˎ Kuvan laatua boken hallintatoiminnolla ei taata 

kaikissa kuvausolosuhteissa.
ˎˎ Boken hallintatoiminto on kytkettynä pois päältä 

seuraavissa tilanteissa.
–– Kun videokamera sammutetaan
–– Kun himmennin, herkkyysvahvistus, suljin tai ND-

suodatin on automaattitilassa
–– Kun kuvaustilaa vaihdetaan
–– Kun ND-suodatinta ei ole asetettu tai se on 

esiasetetussa tilassa tai esiasetetussa tilassa
–– Kun objektiivi irrotetaan
–– Kun laite käynnistyy uudelleen esimerkiksi 

taajuuden vaihtamisen jälkeen
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Välityspalvelimelle tallentaminen
Tällä toiminnolla voit tallentaa pienen 
tarkkuuden välityspalvelindataa samalla kun 
tallennat suuren tarkkuuden alkuperäistä 
videodataa.
Välityspalvelintiedot voidaan automaattisesti 
jakaa muistiyksiköiksi lyhyin väliajoin, ja 
tiedostot voidaan siirtää ennen tallennuksen 
päättymistä.

Tietoja tuetuista muistikorteista, muistikorttien 
formatoinnista ja jäljellä olevan kapasiteetin 
tarkistamisesta, ks. ”Muistikorttien käyttäminen” 
(sivu 26).

Määrittäminen ennen kuvaamista

1	 Määritä Project-tilanäytössä kohdan Proxy 
Rec (sivu 15) tai koko valikon Project-
valikossa kohdan Proxy Rec > Setting 
(sivu 84) asetukseksi On.

2	 Aseta muistikortti CFexpress Type A- / SD-
korttipaikkaan (sivu 6).
ˎˎ CFexpress-korteissa tarrapuoli tulee 
vasemmalle.
ˎˎ SD-korteissa tarrapuoli tulee oikealle ja 
viistetty kulma alaspäin.

[Huomautus]
Proxy Rec -asetukseksi ei voi määrittää On samalla kun 
S&Q Motion tai Interval Rec on käytössä. Kun Proxy 
Rec -asetukseksi määritetään On, muut tallennustilat 
pakotetaan pois käytöstä.

Välityspalvelimen tallentaminen

Aloita tallentaminen painamalla tallennuksen 
START/STOP-painiketta sen jälkeen, kun olet 
saanut kuvauksessa tarvittavat asetukset 
valmiiksi.

[Huomautuksia]
ˎˎ Jos videokamera sammutetaan tai muistikortti 

poistetaan, kun muistikortti on käytössä, kortin 
tietojen eheyttä ei voida taata. Kaikki muistikortille 
tallennettu tieto voi hävitä. Varmista aina, että 
muistikortin käytön ilmaisin on sammunut, ennen 
kuin sammutat videokameran tai poistat muistikortin.
ˎˎ Varmista, että muistikortti ei ponnahda ulos, asetat tai 

poistat sitä.

Poistu lopettamalla tallentaminen.

Äänikanavan määrittäminen 
välityspalvelimelle tallentamista 
varten

Valitse koko valikon Project-valikossa kohta 
Proxy Rec > Audio Channel (sivu 84) ja 
määritä äänikanava välityspalvelimelle 
tallentamista varten.

Välityspalvelintiedoston 
tallentaminen ja lataaminen 
palvelimelle muistiyksikköinä

Kun Auto Upload -asetuksena on Chunk 
ja välityspalvelintiedosto tallennetaan 
muistiyksikköinä, välityspalvelintiedosto 
voidaan ladata palvelimelle tallentamisen 
aikana.

Lisätietoja välityspalvelintiedoston 
lataamisesta palvelimelle muistiyksikköinä 
on kohdissa ”Tiedostojen lataaminen 
automaattisesti” (sivu 66) ja ”C3 Portal App 
-sovelluksen käyttö” (sivu 67).

1	 Valitse Project-valikossa Proxy Rec > 
Chunk (sivu 84) ja valitse muistiyksikön 
tallennuksen aikaväli.
30s: välityspalvelintiedosto tallennetaan 
30 sekunnin muistiyksikköinä 
(oletusasetus).
1min: välityspalvelintiedosto tallennetaan 
1 minuutin muistiyksikköinä.
2min: välityspalvelintiedosto tallennetaan 
2 minuutin muistiyksikköinä.

2	 Valitse Network-valikossa kohdan File 
Transfer > Auto Upload (Proxy) (sivu 105) 
asetukseksi Chunk.
Alkuperäistiedosto tallennetaan paikassa 
A olevalle tietovälineelle, ja 
välityspalvelintiedosto tallennetaan 
muistiyksikköinä paikassa B olevalle 
tietovälineelle.

3	 Aloita välityspalvelimelle tallentaminen.
Välityspalvelintiedosto tallennetaan 
muistiyksikköinä määritetyin aikavälein, ja 
jokainen muistiyksikkö merkitään 
työlistaan siirtotyönä.

[Huomautuksia]
ˎˎ Kun Auto Upload (Proxy) -asetuksena on muu 

kuin Chunk, välityspalvelintiedostoa ei tallenneta 
muistiyksikköinä.
ˎˎ Paikan B muistiväline on tarkoitettu vain 

välityspalvelintiedostojen tallentamiseen 
muistiyksikköinä, joten vuorotallennusta ja 2 paikan 
samanaikaista tallennusta ei tueta.

Tietoja tallennetusta tiedostosta

Tiedostonimen pääte on ”.mp4”.
Myös aikakoodi tallentuu samanaikaisesti.

Tallennetun tiedoston 
tallennuskohde

Tallennettu tiedosto tallennetaan seuraavaan 
hakemistoon.

Tallennusväline Kansion polku

SDXC /PRIVATE/XDROOT/
GENERAL/PXTMP

CFexpress Type A /XDROOT/GENERAL/
PXTMP

Tietoja tiedostonimestä

Tiedostonimi sisältää muistikortille 
tallennetun leikkeen nimen ja liitteen ”S03”. 
Ladattavan, muistiyksikköinä tallennetun 
välityspalvelintiedoston nimi sisältää 
alkuperäisen tiedostonimen, muistiyksikön 
numeron ja liitteen ”S03”.
Lisätietoja tiedostonimistä, katso koko valikon 
TC/Media-valikossa kohta Clip Name Format 
(sivu 91).
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Kuvaaminen halutulla ulkoasulla
Kun videokamera on Custom-tilassa, voit 
lisätä säätöjä mustaan, matriisiin ja muihin 
parametreihin luodaksesi perusulkoasuun 
perustuvan ulkoasun.

：

Ulkoasu

Matriisi

Musta

Perusulkoasu

Voit myös nopeasti valita eri ulkoasun 
tallentamalla kohtaustiedostoihin eri 
asetusyhdistelmiä.
Videokamerassa on yhteensä kuusi 
esiasetettua ulkoasua.

Ulkoasun valitseminen

1	 Kun kuvausnäyttö on näkyvissä, paina 
monitoimisäädintä.

2	 Valitse  (kohtaustiedosto) -kuvake.

3	 Paina monitoimisäädintä.

4	 Valitse haluamasi ulkoasu valikosta ja 
paina monitoimisäädintä.

[Vinkkejä]
ˎˎ Seuraavat esiasetukset on määritetty 

tehdasoletuksena.

Shooting Mode Custom

Target Display SDR(BT.709) HDR(HLG)

Kohtaustiedosto 1 S-Cinetone HLG Live

Kohtaustiedosto 2 Standard HLG Natural

Kohtaustiedosto 3 Still (Ei 
rekisteröity)

Kohtaustiedosto 4 ITU709 (Ei 
rekisteröity)

Kohtaustiedosto  
5–16

(Ei rekisteröity) (Ei 
rekisteröity)

ˎˎ Voit valita ulkoasun myös Main Status -näytön 
kohdassa Scene File (sivu 14) tai koko valikon 
Paint/Look-valikossa kohdassa Scene File > Recall 
(sivu 89). Lisäksi voit palauttaa esiasetetun 
ulkoastun kohdassa Scene File > Preset Recall.

Halutun perusulkoasun tuominen

Voit tuoda perusulkoasuksi tietokoneella tai 
muulla laitteella luodun 3D LUT -tiedoston 
muistikortilta tai pilvipalvelusta. Enintään 16 
tiedostoa voidaan tuoda.
ˎˎ Tiedostomuoto: CUBE-tiedosto (*.cube) 17 
pisteen tai 33 pisteen 3D LUT -tiedostoa 
varten, joka on luotu Catalyst Browse-, RAW 
Viewer- tai DaVinci Resolve -ohjelmalla* 
(Blackmagic Design Pty. Ltd.).
*	 Varmistettu Resolve-versioilla V9.0, V10.0 ja V11.0.

ˎˎ Tulon väriavaruus / gamma: S-Gamut3.
Cine/S-Log3 tai S-Gamut3/S-Log3

Tuonti muistikortilta

3D LUT -tiedoston voi tuoda muistikortilta.

1	 Tallenna 3D LUT -tiedosto tietokoneella tai 
muulla laitteella määrättyyn kansioon tai 
tallennusvälineeseen.

Tallennusväline Kansion polku

SDXC /PRIVATE/SONY/PRO/LUT/

CFexpress  
Type A

/SONY/PRO/LUT/

2	 Aseta tallennusväline, johon 3D 
LUT -tiedostot on tallennettu, CFexpress 
Type A- / SD-korttipaikkaan (B).

3	 Valitse koko valikon Paint/Look-valikossa 
kohta Base Look > Import from Media(B) 
(sivu 89).

4	 Valitse tuontikohde.

5	 Valitse tuotava 3D LUT -tiedosto.
Noudata näytöllä näkyviä ohjeita. 
Videokamera käsittelee 3D LUT -tiedostoa 
perusulkoasuna.

6	 Valitse tuotu 3D LUT -tiedosto koko 
valikon Paint/Look-valikossa kohdassa 
Base Look > Select (sivu 89).

7	 Määritä koko valikon Paint/Look-valikossa 
kohdat Base Look > Input ja Output 
(sivu 89) vastaamaan tuodun 3D 
LUT -tiedoston määreitä.

Tuonti pilvipalvelusta

3D LUT -tiedoston voi tuoda pilvipalvelusta.

1	 Muodosta yhteys laitteeseen C3 Portal 
App -älypuhelinsovelluksesta (sivu 67).

2	 Valitse koko valikon Paint/Look-valikossa 
kohta Base Look > Import from 
Cloud(Private) tai Import from 
Cloud(Share) (sivu 89).

3	 Valitse tuontikohde.

4	 Valitse tuotava 3D LUT -tiedosto.
Noudata näytöllä näkyviä ohjeita. 
Videokamera käsittelee 3D LUT -tiedostoa 
perusulkoasuna.

5	 Valitse tuotu 3D LUT -tiedosto koko 
valikon Paint/Look-valikossa kohdassa 
Base Look > Select (sivu 89).

6	 Määritä koko valikon Paint/Look-valikossa 
kohta Base Look > Input ja Output 
(sivu 89) vastaamaan tuodun 3D 
LUT -tiedoston määreitä.
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Alivalotuksen säätäminen

Jos kuvalla on taipumus alivalottua, kun 
tuotua perusulkoasua käytettäessä valittuna 
on automaattinen valotus, säädä Paint/Look-
valikossa asetusta Base Look > AE Level Offset 
(sivu 89).

[Huomautuksia]
ˎˎ Pelkkä 3D LUT -tiedoston tuonti ei vaikuta kuvaan. 

Lataa tuotu 3D LUT -tiedosto koko valikon Paint/Look-
valikossa kohdassa Base Look > Select (sivu 89).
ˎˎ Jos Input-asetusta ei ole määritetty oikein, ulkoasu ei 

ole oikeanlainen.
ˎˎ Input-, Output- ja AE Level Offset -valikkokohteiden 

asetukset otetaan käyttöön valitussa perusulkoasussa 
valitsemalla Select. Jos tuodaan useita 3D 
LUT -tiedostoja, valitse kullekin 3D LUT -tiedostolle 
Select ja määritä Input, Output ja AE Level Offset 
erikseen kullekin tiedostolle.
ˎˎ Määritetyt Input-, Output- ja AE Level 

Offset -asetukset tallentuvat kullekin 3D 
LUT -tiedostolle.
ˎˎ Perusulkoasu-/LUT-valintavaihtoehdot 

tuoduille 3D LUT -tiedostoille ovat yleisiä 
SDR(BT.709) / HDR(HLG) / Cine EI -tiloille, mutta 
väriavaruus- ja gammamuunnosta ei suoriteta näiden 
tilojen mukaisesti.
ˎˎ 3D LUT -tiedostoja ei poisteta, kun koko valikon 

Maintenance-valikossa suoritetaan All Reset > Reset.

Ulkoasun mukauttaminen

Voit mukauttaa perusulkoasuun perustuvaa 
ulkoasua käyttämällä koko valikon Paint/
Look-valikossa Matrix-asetusta ja muita 
määritettäviä kohteita. Tietoja kustakin 
määritettävästä kohteesta, ks. sivu 89.
Liitä videokamera televisioon tai näyttöön 
ja säädä kuvanlaatua samalla kun tarkkailet 
television tai näytön kuvaa.

[Huomautus]
Kun tuot 3D LUT -tiedoston ja käytät sitä kuvassa, 3D 
LUT -tiedostossa määritettyä haluttua ulkoasua ei saada 
aikaan, jos Matrix-asetusta ja muita kuin perusulkoasun 
asetuksia Paint/Look-valikossa on muutettu. Voit 
tyhjentää kaikki mukautetut asetukset koko valikon 
Paint/Look-valikossa kohdassa Reset Paint Settings > 
Reset without Base Look (sivu 89).

Ulkoasun tallentaminen

Voit tallentaa nykyisen ulkoasun 
kohtaustiedostona sisäiseen muistiin koko 
valikon Paint/Look-valikossa kohdassa Scene 
File > Store (sivu 89).
Voit tallentaa nopeasti käyttämällä 
suoravalikon toimintoja kuvausnäytöstä.

[Huomautuksia]
ˎˎ Jos valitset toisen ulkoasun tallentamatta nykyistä 

ulkoasua, nykyinen ulkoasu häviää.
ˎˎ Kohtaustiedostoja ei poisteta, kun koko valikon 

Maintenance-valikossa on suoritetaan All Reset > 
Reset (sivu 106).

[Vinkki]
Voit korvata esiasetettuja kohtaustiedostoja.
Palauta esiasetettu kohtaustiedosto lataamalla 
palautettava ulkoasu koko valikon Paint/Look-valikossa 
kohdassa Scene File > Preset Recall (sivu 89) ja 
tallentamalla kohtaustiedosto sitten kohdassa Scene File 
> Store.

Tallennetun ulkoasun poistaminen

Voit poistaa sisäiseen muistiin tallennetun 
kohtaustiedoston koko valikon Paint/Look-
valikossa kohdassa Scene File > Delete 
(sivu 89).

[Vinkki]
Poiston jälkeen se ei enää näy suoravalikossa.

Perusulkoasun poistaminen

Voit poistaa tuodun 3D LUT -tiedoston koko 
valikon Paint/Look-valikossa kohdassa Base 
Look > Delete (sivu 89).
Voit poistaa kaikki tuodut 3D LUT -tiedostot 
koko valikon Paint/Look-valikossa kohdassa 
Base Look > Delete All (sivu 89).

[Huomautuksia]
ˎˎ Tarkista ennen poistamista, että perusulkoasu 

ei ole käytössä missään kohtaustiedostossa. Jos 
käytössä oleva perusulkoasu poistetaan, kyseisten 
kohtaustiedostojen ulkoasu on virheellinen.
ˎˎ Tuotuja 3D LUT -tiedostoja ei poisteta, kun koko 

valikon Maintenance-valikossa on valittuna All Reset > 
Reset (sivu 106).
ˎˎ Poistettua perusulkoasua ei voida enää käyttää LUT-

asetuksena Cine EI -tilassa (sivu 58).
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Kuvaaminen ja ulkoasun säätäminen jälkikäsittelyssä
Käyttämällä videokameraa Cine EI -tilassa 
ja tallentamalla sävyjyrkkyydet tasaisesti 
tummista alueista kirkkaisiin alueisiin voit 
tehdä jälkikäsittelyssä hienosäätöjä, kuten 
palauttaa tummien ja vaaleiden alueiden 
sävyjyrkkyydet.
Kuitenkin kun tarkastelet tallennettuja kuvia 
perinteisellä näytöllä, kokonaiskontrasti 
näkyy pienenä, mikä tekee tarkennuksen ja 
valotuksen säädöstä vaikeaa.
Voit käyttää LUT-tiedostoa videokameran 
tavoitenäytössä, jossa se avustaa eri säädöissä 
kuvaamisen aikana. Voit käyttää LUT-tiedostoa 
myös videon toistamisessa lopputuloksen 
tarkistamista varten.
Seuraavat järjestelmät käyttävät LUT-
tiedostoja. Kuitenkin vain yhtä LUT-tiedostoa 
voidaan käyttää.
ˎˎ SDI-lähtö ja HDMI-lähtö
ˎˎ Etsimen ja välityspalvelimen kuvat, 
suoratoisto
ˎˎ Tallennusvälineeseen tallennettu video

LUT-tiedoston käyttäminen 
etsimen kuvaan

1	 Näytä Monitoring Status -näyttö 
painamalla MENU-painiketta.

2	 Valitse Gamut/Gamma-sarake VF-riviltä.

3	 Valitse On tai Off.

[Huomautuksia]
ˎˎ VF-kohdan LUT On/Off -asetusta käytetään myös 

välityspalvelintiedostoon suoratoistovideoon.
ˎˎ Gammanäytön avustustoiminto on saatavilla 

tarkennuksen suurennuksen aikana.

[Vinkkejä]
ˎˎ Voit myös määrittää asetuksen koko valikon Shooting-

valikossa kohdassa LUT On/Off > VF/Proxy/Stream 
(sivu 81).
ˎˎ SDI/HDMI voidaan määrittää samalla tavoin kuin VF.
ˎˎ Tallennusvälineen videossa voit määrittää asetuksen 

koko valikon Shooting-valikossa kohdassa LUT On/Off 
> Internal Rec (sivu 81).

LUT-tiedoston vaihtaminen

1	 Näytä Monitoring Status -näyttö 
painamalla MENU-painiketta.

2	 Valitse Base Look/LUT -kenttä.

3	 Valitse käytettävä LUT 
perusulkoasuluettelosta.

[Vinkkejä]
ˎˎ Laitteessa on LUT-esiasetuksina s709, 709(800%) ja 

S-Log3.
ˎˎ Voit myös tuoda 3D LUT -tiedoston ja käyttää sitä. 

Lisätietoja, ks. ”Halutun perusulkoasun tuominen” 
(sivu 56) ja ”Perusulkoasun poistaminen” 
(sivu 57).
ˎˎ Perusulkoasu voidaan määrittää myös koko valikon 

Paint/Look-valikossa kohdassa Base Look > Select 
(sivu 89).

Tummien ja kirkkaiden alueiden 
jakauman muuttaminen 
tallennetussa videossa

Voit vaihtaa tummien alueiden ja vaaleiden 
alueiden jakaumaa, jos esimerkiksi haluat 
priorisoida tummien alueiden sävyä 
kirkkaiden alueiden sijasta, muuttamalla 
perusherkkyyden Exposure Index -asetusta.

1	 Käytä LUT-tiedostoa etsimen kuvaan 
(sivu 58).

2	 Näytä Camera Status -näyttö painamalla 
MENU-painiketta.

3	 Määritä Exposure Index -asetuksen L/M/
H-kentät.
Yksittäiset asetukset nimetään ISO/
GAIN-kytkimen (sivu 5) 
L/M/H-asennoille.

4	 Valitse käytettävä Exposure Index -arvo 
ISO/GAIN-kytkimellä.

5	 Säädä etsimen kuvan valotusta tarpeen 
mukaisesti.

[Huomautus]
Gammanäytön avustustoiminto on saatavilla 
tarkennuksen suurennuksen aikana. Exposure 
Index -asetusta ei käytetä gammanäytön avustukseen.

[Vinkkejä]
ˎˎ Valotusta voidaan säätää myös koko valikon 

Shooting-valikossa kohdassa ISO/Gain/EI > Exposure 
Index (sivu 77).
ˎˎ Asetuksen toinen numeroarvo osoittaa, miten monta 

kirkkaustasoa suunnataan kirkkaille alueille (kirkkaus 
suurempi kuin 18%:n harmaa). Niitä kirkkaammat 
alueet ovat ylivalottuneita.  
Esimerkki: Asetuksella ”400EI/5.0E” kirkkaalle alueelle 
suunnataan 5,0 kirkkaustasoa.
ˎˎ Voit myös käyttää tätä ohjeena tummien ja kirkkaiden 

alueiden tarkistuksessa kuvaamisen aikana. Jos 

esimerkiksi M-asento on perusherkkyys, L-asento on 
miinus 2 askelta ja H-asento on plus 2 askelta, voit 
tehdä tarkistuksen käyttämällä ISO/GAIN-kytkintä. 
Muista palauttaa M-asento valotuksen tarkistamisen 
jälkeen.
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Voit tallentaa RAW-videosignaalin 
lähdön videokameran SDI OUT- tai HDMI 
OUT -liittimestä tuettuun ulkoiseen 
tallentimeen.

Tallentaminen SDI OUT -liittimestä

1	 Liitä ulkoinen RAW-tallennin 
videokameran SDI OUT -liittimeen.

2	 Määritä kuvaustilaksi Cine EI joko Project-
tilanäytössä (sivu 15) tai koko valikon 
Project-valikossa kohdassa Base Setting > 
Shooting Mode (sivu 82).

3	 Määritä käyttötila (vain FF) joko Project-
tilanäytön kohdassa Imager Scan tai koko 
valikon Project-valikossa kohdassa Rec 
Format > Imager Scan Mode (sivu 82).

4	 Määritä joko Project-tilanäytössä tai koko 
valikon Project-valikossa kohdassa Rec 
Format > Codec (sivu 82) koodekki, joka 
sisältää RAW-muodon.
Jos valintana on RAW & XAVC-I, video 
tallentuu ulkoiseen RAW-tallentimeen 
samalla kun video tallentuu videokameran 
muistikorteille.

5	 Määritä tarkkuus joko Project-tilanäytössä 
tai koko valikon Project-valikossa 
kohdassa Rec Format > RAW Output 
Format (sivu 82).

6	 Tarkista, että ulkoinen tallennin on päällä, 
ja paina sitten videokamerasta 
tallennuksen START/STOP-painiketta.

	 [Huomautus]
Kun tallennus ulkoiselle tallentimelle on alkanut 
ilman tallennuksen START/STOP-painikkeen 
painallusta videokamerassa, leikkeitä ei ehkä 
tallenneta kunnolla.

Tuetut RAW-lähtömuodot näkyvät alla.

Järjestelmän 
taajuus

Codec RAW Output 
Format

59.94/
50/
29.97/
25/
23.98

RAW 4096×2160

3840×2160

RAW & XAVC-I 4096×2160

3840×2160

24 RAW 4096×2160

RAW & XAVC-I 4096×2160

Tallentaminen HDMI OUT 
-liittimestä

1	 Liitä ulkoinen RAW-tallennin 
videokameran HDMI OUT -liittimeen.

2	 Määritä kuvaustilaksi Cine EI joko Project-
tilanäytössä (sivu 15) tai koko valikon 
Project-valikossa kohdassa Base Setting > 
Shooting Mode (sivu 82).

3	 Määritä käyttötila (vain FF) joko Project-
tilanäytön kohdassa Imager Scan tai koko 
valikon Project-valikossa kohdassa Rec 
Format > Imager Scan Mode (sivu 82).

4	 Määritä joko Project-tilanäytössä tai koko 
valikon Project-valikossa kohdassa Rec 
Format > Codec (sivu 82) koodekiksi 
RAW(HDMI).
Jos valintana on RAW(HDMI) & XAVC-I, 
video tallentuu ulkoiseen RAW-
tallentimeen ja samalla videokameran 
muistikorteille.

5	 Tarkista, että ulkoinen tallennin on päällä, 
ja paina sitten videokamerasta 
tallennuksen START/STOP-painiketta.

[Huomautus]
Kun tallennus ulkoiselle tallentimelle on alkanut ilman 
tallennuksen START/STOP-painikkeen painallusta 
videokamerassa, leikkeitä ei ehkä tallenneta kunnolla.

Tuetut RAW-lähtömuodot näkyvät alla.

Järjestelmän 
taajuus

Codec RAW-lähtömuoto

59.94/
50/
29.97/
25/
23.98

RAW(HDMI) 4240×2392

RAW(HDMI) 
& XAVC-I

4240×2392

Tallennuksen tilan ilmaisin

Kun koko valikon Monitoring-valikossa kohdan 
Display On/Off (sivu 93) > RAW Output 
Control Status asetuksena on On, RAW-
tallennuksen tila näkyy kuvakkeena etsimen 
näytöllä.

[Huomautus]
Tallennuksen ohjaussignaali lähtee videokameran SDI 
OUT -liittimestä, mutta ulkoisen tallentimen tilaa ei voi 
saada näkyviin. Samoin videokamera voi näyttää, että 
RAW-videon tallennus on meneillään, vaikka ulkoinen 
tallennin ei tallenna. Tarkista ulkoisen tallentimen 
ilmaisin, jotta saat oikean toimintatilatiedon.

[Vinkki]
Myös RAW Output Format -asetusarvo on näkyvissä.

Hidastettu ja nopeutettu 
tallentaminen

Jos Shooting-valikossa kohdan S&Q Motion 
> Setting asetuksena on On, RAW-videota 
tallennetaan hidastus- ja nopeutustilassa.
Tietoja tuetuista kuvaamisen kuvataajuuksista, 
ks. sivu 50.

[Huomautus]
Slow & Quick Motion -tallennusta HDMI OUT -liittimestä 
ei tueta.

RAW-videon tallentaminen
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Yhteyden muodostaminen muihin laitteisiin lähiverkon kautta
Videokamera voi muodostaa yhteyden 
älypuhelimiin, tabletteihin ja muihin laitteisiin 
lähiverkkoyhteydellä.
Laitteen ja videokameran välinen 
lähiverkkoyhteys mahdollistaa ”Content 
Browser Mobile” -sovelluksen avulla seuraavat.
ˎˎ Etäohjaus 
Voit hallita videokameraa älypuhelimella tai 
tabletilla, joka on yhdistetty videokameraan 
lähiverkon kautta.
ˎˎ Tiedostonsiirto 
Voit siirtää videokameran muistikortille 
tallennetun välityspalvelintiedoston (pieni 
tarkkuus) tai alkuperäisen tiedoston (suuri 
tarkkuus) palvelimelle lähiverkon kautta.
ˎˎ Videon valvonta 
Voit valvoa kameran kuvaa tai toistaa 
videokameran videota laitteen ”Content 
Browser Mobile” -sovelluksella.

	 [Huomautus]
	 Videon valvontaa ei tueta seuraavilla asetuksilla.

–– Slow & Quick Motion -tila
–– Järjestelmän taajuus 24
–– Interval Rec -tila

”Content Browser Mobile” -sovellus

”Content Browser Mobile” -sovelluksella 
voit käyttää videokameraa etänä laitteen 
näytöltä, kun valvot videota videokamerasta, 
ja määrittää videokameran asetuksia.

Tietoja ”Content Browser Mobile” -sovelluksesta saat 
Sonyn myynti- tai palveluedustajalta.

Käyttäjänimen ja salasanan 
määrittäminen

Määritä videokameran käyttäjänimi ja 
salasana, jotta voit käyttää verkkotoimintoja.

1	 Määritä käyttäjänimi koko valikon 
Network-valikossa kohdassa Access 
Authentication > User Name (sivu 102).

2	 Määritä salasana koko valikon Network-
valikossa kohdassa Access Authentication 
> Input Password (sivu 102).

	 [Vinkkejä]
ˎˎ Salasanan voi luoda myös automaattisesti. Valitse 

Generate Password -toiminto Input Password 
-toiminnon sijaan.
ˎˎ Käyttäjänimi, salasana, teksti ja QR-koodi voidaan 

tuoda näkyviin valitsemalla Show Settings.

	 [Huomautus]
Varmista, etteivät muut ihmiset näe QR-koodia ja 
salasanaa.

Yhteyden muodostaminen 
Langattoman lähiverkon 
tukiasematilassa

Videokamera toimii tukiasemana ja 
muodostaa yhteyden laitteeseen langattoman 
lähiverkon kautta.

Älypuhelin/tabletti

Yhteyden muodostaminen NFC-
yhteensopivaan laitteeseen yhdellä 
kosketuksella

NFC-tekniikkaa tukevat laitteet voidaan 
yhdistää toisiinsa (yhden kosketuksen yhteys) 
käyttämällä NFC-toimintoa.

1	 Avaa laitteella [Settings], valitse [More] ja 
rastita NFC-ruutu.

2	 Kytke videokameran virta päälle.

3	 Aktivoi NFC-toiminto.
Aktivoi NFC-yhteystila painamalla pitkään 
(3 sekuntia) nimettävää painiketta, jolle 
NFC on nimetty, tai valitsemalla Network-
valikossa Wireless LAN > NFC.
NFC-toiminto on saatavilla vain, kun 
näytössä näkyy .

4	 Kosketa videokameraa laitteella.
Laite muodostaa yhteyden 
videokameraan ja ”Content Browser 
Mobile” käynnistyy.

	 [Huomautuksia]
ˎˎ Poista lepotila ja näytönlukitus käytöstä 

etukäteen.
ˎˎ Kosketa ja pidä laite paikallaan, kunnes 

”Content Browser Mobile” -sovellus käynnistyy 
(1–2 sekuntia).
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Yhteyden muodostaminen WPS-
yhteensopivaan laitteeseen

WPS-tekniikkaa tukevat laitteet voidaan 
yhdistää toisiinsa käyttämällä WPS-toimintoa.

1	 Valitse koko valikon Network-valikossa 
kohta Wireless LAN > Setting > Access 
Point Mode.

2	 Valitse koko valikon Network-valikossa 
kohta Wireless LAN > WPS > Execute.

3	 Avaa laitteella verkkoasetukset tai Wi-Fi-
asetukset ja ota Wi-Fi käyttöön.

4	 Valitse laitteen Wi-Fi Network -kohdan 
SSID-luettelosta videokameran SSID ja 
muodosta sitten yhteys valitsemalla 
Option-kohdasta WPS Push Button.

	 [Huomautuksia]
ˎˎ Käyttömenetelmä vaihtelee laitekohtaisesti.
ˎˎ Tarkista videokameran SSID ja salasana koko 

valikon Network-valikossa kohdassa AP Mode 
Settings > Camera SSID & Password (sivu 102).

5	 Muodosta yhteys Content Browser 
Mobile -sovelluksella.

	 [Vinkki]
Voit tarkistaa tiedot, jotka tarvitaan yhteyden 
muodostamiseen kameraan, koko valikon Network-
valikossa kohdassa Access Authentication > Show 
Settings (sivu 102).

Yhteyden muodostaminen syöttämällä 
laitteeseen SSID ja salasana

Voit yhdistää videokameran laitteeseen 
syöttämällä sen SSID:n ja salasanan 
laitteeseen.

1	 Valitse koko valikon Network-valikossa 
kohta Wireless LAN > Setting > Access 
Point Mode.

2	 Avaa laitteella verkkoasetukset tai Wi-Fi-
asetukset ja ota Wi-Fi käyttöön.

3	 Yhdistä laite videokameraan valitsemalla 
Wi-Fi Network -kohdan SSID-luettelosta 
videokameran SSID ja syöttämällä 
salasana.
Tarkista videokameran SSID ja salasana 
Network-valikossa kohdassa AP Mode 
Settings > Camera SSID & Password 
(sivu 102).

	 [Huomautus]
Käyttömenetelmä vaihtelee laitekohtaisesti.

4	 Muodosta yhteys Content Browser 
Mobile -sovelluksella.

	 [Vinkki]
Voit tarkistaa tiedot, jotka tarvitaan yhteyden 
muodostamiseen kameraan, koko valikon Network-
valikossa kohdassa Access Authentication >Show 
Settings (sivu 102).

Yhteyden muodostaminen 
Langattoman lähiverkon 
asematilassa

Videokamera muodostaa yhteyden 
langattoman lähiverkon olemassa olevaan 
tukiasemaan asiakkaana. Videokamera ja laite 
yhdistyvät tukiaseman kautta.
Historiassa näkyvät 10 viimeksi yhteyden 
muodostanutta tukiasemaa.
Yhteyshistoria tallentuu ALL-tiedostoon, 
mutta salasanoja ei tallenneta. Salasanan 
syöttäminen on pakollista seuraavalla kerralla, 
kun muodostat yhteyden ALL-tiedoston 
lataamisen jälkeen.

Älypuhelin/
tabletti

Tukiasema

Tietokone

Yhteyden muodostaminen tukiasemaan 
WPS-yhteydellä

Jos tukiasema on yhteensopiva WPS-
toiminnon kautta, voit muodostaa yhteyden 
tukiasemaan yksinkertaisilla asetuksilla.

1	 Kytke tukiasema päälle.

2	 Kytke videokameran virta päälle.

3	 Valitse koko valikon Network-valikossa 
kohta Wireless LAN > Setting > Station 
Mode.

4	 Valitse koko valikon Network-valikossa 
kohta ST Mode Settings > Camera Remote 
Control (sivu 103) > Enable.

5	 Valitse koko valikon Network-valikossa 
kohta Wireless LAN > WPS > Execute.

6	 Paina tukiaseman WPS-painiketta.
Tietoja WPS-painikkeen toiminnasta saat 
tukiaseman käyttöohjeesta.
Kun yhteys on muodostettu, verkon tilan 
ilmaisinkuvake näyttää etsimen näytössä 
voimakkuudeksi vähintään 1.

	 [Huomautus]
Jos yhteyden muodostaminen epäonnistuu, tee 
vaiheet uudelleen aloittaen vaiheesta 1.

7	 Yhdistä laite tukiasemaan.
Tietoja yhteyden muodostamisesta saat 
laitteen käyttöohjeesta.
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8	 Käynnistä ”Content Browser 
Mobile” -sovellus laitteessa ja valitse 
kamera.

	 [Vinkki]
Voit tarkistaa tiedot, jotka tarvitaan yhteyden 
muodostamiseen kameraan, koko valikon Network-
valikossa kohdassa Access Authentication >Show 
Settings (sivu 102).

Yhteyden muodostaminen tukiaseman 
automaattisella tunnistustoiminnolla

1	 Suorita vaiheet 1–3 kohdasta ”Yhteyden 
muodostaminen tukiasemaan WPS-
yhteydellä” (sivu 61).

2	 Valitse koko valikon Network-valikossa 
kohta ST Mode Settings > Scan Networks 
(sivu 103).
Videokamera alkaa etsiä kohteita, joihin 
muodostaa yhteys.
Mahdolliset kohteet näkyvät luettelossa.

3	 Valitse kohde luettelosta.
Näkyviin tulee näyttö, jossa ovat verkon 
(tukiaseman) tiedot. Valittu yhteys näkyy 
SSID-kohdassa.

4	 Valitse Password ja syötä 
salasanansyöttönäytössä sen tukiaseman 
salasana, johon muodostetaan yhteys.
Jos valitset SSID:n yhteyshistoriasta, 
asetukset, myös salasana, määrittyvät 
automaattisesti.
Salasanan määrittämisen jälkeen palaat 
verkon (tukiaseman) tietonäytölle.

5	 Määritä seuraavat yhteysasetukset.
ˎˎ DHCP 
Määritä DHCP-asetus.  
Kun asetuksena on On, videokameralle 
annetaan IP-osoite automaattisesti.  

Jos haluat antaa videokameralle IP-
osoitteen käsin, määritä asetukseksi Off.
ˎˎ IP Address 
Syötä laitteen IP-osoite.  
Asetus on saatavilla vain, kun DHCP-
asetuksena on Off.
ˎˎ Subnet Mask 
Syötä laitteen aliverkon peite.  
Asetus on saatavilla vain, kun DHCP-
asetuksena on Off.
ˎˎ Gateway 
Syötä tukiaseman yhdyskäytävä.  
Asetus on saatavilla vain, kun DHCP-
asetuksena on Off.
ˎˎ DNS Auto 
Määrittää, saadaanko DNS 
automaattisesti.  
Kun asetuksena on On, DNS-
palvelinosoite saadaan automaattisesti. 
Asetus on saatavilla vain, kun DHCP-
asetuksena on On.
ˎˎ Primary DNS Server 
Anna tukiaseman ensisijainen DNS-
palvelin.  
Asetus on saatavilla vain, kun DNS 
Auto -asetuksena on Off.
ˎˎ Secondary DNS Server 
Anna tukiaseman toissijainen DNS-
palvelin.  
Asetus on saatavilla vain, kun DNS 
Auto -asetuksena on Off.

6	 Kun olet valmis, muodosta yhteys 
tukiasemaan valitsemalla Connect.

7	 Yhdistä laite tukiasemaan.
Tietoja yhteyden muodostamisesta saat 
laitteen käyttöohjeesta.

8	 Käynnistä ”Content Browser 
Mobile” -sovellus laitteessa ja valitse 
kamera.

	 [Vinkki]
Voit tarkistaa tiedot, jotka tarvitaan yhteyden 
muodostamiseen kameraan, koko valikon Network-
valikossa kohdassa Access Authentication >Show 
Settings (sivu 102).

Yhteyden muodostaminen käsin 
syöttämällä tukiaseman tiedot

1	 Suorita vaiheet 1–3 kohdasta ”Yhteyden 
muodostaminen tukiasemaan WPS-
yhteydellä” (sivu 61).

2	 Valitse koko valikon Network-valikossa 
kohta ST Mode Settings (sivu 104) > 
Manual Register >Execute.
Näkyviin tulee hetkeksi näyttö, jossa ovat 
verkon (tukiaseman) tiedot.

3	 Määritä seuraavat yhteysasetukset.
ˎˎ SSID 
Syötä tukiaseman SSID.
ˎˎ Security 
Valitse salausmenetelmä.
ˎˎ Password 
Syötä tukiaseman salasana.
ˎˎ DHCP 
Määritä DHCP-asetus.  
Kun asetuksena on On, videokameralle 
annetaan IP-osoite automaattisesti.  
Jos haluat antaa videokameralle IP-
osoitteen käsin, määritä asetukseksi Off.
ˎˎ IP Address 
Syötä laitteen IP-osoite.  
Asetus on saatavilla vain, kun DHCP-
asetuksena on Off.
ˎˎ Subnet Mask 
Syötä laitteen aliverkon peite.  
Asetus on saatavilla vain, kun DHCP-
asetuksena on Off.
ˎˎ Gateway 
Syötä yhdyskäytävän osoite.  
Asetus on saatavilla vain, kun DHCP-
asetuksena on Off.

ˎˎ DNS Auto 
Määrittää, saadaanko DNS 
automaattisesti.  
Kun asetuksena on On, DNS-
palvelinosoite saadaan automaattisesti. 
Asetus on saatavilla vain, kun DHCP-
asetuksena on On.
ˎˎ Primary DNS Server 
Syötä ensisijaisen DNS-palvelimen 
osoite.  
Asetus on saatavilla vain, kun DNS 
Auto -asetuksena on Off.
ˎˎ Secondary DNS Server 
Syötä toissijaisen DNS-palvelimen osoite.  
Asetus on saatavilla vain, kun DNS 
Auto -asetuksena on Off.

4	 Kun olet valmis, muodosta yhteys 
tukiasemaan valitsemalla Connect.

5	 Yhdistä laite tukiasemaan.
Tietoja yhteyden muodostamisesta saat 
laitteen käyttöohjeesta.

6	 Käynnistä ”Content Browser 
Mobile” -sovellus laitteessa ja valitse 
kamera.

	 [Vinkki]
Voit tarkistaa tiedot, jotka tarvitaan yhteyden 
muodostamiseen kameraan, koko valikon Network-
valikossa kohdassa Access Authentication >Show 
Settings (sivu 102).
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Voit yhdistää videokameran internetiin 
käyttämällä USB-yhteydenjakoa, lankaverkkoa 
tai langatonta lähiverkkoa.
Määritä videokameran käyttäjänimi ja salasana 
ennalta (sivu 60).

Yhteyden muodostaminen  
USB-yhteydenjaolla

Voit liittää laitteen älypuhelimeen USB-
kaapelilla ja muodostaa sitten yhteyden 
internetiin älypuhelimella.

Älypuhelinyhteyden määrittäminen

Ota yhteyden jakaminen käyttöön 
älypuhelimessa.
Lisätietoja saat älypuhelimen käyttöoppaasta.

Älypuhelimen liittäminen 
videokameraan

Liitä USB-kaapeli videokameran USB-C-
liittimeen (sivu 7) ja liitä sitten älypuhelin.

[Huomautuksia]
ˎˎ Kiinnitä/irrota älypuhelin, kun videokamera on 

sammutettuna.
ˎˎ USB-yhteydenjakoa ei voida käyttää, jos älypuhelin on 

liitetty USB-keskittimen kautta.
ˎˎ USB-yhteydenjakoa ei voida käyttää, jos tietokone on 

liitetty USB-/multiliittimeen (sivu 7).

Yhteyden muodostaminen verkkoon

1	 Kytke videokameran virta päälle.

2	 Määritä koko valikon Network-valikossa 
kohdan Modem > Setting (sivu 104) 
asetukseksi On.

Käyttöönottaminen älypuhelimesta

Voit ohjata videokameraa etänä USB-kaapelilla 
yhdistetyn älypuhelimen Content Browser 
Mobile -sovelluksella.

1	 Valitse koko valikon Network-valikossa 
kohdan Modem > Camera Remote Control 
(sivu 104) asetukseksi Enable.

2	 Käynnistä ”Content Browser 
Mobile” -sovellus älypuhelimessa ja 
valitse kamera.

	 [Vinkki]
Voit tarkistaa tiedot, jotka tarvitaan yhteyden 
muodostamiseen kameraan Content Browser 
Mobile -sovelluksesta, koko valikon Network-
valikossa kohdassa Access Authentication >Show 
Settings (sivu 102).

Yhteyden muodostaminen 
langattoman lähiverkon 
asematilassa (Wi-Fi-asematila)

Voit yhdistää videokameran internetiin Wi-Fi-
asematilassa valinnaisella Wi-Fi-reitittimellä 
tai älypuhelimen yhteydenjaolla.
Muodosta yhteys Wi-Fi-reitittimeen tai 
laitteeseen, kuten on kuvattu kohdassa 
”Yhteyden muodostaminen Langattoman 
lähiverkon asematilassa” (sivu 61).

Älypuhelin/
tabletti

Wi-Fi-reititin

Tietokone

Internet

Älypuhelin/
tabletti

Internet

Yhteyden muodostaminen 
lähiverkkokaapelilla

Voit muodostaa yhteyden internetiin 
liittämällä videokameran USB-C-liittimeen 
(sivu 7) yhdistetyn lankaverkkosovittimen 
(lisävaruste) lankaverkkoliittimen Wi-Fi-
reitittimeen (lisävaruste) verkkokaapelilla.

Älypuhelin/
tabletti

Tietokone

Wi-Fi-reititin

Lankaverkko- 
sovitin

Internet

Yhteyden muodostaminen internetiin
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Verkkokaapeliyhteydet ja 
lankaverkkoasetukset

1	 Liitä lankaverkkosovitin videokameran 
USB-C-liittimeen.

2	 Liitä lankaverkkosovittimen 
lankaverkkoliitin Wi-Fi-reitittimeen 
verkkokaapelilla.

3	 Kytke videokameran virta päälle.

4	 Määritä koko valikon Network-valikossa 
kohdan Wired LAN > Setting (sivu 104) 
asetukseksi On.

5	 Määritä yhteysasetukset Network-
valikossa kohdassa Wired LAN > Detail 
Settings (sivu 104).
ˎˎ DHCP 
Määritä DHCP-asetus.  
Kun asetuksena on On, videokameralle 
annetaan IP-osoite automaattisesti.  
Jos haluat antaa videokameralle IP-
osoitteen käsin, määritä asetukseksi Off.
ˎˎ IP Address 
Syötä laitteen IP-osoite.  
Asetus on saatavilla vain, kun DHCP-
asetuksena on Off.
ˎˎ Subnet Mask 
Syötä laitteen aliverkon peite.  
Asetus on saatavilla vain, kun DHCP-
asetuksena on Off.
ˎˎ Gateway 
Syötä yhdyskäytävän osoite.  
Asetus on saatavilla vain, kun DHCP-
asetuksena on Off.
ˎˎ DNS Auto 
Määrittää, saadaanko DNS 
automaattisesti.  
Kun asetuksena on On, DNS-
palvelinosoite saadaan automaattisesti. 

Asetus on saatavilla vain, kun DHCP-
asetuksena on On.
ˎˎ Primary DNS Server 
Syötä ensisijaisen DNS-palvelimen 
osoite.  
Asetus on saatavilla vain, kun DNS 
Auto -asetuksena on Off.
ˎˎ Secondary DNS Server 
Syötä toissijaisen DNS-palvelimen osoite.  
Asetus on saatavilla vain, kun DNS 
Auto -asetuksena on Off.

6	 Kun olet valmis, ota asetukset käyttöön 
valitsemalla Set.

[Huomautuksia]
ˎˎ Valitse aina Set, kun olet muuttanut yhteysasetuksia. 

Asetuksia ei oteta käyttöön, jos et valitse kohtaa Set.
ˎˎ Käytä USB Type C -lankaverkkosovitinta. Gigabit 

Ethernet -yhteensopivan sovittimen käyttöä 
suositellaan. Toimintaa ei kuitenkaan voida taata 
kaikilla laitteilla.
ˎˎ USB-lankaverkkosovitinta (lisävaruste) ei voida 

käyttää, jos tietokone on liitetty USB-/multiliittimeen 
(sivu 7).
ˎˎ Lankaverkkosovittimen (lisävaruste) malli voi 

vaikuttaa sisäiseen Wi-Fi-tiedonsiirtotoimintoon.

Käyttöönottaminen älypuhelimesta 
lankaverkon kautta

Jotta voit käyttää videokameraa 
etänä älypuhelimen Content Browser 
Mobile -sovelluksella lankaverkkoon kytketyn 
reitittimen Wi-Fi-yhteyden kautta, määritä 
koko valikon Network-valikossa kohdan Wired 
LAN > Camera Remote Control (sivu 104) 
asetukseksi Enable.
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Tiedostojen lataaminen palvelimelle
Voit ladata videokameraan 
tallennetun alkuperäisen tiedoston tai 
välityspalvelintiedoston palvelimelle 
internetiin tai paikallisverkkoon älypuhelimen 
tai tukiaseman kautta.

Valmistelut

Yhteyden muodostaminen verkkoon

Yhdistä videokamera internetiin tai 
paikallisverkkoon, kuten on kuvattu kohdassa 
”Yhteyden muodostaminen internetiin” 
(sivu 63) tai ”Yhteyden muodostaminen 
muihin laitteisiin lähiverkon kautta” 
(sivu 60).

Tiedostonsiirtokohteen rekisteröiminen

Rekisteröi etukäteen palvelin, johon ladataan.

1	 Valitse koko valikon Network-valikossa File 
Transfer > Server Settings1 (tai Server 
Settings2, Server Settings3).
Siirtokohteen määritysnäyttö tulee 
näkyviin.

2	 Määritä jokainen asetus siirtokohteen 
määritysnäytössä.
Display Name
Syötä siirtokohdeluettelossa näytettävä 
palvelimen nimi.
Service
Näyttää palvelimen tyypin.
”FTP”: FTP-palvelin
Host Name
Syötä palvelimen osoite.
Port
Syötä palvelimen yhdistettävän portin 
numero.

User Name
Syötä käyttäjänimi.
Password
Syötä salasana.
Passive Mode
Kytke passiivitila päälle / pois päältä.
Destination Directory
Syötä kohdepalvelimen hakemiston nimi.

	 [Huomautuksia]
ˎˎ Alkuperäiset tiedostot ladataan siirtokohteeksi 

määritetyn hakemiston Main-kansioon.
ˎˎ Kun muokkaat, ”” osoittaa merkit, joita ei voida 

muuttaa. Virheetöntä toimintaa ei voida taata, jos 
muokkaat hakemistonimen siten, että se sisältää 
kyseisiä merkkejä.  
Jos muokkaat, poista kaikki merkit ja syötä arvo 
uudelleen.
ˎˎ Jos Destination Directory -kohtaan syötetään 

kohdepalvelimella epäkelpoja merkkejä, 
tiedostot siirretään käyttäjän kotihakemistoon. 
Epäkelvolliset merkit vaihtelevat 
palvelinkohtaisesti.

Using Secure Protocol
Määritä, suoritetaanko suojattu FTP-
lataus.
Root Certificate
Lataa/tyhjennä varmenne.
ˎˎ Load 
Tuo myöntäjän varmenne valitsemalla 
Set vaiheessa 3.

*	 Ladattavan varmenteen on oltava PEM-
muodossa tiedostonimellä ”certification.
pem”, ja se on kirjoitettava CFexpress Type 
A- / SD-korttipaikkaan (B) asetetun muistikortin 
juurihakemistoon.

ˎˎ Clear 
Tyhjennä myöntäjän varmenne 
valitsemalla Set vaiheessa 3.
ˎˎ None 
Älä lataa tai tyhjennä varmennetta.

	 [Huomautuksia]
ˎˎ Määritä videokameran kellonaika oikeaksi ennen 

myöntäjän varmenteen tuontia.
ˎˎ Kun tallennetaan tilassa XAVC-I 4096×2160P/ 

3840×2160P 59.94/50P, Load ei ole valittavissa.
ˎˎ Alhaisen varauksen tilassa Load/Clear eivät ole 

valittavissa myöntäjän varmenteelle.

Root Certificate Status
Näyttää varmenteen latauksen tilan.
Reset
Palauta Server Settings -asetukset 
oletuksiksi.

3	 Kun olet valmis, ota asetukset käyttöön 
valitsemalla Set.
Valitse aina Set, kun olet muuttanut 
asetuksia. Asetuksia ei oteta käyttöön, jos 
et valitse kohtaa Set.

Tiedoston valitseminen ja 
lataaminen

Voit valita muistikorteille tallennettuja 
alkuperäisiä tiedostoja tai 
välityspalvelintiedostoja siirrettäviksi 
palvelimelle.

[Huomautus]
Muistiyksikköinä tallennetut välityspalvelintiedostot 
voidaan ladata vain automaattisesti. Niitä ei voi valita ja 
ladata manuaalisesti.

Muistikortin välityspalvelintiedoston 
lataaminen pikkukuvanäytöstä

1	 Yhdistä videokamera ja laite 
lähiverkkoyhteydellä (sivu 60).

2	 Valitse koko valikon Thumbnail-valikossa 
kohta Transfer Clip (Proxy) > Select Clip.
Näyttö muuttuu koko valikosta 
pikkukuvanäytöksi.
Leikkeitä voidaan siirtää 
pikkukuvanäytöstä tai suodatetusta 
leikkeiden pikkukuvanäytöstä.

3	 Valitse leike, jonka haluat siirtää, ja paina 
sitten MENU-painiketta.
Näkyviin tulee siirronvahvistusnäyttö.

4	 Valitse Execute.
Valittua tiedostoa vastaava 
välityspalvelintiedosto rekisteröidään 
siirtotyöksi ja lataaminen alkaa.
Kun siirtotyö on onnistuneesti rekisteröity, 
näkyviin tulee siirtotulosnäyttö.
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5	 Valitse OK.

Kaikkien tiedostojen lataaminen
Siirrä kaikkia tiedostoja vastaavat 
välityspalvelintiedostot valitsemalla 
vaiheessa 2 All Clips eikä Select Clip.

[Huomautus]
Enintään 200 tiedostoa voidaan siirtää.

Muistikortin alkuperäistiedoston 
lataaminen pikkukuvanäytöstä

[Huomautus]
Alkuperäiset tiedostot ladataan siirtokohteeksi 
määritetyn hakemiston Main-kansioon.

1	 Yhdistä videokamera ja laite 
lähiverkkoyhteydellä (sivu 60).

2	 Valitse koko valikon Thumbnail-valikossa 
kohta Transfer Clip > Select Clip.
Näyttö muuttuu koko valikosta 
pikkukuvanäytöksi.
Leikkeitä voidaan siirtää 
pikkukuvanäytöstä tai suodatetusta 
leikkeiden pikkukuvanäytöstä.

3	 Valitse leike, jonka haluat siirtää, ja paina 
sitten MENU-painiketta.
Näkyviin tulee siirronvahvistusnäyttö.

4	 Valitse Execute.
Valittua tiedosto rekisteröidään 
siirtotyöksi ja lataaminen alkaa.
Kun siirtotyö on onnistuneesti rekisteröity, 
näkyviin tulee siirtotulosnäyttö.

5	 Valitse OK.

Kaikkien tiedostojen lataaminen
Siirrä kaikki tiedostot valitsemalla vaiheessa 2 
All Clips eikä Select Clip.

[Huomautus]
Enintään 200 tiedostoa voidaan siirtää.

Tiedostonsiirron tarkistaminen

Voit tarkistaa tiedostonsiirron tilan valitsemalla 
koko valikon Network-valikossa kohdan File 
Transfer > View Job List (sivu 105).
Voit myös tarkistaa tiedostonsiirron tilan 
Content Browser Mobile -sovellusnäytöltä.

[Vinkki]
Jos koko valikon Network-valikossa kohdan File 
Transfer > Auto Upload (sivu 105) tai Auto 
Upload (Proxy) (sivu 105) asetuksena on On ja 
verkkoyhteys on muodostettu, alkuperäistiedostot 
ja välityspalvelintiedostot ladataan tallentamisen 
päättyessä automaattisesti palvelimelle, joka on 
määritetty kohdassa Default Upload Server (sivu 105). 
Jos sekä alkuperäistiedostot että välityspalvelintiedostot 
on määritetty ladattavaksi automaattisesti, 
välityspalvelintiedostojen automaattinen lataus on 
ensisijaista.

[Huomautuksia]
ˎˎ Enintään 200 siirtotyötä voidaan rekisteröidä.
ˎˎ Työluettelo säilyy, kun videokamera sammutetaan, 

mutta enintään 10 minuuttia äskettäisen etenemisen 
tiedosta voi hävitä, jos akku poistetaan tai 
videokamera sammutetaan ennen kuin POWER-kytkin 
on siirretty STANDBY-asentoon.
ˎˎ Työt, jotka on lisätty akun siirryttyä alhaisen varauksen 

tilaan eivät tallennu työluetteloon.
ˎˎ Jos siirron aikana ilmenee virhe, siirretyn leikkeen 

kanssa samannimisen leikkeen siirtoon palaaminen 
ei ehkä onnistu riippuen asetuksista ja siirron 
kohdepalvelimen tilasta. Tarkista siinä tapauksessa 
siirron kohdepalvelimen asetukset ja tila.

Tiedostojen lataaminen 
automaattisesti

Alkuperäistiedoston lataaminen 
automaattisesti

Alkuperäistiedostot voidaan ladata 
määritetylle palvelimelle tallennuksen 
päättyessä. Ota toiminto käyttöön valitsemalla 
koko valikon Network-valikossa kohdan File 
Transfer > Auto Upload (sivu 105) asetukseksi 
On.

Välityspalvelintiedoston lataaminen 
automaattisesti

Välityspalvelintiedostot voidaan ladata 
määritetylle palvelimelle tallennuksen 
päättyessä. Ota toiminto käyttöön valitsemalla 
koko valikon Network-valikossa kohdan File 
Transfer > Auto Upload (Proxy) (sivu 105) 
asetukseksi On.
Vaihtoehtoisesti, kun Auto Upload 
(Proxy) -kohdan asetuksena on Chunk, 
välityspalvelintiedosto voidaan tallentaa 
muistiyksikköinä, jotka voidaan ladata 
määritetylle palvelimelle tallennuksen 
aikana. Muistiyksikköinä tallennetun 
välityspalvelintiedoston lataus on ensisijaista 
muihin tiedostonsiirtotöihin nähden.
Tietoja määrityksestä, ks. 
”Välityspalvelintiedoston tallentaminen ja 
lataaminen palvelimelle muistiyksikköinä” 
(sivu 55).

Lataaminen käyttämällä suojattua 
FTP:tä

Voit ladata FTPS-salattuja tiedostoja Explicit-
tilassa (FTPES) kohdetiedostopalvelinyhteyttä 
varten.

Salatun FTP-siirron määrittäminen

Määritä salattua FTP-siirtoa varten 
kohdetiedostopalvelimen Using Secure 
Protocol -asetukseksi ON ja tuo varmenne.
Tietoja määrityksestä, ks. 
”Tiedostonsiirtokohteen rekisteröiminen” 
(sivu 65).
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C3 Portal App -sovelluksen käyttö
Tiedostoja voi siirtää C3 Portal -pilvipalveluun 
helposti linkittämällä laitteen C3 Portal App 
-älypuhelinsovellukseen.
Hanki ensin C3 Portal -tili ja asenna C3 Portal 
App älypuhelimeen.
Lisätietoja C3 Portal -pilvipalvelutilin 
hankkimisesta saat organisaatiosi 
pääkäyttäjältä.

[Huomautuksia]
ˎˎ Palvelu ei ehkä ole saatavilla kaikilla alueilla.
ˎˎ Lisätietoja C3 Portal App -sovelluksen käytöstä on C3 

Portal App -sovelluksen ohjekirjassa.

Tiedostojen lataaminen C3 Portal 
-palveluun

1	 Valitse Network-valikossa Setup for 
Mobile App > Setup (sivu 102).
Näkyviin tulee automaattisesti 
päivitettävien kohteiden vahvistusnäyttö.
Seuraavat Network-valikon asetukset 
valitaan automaattisesti.
ˎˎ Wired LAN > Setting: Off
ˎˎ Modem > Setting: On
ˎˎ Modem > Camera Remote Control: 
Enable
ˎˎ Access Authentication > Input Password: 
(luodaan automaattisesti, jos ei 
määritetty)

2	 Tarkasta asetukset ja valitse OK.
Määritys alkaa. Määrityksen aikana 
näkyviin tulee ilmoitus ”Now changing”.
Kun määritys on valmis, etsimeen tulee 
seuraava näyttö.

Seuraavat käyttöoikeuden 
todentamistiedot tulevat näkyviin:
käyttäjänimi, salasana, sormenjälki, 
videokameran mallinimi, sarjanumero.

	 [Vinkki]
Tätä näyttöä ei lähetetä videolähtöön.

	 [Huomautus]
Varmista, etteivät muut ihmiset näe salasanaa 
eivätkä voi kopioida QR-koodin kuvaa.

3	 Käynnistä C3 Portal App älypuhelimessa ja 
kirjaudu sisään pilvipalveluun.

4	 Yhdistä älypuhelin USB-kaapelilla laitteen 
USB-C-liittimeen.

5	 Ota USB-yhteydenjako käyttöön 
älypuhelimessa.
Tietoja määrityksestä, ks. ”Yhteyden 
muodostaminen  
USB-yhteydenjaolla” (sivu 63).
Menettely vaihtelee älypuhelinkohtaisesti. 
Lisätietoja saat älypuhelimen 
käyttöoppaasta.

6	 Skannaa etsimeen ilmestyvä QR-koodi C3 
Portal App -sovelluksen näytössä olevien 
ohjeiden mukaisesti.
Tiedostonsiirron määritystiedot lähetetään 
älypuhelimesta laitteeseen, ja näkyviin 
tulee seuraava ilmoitus.

7	 Valitse OK.
Määritystietojen lataus alkaa.
Kun määritykset on ladattu, näkyviin tulee 
ilmoitus ”Network File loaded.”.

[Huomautuksia]
ˎˎ C3 Portal App korvaa laitteen Network-valikon File 

Transfer (sivu 105) -asetuksen.
ˎˎ Root Certificate -varmennetta ei voida asettaa 

automaattisesti. Määritä se manuaalisesti.

Alkuperäistiedoston lataaminen 
palvelimelle

Ota alkuperäistiedostojen lataaminen C3 
Portaliin käyttöön valitsemalla Network-
valikon kohdan File Transfer > Auto Upload 
(sivu 105) asetukseksi On.
Aina tallennuksen päättyessä tiedosto 
ladataan C3 Portal -tiliisi liitettyyn sijaintiin.

Välityspalvelintiedoston lataaminen 
palvelimelle

Ota välityspalvelintiedostojen lataaminen 
C3 Portaliin käyttöön valitsemalla Network-
valikon kohdan File Transfer > Auto Upload 
(Proxy) (sivu 105) asetukseksi On.
Aina tallennuksen päättyessä tiedosto 
ladataan C3 Portal -tiliisi liitettyyn sijaintiin.
Kun Auto Upload (Proxy) -kohdan asetuksena 
on Chunk, välityspalvelintiedosto jaetaan 
muistiyksiköiksi ja ladataan palvelimelle 
säännöllisin väliajoin tallennuksen alettua.  
Tietoja määrityksestä, ks. 
”Välityspalvelintiedoston tallentaminen ja 
lataaminen palvelimelle muistiyksikköinä” 
(sivu 55).

Satunnaisten tiedostojen lataaminen 
palvelimelle

Ks. ”Tiedoston valitseminen ja lataaminen” 
(sivu 65).

[Vinkkejä]
ˎˎ Laitteen lähettämät tiedot tallennetaan C3 Portal App 

-sovelluksen välimuistiin ja siirretään C3 Portaliin. 
Tiedostonsiirron tilanäyttö laitteessa osoittaa C3 
Portal App -sovellukseen siirron tilan.
ˎˎ Kun tiedostonsiirto laitteesta älypuhelimen C3 Portal 

App -sovellukseen on valmis, voit sammuttaa laitteen. 
Huomaa kuitenkin, että tiedostonsiirto älypuhelimesta 
saattaa olla vielä kesken. Huolehdi, että älypuhelimen 
akun varaus on riittävä.

Muita C3 Portalia käyttäviä 
toimintoja

3D LUT -tiedostojen hallinta

C3 Portaliin tallennettuja 3D LUT -tiedostoja 
voidaan tuoda laitteeseen. Ks. ”Tuonti 
pilvipalvelusta” (sivu 56).

ALL-tiedostojen hallinta

Laitteen luoma ALL-tiedosto voidaan tallentaa 
C3 Portaliin ja ALL-tiedosto voidaan ladata C3 
Portalista. Ks. ”ALL-tiedoston tallentaminen 
pilvipalveluun” (sivu 112) ja ”ALL-tiedoston 
lataaminen pilvipalvelusta” (sivu 113).
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Pikkukuvanäyttö
Kun painat THUMBNAIL-painiketta (sivu 5), muistikortille tallennetut leikkeet näkyvät näytöllä pikkukuvina.
Voit valita leikkeen pikkukuvanäytöltä ja ryhtyä toistamaan sitä. Toistettavaa kuvaa voidaan näyttää etsimessä ja ulkoisella näytöllä.
THUMBNAIL-painikkeen uusi painallus sulkee pikkukuvanäytön ja palaa kameran kuvaan.

[Huomautus]
Vain parhaillaan valittuna olevassa tallennusmuodossa tallennetut leikkeet näytetään pikkukuvanäytöllä. Jos valittua tallennettua leikettä ei näytetä, tarkista tallennusmuoto. Huomioi tämä erityisesti ennen tietovälineen formatointia 
(alustusta).

Näytön rakenne

Kohdistimen kohdassa olevan leikkeen tiedot näytetään näytön alaosassa.

4 5

6

3

1

2

Parhaillaan valittuna olevan muistikortin ilmaisin
(Lukkokuvake näkyy, jos kortti on suojattu.)

Kohdistin 
(keltainen)

Leikkeen numero / leikkeiden 
kokonaismäärä

1.	 Pikkukuva (hakemistokuva)
Näyttää leikkeen hakemistokuvan. Kun leike 
tallennetaan, sen ensimmäinen kuva asetetaan 
automaattisesti hakemistokuvaksi.
Leikkeen/kuvan tiedot näkyvät pikkukuvan 
alla. Voit muuttaa näytettäviä tietoja koko 
valikon Thumbnail-valikossa kohdassa 
Customize View (sivu 98) > Thumbnail 
Caption.

2.	 Leikkeen nimi
Näyttää valitun leikkeen nimen.

3.	 Videotallennusmuoto
Näyttää valitun leikkeen tiedostomuodon.

4.	 Erityiset tallennustiedot
Näyttää tallennusmuodon vain, jos leike 
tallennettiin käyttämällä erikoistallennustilaa.
Hidastetuissa ja nopeutetuissa leikkeissä 
kuvataajuus näkyy oikealla.

5.	 Leikkeen kesto

6.	 Luontipäivä
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Leikkeiden toistaminen

Tallennettujen leikkeiden 
toistaminen

Voit toistaa tallennettuja leikkeitä, kun 
videokamera on tallentamisen valmiustilassa 
(Stby).

1	 Toista asettamalla muistikortti.

2	 Paina THUMBNAIL-painiketta.

3	 Siirrä kohdistin joko monivalitsimella 
(sivu 7) tai monitoimisäätimellä 
(sivu 5) toistettavan leikkeen 
pikkukuvaan.

4	 Paina monivalitsimen käytä-painiketta tai 
monitoimisäädintä.
Toisto alkaa valitun leikkeen alusta.

Voit ohjata toistoa painamalla seuraavia 
painikkeita.
Paina monivalitsimen käytä-painiketta tai 

monitoimisäädintä: 
Keskeyttää toiston.  
Palaa normaaliin toistoon painamalla 
uudelleen.

Paina monivalitsimen vasen/oikea-
painikkeita: 
Siirtyy leikkeen alkuun tai edelliseen/
seuraavaan leikkeeseen.

Paina pitkään monivalitsimen vasen/oikea-
painikkeita: 
Pikakelaus taakse/eteen.  
Palaa normaaliin toistoon vapauttamalla 
painike.

CANCEL/BACK-painike: 
Lopettaa toiston ja palaa tallentamisen 
valmiustilaan.

[Huomautuksia]
ˎˎ Leikkeiden välikohdissa voi olla hetkellisiä 

kuvavääristymiä tai näkyä still-kuvia. Tällöin 
videokameraa ei voi käyttää.
ˎˎ Kun valitset leikkeen pikkukuvanäytöstä ja ryhdyt 

toistamaan, leikkeen alussa voi olla hetkellisiä 
kuvavääristymiä. Näytä leikkeen alku ilman 
vääristymiä laittamalla videokamera toistotilaan, 
keskeyttämällä, palaamalla monivalitsimen 
vasemman painikkeen avulla leikkeen alkuun ja 
käynnistämällä toisto uudelleen.
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Pikkukuvanäytössä voit tehdä leikkeille 
toimintoja tai tarkistaa leikkeen ominaisuudet 
koko valikon Thumbnail-valikossa.
Thumbnail-valikko (sivu 98) tulee näkyviin, 
kun painat pitkään MENU-painiketta ja valitset 
Thumbnail.

Thumbnail-valikon toiminnot

Valitse toiminto monivalitsimella (sivu 7) 
tai monitoimisäätimellä (sivu 5), ja paina 
sitten monivalitsimen käytä-painiketta tai 
monitoimisäädintä.
Palaa edelliseen näyttöön painamalla 
CANCEL/BACK-painiketta (sivu 5).

[Huomautus]
Joitakin kohteita ei voida valita riippuen siitä, missä 
tilassa valikko näytetään.

Leiketoimintojen valikkokohteet

ˎˎ Display Clip Properties
ˎˎ Set Clip Flag
ˎˎ Lock/Unlock Clip
ˎˎ Delete Clip
ˎˎ Transfer Clip
ˎˎ Transfer Clip (Proxy)
ˎˎ Filter Clips
ˎˎ Customize View

Tietoja leiketoimintojen valikkokohteista, ks. 
Thumbnail-valikko (sivu 98).

Leikkeen ominaisuuksien näyttäminen

Näytä leikkeen ominaisuudet valitsemalla 
Thumbnail-valikossa Display Clip Properties 
(sivu 98).
Siirry seuraavaan/edelliseen leikkeeseen 
painamalla monivalitsimen vasen/oikea-
painiketta.

Leikelippujen asettaminen

Voit lisätä leikkeisiin leikelippuja (OK-, NG- tai 
KP-merkkejä), jotta voit suodattaa näytettäviä 
leikkeitä leikelippujen avulla.
Valitse sen leikkeen pikkukuva, johon haluat 
lisätä leikelipun, ja valitse sitten leikelippu 
koko valikon Thumbnail-valikossa kohdassa 
Set Clip Flag (sivu 98).

Asetus Lisätty leikelippu

Add OK OK

Add NG NG

Add KEEP KP

[Vinkkejä]
ˎˎ Voit lisätä leikelippuja myös käyttämällä nimettävää 

painiketta, jolle leikelipputoiminto on nimetty 
(sivu 49).
ˎˎ Voit lisätä OK-leikelipun (sivu 53) valitun leikkeen 

pikkukuvaan painamalla Clip Flag -painiketta 
(sivu 5).

Suodatetun pikkukuvanäytön 
näyttäminen

Näytä vain tietyllä lipulla varustetut leikkeet 
valitsemalla koko valikon Thumbnail-valikossa 
Filter Clips (sivu 98) ja valitsemalla 
leikelipputyyppi.
Näytä kaikki liput valitsemalla All.

[Vinkki]
Voit myös vaihtaa suodattimia peräjälkeen DISPLAY-
painikkeella.

Leikkeiden poistaminen

Voit poistaa leikkeitä muistikorteilta.
Valitse koko valikon Thumbnail-valikossa 
kohta Delete Clip > Select Clip tai All Clips.
Select Clip: 

Poistaa valitun leikkeen. Useiden 
leikkeiden valitsemista tuetaan.

All Clips: 
Poistaa kaikki näytettävät leikkeet.

Pikkukuvanäytössä näkyvien tietojen 
muuttaminen

Voit muuttaa pikkukuvan alla näkyviä 
leikkeen/kuvan tietoja.
Valitse koko valikon Thumbnail-valikossa 
Customize View > Thumbnail Caption ja valitse 
näytettävät tiedot.
Date Time: 

Näyttää päivämäärän ja kellonajan, jolloin 
leike on luotu ja viimeksi muokattu.

Time Code: 
Näyttää aikakoodin.

Duration: 
Näyttää leikkeen keston.

Sequential Number: 
Näyttää kunkin pikkukuvan 
järjestysnumeron.

Leiketoiminnot
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Koko valikon määritys ja hierarkia
Näytä koko valikko etsimessä painamalla 
pitkään MENU-painiketta, niin voit määrittää 
kuvaamisen, tallennuksen ja toiston eri 
asetuksia (valikko voidaan näyttää myös 
ulkoisella näytöllä). Koko valikko sisältää 
seuraavat valikot.

Valikkomääritys

User-valikko
Sisältää käyttäjän Edit User -valikossa 
määrittämät valikkokohteet.

Edit User -valikko
Sisältää valikkokohteet User-valikon 
muokkaamiseen.

Shooting-valikko
Sisältää kuvaamiseen liittyvät asetukset.

Project-valikko
Sisältää projektin perusasetukset.

Paint/Look-valikko
Sisältää kuvanlaatuun liittyvät asetukset.

TC/Media-valikko
Sisältää aikakoodeihin ja 
tallennusvälineisiin liittyvät asetukset.

Monitoring-valikko
Sisältää videolähtöön ja etsimen näyttöön 
liittyvät asetukset.

Audio-valikko
Sisältää ääneen liittyvät asetukset.

Thumbnail-valikko
Sisältää pikkukuvanäyttöön liittyvät 
asetukset.

Technical-valikko
Sisältää teknisten kohteiden asetukset.

Network-valikko
Sisältää verkkoihin liittyvät asetukset.

Maintenance-valikko
Sisältää laiteasetukset, kuten kellon ja 
kielen.

Koko valikon hierarkia

User 
(tehdasasetukset)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Assignable Button

Assignable Dial

Multi Function Dial

All File

Clip Name Format

Format Media

VF Setting

Zebra

Zoom

Menu Settings

Edit User Menu Add Item

Customize Reset

Shooting ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project Base Setting

Rec Format

Cine EI Setting

HDR Setting

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Assignable Dial

Multi Function Dial

User File

All File

Paint/Look Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

TC/Media Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Monitoring Output On/Off

Output Format

Output Display

Display On/Off

Marker

VF Setting

Gamma Display Assist

Peaking

Zebra

Audio Audio Input

Audio Output

Thumbnail Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical Color Bars

ND Dial

Tally

HOLD Switch Setting

Touch Operation

Rec Review

Zoom

Handle Zoom

Menu Settings

Menu Page On/Off

Fan Control

Lens

Video Light Set

APR

Camera Battery Alarm

Camera DC IN Alarm
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Network Access Authentication

Wireless LAN

AP Mode Settings

ST Mode Settings

Wired LAN

Modem

File Transfer

Network Reset

Maintenance Language

Clock Set

All Reset

Hours Meter

Version
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Koko valikon toiminnot
Näytä koko valikko etsimessä painamalla 
pitkään MENU-painiketta, niin voit määrittää 
yksityiskohtaisia asetuksia (valikko voidaan 
näyttää myös ulkoisella näytöllä).

Valikon ohjaimet

MENU-painike (sivu 5)
Näytä koko valikko painamalla pitkään. 
Piilota valikko painamalla uudelleen, kun 
koko valikko on näkyvissä.

Monivalitsin (8-suuntainen ohjainpainike ja 
käytä-painike) (sivu 7)

Siirrä kohdistinta ylös/alas/vasemmalle/
oikealle 8-suuntaisen ohjaimen 
painikkeilla, jotta voit valita 
valikkokohteita tai asetuksia.
Ota valittu kohde käyttöön painamalla 
monivalitsimen käytä-painiketta.

Monitoimisäädin (sivu 5)
Siirrä kohdistinta ylös/alas kääntämällä 
monitoimisäädintä, jotta voit valita 
valikkokohteita tai asetuksia.
Ota valittu kohde käyttöön painamalla 
monitoimisäädintä.

CANCEL/BACK-painike (sivu 5)
Palaa edelliseen valikkoon painamalla. 
Vahvistamaton muutos peruuntuu.

[Huomautuksia]
ˎˎ Koko valikkoa ei voida käyttää tarkennuksen 

suurennus -tilassa (sivu 37).
ˎˎ Joitakin kohteita ei voida valita riippuen siitä, missä 

tilassa valikko näytetään.

Valikkokohteiden määrittäminen

Siirrä kohdistin määritettävään 
valikkokohteeseen 8-suuntaisen ohjaimen 
painikkeilla tai kääntämällä monitoimisäädintä 
ja valitse kohde sitten painamalla käytä-
painiketta tai monitoimisäädintä.
ˎˎ Valikkokohteen valinta-alue näyttää 
enintään kahdeksan riviä. Jos kohteen 
saatavilla olevat vaihtoehdot eivät näy 
samaan aikaan, vieritä näyttöä siirtämällä 
kohdistinta ylös/alas.
ˎˎ Alakohteissa, joissa on suuri asetusalue 
(esimerkiksi –99–+99), asetusalue ei ole 
näkyvissä. Nykyinen asetus on korostettu, 
mikä tarkoittaa, että arvoa voidaan muuttaa.
ˎˎ Kun valitset toiminnolle kohdan [Execute], 
kyseinen toiminto suoritetaan.
ˎˎ Jos valitset kohteen, joka edellyttää 
vahvistusta ennen suorittamista, valikko 
piilotetaan tilapäisesti ja vahvistusviesti 
tulee näkyviin. Tarkista viesti ja valitse sitten, 
haluatko suorittaa vai peruuttaa toiminnon.

Merkkijonon syöttäminen

Kun valitset kohteen, kuten tiedostonimen, 
joka edellyttää merkkien syöttämistä, näkyviin 
tulee merkkiensyöttönäyttö.

1

2 3

1	 Valitse merkkityyppi 8-suuntaisen 
ohjaimen painikkeilla tai kääntämällä 
monitoimisäädintä ja ota asetus käyttöön.
ABC: aakkosmerkit isoin kirjaimin
abc: aakkosmerkit pienin kirjaimin
123: numeromerkit
!#$: erikoismerkit

2	 Valitse merkki valitusta merkkijoukosta ja 
ota se käyttöön.
Kohdistin siirtyy seuraavaan kenttään.

Space: Lisää välilyönnin kohdistimen 
kohtaan.

/: Siirtää kohdistimen paikkaa.
BS: Poistaa merkin kohdistimen 

vasemmalta puolelta (askelpalautin).

3	 Kun olet valmis, ota asetus käyttöön 
valitsemalla [Done].
Merkkijono vahvistetaan ja 
merkkiensyöttönäyttö poistuu.

Valikon lukitseminen ja lukituksen 
avaaminen

Voit lukita koko valikon siten, että vain User-
valikko on näkyvissä.
Tässä tilassa asetuksia ei voida muuttaa 
tilanäytöissä.

Valikon lukitseminen

1	 Paina pitkään monitoimisäädintä ja paina 
pitkään MENU-painiketta.

2	 Valitse Technical-valikossa kohta Menu 
Settings > User Menu with Lock.

	 [Huomautus]
Kun painat pitkään vain MENU-painiketta 
näyttääksesi normaalin koko valikon, Technical-
valikossa kohdassa Menu Settings näkyy User Menu 
Only. Näytä User Menu with Lock painamalla pitkään 
monitoimisäädintä ja painamalla pitkään MENU-
painiketta.

3	 Määritä asetukseksi On ja paina käytä-
painiketta tai monitoimisäädintä.
Etsimen näyttöön vaihtuu 
salakoodinsyöttönäyttö.

4	 Syötä mielivaltainen luku.
Syötä 4-numeroinen luku 0000–9999. 
Oletusarvona on 0000.
Syötä luku ja siirrä kohdistin seuraavaan 
numeroon painamalla käytä-painiketta tai 
monitoimisäädintä.
Kun kaikki numerot on syötetty, siirrä 
kohdistin kohtaan SET.

5	 Paina käytä-painiketta tai 
monitoimisäädintä.
Syötetty luku otetaan käyttöön.
Näkyviin tulee vahvistusviesti ja näyttöön 
vaihtuu User-valikko.
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Valikon lukituksen avaaminen

1	 Paina pitkään monitoimisäädintä ja paina 
pitkään MENU-painiketta.

2	 Valitse User-valikossa kohta Menu 
Settings > User Menu with Lock.

	 [Huomautus]
Kun painat pitkään vain MENU-painiketta 
näyttääksesi normaalin koko valikon, Technical-
valikossa kohdassa Menu Settings näkyy User 
Menu Only. Näytä User Menu with Lock painamalla 
pitkään monitoimisäädintä ja painamalla pitkään 
MENU-painiketta.

3	 Määritä asetukseksi Off ja paina käytä-
painiketta tai monitoimisäädintä.
Etsimen näyttöön vaihtuu 
salakoodinsyöttönäyttö.

4	 Syötä salakoodi, jolla valikko lukittiin.
Syötä luku ja siirrä kohdistin seuraavaan 
numeroon painamalla käytä-painiketta tai 
monitoimisäädintä.
Kun kaikki numerot on syötetty, siirrä 
kohdistin kohtaan Set.

5	 Paina käytä-painiketta tai 
monitoimisäädintä.
Syötetty luku otetaan käyttöön.
Jos syötetty salakoodi vastaa valikon 
lukituksessa käytettyä salakoodia, valikon 
lukitus avataan ja valikko tulee näkyviin.

[Huomautuksia]
ˎˎ Jos syötetty salakoodi ei vastaa valikon lukituksessa 

käytettyä salakoodia, valikon lukitus ei avaudu.
ˎˎ On suositeltavaa, että merkitset salakoodin muistiin 

lähistölle unohtamisen varalta. Jos unohdat 
salakoodin, ota yhteyttä Sonyn palveluedustajaan.
ˎˎ Jos valikko lukitaan ilman, että seuraavassa taulukossa 

olevia koko valikon kohteita on rekisteröity User-
valikkoon, kyseisiä toimintoja ei voida nimetä 
nimettäville painikkeille.

ˎˎ Jos kyseiset toiminnot on jo nimetty nimettäville 
painikkeille, nimetty asetus pakotetaan pois käytöstä, 
kun valikko lukitaan.

Koko valikon kohde Nimettävän 
painikkeen valinta

Shooting >ISO/Gain/EI 
>Base Sensitivity,  
Shooting >ISO/Gain/EI 
>Base ISO

Base ISO/Sensitivity

Shooting >Auto 
Exposure >AGC

AGC

— Auto ND Filter

Shooting >Iris >Bokeh 
Control

Bokeh Control

Shooting >Auto 
Exposure >Auto Shutter

Auto Shutter

Shooting >Auto 
Exposure >Level

Auto Exposure Level

Shooting >Auto 
Exposure >Mode

Backlight

Shooting >Auto 
Exposure >Mode

Spotlight

Shooting >White > 
Preset White

Preset White Select

Shooting >Focus > 
AF Transition Speed,  
Shooting >Focus > 
AF Subj. Shift Sens.

AF Speed/Sens.

Shooting >Focus > 
Focus Area

Focus Area

Shooting >Focus > 
Focus Area(AF-S)

Focus Area(AF-S)

Shooting >Focus > 
Face/Eye Detection AF

Face/Eye Detection 
AF

Shooting >Focus > 
Push AF Mode

Push AF Mode

Shooting >S&Q Motion 
>Setting

S&Q Motion

Shooting >SteadyShot 
>Setting

SteadyShot

Project >Picture Cache 
Rec >Setting

Picture Cache Rec

Koko valikon kohde Nimettävän 
painikkeen valinta

Technical >Rec Review 
>Setting

Rec Review

Thumbnail >Set Clip 
Flag >Add OK

Clip Flag OK

Thumbnail >Set Clip 
Flag >Add NG

Clip Flag NG

Thumbnail >Set Clip 
Flag >Add KEEP

Clip Flag Keep

Technical >Color Bars 
>Setting

Color Bars

Monitoring >Display 
On/Off >Lens Info

Lens Info

Monitoring >Display 
On/Off >Video Signal 
Monitor

Video Signal 
Monitor

Monitoring >Marker 
>Setting

Marker

Monitoring >VF Setting 
>Color Mode

VF Mode

Monitoring >Gamma 
Display Assist >Setting

Gamma Display 
Assist

Monitoring >Peaking 
>Setting

Peaking

Monitoring >Zebra 
>Setting

Zebra

Audio >Audio Output 
>Volume

Volume

Technical >Touch 
Operation >Setting

Touch Operation

Technical >Handle 
Zoom >Setting

Handle Zoom

Network >Wireless LAN 
>NFC

NFC

Network >File Transfer 
>Auto Upload (Proxy)

Auto Upload (Proxy)

User User Menu
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User-valikko
Tässä osiossa kuvataan kunkin valikkokohteen toiminnot ja asetukset.

User

Kohde Kuvaus

Base Setting Project >Base Setting -kohde

Focus Shooting >Focus -kohde

S&Q Motion Shooting >S&Q Motion -kohde

LUT On/Off Shooting >LUT On/Off -kohde

Simul Rec Project >Simul Rec -kohde

Proxy Rec Project >Proxy Rec -kohde

Interval Rec Project >Interval Rec -kohde

Assignable Button Project >Assignable Button -kohde

Assignable Dial Project >Assignable Dial -kohde

Multi Function Dial Project >Multi Function Dial -kohde

All File Project >All File -kohde

Clip Name Format TC/Media >Clip Name Format -kohde

Format Media TC/Media >Format Media -kohde

VF Setting Monitoring >VF Setting -kohde

Zebra Monitoring >Zebra -kohde

Zoom Technical >Zoom -kohde

Menu Settings Technical >Menu Settings -kohde

Edit User Menu Näyttää Edit User -valikkonäytön.

[Huomautus]
Voit lisätä ja poistaa valikkokohteita User-valikossa käyttämällä Edit User -valikkoa. Enintään 20 kohdetta voidaan 
määrittää.
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Edit User -valikko
Edit User -valikko näkyy yläosassa, kun User-valikosta on valittuna Edit User Menu.

Edit User

Kohde Alakohteen asetus Kuvaus

Add Item
Lisää kohde User-
valikkoon

Lisää kohteen User-valikkoon.

Customize Reset
Nollaa User-valikon 
kohteet

Palauttaa User-valikkoon 
rekisteröidyt valikkokohteet 
tehdasoletuksiksi.

Muokkauksen aikana 
valittu valikkokohde

Delete Poistaa rekisteröidyn valikkokohteen 
User-valikosta.

Move Järjestää rekisteröidyt valikkokohteet 
uudelleen User-valikossa.

Edit Sub Item Muokkaa (rekisteröi/poistaa) 
rekisteröidyn valikon alakohteen 
User-valikosta.
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Shooting-valikko
Tässä osiossa kuvataan kunkin valikkokohteen toiminnot ja asetukset.
Tehdasoletusasetukset on lihavoitu (esimerkiksi 18dB).

Shooting >ISO/Gain/EI
Määrittää herkkyysvahvistusasetukset.

Kohde Alakohteen asetus Kuvaus

Mode ISO/dB Valitsee herkkyysvahvistusasetuksen 
tilan.

ISO/Gain<H> Tietoja asetuksista, ks. ”ISO/Gain-asetukset 
ja oletusarvot” (sivu 107).

Määrittää herkkyysvahvistuksen 
esiasetetun arvon <H>.

ISO/Gain<M> Tietoja asetuksista, ks. ”ISO/Gain-asetukset 
ja oletusarvot” (sivu 107).

Määrittää herkkyysvahvistuksen 
esiasetetun arvon <M>.

ISO/Gain<L> Tietoja asetuksista, ks. ”ISO/Gain-asetukset 
ja oletusarvot” (sivu 107).

Määrittää herkkyysvahvistuksen 
esiasetetun arvon <L>.

Exposure 
Index<H>

Kun Base ISO on ISO 800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E

Kun Base ISO on ISO 12800:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Määrittää valotusindeksin arvon <H>.
Saatavilla vain Cine EI -tilassa.

Shooting >ISO/Gain/EI
Määrittää herkkyysvahvistusasetukset.

Kohde Alakohteen asetus Kuvaus

Exposure 
Index<M>

(Samat asetukset kuin kohteessa Exposure 
Index<H>)
Kun Base ISO on ISO 800:

1000EI / 6.3E
Kun Base ISO on ISO 12800:

16000EI / 6.3E

Määrittää valotusindeksin arvon <M>.

Exposure 
Index<L>

(Samat asetukset kuin kohteessa Exposure 
Index<H>)
Kun Base ISO on ISO 800:

800EI / 6.0E
Kun Base ISO on ISO 12800:

12800EI / 6.0E

Määrittää valotusindeksin arvon <L>.

Shockless 
Gain

On / Off Kytkee herkkyysvahvistuksen siirtymän 
pehmennystoiminnon päälle / pois 
päältä.

Base 
Sensitivity

High / Low Määrittää perusherkkyyden Custom-
tilassa.

Base ISO ISO 12800 / ISO 800 Määrittää ISO-perusherkkyyden Cine 
EI -tilassa.

Shooting >ND Filter
Määrittää ND-suodattimen esiasetetut arvot.

Kohde Alakohteen asetus Kuvaus

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Määrittää ND-suodattimen esiasetuksen 
1 arvon.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Määrittää ND-suodattimen esiasetuksen 
2 arvon.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Määrittää ND-suodattimen esiasetuksen 
3 arvon.

Shooting >Shutter
Määrittää elektronisen sulkimen toiminnan.

Kohde Alakohteen asetus Kuvaus

Mode Speed / Angle Valitsee elektronisen sulkimen 
toimintatilan.
Käytetään nopeasti liikkuvien kohteiden 
kuvaamiseen selkeästi. Valitsee tilan, joka 
määrittää suljinajan sekunteina (Speed) 
tai suljinkulman (Angle).
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Shooting >Shutter
Määrittää elektronisen sulkimen toiminnan.

Kohde Alakohteen asetus Kuvaus

Shutter 
Speed  
On/Off

On / Off Määrittää, vastaako valotusaika Speed-
tilassa Shutter Speed -arvoa vai 
määritetäänkö se täydelle valotukselle.

Shutter 
Speed

64F–1/8000
Saatavilla olevat asetukset riippuvat valitun 
tallennusmuodon järjestelmätaajuudesta.
59.94P: 

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

50P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

29.97P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

25P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

24P/23.98P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 
1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 
1/250 / 1/500 / 1/1000 / 1/2000 / 
1/4000 / 1/8000

Määrittää suljinajan, kun kohdan Mode 
asetuksena on Speed.

Shutter Angle 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 360.0° / 300.0° /  
270.0° / 240.0° / 216.0° / 210.0° /  
180.0° / 172.8° / 150.0° / 144.0° /  
120.0° / 90.0° / 86.4° / 72.0° / 45.0° / 
30.0° / 22.5° / 11.25° / 5.6°

Määrittää suljinkulman, kun kohdan 
Mode asetuksena on Angle.

ECS On/Off On / Off Kytkee Extended Clear Scan -toiminnon 
päälle / pois päältä.

Shooting >Shutter
Määrittää elektronisen sulkimen toiminnan.

Kohde Alakohteen asetus Kuvaus

ECS 
Frequency

23.99–8000
Saatavilla olevat asetukset riippuvat valitun 
tallennusmuodon järjestelmätaajuudesta.
Oletusarvot ovat alla.
59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Määrittää ECS-taajuuden, kun kohdan 
Mode asetuksena ECS Frequency.

Shooting >Iris
Määrittää boken hallintatoiminnon asetukset.

Kohde Alakohteen asetus Kuvaus

Bokeh 
Control

On / Off Kytkee boken hallintatoiminnon 
päälle / pois päältä.

Shooting >Auto Exposure
Määrittää automaattivalotuksen säädän asetukset.

Kohde Alakohteen asetus Kuvaus

Level +3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 / 
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 / 
±0 / –0.25 / –0.5 / –0.75 / –1.0 / –1.25 / 
–1.5 / –1.75 / –2.0 / –2.25 / –2.5 / –2.75 / 
–3.0

Määrittää kirkkaustason automaattisesti 
havaittua valotusta varten.

Mode Backlight / Standard / Spotlight Määrittää automaattivalotuksen säädön 
toimintatilan.
Backlight: 

Taustavalotila (tila vähentää kohteen 
tummenemista, kun kohde on 
taustavalaistu)

Standard: 
Vakiotila

Spotlight: 
Kohdevalotila (tila vähentää 
valkoisten alueiden leikkautumista, 
kun kohde on kohdevalaistu)

Speed –99–+99 (±0) Määrittää automaattivalotuksen säädön 
säätönopeuden.
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Shooting >Auto Exposure
Määrittää automaattivalotuksen säädän asetukset.

Kohde Alakohteen asetus Kuvaus

AGC On / Off Kytkee AGC-toiminnon (automaattinen 
herkkyysvahvistuksensäätö) päälle / pois 
päältä.

AGC Limit Tietoja asetuksista, ks. ”AGC 
Limit -asetukset ja oletusarvot” 
(sivu 109).

Määrittää AGC-toiminnon 
enimmäisherkkyysvahvistuksen.

AGC Point F2.8 / F4 / F5.6 Määrittää himmentimen aukkoarvon, 
jossa AGC:n toiminta alkaa, kun AGC-
toiminto on päällä.

Auto Shutter On / Off Kytkee automaattisen 
sulkimenhallintatoiminnon päälle / pois 
päältä.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 Määrittää automaattisen suljintoiminnon 
nopeimman suljinajan.

A.SHT Point F5.6 / F8 / F11 / F16 Määrittää himmentimen aukkoarvon, 
jossa automaattisen sulkimen toiminta 
alkaa.

Clip High 
light

On / Off Kytkee päälle / pois päältä toiminnon, 
joka jättää huomiotta kirkkaimmat alueet 
tasatakseen vastetta suurella 
luminanssilla.

Detect 
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom Määrittää valonmittausalueen valotuksen 
automaattiseen säätämiseen kohteen 
kirkkauden mukaan. (Ei saatavilla, kun 
valotusta säädetään käsin)

Detect 
Window 
Indication

On / Off Kytkee valonmittausalueen ilmaisimen 
päälle / pois päältä.

Custom 
Width

40–999 (500) Määrittää valonmittausalueen leveyden.

Custom 
Height

70–999 (500) Määrittää valonmittausalueen korkeuden.

Custom H 
Position

–479–+479 (±0) Määrittää valonmittausalueen 
vaakasuunnassa.

Custom V 
Position

–464–+464 (±0) Määrittää valonmittausalueen 
pystysuunnassa.

Shooting >White
Määrittää valkotasapainon asetukset.

Kohde Alakohteen asetus Kuvaus

Preset White 2000K–15000K (3200K) Määrittää valkotasapainon esiasetetun 
arvon.

Color Temp 
<A>

2000K–15000K (3200K) Määrittää muistiin A tallennetun 
valkotasapainon värilämpötilan.

[Huomautus]
Koska Color Temp leikkautuu arvoissa 2000K 
ja 15000K, R/B Gain -toiminnon aikana, R/B 
Gain -arvolle ei välttämättä voida näyttää 
oikeaa Color Temp -arvoa.

Tint<A> –99–+99 (±0) Määrittää muistiin A tallennetun 
valkotasapainon sävyn arvon.

[Huomautus]
Koska Tint leikkautuu arvossa ±99, R/B 
Gain -toiminnon aikana, R/B Gain -arvolle ei 
välttämättä voida näyttää oikeaa Tint-arvoa.

R Gain <A> –99.0–+99.0 (±0.0) Määrittää muistiin A tallennetun 
valkotasapainon 
R-herkkyysvahvistusarvon.

B Gain <A> –99.0–+99.0 (±0.0) Määrittää muistiin A tallennetun 
valkotasapainon 
B-herkkyysvahvistusarvon.

Color Temp 
<B>

2000K–15000K (3200K) Määrittää muistiin B tallennetun 
valkotasapainon värilämpötilan.

[Huomautus]
Koska Color Temp leikkautuu arvoissa 2000K 
ja 15000K, R/B Gain -toiminnon aikana, R/B 
Gain -arvolle ei välttämättä voida näyttää 
oikeaa Color Temp -arvoa.

Tint<B> –99–+99 (±0) Määrittää muistiin B tallennetun 
valkotasapainon sävyn arvon.

[Huomautus]
Koska Tint leikkautuu arvossa ±99, R/B 
Gain -toiminnon aikana, R/B Gain -arvolle ei 
välttämättä voida näyttää oikeaa Tint-arvoa.

R Gain <B> –99.0–+99.0 (±0.0) Määrittää muistiin B tallennetun 
valkotasapainon 
R-herkkyysvahvistusarvon.

B Gain <B> –99.0–+99.0 (±0.0) Määrittää muistiin B tallennetun 
valkotasapainon 
B-herkkyysvahvistusarvon.
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Shooting >White Setting
Säätää valkotasapainon asetuksia.

Kohde Alakohteen asetus Kuvaus

Shockless 
White

Off / 1 / 2 / 3 Määrittää valkotasapainon vasteajan, kun 
valkotasapainotilaa muutetaan.
Off: Vaihtuu välittömästi.
1–3: Vaihtuu sitä hitaammin mitä 

suurempi numero.

ATW Speed 1 / 2 / 3 / 4 / 5 Määrittää vasteajan ATW-tilassa.
1: Nopein vaste

White 
Switch<B>

Memory / ATW Valitsee valkotasapainon säätötilan, joka 
valitaan, kun WHT BAL -kytkin on 
asennossa B.

Filter White 
Memory

On / Off Kytkee päälle / pois päältä toiminnon, 
joka määrittää valkotasapainon 
muistialueen kullekin ND-suodattimelle.
On: Määrittää valkotasapainon muistin 

kullekin ND-suodattimelle.

	 [Vinkki]
Esiasetetussa tilassa on neljä asetusta 
(CLEAR/1/2/3). Muuttuvassa tilassa on 
kaksi asetusta (CLEAR/On).

Off: Määrittää kaikille ND-suodattimille 
yhteisen valkotasapainon muistin.

Shooting >Offset White
Määrittää valkotasapainon poikkeama-asetukset.

Kohde Alakohteen asetus Kuvaus

Offset White 
<A>

On / Off Valitsee, lisätäänkö (On) vai eikö lisätä 
(Off) poikkeama-arvo valkotasapainolle 
muistissa A.

Offset Color 
Temp<A>

–99–+99 (±0) Määrittää värilämpötilan poikkeaman, 
joka lisätään valkotasapainoon muistissa 
A, kun kohdan Offset White <A> 
asetuksena on On.

Offset 
Tint<A>

–99–+99 (±0) Määrittää Tint-arvon poikkeaman, joka 
lisätään valkotasapainoon muistissa A, 
kun kohdan Offset White <A> asetuksena 
on On.

Offset White 
<B>

On / Off Valitsee, lisätäänkö (On) vai eikö lisätä 
(Off) poikkeama-arvo valkotasapainolle 
muistissa B.

Shooting >Offset White
Määrittää valkotasapainon poikkeama-asetukset.

Kohde Alakohteen asetus Kuvaus

Offset Color 
Temp<B>

–99–+99 (±0) Määrittää värilämpötilan poikkeaman, 
joka lisätään valkotasapainoon muistissa 
B, kun kohdan Offset White <B> 
asetuksena on On.

Offset 
Tint<B>

–99–+99 (±0) Määrittää Tint-arvon poikkeaman, joka 
lisätään valkotasapainoon muistissa B, 
kun kohdan Offset White <B> asetuksena 
on On.

Offset White 
<ATW>

On / Off Valitsee, lisätäänkö (On) vai eikö lisätä 
(Off) poikkeama-arvo ATW-
valkotasapainolle.

Offset Color 
Temp<ATW>

–99–+99 (±0) Määrittää värilämpötilan poikkeaman, 
joka lisätään ATW-valkotasapainoon, kun 
kohdan Offset White <ATW> asetuksena 
on On.

Offset 
Tint<ATW>

–99–+99 (±0) Määrittää Tint-arvon poikkeaman, joka 
lisätään ATW-valkotasapainoon, kun 
kohdan Offset White <ATW> asetuksena 
on On.

Shooting >Focus
Määrittää tarkennusasetukset.

Kohde Alakohteen asetus Kuvaus

AF Transition 
Speed

1(Slow) / 2 / 3 / 4 / 5 / 6 / 7(Fast) Määrittää tarkennusnopeuden 
tilanteisiin, joissa kohde vaihtuu 
automaattitarkennuksen aikana.

AF Subj. Shift 
Sens.

1(Locked On) / 2 / 3 / 4 / 5(Responsive) Määrittää kohteenvaihtumisherkkyyden 
automaattitarkennuksen aikana.

Focus Area Wide / Zone / Flexible Spot Määrittää tavoitealueen 
automaattitarkennukselle ja tilapäiselle 
automaattitarkennukselle (AF) 
(sivu 38).
Wide: 

Hakee kohdetta tarkennettaessa 
kuvan laajakulmasta.

Zone: 
Hakee automaattisesti 
tarkennuskohdan määritetyltä 
alueelta.

Flexible Spot: 
Tarkentaa kuvan tiettyyn kohtaan.
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Shooting >Focus
Määrittää tarkennusasetukset.

Kohde Alakohteen asetus Kuvaus

Focus Area 
(AF-S)

Flexible Spot Määrittää tavoitealueen tilapäiselle 
automaattitarkennukselle (AF-S).

Face/Eye 
Detection AF

Face/Eye Only AF / Face/Eye Priority AF / 
Off

Ottaa käyttöön / poistaa käytöstä 
kasvojentunnistuksen 
automaattitarkennuksen.

Push AF 
Mode

AF / Single-shot AF(AF-S) Määrittää tilapäisen 
automaattitarkennuksen tilan 
manuaalisen tarkennuksen aikana.

Touch 
Function in 
MF

Tracking AF / Spot Focus Määrittää toiminnon, joka suoritetaan, 
kun kosketuspaneelia napautetaan 
manuaalisen tarkennuksen aikana.

AF Assist On / Off Kun asetuksena on On, sallii 
automaattitarkennuksen tilapäisen 
ohituksen ja tarkentamisen käsin.

Shooting >S&Q Motion
Määrittää hidastus- ja nopeutustilan asetukset (sivu 50).

Kohde Alakohteen asetus Kuvaus

Setting On / Off Kytkee hidastus- ja nopeutustilan 
päälle / pois päältä.
Kun asetuksena on On, seuraavat 
toiminnot ovat poissa käytöstä.

ˎˎ Automaattihimmennin
ˎˎ Automaattitarkennus

Frame Rate 1fps – 60fps / 100fps / 120fps / 150fps / 
180fps / 200fps / 240fps

Määrittää hidastetun ja nopeutetun 
kuvaamisen kuvataajuuden.

[Huomautus]
Saatavilla olevat asetukset riippuvat valitusta 
järjestelmän taajuudesta, koodekista ja 
videomuodosta.

Shooting >LUT On/Off
Määrittää LUT-asetukset.

Kohde Alakohteen asetus Kuvaus

SDI/HDMI MLUT On / MLUT Off Valitsee, lisätäänkö näytön LUT SDI- ja 
HDMI-tulovideoihin.

Shooting >LUT On/Off
Määrittää LUT-asetukset.

Kohde Alakohteen asetus Kuvaus

VF/Proxy/
Stream

MLUT On / MLUT Off Valitsee, lisätäänkö näytön LUT etsimen, 
välityspalvelimen ja suoratoiston 
tulovideoihin.

Internal Rec MLUT On / MLUT Off Valitsee, lisätäänkö näytön LUT sisäisesti 
tallennettaviin videoihin.

Shooting >Noise Suppression
Määrittää kohinanpoiston asetukset.

[Vinkki]
Setting(Custom)- ja Level(Custom)-asetukset vaikuttavat Target Display -asetukseen (sivu 111).

Kohde Alakohteen asetus Kuvaus

Setting 
(Custom)

On / Off Kytkee kohinanpoistotoiminnon 
päälle / pois päältä Custom-tilassa.

Level 
(Custom)

Low / Mid / High Määrittää kohinanpoistotason Custom-
tilassa.

Setting 
(Cine EI)

On / Off Kytkee kohinanpoistotoiminnon 
päälle / pois päältä Cine EI -tilassa.

Level 
(Cine EI)

Low / Mid / High Määrittää kohinanpoistotason Cine 
EI -tilassa.

Shooting >Flicker Reduce
Määrittää värinänkorjausasetukset.

Kohde Alakohteen asetus Kuvaus

Mode Auto / On / Off Määrittää värinänkorjaustilan.

Frequency 50Hz / 60Hz Määrittää valoa tuottavan, värinää 
aiheuttavan virtalähteen taajuuden.

Shooting >SteadyShot
Määrittää kuvanvakautusasetukset.

Kohde Alakohteen asetus Kuvaus

Setting Active / Standard / Off Määrittää kuvanvakautustoiminnon.

[Huomautus]
Käytössä, kun yhteensopiva objektiivi on 
kiinnitettynä.
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Tässä osiossa kuvataan kunkin valikkokohteen toiminnot ja asetukset.
Tehdasoletusasetukset on lihavoitu (esimerkiksi 18dB).

Project >Base Setting
Määrittää perusasetukset.

Kohde Alakohteen asetus Kuvaus

Shooting 
Mode

Custom / Cine EI Määrittää kuvaustilan (sivu 24).

Target 
Display

SDR(BT.709) / HDR(HLG) Määrittää tallennuksen/tulon 
väriavaruuden Custom-tilassa.

Project >Rec Format
Määrittää tallennusmuodon asetukset.

Kohde Alakohteen asetus Kuvaus

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 Valitsee järjestelmän taajuuden.

Imager Scan 
Mode

FF / S35 Valitsee kuvakennon koon.

Codec RAW / RAW & XAVC-I / RAW(HDMI) /  
RAW(HDMI) & XAVC-I / XAVC-I / XAVC-L

Määrittää leikkeen tallennus-/
toistokoodekin.

RAW Output 
Format

Saatavilla olevat asetukset riippuvat 
Frequency- ja Codec-asetuksista.

Määrittää RAW-lähtömuodon kuvakoon.

[Huomautus]
Kun kohdan Codec asetukseksi on määritetty 
RAW & XAVC-I, Video Format -asetus muuttuu 
yhdessä RAW Output Format -asetuksen 
kanssa.

Frequency Codec Valittavat 
vaihtoehdot

59.94/
50/
29.97/
25/
23.98

RAW 4096×2160

3840×2160

RAW & 
XAVC-I

4096×2160

3840×2160

RAW(HDMI) 4240×2392

RAW(HDMI) 
& XAVC-I

4240×2392

24 RAW 4096×2160

RAW & 
XAVC-I

4096×2160

Project >Rec Format
Määrittää tallennusmuodon asetukset.

Kohde Alakohteen asetus Kuvaus

Video Format Saatavilla olevat asetukset riippuvat 
Frequency- ja Codec-asetuksista.

Määrittää kuvakoon ja bittinopeuden.

Frequency Codec Valittavat 
vaihtoehdot

59.94 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

50 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

Project-valikko
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Project >Rec Format
Määrittää tallennusmuodon asetukset.

Kohde Alakohteen asetus Kuvaus

Video Format 29.97 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

25 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

Project >Rec Format
Määrittää tallennusmuodon asetukset.

Kohde Alakohteen asetus Kuvaus

Video Format 23.98 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

24 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

Project >Cine EI Setting
Määrittää Cine EI -tilan asetukset.

Kohde Alakohteen asetus Kuvaus

Color Gamut S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Määrittää väriavaruuden Cine EI -tilassa.

Project >HDR Setting
Määrittää HDR-tilan asetukset.

Kohde Alakohteen asetus Kuvaus

VF SDR 
Preview

On / Off HDR-tilassa tämä kytkee päälle / pois 
päältä toiminnon, joka muuntaa etsimen 
kuvan HDR:stä SDR:ksi, kun 
gammanäytön avustustoiminto on 
käytössä.

[Vinkki]
Kun asetukseksi on määritetty On, SDR Gain 
-asetusta käytetään etsimen kuvassa.
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Project >HDR Setting
Määrittää HDR-tilan asetukset.

Kohde Alakohteen asetus Kuvaus

SDR Gain 0dB ... –15dB (–6dB) HDR-tilassa tämä määrittää SDR Gain 
-asetuksen, jota käytetään etsimessä, kun 
kohdan VF SDR Preview asetukseksi on 
määritetty On.

Project >Simul Rec
Määrittää samanaikainen tallennus -tilan asetukset (sivu 52).

Kohde Alakohteen asetus Kuvaus

Setting On / Off Kytkee samanaikaisen tallennuksen 
päälle / pois päältä ja määrittää 
tietovälineen, johon tallennetaan.

Rec Button 
Set

Rec Button:[SlotA SlotB] Handle Rec 
Button:[SlotA SlotB] / Rec Button:[SlotA] 
Handle Rec Button:[SlotB] / Rec 
Button:[SlotB] Handle Rec Button:[SlotA]

Nimeä kunkin tallennusvälineen 
ohjaamiseen käytettävät 
tallennuspainikkeet.

Project >Proxy Rec
Määrittää välityspalvelimelle tallentaminen -tilan asetukset.

Kohde Alakohteen asetus Kuvaus

Setting On / Off Kytkee välityspalvelintallennuksen 
päälle / pois päältä.

Audio 
Channel

CH1/CH2 / CH3/CH4 Valitsee välityspalvelintietojen 
tallentamisen äänikanavan.

Chunk 30s / 1min / 2min Valitsee välityspalvelintiedostojen 
muistiyksikön tallennusvälin.

Project >Interval Rec
Määrittää intervallikuvaustilan asetukset (sivu 50).

Kohde Alakohteen asetus Kuvaus

Setting On / Off Kytkee intervallikuvauksen päälle / pois 
päältä. (Kun tämä tila asetetaan tilaan 
On, muut erikoistilat siirtyvät tilaan Off.)

Interval Time 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 
20 / 30 / 40 / 50 (s)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 / 
30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (h)

Määrittää tallennusten välisen aikavälin 
Interval Rec -tallennustilassa (kun kohdan 
Interval Rec asetuksena on On).

Project >Interval Rec
Määrittää intervallikuvaustilan asetukset (sivu 50).

Kohde Alakohteen asetus Kuvaus

Number of 
Frames

1frame / 2frames / 3frames / 6frames / 
9frames / 12frames
Saatavilla olevat asetukset riippuvat valitun 
videomuodon kuvataajuudesta.
59.94P/50P: 

2frames / 6frames / 12frames
29.97P/25P/24P/23.98P: 

1frame / 3frames / 6frames / 9frames

Määrittää tallennettavien kuvien 
lukumäärän kuvauskertaa kohti Interval 
Rec -tallennustilassa (kun kohdan Interval 
Rec asetuksena on On).

Pre-Lighting Off / 2 s / 5 s / 10 s Määrittää sekuntimäärän, paljonko ennen 
tallennuksen alkamista videovalo syttyy 
Interval Rec -tallennustilassa.

[Vinkki]
Saatavilla vain, kun käytössä on HVL-LBPC 
(lisävaruste).

Project >Picture Cache Rec
Määrittää Picture Cache -tallennustilan asetukset (sivu 51).

Kohde Alakohteen asetus Kuvaus

Setting On / Off Kytkee kuvan välimuistitallennuksen 
päälle / pois päältä.

Cache Size Short / Medium / Long / Max Määrittää ajan, jolta kuvia kerätään 
kuvavälimuistiin (kuvavälimuistin 
tallennusaika).

Cache Rec 
Time

Näyttää ajan, jolta kuvia kerätään 
kuvavälimuistiin (kuvavälimuistin 
tallennusaika).
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Project >SDI/HDMI Rec Control
Määrittää SDI/HDMI-tallennuksen ohjausasetukset.

Kohde Alakohteen asetus Kuvaus

Setting Off / SDI/HDMI Remote I/F / Parallel Rec Määrittää ulkoisella laitteella 
tallennuksen alkamisen/päättymisen 
ohjauksen SDI/HDMI-lähtösignaalin 
kautta.
Off: 

Älä käytä kauko-ohjainta.
SDI/HDMI Remote I/F: 

Ulkoisella liitetyllä laitteella 
tallennuksen alkamisen/päättymisen 
ohjaus, kun videokameraan ei ole 
asetettu tietovälinettä. Kuvien oikea-
aikaisuutta ei synkronoitu 
videokameran tietovälineen kanssa.

Parallel Rec: 
Ulkoisella liitetyllä laitteella 
tallennuksen alkamisen/päättymisen 
ohjaus, kun videokameraan on 
asetettu tietoväline. Kuvien oikea-
aikaisuus synkronoitu videokameran 
tietovälineen kanssa.

[Huomautus]
Ohjaukseen käyttämällä HDMI-lähtösignaalia 
määritä koko valikon TC/Media-valikossa 
kohdan HDMI TC Out > Setting (sivu 91) 
asetukseksi On.

Project >Assignable Button
Määrittää toimintojen nimeämiset nimettäville painikkeille.

Kohde Alakohteen asetus Kuvaus

<1> – <9>, 
Focus Hold 
Button

Off / Base ISO/Sensitivity / AGC / Push 
AGC / ND Filter Position / Auto ND Filter / 
Push Auto ND / Auto Iris / Push Auto Iris / 
Bokeh Control / Auto Shutter / Auto 
Exposure Level / Backlight / Spotlight / 
Preset White Select / ATW / ATW Hold / AF 
Speed/Sens. / Focus Setting / Focus Area / 
Focus Area(AF-S) / Face/Eye Detection AF / 
Push AF Mode / Push AF/Push MF / Focus 
Hold / Focus Magnifier x3/x6 / Focus 
Magnifier x3 / Focus Magnifier x6 / S&Q 
Motion / SteadyShot / Rec / Picture Cache 
Rec / Rec Review / Clip Flag OK / Clip Flag 
NG / Clip Flag Keep / Color Bars / Tally 
[Front] / DURATION/TC/U-BIT / Display / 
Lens Info / Video Signal Monitor / Marker / 
VF Adjust / VF Mode / Gamma Display 
Assist / Peaking / Zebra / Volume / 
Thumbnail / Touch Operation / Handle 
Zoom / NFC / Auto Upload (Proxy) / Direct 
Menu / User Menu / Menu

Nimeää toimintoja nimettäville 
painikkeille.
Base ISO/Sensitivity: 

Vaihtaa kuvakennon 
perusherkkyyden.

AGC: 
Kytkee AGC-toiminnon päälle / pois 
päältä.

Push AGC: 
Mahdollistaa AGC-toiminnon 
painikkeen painalluksella.

ND Filter Position: 
Vaihtaa ND-suodattimia.

Auto ND Filter: 
Kytkee automaattisen ND-
suodatintoiminnon päälle / pois 
päältä.

Push Auto ND: 
Mahdollistaa automaattisen ND-
suodatintoiminnon painikkeen 
painalluksella.

Auto Iris: 
Kytkee himmennintoiminnon 
päälle / pois päältä.

Push Auto Iris: 
Mahdollistaa automaattisen 
himmennintoiminnon painikkeen 
painalluksella.

Bokeh Control: 
Kytkee boken hallintatilan 
päälle / pois päältä.

Auto Shutter: 
Kytkee automaattisen 
suljintoiminnon päälle / pois päältä.

Auto Exposure Level: 
Näyttää/poistuu Auto Exposure 
Level -suoravalikon/-valikosta.

Backlight: 
Vaihtaa asetusten Backlight ja 
Standard välillä.

Spotlight: 
Vaihtaa asetusten Spotlight ja 
Standard välillä.

Preset White Select: 
Vaihtaa valkotasapainon esiasetetun 
tilan arvon.
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Project >Assignable Button
Määrittää toimintojen nimeämiset nimettäville painikkeille.

Kohde Alakohteen asetus Kuvaus

<1> – <9>, 
Focus Hold 
Button

ATW: 
Kytkee ATW-toiminnon päälle / pois 
päältä.

ATW Hold: 
Keskeyttää ATW-toiminnon.

AF Speed/Sens.: 
Vaihtaa automaattitarkennuksen 
siirtymisnopeuden asetuksen ja 
automaattitarkennuksen 
kohteenvaihtumisherkkyyden asetuksen.

Focus Setting: 
Määrittää tarkennusalueen. 

Focus Area: 
Määrittää tarkennusalueen 
automaattitarkennuksessa ja 
tilapäisessä 
automaattitarkennuksessa.

Focus Area(AF-S): 
Määrittää tarkennusalueen 
tilapäisessä 
automaattitarkennuksessa (AF-S).

Face/Eye Detection AF: 
Vaihtaa kasvojen-/
silmientunnistuksen 
automaattitarkennuksen asetuksia.

Push AF Mode: 
Vaihtaa Push AF -tilan asetuksen.

Push AF/Push MF: 
MF-tarkennustilassa aktivoi 
automaattitarkennuksen painikkeen 
painalluksella. 
AF-tarkennustilassa aktivoi 
manuaalitarkennuksen painikkeen 
painalluksella.

Focus Hold: 
AF-tarkennustilassa tarkennus 
lukittuu painikkeen painalluksella.

Focus Magnifier x3/x6:
Focus Magnifier x3:
Focus Magnifier x6: 

Kytkee tarkennuksen 
suurennustoiminnon päälle / pois 
päältä.

Project >Assignable Button
Määrittää toimintojen nimeämiset nimettäville painikkeille.

Kohde Alakohteen asetus Kuvaus

<1> – <9>, 
Focus Hold 
Button

S&Q Motion: 
Kytkee hidastuksen ja nopeutuksen 
päälle / pois päältä. 
Määrittää kuvaamisen kuvataajuuden, 
kun painetaan pitkään.

SteadyShot: 
Vaihtaa asetusten Active, Standard ja 
Off välillä.

Rec: 
Aloittaa/lopettaa tallennuksen.

Picture Cache Rec: 
Kytkee kuvan välimuistitallennuksen 
päälle / pois päältä.

Rec Review: 
Kytkee Rec Review -toiminnon 
päälle / pois päältä.

Clip Flag OK: 
Suorittaa Add OK -toiminnon. 
Suorita Delete Clip Flag painamalla 
kahdesti.

Clip Flag NG: 
Suorittaa Add NG -toiminnon. 
Suorita Delete Clip Flag painamalla 
kahdesti.

Clip Flag Keep: 
Suorittaa Add Keep -toiminnon. 
Suorita Delete Clip Flag painamalla 
kahdesti.

Color Bars: 
Kytkee väripalkit päälle / pois päältä.

Tally [Front]: 
Kytkee tallennuksen merkkivalon 
palamis-/vilkkumistoiminnon 
päälle / pois päältä.

DURATION/TC/U-BIT: 
Vaihtaa asetusten Time Code, Users 
Bit ja Duration välillä.

Display: 
Kytkee näytön ilmaisimet 
päälle / pois päältä.

Lens Info: 
Vaihtaa terävyysalueen ilmaisinta.

Video Signal Monitor: 
Vaihtaa videosignaalin näyttöä (kuten 
aaltomuoto).
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Project >Assignable Button
Määrittää toimintojen nimeämiset nimettäville painikkeille.

Kohde Alakohteen asetus Kuvaus

<1> – <9>, 
Focus Hold 
Button

Marker: 
Kytkee merkkitoiminnon päälle / pois 
päältä.

VF Adjust: 
Näyttää tasopalkit etsimen näytön 
säätämistä varten.

VF Mode: 
Vaihtaa etsimen näytön värilliseksi tai 
mustavalkoiseksi.

Gamma Display Assist: 
Vaihtaa gammanäytön 
avustustoiminnon.

Peaking: 
Kytkee korostustoiminnon 
päälle / pois päältä.

Zebra: 
Kytkee Zebra-toiminnon päälle / pois 
päältä.

Volume: 
Säätää näytön äänitason lähtöä 
kuulokeliitäntään ja sisäiseen 
kaiuttimeen.

Thumbnail: 
Näyttää/poistuu pikkukuvanäytön/-
näytöstä.

Touch Operation: 
Kytkee kosketustoiminnot 
päälle / pois päältä.

Handle Zoom: 
Vaihtaa yläkahvan zoomin toiminnan.

NFC: 
Suorittaa NFC-toiminnon.

Auto Upload (Proxy): 
Kytkee välityspalvelintiedoston 
automaattisen latauksen päälle / pois 
päältä tai määrittää muistiyksikkötilan.

Direct Menu: 
Näyttää/poistuu suoravalikon/-
valikosta.

User Menu: 
Näyttää/poistuu User-valikon/-
valikosta.

Menu: 
Näyttää/poistuu koko valikon/
valikosta.

Project >Assignable Dial
Määrittää toimintojen nimeämiset nimettävälle säätimelle ja määrittää kiertosuunnan.

Kohde Alakohteen asetus Kuvaus

Grip/Remote 
Dial

Off / ISO/Gain/EI / ND Filter / IRIS /  
Auto Exposure Level / Audio Input Level / 
Multi Function Dial

Nimeä toimintoja ohjainkahvan 
nimettävälle säätimelle.
ISO/Gain/EI: 

Säätää herkkyysvahvistuksen tai 
EI-arvon.

ND Filter: 
Säätää ND-suodatinta.

IRIS: 
Säätää himmennintä.

Auto Exposure Level: 
Säätää automaattivalotuksen tasoa.

Audio Input Level: 
Säätää äänitystasoa.

Multi Function Dial: 
Toimii monitoimisäätimenä.

Grip Dial 
Direction

Normal / Opposite Määrittää kauko-ohjainkahvan 
nimettävän säätimen kiertosuunnan.
Normal: Kääntyy normaaliin suuntaan.
Opposite: Kääntyy vastakkaiseen 

suuntaan.

Handle Dial Off / ISO/Gain/EI / ND Filter / IRIS / Auto 
Exposure Level / Audio Input Level / Multi 
Function Dial

Nimeää toimintoja yläkahvan 
nimettävälle säätimelle.
ISO/Gain/EI: 

Säätää herkkyysvahvistuksen tai 
EI-arvon.

ND Filter: 
Säätää ND-suodatinta.

IRIS: 
Säätää himmennintä.

Auto Exposure Level: 
Säätää automaattivalotuksen tasoa.

Audio Input Level: 
Säätää äänitystasoa.

Multi Function Dial: 
Toimii monitoimisäätimenä.

Handle Dial 
Direction

Normal / Opposite Määrittää yläkahvan nimettävän 
säätimen kiertosuunnan.
Normal: Kääntyy normaaliin suuntaan.
Opposite: Kääntyy vastakkaiseen 

suuntaan.
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Project >Multi Function Dial
Nimeää toimintoja monitoimisäätimelle.

Kohde Alakohteen asetus Kuvaus

Default 
Function

Off / IRIS / ISO/Gain/EI / Auto Exposure 
Level / Audio Input Level

Nimeää oletustoiminnon 
monitoimisäätimelle.
IRIS: 

Säätää himmennintä.
ISO/Gain/EI: 

Säätää herkkyysvahvistuksen tai 
EI-arvon.

Auto Exposure Level: 
Säätää automaattivalotuksen tasoa.

Audio Input Level: 
Säätää äänitystasoa.

Project >User File
Määrittää käyttäjän tiedostotoimintoihin liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

Load from 
Media(B)

Execute / Cancel Lataa käyttäjän tiedostoasetukset 
CFexpress Type A- / SD-korttipaikkaan (B) 
asetetulta muistikortilta.
Execute: Suorita toiminto.

Save to 
Media(B)

Execute / Cancel Tallentaa käyttäjän tiedostoasetukset 
CFexpress Type A- / SD-korttipaikkaan (B) 
asetetulle muistikortille.
Execute: Suorita toiminto.

File ID Näyttää käyttäjän tiedostojen 
tiedostotunnuksen näyttö-/
muokkausnäytön.

Load 
Customize 
Data

On / Off Määrittää, ladataanko User-valikon 
mukautettavat tiedot, kun Load from 
Media(B) suoritetaan.

Load White 
Data

On / Off Määrittää, ladataanko 
valkotasapainotiedot, kun Load from 
Media(B) suoritetaan.

Project >All File
Määrittää ALL-tiedostoon liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

Load from 
Media(B)

Execute / Cancel Lataa ALL-tiedostoasetukset CFexpress 
Type A- / SD-korttipaikkaan (B) asetetulta 
muistikortilta.
Execute: Suorita toiminto.

Load from 
Cloud(Private)

Execute / Cancel Lataa palvelimelle ladatun ALL-tiedoston 
C3 Portal -pilvipalvelusta (yksityinen).
Execute: Suorita toiminto.

Load from 
Cloud(Share)

Execute / Cancel Lataa palvelimelle ladatun ALL-tiedoston 
C3 Portal -pilvipalvelusta (jako).
Execute: Suorita toiminto.

Save to 
Media(B)

Execute / Cancel Tallentaa ALL-tiedostoasetukset 
CFexpress Type A- / SD-korttipaikkaan (B) 
asetetulle muistikortille.
Execute: Suorita toiminto.

Save to 
Cloud(Private)

Execute / Cancel Tallentaa ALL-tiedostoasetustiedoston C3 
Portal -pilvipalveluun (yksityinen).
Execute: Suorita toiminto.

Save to 
Cloud(Share)

Execute / Cancel Tallentaa ALL-tiedostoasetustiedoston C3 
Portal -pilvipalveluun (jako).
Execute: Suorita toiminto.

File ID Nimeää tiedoston.

Load Network 
Data

On / Off Määrittää, ladataanko Network-valikon 
asetustiedot, kun Load from Media(B), 
Load from Cloud(Private) tai Load from 
Cloud(Share) suoritetaan.
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Paint/Look-valikko
Tässä osiossa kuvataan kunkin valikkokohteen toiminnot ja asetukset.
Tehdasoletusasetukset on lihavoitu (esimerkiksi 18dB).

Paint/Look >Scene File
Määrittää kohtaustiedostoihin liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

Recall Lataa sisäiseen muistiin tallennetun 
kohtaustiedoston ja ottaa käyttöön 
asetukset nykyisinä 
kuvanlaatuasetuksina.

Store Tallentaa nykyisen kuvanlaatutilan 
kohtaustiedostona sisäiseen muistiin.

Delete Poistaa sisäiseen muistiin tallennetun 
kohtaustiedoston.

Preset Recall Kun kohdan Shooting Mode asetuksena on 
Custom ja kohdan Target Display 
asetuksena on SDR(BT.709):

S-Cinetone / Standard / Still / ITU709
Kun kohdan Shooting Mode asetuksena on 
Custom ja kohdan Target Display 
asetuksena on HDR(HLG):

HLG Live / HLG Natural

Ottaa käyttöön esiasetetut 
kuvanlaatuasetukset (ei 
uudelleenkirjoitettavat) nykyisinä 
kuvanlaatuasetuksina.

Paint/Look >Base Look
Määrittää perusulkoasuun liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

Select Kun kohdan Shooting Mode asetuksena on 
Custom ja kohdan Target Display 
asetuksena on SDR(BT.709):

S-Cinetone / Standard / Still / ITU709 / 
User1–User16

Kun kohdan Shooting Mode asetuksena on 
Custom ja kohdan Target Display 
asetuksena on HDR(HLG):

HLG Live / HLG Natural / User1–User16
Kun kohdan Shooting Mode asetuksena on 
Cine EI:

s709 / 709(800) / S-Log3 / User1–
User16

Valitsee perusulkoasun.

Delete Poistaa valitun perusulkoasun.

Delete All Poistaa kaikki perusulkoasut.
Import from 
Media(B)

Execute / Cancel Lataa perusulkoasutiedoston CFexpress 
Type A- / SD-korttipaikkaan (B) asetetulta 
muistikortilta.
Execute: Suorita toiminto.

Paint/Look >Base Look
Määrittää perusulkoasuun liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus
Import from 
Cloud(Private)

Execute / Cancel Tuo palvelimelle ladatun 
perusulkoasutiedoston C3 Portal 
-pilvipalvelusta (yksityinen).
Execute: Suorita toiminto.

Import from 
Cloud(Share)

Execute / Cancel Tuo palvelimelle ladatun 
perusulkoasutiedoston C3 Portal 
-pilvipalvelusta (jako).
Execute: Suorita toiminto.

Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Määrittää tuloalueen valitulle 
perusulkoasulle.

Output BT.709 / HLG Määrittää lähtövärialueen valitulle 
perusulkoasulle.

AE Level 
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV /  
5/3EV / 2EV

Määrittää valotuksen viitearvon valitulle 
perusulkoasulle.

Paint/Look >Reset Paint Settings
Palauttaa Paint/Look-valikkoasetukset, pois lukien perusulkoasu.

Kohde Alakohteen asetus Kuvaus

Reset without 
Base Look

Execute / Cancel Palauttaa Paint/Look-valikkoasetukset, 
pois lukien perusulkoasu.
Execute: Suorita toiminto.

Paint/Look >Black
Määrittää mustan asetukset.

Kohde Alakohteen asetus Kuvaus

Master Black –99.0–+99.0 (±0.0) Määrittää master-mustan tason.

R Black –99.0–+99.0 (±0.0) Määrittää R-mustan tason.

B Black –99.0–+99.0 (±0.0) Määrittää B-mustan tason.

Paint/Look >Knee
Määrittää ylivalotuksen estoasetukset.

Kohde Alakohteen asetus Kuvaus

Setting Kun kohdan Target Display asetuksena on 
SDR(BT.709):

On / Off / ---
Kun kohdan Target Display asetuksena on 
HDR(HLG):

On / Off / ---

Kytkee ylivalotuksen eston 
korjaustoiminnon päälle / pois päältä.

[Vinkki]
Käytössä vain, kun kohdan Base Look > Select 
asetuksena on Standard, ITU709, HLG Live tai 
HLG Natural.
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Paint/Look >Knee
Määrittää ylivalotuksen estoasetukset.

Kohde Alakohteen asetus Kuvaus

Auto Knee Kun kohdan Target Display asetuksena on 
SDR(BT.709):

On / Off / ---
Kun kohdan Target Display asetuksena on 
HDR(HLG):

On / Off / ---

Kytkee automaattisen 
ylivalotuksenestotoiminnon päälle / pois 
päältä.

[Vinkki]
Käytössä vain, kun ylivalotuksen estoasetus on 
On ja kohdan Base Look > Select asetuksena on 
Standard tai ITU709. 

Point 75%–109% (90%) Määrittää ylivalotuksen estokohdan.

Slope –99–+99 (±0) Määrittää ylivalotuksen eston 
kulmakertoimen.

Paint/Look >Detail
Määrittää yksityiskohtien säätöasetukset.

Kohde Alakohteen asetus Kuvaus

Setting On / Off Kytkee yksityiskohtatoiminnon 
päälle / pois päältä.

Level –7–+7 (±0) Määrittää yksityiskohtatason.

Manual 
Setting

On / Off / --- Kytkee yksityiskohtien 
manuaalisäätötoiminnon päälle / pois 
päältä.

V/H Balance –2–+2 (±0) Määrittää pystysuuntaisten (V) ja 
vaakasuuntaisten (H) yksityiskohtien 
tasapainon yksityiskohtien 
manuaalisäätöä varten.

B/W Balance Type1 / Type2 / Type3 / Type4 / Type5 Määrittää matalan luminanssin alueiden 
mustien (B) yksityiskohtien ja korkean 
luminanssin alueiden valkoisten (W) 
yksityiskohtien välisen tasapainon 
yksityiskohtien manuaalisäätöä varten.

Limit 0–7 Määrittää yksityiskohtien rajatason 
yksityiskohtien manuaalisäätöä varten.

Crispening 0–7 Määrittää terävöintitason yksityiskohtien 
manuaalisäätöä varten.

High Light 
Detail

0–4 Määrittää korkean luminanssin alueiden 
yksityiskohtatason yksityiskohtien 
manuaalisäätöä varten.

Paint/Look >Matrix
Määrittää matriisinkorjausasetukset.

Kohde Alakohteen asetus Kuvaus

User Matrix On / Off Kytkee käyttäjän 
matriisinkorjaustoiminnon päälle / pois 
päältä.

User Matrix 
Level

–99–+99 (±0) Säätää koko kuvan värikylläisyyttä.

User Matrix 
Phase

–99–+99 (±0) Säätää koko kuvan värisävyä (-vaihetta).

User Matrix 
R-G

–99–+99 (±0) Määrittää käyttäjän määrittämän R-G-
käyttäjämatriisin.

User Matrix 
R-B

–99–+99 (±0) Määrittää käyttäjän määrittämän R-B-
käyttäjämatriisin.

User Matrix 
G-R

–99–+99 (±0) Määrittää käyttäjän määrittämän G-R-
käyttäjämatriisin.

User Matrix 
G-B

–99–+99 (±0) Määrittää käyttäjän määrittämän G-B-
käyttäjämatriisin.

User Matrix 
B-R

–99–+99 (±0) Määrittää käyttäjän määrittämän B-R-
käyttäjämatriisin.

User Matrix 
B-G

–99–+99 (±0) Määrittää käyttäjän määrittämän B-G-
käyttäjämatriisin.

Paint/Look >Multi Matrix
Määrittää monen matriisin korjausasetukset.

Kohde Alakohteen asetus Kuvaus

Setting On / Off Kytkee monen matriisin korjaustoiminnon 
päälle / pois päältä.

Reset Execute / Cancel Palauttaa kunkin akselin värin sävyn ja 
kylläisyyden oletusarvoihin.

Axis B / B+ / MG– / MG / MG+ / R / R+ / YL– / 
YL / YL+ / G– / G / G+ / CY / CY+ / B–

Valitsee akselin.

Hue –99–+99 (±0) Määrittää monen matriisin korjaukseen 
käytettävän värin sävyn.

Saturation –99–+99 (±0) Määrittää monen matriisin korjaukseen 
käytettävän värin kylläisyyden.
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TC/Media-valikko
Tässä osiossa kuvataan kunkin valikkokohteen toiminnot ja asetukset.
Tehdasoletusasetukset on lihavoitu (esimerkiksi 18dB).

TC/Media >Timecode
Määrittää aikakoodin asetukset.

Kohde Alakohteen asetus Kuvaus

Mode Preset / Regen / Clock Määrittää aikakoodin käyntitilan.
Preset: 

Käynnistyy esiasetetusta arvosta.
Regen: 

Käynnistyy edellisen leikkeen lopun 
aikakoodista.

Clock: 
Käyttää sisäistä kelloa aikakoodina.

Run Rec Run / Free Run Rec Run: Käy vain tallennettaessa.
Free Run: Käy aina videokameran 

toiminnasta riippumatta.

Setting Määrittää aikakoodille mielivaltaisen 
arvon.
SET: Määritä arvo.

Reset Execute / Cancel Palauttaa aikakoodiksi 00:00:00:00.
Execute: Suorita toiminto.

TC Format DF / NDF Määrittää aikakoodin muodon.
DF: Drop Frame -tasaus
NDF: Ei Drop Frame -tasausta

TC/Media >TC Display
Määrittää aikatietojen näyttöasetukset.

Kohde Alakohteen asetus Kuvaus

Display Select Timecode / Users Bit / Duration Vaihtaa aikatietojen näytön.

TC/Media >Users Bit
Määrittää nimitietoihin liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

Mode Fix / Time Määrittää nimitietotilan.
Fix: Käyttää nimitiedoissa mielivaltaista 

kiinteää arvoa.
Time: Käyttää nimitiedoissa kuluvaa 

tuntia, minuuttia ja sekuntia.

Setting Määrittää nimitiedoille mielivaltaisen 
arvon.

TC/Media >HDMI TC Out
Määrittää aikakoodin lähtöön liittyvät tiedot käytettäessä HDMI-kaapelia.

Kohde Alakohteen asetus Kuvaus

Setting On / Off Määrittää, lähetetäänkö aikakoodi 
laitteille muita tarkoituksia varten HDMI-
kaapelin kautta.

TC/Media >Clip Name Format
Määrittää leikkeen nimeämiseen ja poistamiseen liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

Title Prefix nnn_ (nnn on sarjanumeron 3 viimeistä 
numeroa)

Määrittää leikkeen nimen otsikko-osan 
(4–46 merkkiä).
Avaa merkkijonon syöttönäytön.

Merkkijonon syöttönäytön rakenne
Merkkienvalinta-alue (3 riviä): 

Valitsee Title Prefix -alueella 
kohdistimen kohdalle asetettavat 
merkit.  
!#$%()+.-.;=@[ ]^_~0123456789 
abcdefghijklmnopqrstuvwxyz 
ABCDEFGHIJKLMNOPQRSTUVWXYZ

Kohdistimen toiminta-alue (1 rivi): 
Space: Asettaa välilyönnin 
kohdistimen kohdalle.  
: Siirtää kohdistinta vasemmalle.  
: Siirtää kohdistinta oikealle.  
BS: Poistaa merkin kohdistimen 
vasemmalta puolelta.

Title Prefix -alue (1 rivi): 
Alue otsikon syöttämiseen.

Otsikon määrittäminen
1.	 Valitse Title Prefix -alueella 

kohdistimen kohdalle asetettava 
merkki merkkienvalinta-alueelta 
monivalitsimella (sivu 7) ja paina 
monivalitsimen käytä-painiketta. 
(Valittu merkki asetetaan ja kohdistin 
siirtyy oikealle.)

2.	 Määritä otsikko toistamalla vaihe 1. 
(Käytä BS-painiketta tarpeen 
mukaan.)

3.	 Valitse otsikon määrittämisen jälkeen 
Done sulkeaksesi syöttönäytön.
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TC/Media >Clip Name Format
Määrittää leikkeen nimeämiseen ja poistamiseen liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

Number Set 0001–9999 Määrittää 4-numeroisen luvun liitteeksi 
leikkeen nimeen.

TC/Media >Update Media
Päivittää muistikorttien hallintatiedoston.

Kohde Alakohteen asetus Kuvaus

Media(A) Execute / Cancel Päivittää korttipaikassa A olevan 
muistikortin hallintatiedoston.
Execute: Suorita toiminto.

Media(B) Execute / Cancel Päivittää korttipaikassa B olevan 
muistikortin hallintatiedoston.
Execute: Suorita toiminto.

TC/Media >Format Media
Alustaa muistikortit.

Kohde Alakohteen asetus Kuvaus

Media(A) Full Format / Quick Format / Cancel Formatoi korttipaikassa A olevan 
muistikortin.

Media(B) Full Format / Quick Format / Cancel Formatoi korttipaikassa B olevan 
muistikortin.



6. Valikkonäyttö ja asetukset93

Tässä osiossa kuvataan kunkin valikkokohteen toiminnot ja asetukset.
Tehdasoletusasetukset on lihavoitu (esimerkiksi 18dB).

Monitoring >Output On/Off
Määrittää videolähdön asetukset.

Kohde Alakohteen asetus Kuvaus

SDI On / Off Kytkee SDI-lähdön päälle / pois päältä.

HDMI On / Off Kytkee HDMI-lähdön päälle / pois päältä.

Monitoring >Output Format
Määrittää lähtömuodon asetukset.

Kohde Alakohteen asetus Kuvaus

SDI Tietoja asetuksista, ks. ”Lähtömuodot ja 
rajoitteet” (sivu 118).

Määrittää SDI- ja HDMI-lähdön 
tarkkuuden.HDMI

Monitoring >Output Display
Määrittää näytön lähtöasetukset.

Kohde Alakohteen asetus Kuvaus

SDI On / Off Määrittää, upotetaanko valikko, tila ja 
näyttö SDI-lähtösignaaliin.

HDMI On / Off Määrittää, upotetaanko valikko, tila ja 
näyttö HDMI-lähtösignaaliin.

Monitoring >Display On/Off
Määrittää näyttökohteen asetukset.

Kohde Alakohteen asetus Kuvaus

Network 
Status

On / Off Valitsee etsimessä näytettävät kohteet.

File Transfer 
Status

On / Off

Rec/Play 
Status

On / Off

RAW Output 
Control 
Status

On / Off

Tally On / Off

Battery 
Remain

On / Off

Focus Mode On / Off

Focus 
Position

On / Off

Focus Area 
Indicator

On / Off

Focus Area 
Ind.(AF-S)

On / Off

Face/Eye 
Detection 
Frame

On / Off

Lens Info On / Off

Imager Scan 
Mode

On / Off

Rec Format On / Off

Frame Rate On / Off

Zoom 
Position

On / Off

UWP RF Level On / Off

SteadyShot On / Off

Monitoring-valikko
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Monitoring >Display On/Off
Määrittää näyttökohteen asetukset.

Kohde Alakohteen asetus Kuvaus

Base Look/
LUT

On / Off

SDI/HDMI 
Rec Control

On / Off

Gamma 
Display Assist

On / Off

Proxy Status On / Off

Base ISO/
Sensitivity

On / Off

Media Status On / Off

Video Signal 
Monitor

Off / Waveform / Vector / Histogram

Clip Name On / Off

White 
Balance

On / Off

Scene File On / Off

Focus 
Indicator

On / Off

Auto 
Exposure 
Mode

On / Off

Auto 
Exposure 
Level

On / Off

Timecode On / Off

ND Filter On / Off

Iris On / Off

ISO/Gain/EI On / Off

Shutter On / Off

Level Gauge On / Off

Audio Level 
Meter

On / Off

Video Level 
Warning

On / Off

Clip Number On / Off

Notice 
Message

On / Off

Monitoring >Marker
Määrittää merkkinäytön asetukset.

Kohde Alakohteen asetus Kuvaus

Setting On / Off Kytkee kaikkien merkkien näytön 
päälle / pois päältä.

Color White / Yellow / Cyan / Green / Magenta / 
Red / Blue

Valitsee merkkisignaalivärin.

Center 
Marker

1 / 2 / 3 / 4 / Off Valitsee keskimerkin.

Safety Zone On / Off Kytkee turva-alueen merkin päälle / pois 
päältä.

Safety Area 80% / 90% / 92.5% / 95% Valitsee turva-alueen merkin koon 
(prosenttiosuutena näytön 
kokonaiskoosta).

Aspect 
Marker

Line / Mask / Off Valitsee kuvasuhdemerkin tyypin.

Aspect Mask 0–15 (12) Määrittää merkin ulkopuolisen 
videosignaalin tason.

Aspect Safety 
Zone

On / Off Kytkee kuvasuhteen turva-alueen merkin 
päälle / pois päältä.

Aspect Safety 
Area

80% / 90% / 92.5% / 95% Valitsee kuvasuhteen turva-alueen 
merkin koon (prosenttiosuutena näytön 
kokonaiskoosta).

Aspect Select 1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 / 17:9 / 
1.66:1 / 1.85:1 / 2.35:1 / 2.39:1 / Custom

Määrittää tilan, kun kuvasuhdemerkki 
näytetään.

Custom 
Aspect Ratio

Syötä mielivaltainen arvo (01.00:01.00) Määrittää kuvasuhteelle mielivaltaisen 
arvon.

[Huomautus]
Asetus on käytössä, kun Aspect 
Select -asetuksena on Custom.

Guide Frame On / Off Kytkee ohjauskehyksen näytön 
päälle / pois päältä.

100% Marker On / Off Kytkee 100%-merkin päälle / pois päältä.

User Box On / Off Kytkee käyttäjäruudun merkin 
päälle / pois päältä.

User Box 
Width

3–479 (240) Määrittää käyttäjäruudun merkin 
leveyden (etäisyys keskeltä vasempaan ja 
oikeaan reunaan).

User Box 
Height

3–269 (135) Määrittää käyttäjäruudun merkin 
korkeuden (etäisyys keskeltä ylä- ja 
alareunaan).
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Monitoring >Marker
Määrittää merkkinäytön asetukset.

Kohde Alakohteen asetus Kuvaus

User Box H 
Position

–476–+476 (0) Määrittää käyttäjäruudun merkin 
keskikohdan vaaka-asennon.

User Box V 
Position

–266–+266 (0) Määrittää käyttäjäruudun merkin 
keskikohdan pystyasennon.

Monitoring >VF Setting
Määrittää etsimen asetukset.

Kohde Alakohteen asetus Kuvaus

Brightness 1–15 (8) Säätää etsimen kuvan kirkkautta.

Color Mode Color / B&W Valitsee etsimen näyttötilan E-E/
tallennustilassa.

Monitoring >Gamma Display Assist
Määrittää gammanäytön avustusasetukset.

Kohde Alakohteen asetus Kuvaus

Setting On / Off Kytkee gammanäytön avustustoiminnon 
päälle / pois päältä Custom-tilassa, kun 
kohdan Target Display asetuksena on 
HDR(HLG).

Monitoring >Peaking
Määrittää korostuksen asetukset.

Kohde Alakohteen asetus Kuvaus

Setting On / Off Kytkee korostustoiminnon päälle / pois 
päältä.

Peaking Level High / Mid / Low Määrittää värinkorostussignaalin tason.

Color B&W / Red / Yellow / Blue Valitsee värinkorostussignaalin värin.

Monitoring >Zebra
Määrittää seeprakuvion asetukset.

Kohde Alakohteen asetus Kuvaus

Setting Off / Zebra1 / Zebra2 Valitsee seeprakuvion tyypin (Off, Zebra 1, 
Zebra 2).

Zebra1 Level 0%–109% (70%) Määrittää Zebra 1 -näyttötason.

Zebra1 
Aperture 
Level

2%–20% (10%) Määrittää Zebra 1 -aukkotason.

Zebra2 Level 0%–109% (100%) Määrittää Zebra 2 -näyttötason.
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Audio-valikko
Tässä osiossa kuvataan kunkin valikkokohteen toiminnot ja asetukset.
Tehdasoletusasetukset on lihavoitu (esimerkiksi 18dB).
Ks. ”Lohkokaaviot” (sivu 132).

Audio >Audio Input
Määrittää äänitulon asetukset.

Kohde Alakohteen asetus Kuvaus

CH1 Input 
Select

INPUT1 / Internal MIC / Shoe CH1 Vaihtaa tallennuksen tulolähteen 
kanavalla 1.

CH2 Input 
Select

INPUT1 / INPUT2 / Internal MIC / Shoe CH2 Vaihtaa tallennuksen tulolähteen 
kanavalla 2.

CH3 Input 
Select

Off / INPUT1 / Internal MIC / Shoe CH1 Vaihtaa tallennuksen tulolähteen 
kanavalla 3.

CH4 Input 
Select

Off / INPUT1 / INPUT2 / Internal MIC / 
Shoe CH2

Vaihtaa tallennuksen tulolähteen 
kanavalla 4.

INPUT1 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Määrittää viitetallennustason XLR-
mikrofonitulolle tulosta INPUT1.

INPUT2 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Määrittää viitetallennustason XLR-
mikrofonitulolle tulosta INPUT2.

Line Input 
Reference

+4dB / 0dB / –3dB / EBUL Valitsee viitetulotason, kun INPUT1/
INPUT2 -kytkin on asennossa LINE.

Reference 
Level

–20dB / –18dB / –16dB / –12dB / EBUL Valitsee 1 kHz:n viiteäänisignaalin 
tallennustason.

CH1 Wind 
Filter

On / Off Ottaa käyttöön / poistaa käytöstä 
tuulimelun vähennyssuodattimen 
kanavan 1 tallennuksessa.

CH2 Wind 
Filter

On / Off Ottaa käyttöön / poistaa käytöstä 
tuulimelun vähennyssuodattimen 
kanavan 2 tallennuksessa.

CH3 Wind 
Filter

On / Off Ottaa käyttöön / poistaa käytöstä 
tuulimelun vähennyssuodattimen 
kanavan 3 tallennuksessa.

CH4 Wind 
Filter

On / Off Ottaa käyttöön / poistaa käytöstä 
tuulimelun vähennyssuodattimen 
kanavan 4 tallennuksessa.

CH3 Level 
Control

Auto / Manual Valitsee automaattisen äänitulon 
tasonsäädön tai manuaalisen säädön 
kanavan 3 tallennukselle.

[Huomautus]
Jos sekä kohdan CH3 Input Select että kohdan 
CH4 Input Select asetukseksi on määritetty 
Internal MIC, CH4 vaihtuu automaattiseksi/
manuaaliseksi yhdessä tämän asetuksen 
kanssa.

Audio >Audio Input
Määrittää äänitulon asetukset.

Kohde Alakohteen asetus Kuvaus

CH4 Level 
Control

Auto / Manual Valitsee automaattisen äänitulon 
tasonsäädön tai manuaalisen säädön 
kanavan 4 tallennukselle.

[Huomautus]
Jos sekä kohdan CH3 Input Select että kohdan 
CH4 Input Select asetukseksi on määritetty 
Internal MIC, CH4 vaihtuu automaattiseksi/
manuaaliseksi yhdessä CH3 Level 
Control -asetuksen kanssa.

CH3 Input 
Level

0–99 (49) Määrittää tulotason kanavan 3 
tallennukselle.

CH4 Input 
Level

0–99 (49) Määrittää tulotason kanavan 4 
tallennukselle.

Audio Input 
Level

0–99 Määrittää äänen tulotason.
Voidaan käyttää master-
äänenvoimakkuutena tasojen CH1 Level 
– CH4 Level asetusten mukaisesti.

Limiter Mode Off / –6dB / –9dB / –12dB / –15dB / –17dB Valitsee rajoittimen ominaisuudet suurille 
tulosignaaleille, kun äänen tulotasoa 
säädetään manuaalisesti.

CH1&2 AGC 
Mode

Mono / Stereo Määrittää automaattisen tasonsäädön 
tilan kanavan 1 ja kanavan 2 
tallennukselle. Kun asetuksena on Stereo, 
AGC on yhdistetty kanavien välillä.

CH3&4 AGC 
Mode

Mono / Stereo Määrittää automaattisen tasonsäädön 
tilan kanavan 3 ja kanavan 4 
tallennukselle. Kun asetuksena on Stereo, 
AGC on yhdistetty kanavien välillä.

AGC Spec –6dB / –9dB / –12dB / –15dB / –17dB Valitsee AGC-ominaisuudet.

1kHz Tone on 
Color Bars

On / Off Kytkee 1 kHz:n viiteäänisignaalin 
päälle / pois päältä, kun väripalkit ovat 
näkyvissä.

[Huomautus]
Kun asetukseksi on määritetty On, 1 kHz:n 
viiteäänisignaali on määritetty kanavan 3 ja 
kanavan 4 tallentamiseen, vaikka kohtien CH3 
Input Select ja CH4 Input Select asetuksena 
olisi Off.
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Audio >Audio Input
Määrittää äänitulon asetukset.

Kohde Alakohteen asetus Kuvaus

CH1 Level Tulo ilman XLR-sovitinta
Audio Input Level / Side / Level+Side

Tulo XLR-sovittimella (sivu 48)
Audio Input Level / Through

Määrittää äänitulon tasonsäätöön 
käyttöön otetun yhdistelmän kanavan 1 
tallennukselle.

[Huomautus]
”Side” viittaa videokameran kyljessä 
sijaitsevaan AUDIO LEVEL (CH1) -säätimeen. 
Kun valittuna on Level+Side, äänitystaso 
määrittyy Audio Input Level -asetuksen ja 
säädinasetusten yhdistelmän perusteella 
(sivu 132).

CH2 Level Tulo ilman XLR-sovitinta
Audio Input Level / Side / Level+Side

Tulo XLR-sovittimella (sivu 48)
Audio Input Level / Through

Määrittää äänitulon tasonsäätöön 
käyttöön otetun yhdistelmän kanavan 2 
tallennukselle.

[Huomautus]
”Side” viittaa videokameran kyljessä 
sijaitsevaan AUDIO LEVEL (CH2) -säätimeen. 
Kun valittuna on Level+Side, äänitystaso 
määrittyy Audio Input Level -asetuksen ja 
säädinasetusten yhdistelmän perusteella 
(sivu 132).

CH3 Level Tulo ilman XLR-sovitinta
Audio Input Level / CH3 Input Level / 
Level+CH3 Input Level

Tulo XLR-sovittimella (sivu 48)
Audio Input Level / Through

Määrittää äänitulon tasonsäätöön 
käyttöön otetun yhdistelmän kanavan 3 
tallennukselle.

CH4 Level Tulo ilman XLR-sovitinta
Audio Input Level / CH4 Input Level / 
Level+CH4 Input Level

Tulo XLR-sovittimella (sivu 48)
Audio Input Level / Through

Määrittää äänitulon tasonsäätöön 
käyttöön otetun yhdistelmän kanavan 4 
tallennukselle.

Audio >Audio Output
Määrittää äänilähdön asetukset.

Kohde Alakohteen asetus Kuvaus

Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1 / 
CH2 / CH3 / CH4

Valitsee äänikanavan lähdön 
kuulokeliitäntään ja sisäiseen 
kaiuttimeen.

[Huomautus]
Jos useiden kanavien ääni määritetään 
rinnakkaiseksi lähdöksi, kunkin kanavan 
lähtötaso vähennetään lähdön ylisäätämisen 
estämiseksi.

Volume 0–50 Säätää näytön äänitason lähtöä 
kuulokeliitäntään ja sisäiseen 
kaiuttimeen.

Headphone 
Out

Mono / Stereo Valitsee, onko kuulokeliitäntä 
monauraalinen (Mono) vai stereo 
(Stereo).

Alarm Level 0–7 (4) Säätää hälyttimen äänenvoimakkuuden.

HDMI Output 
CH

CH1/CH2 / CH3/CH4 Määrittää äänikanavien yhdistelmän 
HDMI-lähdössä.
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Tässä osiossa kuvataan kunkin valikkokohteen toiminnot ja asetukset.
Tehdasoletusasetukset on lihavoitu (esimerkiksi 18dB).

Thumbnail

Kohde Alakohteen asetus Kuvaus

Display Clip 
Properties

Näyttää leikkeen ominaisuusnäytön.

Thumbnail >Set Clip Flag
Määrittää leikelipun asetukset.

Kohde Alakohteen asetus Kuvaus

Add OK Lisää OK-lipun.

Add NG Lisää NG-lipun.

Add KEEP Lisää Keep-lipun.

Delete Clip 
Flag

Poistaa leikelipun.

Thumbnail >Lock/Unlock Clip
Määrittää leikkeen suojausasetukset.

Kohde Alakohteen asetus Kuvaus

Select Clip Valitsee ja lukitsee leikkeen / avaa 
leikkeen lukituksen.

Lock All Clips Lukitsee kaikki leikkeet.

Unlock All 
Clips

Avaa kaikkien leikkeiden lukituksen.

Thumbnail >Delete Clip
Poistaa leikkeitä.

Kohde Alakohteen asetus Kuvaus

Select Clip Poistaa valitun leikkeen.

All Clips Poistaa kaikki leikkeet.

Thumbnail >Transfer Clip
Siirtää leikkeitä.

[Huomautus]
Transfer Clip -asetusta ei voi määrittää, kun salasanaa ei ole määritetty Network-valikon Access Authentication 
-kohdassa.

Kohde Alakohteen asetus Kuvaus

Select Clip Siirtää valitut leikkeet.

All Clips Siirtää kaikki leikkeet.

[Huomautus]
Enintään 200 leikettä voidaan siirtää.

Thumbnail >Transfer Clip (Proxy)
Siirtää välityspalvelinleikkeet.

[Huomautus]
Transfer Clip (Proxy) -asetusta ei voi määrittää, kun salasanaa ei ole määritetty Network-valikon Access 
Authentication -kohdassa.

Kohde Alakohteen asetus Kuvaus

Select Clip Siirtää valittuja leikkeitä vastaavat 
välityspalvelinleikkeet.

All Clips Siirtää kaikkia leikkeitä vastaavat 
välityspalvelinleikkeet.

[Huomautus]
Enintään 200 leikettä voidaan siirtää.

Thumbnail >Filter Clips
Määrittää näytettävien leikkeiden asetukset.

Kohde Alakohteen asetus Kuvaus

OK Näyttää vain leikkeet, joilla on OK-lippu.

NG Näyttää vain leikkeet, joilla on NG-lippu.

KEEP Näyttää vain leikkeet, joilla on Keep-
lippu.

None Näyttää vain leikkeet, joilla ei ole lippua.

All Näyttää kaikki leikkeet riippumatta siitä, 
onko niillä lippu vai ei.

Thumbnail >Customize View
Vaihtaa pikkukuvanäkymän.

Kohde Alakohteen asetus Kuvaus

Thumbnail 
Caption

Date Time / Time Code / Duration / 
Sequential Number

Vaihtaa pikkukuvien alla näytettävän 
tiedon.

Thumbnail-valikko
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Technical-valikko
Tässä osiossa kuvataan kunkin valikkokohteen toiminnot ja asetukset.
Tehdasoletusasetukset on lihavoitu (esimerkiksi 18dB).

Technical >Color Bars
Määrittää väripalkin asetukset.

Kohde Alakohteen asetus Kuvaus

Setting On / Off Kytkee väripalkit päälle / pois päältä.

Type ARIB / 100% / 75% / SMPTE Valitsee väripalkin tyypin.

Technical >ND Dial
Määrittää ND VARIABLE -säätimen toimintoihin liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

CLEAR with 
Dial

On / Off Määrittää, otetaanko ND-tilan 
vaihtaminen käyttöön (CLEAR  On) 
käyttämällä ND VARIABLE -säädintä.

Technical >Tally
Määrittää tallennuksen merkkivalon asetukset.

Kohde Alakohteen asetus Kuvaus

Front On / Off Kytkee tallennuksen merkkivalon 
(edessä) päälle / pois päältä.

Rear On / Off Kytkee tallennuksen merkkivalon (takana) 
päälle / pois päältä.

Technical >HOLD Switch Setting
Määrittää Hold-kytkimen asetukset.

Kohde Alakohteen asetus Kuvaus

with Rec 
Button

On / Off Määrittää, lukitaanko tallennuksen 
START/STOP-painikkeen toiminta.

with Hand 
Grip Remote

On / Off Määrittää, lukitaanko tallennuksen 
kauko-ohjainkahvan toiminta.

Handle HOLD 
Switch

Normal / Rec Button Only Määrittää, onko yläkahvan HOLD-
kytkimen ainoa pitokohde yläkahvan 
tallennuksen START/STOP-painike.
Normal: 

Kaikki yläkahvan säätimet ovat 
pitotoiminnon alaisia.  
Yläkahvan tallennuksen START/
STOP-painike noudattaa kuitenkin 
asetusta ”with Rec Button”.

Rec Button Only: 
Vain yläkahvan tallennuksen START/
STOP-painike on pitotoiminnon 
alainen.

Technical >Touch Operation
Määrittää kosketustoimintoihin liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

Setting On / Off Kytkee kosketustoiminnot päälle / pois 
päältä.

Technical >Rec Review
Määrittää tallennuksen tarkastelun asetukset.

Kohde Alakohteen asetus Kuvaus

Setting 3 s / 10 s / Clip Valitsee juuri tallennettujen leikkeiden 
toistoajan tarkastelua varten.

Technical >Zoom
Määrittää zoomin asetukset.

Kohde Alakohteen asetus Kuvaus

Zoom Type Optical Zoom Only / On(Clear Image 
Zoom)

Määrittää zoomin tyypin.
Optical Zoom Only: 

Optista zoomia säädetään 
käyttämällä objektiivia.

On(Clear Image Zoom): 
Elektroninen zoomi, kuvanlaatu 
vaurioituu vain vähän tai ei lainkaan.

Technical >Handle Zoom
Määrittää yläkahvan zoomin asetukset.

Kohde Alakohteen asetus Kuvaus

Setting Off / Low / High / Variable Määrittää yläkahvan zoomin nopeuden.

High 1–8 (8) Määrittää yläkahvan zoomausvivun 
zoomausnopeuden, kun yläkahvan 
zoomausnopeudeksi on valittu High.

Low 1–8 (3) Määrittää yläkahvan zoomausvivun 
zoomausnopeuden, kun yläkahvan 
zoomausnopeudeksi on valittu Low.

[Huomautus]
Kun zoomausnopeus asetetaan matalaksi, 
zoomaus voi olla epätasaista.

Technical >Menu Settings
Määrittää valikkoon liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

User Menu 
Only

On / Off Määrittää, onko näkyvissä vain User-
valikko (On) vai valikkoluettelo (Off), kun 
videokamera näyttää valikon.
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Technical >Menu Settings
Määrittää valikkoon liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

User Menu 
with Lock

On / Off Määrittää, lukitaanko valikkonäyttö niin, 
että näkyvissä on vain User-valikko.

[Huomautus]
Kun käytetään normaalia valikkonäyttöä, tämä 
kohde ei ole näkyvissä. Tietoja valikkonäytön 
käytöstä, ks. sivu 73.

Technical >Menu Page On/Off
Määrittää tilanäyttöön liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

Main On / Off Kytkee Main Status -näytön päälle / pois 
päältä.

Camera On / Off Kytkee Camera Status -näytön 
päälle / pois päältä.

Audio On / Off Kytkee Audio Status -näytön päälle / pois 
päältä.

Project On / Off Kytkee Project-tilanäytön päälle / pois 
päältä.

Monitoring On / Off Kytkee Monitoring Status -näytön 
päälle / pois päältä.

Assignable 
Button

On / Off Kytkee Assignable Button Status -näytön 
päälle / pois päältä.

Battery On / Off Kytkee Battery Status -näytön 
päälle / pois päältä.

Media On / Off Kytkee Media Status -näytön päälle / pois 
päältä.

Network On / Off Kytkee Network Status -näytön 
päälle / pois päältä.

File Transfer On / Off Kytkee File Transfer Status -näytön 
päälle / pois päältä.

Technical >Fan Control
Määrittää tuulettimen ohjaustilan asetukset.

Kohde Alakohteen asetus Kuvaus

Setting Auto / Minimum / Off in Rec Määrittää videokameran tuulettimen 
ohjaustilan.

[Huomautus]
Vaikka Off in Rec on valittuna, jos 
videokameran sisäinen lämpötila nousee tietyn 
arvon yli.

Technical >Lens
Määrittää objektiiveihin liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

Zoom Ring 
Direction

Left(W)/Right(T) / Right(W)/Left(T) Määrittää zoomausrenkaan suunnan.

[Huomautus]
Käytössä vain, kun käytetään E-pidikkeellistä 
objektiivia, joka tulee zoomausrenkaan 
suunnanvaihtoa.

Shading 
Compensation

Auto / Off Määrittää automaattisen 
varjostustoiminnon.

Chroma 
Aberration 
Comp.

Auto / Off Määrittää automaattisen väripoikkeaman 
kompensaation.

Distortion 
Comp.

Auto / Off Määrittää automaattisen vääristymän 
kompensaation.

Breathing 
Compensation

Auto / Off Määrittää objektiivin hengityksen 
kompensaation.

Distance 
Display

Meter / Feet Määrittää objektiivin tietojen ja 
tarkennuskohdan näyttöyksiköt.

Zoom 
Position 
Display

Focal Length / Number / Bar Määrittää zoomausasennon 
näyttömuodon.

Technical >Video Light Set
Määrittää videovalon valaistusmenetelmän. Saatavilla vain, kun käytössä on HVL-LBPC 
(lisävaruste).

Kohde Alakohteen asetus Kuvaus

Video Light 
Set

Power Link / Rec Link / Rec Link + Stby Määrittää moniliitäntäkenkään kiinnitetyn 
videovalon 
valaistuksenhallintamenetelmän.
Power Link: 

Kytkee videovalon päälle / pois 
päältä, kun videokamera on 
päällä / pois päältä.

Rec Link: 
Kytkee videovalon päälle / pois 
päältä, kun videokamera alkaa 
tallentaa / lopettaa tallentamisen.

Rec Link+ Stby: 
Kytkee videovalon päälle/
valmiustilaan, kun videokamera alkaa 
tallentaa / lopettaa tallentamisen.



6. Valikkonäyttö ja asetukset: Technical-valikko101

Technical >APR
Suorittaa APR-toiminnon.

Kohde Alakohteen asetus Kuvaus

APR Execute / Cancel Suorittaa APR-toiminnon (Automatic 
Pixel Restoration) kuvakennon 
automaattisäätöä varten.
Execute: Suorita toiminto.

[Huomautus]
Kiinnitä objektiivinsuojus aina ennen APR-
toiminnon suorittamista.

Technical >Camera Battery Alarm
Määrittää akun alhaisen varauksen hälytysasetukset.

Kohde Alakohteen asetus Kuvaus

Low Battery 5% / 10% / 15% / … / 45% / 50% Määrittää akun jäljellä olevan 
varaustason ja näyttää akun alhaisen 
varauksen hälytyksen (5%:n välein).

Battery 
Empty

3% – 7% Määrittää akun jäljellä olevan 
varaustason ja näyttää akun 
tyhjenemisen hälytyksen.

Technical >Camera DC IN Alarm
Määrittää tulojännitteen hälytysasetukset.

Kohde Alakohteen asetus Kuvaus

DC Low 
Voltage1

16.0V–19.0V (16.5V) Määrittää jännitteen ja näyttää alhaisen 
DC IN -tulojännitteen hälytyksen.

DC Low 
Voltage2

15.5V–18.5V Määrittää jännitteen ja näyttää 
riittämättömän DC IN -tulojännitteen 
hälytyksen.
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Network-valikko
Tässä osiossa kuvataan kunkin valikkokohteen toiminnot ja asetukset.
Tehdasoletusasetukset on lihavoitu (esimerkiksi 18dB).

Network > Setup for Mobile App
Suorittaa verkkoasetusten ohjatun määritystyökalun.

Kohde Alakohteen asetus Kuvaus

Setup Käynnistää verkkoasetusten ohjatun 
määritystyökalun.

Network >Access Authentication
Määrittää käyttöoikeuden todentamiseen liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

User Name Määrittää käyttäjänimen käyttöoikeuden 
todennusta varten.

Input 
Password

Määrittää salasanan käyttöoikeuden 
todennusta varten.

[Huomautus]
Tietoturvanäkökohdista on suositeltavaa 
asettaa salasanaksi riittävän pitkä merkkijono, 
jota muiden on vaikea arvata, ja tallettaa se 
turvalliseen paikkaan.

Generate 
Password

Execute / Cancel Luo automaattisesti salasanan 
käyttöoikeuden todentamista varten.
Execute: Suorita toiminto.

Show 
Settings

Näyttää käyttöoikeuden 
todentamistiedot.
Näyttää käyttäjänimen, salasanan, 
sormenjäljen, sarjanumeron ja 
mallinimen tekstinä ja QR-koodina.

[Huomautus]
Varmista, etteivät muut ihmiset näe salasanaa 
eivätkä voi kopioida QR-koodin kuvaa.

Network >Wireless LAN
Määrittää langattomiin lähiverkkoyhteyksiin liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

Setting Access Point Mode / Station Mode / Off Valitsee langattoman lähiverkkoyhteyden 
toimintatilan.

WPS Execute / Cancel Muodostaa yhteyden WPS-toiminnolla 
(Wi-Fi Protected Setup).
Execute: Suorita toiminto.

Network >Wireless LAN
Määrittää langattomiin lähiverkkoyhteyksiin liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

NFC Execute / Cancel Muodostaa yhteyden NFC-toiminnolla 
(Near Field Communication).
Execute: Suorita toiminto.

MAC Address Näyttää videokameran langattoman 
lähiverkkoliittymän MAC-osoitteen.

Network >AP Mode Settings
Määrittää tukiasematilaan liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

Channel Auto(5GHz) / Auto / CH1 / CH2 /  
CH3 / CH4 / CH5 / CH6 / CH7 / CH8 / CH9 / 
CH10 / CH11

Määrittää langattoman lähiverkon 
kanavan.
Auto(5GHz) on saatavilla vain ILME‑FX6V/
VK-laitteessa.

Camera SSID 
& Password

Näyttää videokameran SSID:n ja 
salasanan.

Regenerate 
Password

Execute / Cancel Luo uuden salasanan.
Execute: Suorita toiminto.

IP Address Näyttää videokameran IP-osoitteen 
tukiasematilassa.

Subnet Mask Näyttää videokameran aliverkon peitteen 
tukiasematilassa.



6. Valikkonäyttö ja asetukset: Network-valikko103

Network >ST Mode Settings
Määrittää asematilaan liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

Camera 
Remote 
Control

Enable / Disable Määrittää, otetaanko käyttöön 
videokameraan langattomalla 
lähiverkkoyhteydellä liitetyn laitteen 
kauko-ohjain asematilassa.

Connected 
Network

Näyttää yhteydessä olevan langattoman 
lähiverkon (tukiasema).

SSID Näyttää sen tukiaseman SSID:n, johon 
muodostetaan yhteys.

Security Näyttää sen tukiaseman suojaustyypin, 
johon muodostetaan yhteys.

Password Näyttää sen tukiaseman salasanan, johon 
muodostetaan yhteys.
Kun kohdan Security asetuksena on WEP 

tai WPA: *******
Kun kohdan Security asetuksena on 

None: (tyhjä)

DHCP Näyttää, onko DHCP päällä / pois päältä.

IP Address Näyttää videokameran IP-osoitteen, kun 
DHCP-asetukseksi on määritetty Off.

Subnet Mask Näyttää videokameran aliverkon 
peitteen, kun DHCP-asetukseksi on 
määritetty Off.

Gateway Näyttää videokameran 
oletusyhdyskäytävän, kun DHCP-
asetukseksi on määritetty Off.

DNS Auto Näyttää, onko DNS-saanti päällä / pois 
päältä.

Primary DNS Server Näyttää videokameran ensisijaisen 
DNS-palvelimen, kun DNS 
Auto -asetukseksi on määritetty Off.

Secondary DNS Server Näyttää videokameran toissijaisen 
DNS-palvelimen, kun DNS 
Auto -asetukseksi on määritetty Off.

Network >ST Mode Settings
Määrittää asematilaan liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

Scan 
Networks

Havaitsee langattomia lähiverkkoja 
(tukiasemia) ja näyttää luettelon.
Valitse luettelosta kohde, johon 
muodostetaan yhteys.

SSID Näyttää sen tukiaseman SSID:n, johon 
muodostetaan yhteys.

Security Näyttää sen tukiaseman suojaustyypin, 
johon muodostetaan yhteys.

Password Syötä sen tukiaseman salasana, johon 
muodostetaan yhteys.

DHCP 
On / Off

Kytkee DHCP:n päälle / pois päältä.

IP Address Syötä videokameran IP-osoite, kun DHCP-
asetukseksi on määritetty Off.

Subnet Mask Syötä videokameran aliverkon peite, kun 
DHCP-asetukseksi on määritetty Off.

Gateway Syötä videokameran oletusyhdyskäytävä, 
kun DHCP-asetukseksi on määritetty Off.

DNS Auto 
On / Off

Kytkee DNS-saannin päälle / pois päältä.

Primary DNS Server Syötä videokameran ensisijainen DNS-
palvelin, kun DNS Auto -asetukseksi on 
määritetty Off.

Secondary DNS Server Syötä videokameran toissijainen DNS-
palvelin, kun DNS Auto -asetukseksi on 
määritetty Off.
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Network >ST Mode Settings
Määrittää asematilaan liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

Manual 
Register

Rekisteröi asetukset, joilla muodostetaan 
yhteys tukiasemaan käsin.

SSID Syötä sen tukiaseman SSID, johon 
muodostetaan yhteys.

Security 
None / WEP / WPA

Määritä suojaustyyppi sille tukiasemalle, 
johon muodostetaan yhteys. Valitse WPA, 
jos kohteena olevan tukiaseman 
suojaustyyppi on WPA tai WPA2.

Password Syötä salasana sille tukiasemalle, johon 
muodostetaan yhteys.

DHCP 
On / Off

Kytkee DHCP:n päälle / pois päältä.

IP Address Syötä videokameran IP-osoite, kun DHCP-
asetukseksi on määritetty Off.

Subnet Mask Syötä videokameran aliverkon peite, kun 
DHCP-asetukseksi on määritetty Off.

Gateway Syötä videokameran oletusyhdyskäytävä, 
kun DHCP-asetukseksi on määritetty Off.

DNS Auto 
On / Off

Kytkee DNS-saannin päälle / pois päältä.

Primary DNS Server Syötä ensisijainen DNS-palvelin, kun DNS 
Auto -asetukseksi on määritetty Off.

Secondary DNS Server Syötä toissijainen DNS-palvelin, kun DNS 
Auto -asetukseksi on määritetty Off.

Network >Wired LAN
Määrittää lankaverkkoyhteyksiin liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

Setting On / Off Kytkee lankaverkkotoiminnon 
päälle / pois päältä.

Camera 
Remote 
Control

Enable / Disable Määrittää, otetaanko käyttöön 
videokameraan lankaverkkoyhteydellä 
liitetyn laitteen kauko-ohjain.

Detail 
Settings

Määrittää lankaverkkoyhteyden 
ominaisuudet.

DHCP 
On / Off

Kytkee DHCP:n päälle / pois päältä.

IP Address Syötä videokameran IP-osoite, kun DHCP-
asetukseksi on määritetty Off.

Subnet Mask Syötä videokameran aliverkon peite, kun 
DHCP-asetukseksi on määritetty Off.

Gateway Syötä videokameran oletusyhdyskäytävä, 
kun DHCP-asetukseksi on määritetty Off.

DNS Auto 
On / Off

Kytkee DNS-saannin päälle / pois päältä.

Primary DNS Server Syötä ensisijainen DNS-palvelin, kun DNS 
Auto -asetukseksi on määritetty Off.

Secondary DNS Server Syötä toissijainen DNS-palvelin, kun DNS 
Auto -asetukseksi on määritetty Off.

Network >Modem
Määrittää USB-yhteydenjakoon liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

Setting On / Off Kytkee älypuhelinyhteyden päälle / pois 
päältä.

Camera 
Remote 
Control

Enable / Disable Määrittää kauko-ohjausoikeuden USB-
yhteydenjaon kautta 
älypuhelinsovelluksella, kuten CBM 
(Content Browser Mobile) tai C3 Portal 
App.

Device Name Näyttää älypuhelimen laitenimen.

IP Address Näyttää älypuhelimen IP-osoitteen.

Subnet Mask Näyttää älypuhelimen aliverkon peitteen.
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Network >File Transfer
Määrittää tiedostonsiirtoihin liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

Auto Upload On / Off Kytkee alkuperäistiedostojen 
automaattisen latauksen päälle / pois 
päältä.

[Huomautus]
Kun Project-valikon kohdan Simul Rec > Setting 
(sivu 84) asetuksena on On, paikassa B 
olevalle tietovälineelle tallennettuja leikkeitä ei 
ladata palvelimelle automaattisesti.

Auto Upload 
(Proxy)

On / Off / Chunk On:
Kytkee välityspalvelintiedoston 
automaattisen latauksen päälle.

Off:
Kytkee välityspalvelintiedoston 
automaattisen latauksen pois päältä.

Chunk:
Muistiyksikköinä tallennettu 
välityspalvelintiedosto ladataan 
palvelimelle automaattisesti.

[Huomautus]
Kun Project-valikon kohdan Simul Rec > Setting 
(sivu 84) asetuksena on On, paikassa B 
olevalle tietovälineelle tallennettuja leikkeitä 
ei ladata palvelimelle automaattisesti. Lisäksi 
Chunk näkyy harmaana eikä sitä voi valita.

Default 
Upload 
Server

Valitsee tiedostojen latauksen 
kohdepalvelimen. Tässä valitusta 
palvelimesta tulee alkuperäisten 
tiedostojen ja välityspalvelintiedostojen 
automaattisen latauksen kohdepalvelin 
ja pikkukuvanäytöstä ladattavien 
tiedostojen kohdepalvelin.
Näyttää näyttönimen, joka on määritetty 
Server Settings -asetuksissa 1–3.

Clear 
Completed 
Jobs

Execute / Cancel Tyhjentää valmiit siirtotyöt luettelosta.
Execute: Suorita toiminto.

Clear All Jobs Execute / Cancel Tyhjentää kaikki siirtotyöt luettelosta.
Execute: Suorita toiminto.

View Job List Näyttää siirtotyöluettelon.

Network >File Transfer
Määrittää tiedostonsiirtoihin liittyvät asetukset.

Kohde Alakohteen asetus Kuvaus

Server 
Settings1

Display Name Määrittää siirtokohteen määritysvalikossa 
näkyvän näyttönimen.

Service 
FTP

Näyttää palvelimen tyypin.

Host Name Määrittää siirtokohteen palvelimen 
isäntänimen.

Port (1–65535 (21)) Määrittää siirtokohteen palvelimen portin 
numeron.

User Name Määrittää käyttäjänimen siirtokohteen 
palvelinyhteyden todennukseen.

Password Määrittää salasanan siirtokohteen 
palvelinyhteyden todennukseen.

Passive Mode 
On / Off

Kytkee PASV-tilan päälle / pois päältä.

Destination Directory Syötä siirtokohteen hakemiston nimi.

Using Secure Protocol 
On / Off

Määrittää, käytetäänkö (On) vai eikö 
käytetä (Off) suojattua FTP-siirtoa (FTPS 
Explicit Mode: FTPES).

Root Certificate 
Load / Clear / None

Lataa päävarmenteen suojattua FTP-
siirtoa varten ja tyhjentää asetukset.

Root Certificate Status 
Loaded / No Certificate

Näyttää päävarmenteen latautumistiedot 
suojattua FTP-siirtoa varten.

Reset 
Execute / Cancel

Palauttaa Server Settings -asetukset 
oletuksiksi.
Execute: Suorita toiminto.

Server 
Settings2

Sama kuin Server Settings1.

Server 
Settings3

Sama kuin Server Settings1.

Network >Network Reset
Palauttaa verkkoasetukset.

Kohde Alakohteen asetus Kuvaus

Reset Execute / Cancel Palauttaa verkkoasetukset.
Execute: Suorita toiminto.
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Tässä osiossa kuvataan kunkin valikkokohteen toiminnot ja asetukset.
Tehdasoletusasetukset on lihavoitu (esimerkiksi 18dB).

Maintenance >Language
Määrittää näyttökielen.

Kohde Alakohteen asetus Kuvaus

Select Määrittää näyttökielen.
SET: Määritä kieli.

Maintenance >Clock Set
Määrittää sisäisen kellon asetukset.

Kohde Alakohteen asetus Kuvaus

Time Zone UTC – 12:00 – UTC + 14:00 Määrittää aikaeron UTC-aikaan 30 
minuutin jaksoissa.

Date Mode YYMMDD / MMDDYY / DDMMYY Valitsee päivämäärien näyttömuodon.
YYMMDD: vuosi, kuukausi, päivä
MMDDYY: kuukausi, päivä, vuosi
DDMMYY: päivä, kuukausi, vuosi

12h/24h 12h / 24h Valitsee kellon näyttömuodon.
12h: 12 tunnin tila
24h: 24 tunnin tila

Date Määrittää kuluvan päivän päivämäärän.
SET: Määritä arvo.

Time Määrittää tämänhetkisen kellonajan.
SET: Määritä arvo.

Maintenance >All Reset
Palauttaa asetukset tehdasoletuksiin.

Kohde Alakohteen asetus Kuvaus

Reset Execute / Cancel Palauttaa kaikki asetukset 
tehdasoletuksiinsa.
Execute: Suorita toiminto.

[Huomautus]
3D LUT -tiedostoa, joka on tuotu Paint/
Look-valikon toiminnolla Base Look > Import 
from Media(B), Import from Cloud(Private) tai 
Import from Cloud(Share) (sivu 89), ei voi 
poistaa. Poista kaikki tuodut 3D LUT -tiedostot 
valitsemalla koko valikon Paint/Look-valikossa 
kohta Base Look > Delete All (sivu 89).

Reset without 
Network

Execute / Cancel Palauttaa valikkoasetukset 
tehdasoletuksiin, pois lukien Network-
valikon asetukset.

Maintenance >Hours Meter
Näyttää kertyneen käyttöajan.

Kohde Alakohteen asetus Kuvaus

Hours 
(System)

Näyttää kertyneet käyttötunnit (ei voida 
nollata).

Hours(Reset) Näyttää kertyneet käyttötunnit (voidaan 
nollata).

Reset Execute / Cancel Palauttaa Hours(Reset) -näytön arvoon 0.
Execute: Suorita toiminto.

Maintenance >Version
Näyttää versiotiedot.

Kohde Alakohteen asetus Kuvaus

Version 
Number

Vx.xx Näyttää videokameran ohjelmistoversion.

Version Up Execute / Cancel Päivittää videokameran.*

Execute: Suorita toiminto.
*	 Tämä toiminto päivittää videokameran 

ohjelmiston.

Lens Version 
Number

Vxx Näyttää E-pidikkeellisen objektiivin 
ohjelmistoversion numeron.

Maintenance-valikko
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Shooting-valikon asetukset ja oletusarvot

ISO/Gain-asetukset ja oletusarvot

ISO/Gain (sivu 77) -asetusalue ja oletusarvot vaihtelevat riippuen kohtien Mode, Target Display, Base Look >Select ja Base Sensitivity asetuksista. Saatavilla olevat vaihtoehdot on korostettu 
harmaalla.

Kun kohdan Mode asetuksena on ISO

Target Display SDR(BT.709) HDR(HLG) SDR(BT.709) ja HDR(HLG) yhdessä

Base Look >Select S-Cinetone / Standard / ITU709 / Still HLG Live / HLG Natural User1–User16

Base Sensitivity Low High Low High Low High

ISO 320 ISO/Gain<L>-oletus

ISO 400

ISO 500

ISO 640 ISO/Gain<M>-oletus

ISO 800 ISO/Gain<L>-oletus ISO/Gain<L>-oletus

ISO 1000

ISO 1250 ISO/Gain<H>-oletus

ISO 1600 ISO/Gain<M>-oletus ISO/Gain<M>-oletus

ISO 2000

ISO 2500

ISO 3200 ISO/Gain<H>-oletus ISO/Gain<H>-oletus

ISO 4000

ISO 5000 ISO/Gain<L>-oletus

ISO 6400

ISO 8000

ISO 10000 ISO/Gain<M>-oletus

ISO 12800 ISO/Gain<L>-oletus ISO/Gain<L>-oletus

ISO 16000

ISO 20000 ISO/Gain<H>-oletus

ISO 25600 ISO/Gain<M>-oletus ISO/Gain<M>-oletus

ISO 32000

ISO 40000

ISO 51200 ISO/Gain<H>-oletus ISO/Gain<H>-oletus

ISO 64000

ISO 80000

ISO 102400

ISO 128000

ISO 160000

ISO 204800

ISO 256000

ISO 320000

ISO 409600
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Kun kohdan Mode asetuksena on dB

Asetusalue

–3dB

–2dB

–1dB

0dB ISO/Gain<L>-oletus

1dB

2dB

3dB

4dB

5dB

6dB ISO/Gain<M>-oletus

7dB

8dB

9dB

10dB

11dB

12dB ISO/Gain<H>-oletus

13dB

14dB

15dB

16dB

17dB

18dB

19dB

20dB

21dB

22dB

23dB

24dB

25dB

26dB

27dB

28dB

29dB

30dB
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AGC Limit -asetukset ja oletusarvot

AGC Limit (sivu 79) -asetusten alue ja oletusarvot vaihtelevat riippuen kohtien Mode, Target Display, Base Look >Select ja Base Sensitivity asetuksista. Saatavilla olevat vaihtoehdot on korostettu 
harmaalla.

Kun kohdan Mode asetuksena on ISO

Target Display SDR(BT.709) HDR(HLG) HDR(HLG) SDR(BT.709) ja HDR(HLG) yhdessä

Base Look >Select S-Cinetone / Standard / ITU709 / Still HLG Live HLG Natural User1–User16

Base Sensitivity Low High Low High Low High Low High

ISO 400

ISO 500

ISO 640

ISO 800

ISO 1000

ISO 1250

ISO 1600

ISO 2000 Oletus

ISO 2500

ISO 3200

ISO 4000

ISO 5000 Oletus Oletus Oletus

ISO 6400

ISO 8000

ISO 10000

ISO 12800

ISO 16000

ISO 20000

ISO 25600

ISO 32000 Oletus

ISO 40000

ISO 51200

ISO 64000

ISO 80000 Oletus Oletus Oletus

ISO 102400

ISO 128000

ISO 160000

ISO 204800

ISO 256000

ISO 320000

ISO 409600
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Kun kohdan Mode asetuksena on dB

Asetusalue

3dB

6dB

9dB

12dB

15dB Oletus

18dB

21dB

24dB

27dB

30dB
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Kullekin kuvaustilalle tallennetut kuvanlaatuasetukset
Kuvanlaatuun liittyvien määrityskohteiden nykyinen tila tallennetaan kullekin seuraavista kuvaustiloista (sivu 24). Kun vaihdat kuvaustilaa, sitä vastaavat tallennetut asetukset otetaan käyttöön.
ˎˎ Custom-tila SDR(BT.709)
ˎˎ Custom-tila HDR(HLG)
ˎˎ Cine EI -tila

Alla näkyvät kullekin kuvaustilalle tallennetut kuvanlaatuun liittyvät määrityskohteet.
Kyllä: Kohde on tallennettu.
Ei: Kohdetta ei ole tallennettu.

Määrityskohde Kuvaustila

Custom-tila Cine EI -tila

SDR(BT.709) HDR(HLG)

Shooting-valikko ISO/Gain/EI ISO/Gain Kyllä1) Ei

Exposure Index Ei Kyllä

Base Sensitivity Kyllä Ei

Base ISO Ei Kyllä

White Preset White Kyllä Kyllä

Muu kuin yllä Kyllä

White Setting Kyllä

Offset White Kyllä Ei

LUT On/Off Ei Kyllä

Noise Suppression Setting(Custom) Kyllä Kyllä Ei

Level(Custom) Kyllä Kyllä Ei

Setting(Cine EI) Ei Kyllä

Level(Cine EI) Ei Kyllä

Paint/Look-valikko Base Look Select Kyllä Kyllä Kyllä

Input2) Kyllä

Output2) Kyllä

AE Level Offset2) Kyllä

Black Kyllä Kyllä Ei

Knee Auto Knee Kyllä Ei Ei

Muu kuin yllä Kyllä Kyllä Ei

Detail Kyllä Kyllä Ei

Matrix Kyllä Kyllä Ei

Multi Matrix Kyllä Kyllä Ei

1)	 Erilliset ISO-herkkyden asetukset tallennetaan molempiin Custom-tiloihin SDR(BT.709) ja HDR(HLG).
2)	Asetukset tallennetaan kuhunkin Base Look -kohtaan eivätkä ne riipu kuvaustilasta.
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Määritystiedot

Voit tallentaa koko valikon asetukset CFexpress 
Type A- / SD-korttipaikkaan (B) asetetulle 
muistikortille. Voit myös tallentaa ALL-
tiedoston pilvipalveluun. Näin voit nopeasti 
palauttaa kulloiseenkin tilanteeseen sopivat 
valikkoasetukset.
Määritystiedot tallennetaan seuraaviin 
kategorioihin.

Käyttäjätiedostot
Käyttäjätiedostot tallentavat mukautettavan 
User-valikon asetuskohteet ja tiedot.
Voit tallentaa muistikortille enintään 
64 tiedostoa.
Lataamalla tiedoston videokameran muistiin 
voit mukauttaa User-valikon määrityksiä.

ALL-tiedostot (kaikki asetukset)
ALL-tiedostot tallentavat kaikkien 
valikkojen määritystiedot. Voit tallentaa 
muistikortille enintään 64 tiedostoa. C3 Portal 
-pilvipalveluun voi tallentaa enintään 120 
tiedostoa, mikä käsittää enintään 60 yksityistä 
tiedostoja ja 60 jaettua tiedostoa.

[Huomautus]
Lisätietoja ALL-tiedostoon tallennettavasta sisällöstä on 
kohdassa ”Tiedostoihin tallennetut kohteet” (sivu 124).

Käyttäjätiedoston/ALL-tiedoston 
tallentaminen

Tallentaminen muistikortille

1	 Aseta muistikortti CFexpress Type- / SD-
korttipaikkaan (B) (sivu 6).
ˎˎ CFexpress-korteissa tarrapuoli tulee 
vasemmalle.
ˎˎ SD-korteissa tarrapuoli tulee oikealle ja 
viistetty kulma alaspäin.

2	 Valitse käyttäjätiedostoa varten koko 
valikon Project-valikossa User File > Save 
to Media(B) (sivu 88) > Execute.
Valitse ALL-tiedostoa varten koko valikon 
Project-valikossa All File > Save to 
Media(B) (sivu 88) > Execute.
Näkyviin tulee tiedoston 
tallennuskohdenäyttö.

3	 Valitse tallennuskohdenäytöstä rivi ”No 
File”.
Jos valitset rivin, jolle on syötetty 
tiedostotunnus, valittu rivi korvataan.
Tallennettaessa määritettyä File ID:tä voi 
muuttaa valikossa. Tietoja määrityksestä, 
ks. ”File ID:n muuttaminen” (sivu 113).

4	 Valitse vahvistusnäytössä Execute.

ALL-tiedoston tallentaminen 
pilvipalveluun

1	 Muodosta yhteys laitteeseen C3 Portal 
App -älypuhelinsovelluksesta (sivu 67).

2	 Valitse koko valikon Project-valikossa All 
File > Save to Cloud(Private) tai Save to 
Cloud(Share) (sivu 88) > Execute.
Näkyviin tulee tiedoston 
tallennuskohdenäyttö.

3	 Valitse tallennuskohdenäytöstä rivi ”No 
File”.
Jos valitset rivin, jolle on syötetty 
tiedostotunnus, valittu rivi korvataan.
Tallennettaessa määritettyä File ID:tä voi 
muuttaa valikossa. Tietoja määrityksestä, 
ks. ”File ID:n muuttaminen” (sivu 113).

4	 Valitse vahvistusnäytössä Execute.

Käyttäjätiedoston/ALL-tiedoston 
lataaminen

Lataaminen muistikortilta

1	 Aseta muistikortti, johon tiedosto on 
tallennettu, CFexpress Type- / SD-
korttipaikkaan (B) (sivu 6).
ˎˎ CFexpress-korteissa tarrapuoli tulee 
vasemmalle.
ˎˎ SD-korteissa tarrapuoli tulee oikealle ja 
viistetty kulma alaspäin.

2	 Valitse käyttäjätiedostoa varten koko 
valikon Project-valikossa kohta User File > 
Load from Media(B) (sivu 88) > Execute.
Valitse ALL-tiedostoa varten koko valikon 
Project-valikossa kohta All File > Load 
from Media(B) (sivu 88) > Execute.
Näkyviin tulee tiedostoluettelonäyttö.

3	 Valitse ladattava tiedosto.
Näkyviin tulee vahvistusnäyttö.

4	 Valitse Execute.

[Huomautuksia]
ˎˎ Laite käynnistyy automaattisesti uudelleen 

määritystietojen lataamisen jälkeen.
ˎˎ Kun koko valikon Project-valikossa kohdan All File > 

Load Network Data asetuksena on Off, kaikki ALL-
tiedoston asetukset ladataan, pois lukien Network-
valikon asetukset.

Määritystietojen tallentaminen ja lataaminen
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ALL-tiedoston lataaminen 
pilvipalvelusta

1	 Muodosta yhteys laitteeseen C3 Portal 
App -älypuhelinsovelluksesta (sivu 67).

2	 Valitse koko valikon Project-valikossa All 
File > Load from Cloud(Private) tai Load 
from Cloud(Share) (sivu 88) > Execute.
Näkyviin tulee tiedostoluettelonäyttö.

3	 Valitse ladattava tiedosto.
Näkyviin tulee vahvistusnäyttö.

4	 Valitse Execute.

[Huomautuksia]
ˎˎ Laite käynnistyy automaattisesti uudelleen 

määritystietojen lataamisen jälkeen.
ˎˎ Kun koko valikon Project-valikossa kohdan All File > 

Load Network Data asetuksena on Off, kaikki ALL-
tiedoston asetukset ladataan, pois lukien Network-
valikon asetukset.

File ID:n muuttaminen

1	 Valitse käyttäjätiedostoa varten koko 
valikon Project-valikossa kohta User File > 
File ID (sivu 88).
Valitse ALL-tiedostoa varten koko valikon 
Project-valikossa kohta All File > File ID 
(sivu 88).
Näkyviin tulee File ID:n muokkausnäyttö.

2	 Valitse merkki monivalitsimella 
(sivu 7) tai monitoimisäätimellä 
(sivu 5), ja paina sitten monivalitsimen 
käytä-painiketta tai monitoimisäädintä.

3	 Toista vaihe 2 tarvittaessa.

4	 Kun merkkien syöttäminen on valmis, 
valitse Done.
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Ulkoisten näyttöjen ja tallennuslaitteiden liittäminen
Jotta voit näyttää tallennettua/toistettavaa 
kuvaa ulkoisessa näytössä, liitä näyttö 
valitsemalla videokameran lähtösignaali ja 
käyttämällä sopivaa kaapelia.
Voit liittää myös tallennuslaitteita, kuten 
kuvanauhurin, ja tallentaa lähtösignaalia 
videokamerasta.
Voit näyttää ulkoisella näytöllä samat tiedot, 
joka näkyvät etsimessä, kuten tilatiedot ja 
valikot. Määritä Monitoring Status -näytön 
kohdan Info. Disp. (sivu 15) tai koko 
valikon Monitoring-valikossa kohdan Output 
Display (sivu 93) asetukseksi On näyttöön 
lähetettävän signaalin mukaisesti.

[Huomautus]
Noudata seuraavia ohjeita, kun yhdistät laitteeseen 
ulkoisen näytön tai tallennuslaitteen. Niiden laiminlyönti 
saattaa vahingoittaa laitteen sisäisiä virtapiirejä.
–– Käytä ulkoisen näytön tai tallennuslaitteen 

liittämiseen DC-kaapelia, jolla on alhainen GND-
linjaimpedanssi.

–– Varmista ennen 75 Ω koaksiaalikaapelin tai HDMI-
kaapelin kytkemistä, ettei laitteen ja ulkoisen näytön 
tai tallennuslaitteen kotelon välillä ole potentiaalieroa.

–– Varmista ennen 75 Ω koaksiaalikaapelin tai HDMI-
kaapelin kytkemistä, että laitteen sekä ulkoisen 
näytön tai tallennuslaitteen virta on katkaistu. Kytke 
kaikki kaapelit ja käynnistä sitten kukin laite.

Lisätietoja saat ottamalla yhteyttä Sonyn 
palveluedustajaan.

SDI OUT -liitin (BNC)

Määritä lähdön on/off-asetus ja lähtömuoto 
Monitoring-valikossa (sivu 93).
Käytä liitäntään kaupallisesti saatavilla olevaa 
75 Ω:n koaksiaalikaapelia.

Tallennuksen aloittaminen 
samanaikaisesti videokameralla ja 
ulkoisella laitteella

Kun SDI-signaalin lähtö on käytössä, määritä 
koko valikon Project-valikossa kohdan SDI/
HDMI Rec Control (sivu 85) > Setting 
asetukseksi SDI/HDMI Remote I/F tai 
Parallel Rec, jotta voit ottaa käyttöön REC-
liipaisusignaalin lähdön ulkoiseen laitteeseen, 
joka on liitetty SDI OUT -liittimeen. Tämä 
synkronoi tallentamisen ulkoiseen laitteeseen 
yhdessä videokameran kanssa.

[Huomautuksia]
ˎˎ Jos liitetty ulkoinen laite ei tue REC-liipaisusignaalia, 

laitetta ei voi käyttää.
ˎˎ Vain REC-liipaisusignaali lähetetään silloin, kun 

tietovälinettä ei ole asennettuna.

HDMI OUT -liitin (Type A -liitin)

Määritä lähdön On/Off-asetus ja lähtömuoto 
koko valikon Monitoring-valikossa (sivu 93).

Tallennuksen aloittaminen 
samanaikaisesti videokameralla ja 
ulkoisella laitteella

Kun HDMI-signaalin lähtö on käytössä, määritä 
koko valikon TC/Media-valikossa kohdan HDMI 
TC Out > Setting (sivu 91) asetukseksi On 
ja Project-valikossa kohdan SDI/HDMI Rec 
Control > Setting (sivu 85) asetukseksi SDI/
HDMI Remote I/F tai Parallel Rec, jotta voit 
ottaa käyttöön REC-liipaisusignaalin lähdön 
ulkoiseen laitteeseen, joka on liitetty HDMI 
OUT -liittimeen. Tämä synkronoi tallentamisen 
ulkoiseen laitteeseen yhdessä videokameran 
kanssa.

[Huomautuksia]
ˎˎ Jos liitetty ulkoinen laite ei tue REC-liipaisusignaalia, 

laitetta ei voi käyttää.
ˎˎ Kun asetuksena on SDI/HDMI Remote I/F, vain REC-

liipaisusignaali lähetetään silloin, kun tallennuksen 
tietovälinettä ei ole asetettu paikalleen.
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Aikakoodien synkronoiminen
Voit synkronoida laitteen aikakoodin muiden 
laitteiden kanssa.

Aikakoodin lukitseminen muihin 
laitteisiin

Määritä aikakoodin antava laite tilaan, jossa 
aikakoodin lähtö pysyy toiminnassa (kuten 
Free Run tai Clock).

1	 Määritä koko valikon TC/Media-valikossa 
kohta Timecode (sivu 91) seuraavasti.
Mode: Preset
Run: Free Run

2	 Näytä aikakoodi näytöllä painamalla 
nimettävää painiketta (sivu 49), jolle 
DURATION/TC/U-BIT toiminto on nimetty.

3	 Tarkista, että TC IN/OUT -valintakytkin 
(sivu 4) on asennossa IN, ja syötä 
viiteaikakoodi videokameran järjestelmän 
taajuuden synkronoimiseksi TC IN/TC 
OUT -liittimeen.

Videokameran aikakoodigeneraattori saa 
lukituksen viiteaikakoodiin, ja näytöllä näkyy 
”EXT-LK”.
Kun noin kymmenen sekuntia on kulunut 
aikakoodin lukituksen jälkeen, ulkoisen 
lukituksen tila säilyy, vaikka ulkoisen 
viiteaikakoodin lähteen yhteys katkeaisi.

[Huomautuksia]
ˎˎ Kun käytät ulkoista lukitusta, aikakoodi saa heti 

lukituksen ulkoiseen aikakoodiin ja ulkoisen 
aikakoodin arvo näkyy datanäytön alueella. Älä 
kuitenkaan aloita tallentamista välittömästi. 
Odota ennen tallentamista muutama sekunti, että 
aikakoodigeneraattori tasaantuu.
ˎˎ Jos viiteaikakoodin taajuus ja videokameran 

kuvataajuus eivät ole samat, lukitus ei onnistu eikä 
videokamera toimi kunnolla. Jos näin käy, aikakoodin 
lukitus ulkoiseen aikakoodiin ei onnistu.
ˎˎ Aikakoodi voi muuttua yhden kuvan verran tunnissa 

viiteaikakoodin suhteen.

Ulkoisen lukituksen vapauttaminen

Muuta Timecode-asetusta koko valikon TC/
Media-valikossa.
Ulkoinen synkronointi vapautuu myös, jos 
järjestelmän taajuus muuttuu ja kun alat 
tallentaa erikoistallennustilassa (hidastus ja 
nopeutus tai Interval Rec).

Toisen laitteen aikakoodin 
synkronoiminen videokameran 
aikakoodin kanssa

Määritä aikakoodin antava laite tilaan, jossa 
aikakoodin lähtö pysyy toiminnassa (kuten 
Free Run tai Clock).

1	 Määritä videokameran aikakoodi koko 
valikon TC/Media-valikossa kohdassa 
Timecode (sivu 91).

2	 Tarkista, että TC IN/OUT -valintakytkin 
(sivu 4) on asennossa OUT, ja liitä TC 
IN/TC OUT -liitin synkronoitavan laitteen 
aikakoodin tuloliittimeen.
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Leikkeiden hallitseminen/muokkaaminen tietokoneella

Yhteyden muodostaminen  
USB-kaapelilla

Kortinlukijan käyttäminen (lisävaruste)

Liitä CFexpress-kortinlukija tai SD-
kortinlukija tietokoneeseen USB-kaapelilla 
ja aseta muistikortti kortinlukijan aukkoon. 
Järjestelmä tunnistaa muistikortin tietokoneen 
lisäasemana. Tuetuilla tietokoneilla voit tuoda 
leikkeitä suurella nopeudella käyttämällä 
videokameran massamuistitilaa.

Massamuistitilan käyttäminen

[Huomautus]
Massamuistitilaa ei voida käyttää, kun koko valikon 
Network-valikossa kohdan Modem > Setting asetuksena 
on On tai kun Network-valikossa kohdan Wired LAN 
> Setting asetuksena on On. Määritä molempiin 
asetukseksi Off.

Liitä videokamera USB-kaapelilla ja aseta 
muistikortti korttipaikkaan A tai B. Järjestelmä 
tunnistaa muistikortin tietokoneen 
lisäasemana.

1	 Liitä USB-C-liitin (sivu 7) tai USB-/
multiliitin (sivu 7) tietokoneeseen 
USB-kaapelilla.

2	 Siirrä videokameran POWER-kytkin ON-
asentoon.
Etsimen näyttöön tulee viesti, jossa 
kysytään, otetaanko USB-yhteys käyttöön.

	 [Huomautus]
USB-yhteyden vahvistusviestiä ei näytetä, jos 
toinen vahvistusviesti tai etenemisviesti on 
näkyvissä, esimerkiksi muistikortin formatoinnin tai 
palauttamisen yhteydessä.
Vahvistusviesti näytetään, kun formatoiminen tai 
palauttaminen päättyy. USB-vahvistusviestiä ei 
näytetä myöskään, kun leikkeen ominaisuuksien 
näyttö on näkyvissä. Viesti näytetään, kun 

meneillään oleva toiminto päättyy tai kun palaat 
pikkukuvanäyttöön.

3	 Valitse Execute kääntämällä 
monitoimisäädintä.

4	 Tarkista Windows-koneessa, että kortti on 
lisätty siirrettävänä levynä ”Oma 
tietokone” -ikkunaan.
Tarkista Mac-koneessa, että työpöydälle 
on luotu kansio nimeltä ”NO NAME” tai 
”Untitled” (muokattava).

[Huomautuksia]
ˎˎ Älä tee seuraavia toimenpiteitä, jos käytön ilmaisin 

palaa punaisena.
–– Virran sammuttaminen tai virtajohdon irrottaminen
–– Muistikortin poistaminen
–– USB-kaapelin irrottaminen

ˎˎ Toimintaa ei voida taata kaikilla tietokoneilla.

Non-lineaarisen 
editointijärjestelmän käyttäminen

Non-lineaarisessa editointijärjestelmässä 
tarvitaan editointiohjelmisto (lisävaruste), joka 
tukee videokameran tallentamia muotoja.
Käytä siihen tarkoitettua sovellusohjelmistoa 
tallentaaksesi leikkeitä, joita haluat editoida 
tietokoneen kiintolevyllä etukäteen.
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Käyttöä koskevat varoitukset
Kondensaatiosta

Jos laite siirretään suoraan kylmästä 
lämpimään paikkaan tai ympäristön lämpötila 
nousee yhtäkkiä, laitteen pinnalle ja/tai sisälle 
saattaa muodostua kosteutta. Tätä kutsutaan 
kosteuden kondensoitumiseksi. Jos huomaat 
kondensoitumista, katkaise virta laitteesta 
äläkä käytä sitä, ennen kuin kondenssi on 
haihtunut. Jos laitetta käytetään, kun siinä on 
kondenssia, laite saattaa vahingoittua.

LCD-paneeleista

Tähän laitteeseen asennettu nestekidenäyttö 
on valmistettu tarkkuustekniikalla, jonka 
johdosta toimivien kuva-alkioiden suhde on 
vähintään 99,99%. Täten näytössä saattaa 
olla hyvin pieni osuus kuva-alkioita, jotka ovat 
"jumiutuneet" joko aina pois päältä (musta), 
aina päälle (punainen, vihreä tai sininen) tai 
vilkkumaan. Lisäksi pitkän käyttöajan kuluessa 
nestekidenäytön fyysisten ominaisuuksien 
vuoksi tällaisia ”jumiutuneita” kuva-alkioita 
saattaa ilmestyä itsestään. Nämä ongelmat 
eivät ole toimintavika. Ne eivät vaikuta 
tallennettuihin tietoihin.

Kameran CMOS-kuvakennon ilmiöt

[Huomautus]
Seuraavat kuvissa mahdollisesti näkyvät ilmiöt ovat 
ominaisia kuvakennoille. Ne eivät ole merkkejä 
toimintahäiriöstä.

Valkoiset täplät
Vaikka kuvakennot edustavat 
huipputeknologiaa, näytölle voi joissakin 
harvinaisissa tapauksissa muodostua hienoisia 
valkoisia täpliä esimerkiksi kosmisen säteilyn 
vuoksi.
Se liittyy kuvakennojen toimintaperiaatteeseen 
eikä kyse ole toimintahäiriöstä.
Valkoisia täpliä näkyy tyypillisesti seuraavissa 
tapauksissa:

ˎˎ Kun laitetta käytetään ympäristön korkeissa 
lämpötiloissa
ˎˎ Kun herkkyysvahvistus on suuri

Välkkyminen
Kun kuvataan loisteputkien, 
natriumlamppujen, elohopealamppujen tai 
LED-valojen valaisemassa ympäristössä, 
näyttö voi välkkyä tai värit voivat vaihdella.

Kulutusosista

ˎˎ Tuuletin ja akku ovat kulutusosia, jotka on 
vaihdettava säännöllisesti.  
Huoneenlämpötilassa käytettäessä normaali 
vaihtoväli on noin 5 vuotta. Tämä vaihtoväli 
on kuitenkin vain ohjeellinen eikä takaa 
näiden osien odotettua käyttöikää. Sonyn 
huoltoliike tai jälleenmyyjä antaa lisätietoja 
osan vaihtamisesta.
ˎˎ Verkkolaitteen ja 
elektrolyyttikondensaattorin odotettu 
käyttöikä on noin 5 vuotta normaaleissa 
käyttölämpötiloissa ja normaalikäytössä (8 
tuntia päivässä ja 25 päivää kuukaudessa). 
Jos edellä mainittu käyttömäärä ylitetään, 
odotettu käyttöikä saattaa lyhentyä 
vastaavasti.
ˎˎ Tämän laitteen akun napa (akkujen ja 
verkkovirtalaitteiden liitin) on kulutusosa.  
Laite ei välttämättä saa kunnolla virtaa, 
jos akun napojen nastat ovat taipuneet tai 
epämuodostuneet iskun tai tärinän vuoksi, 
tai jos ne ovat hapettuneet pitkäaikaisen 
ulkokäytön seurauksena.  
Määräaikaiset tarkastukset ovat 
suositeltavia, jotta laite toimii kunnolla ja 
sen käyttöikä olisi mahdollisimman pitkä. 
Tietoja tarkastuksista saat Sonyn palvelu- tai 
myyntiedustajalta.

Tietoa sisäisestä ladattavasta akusta

Videokamerassa on sisäinen ladattava akku, 
jotta päivämäärä, kellonaika ja muita asetuksia 
pysyy tallessa silloinkin, kun videokamera 
on pois päältä. Sisäinen ladattava akku 
latautuu täyteen 24 tunnissa, jos laite on 
liitetty pistorasiaan verkkovirtalaitteella tai 
jos laitteeseen on kiinnitetty täyteen ladattu 
akku, riippumatta siitä, onko videokamera 
kytketty päälle / pois päältä. Ladattava akku 
purkautuu tyhjäksi noin 2 kuukaudessa, jos 
verkkovirtalaitetta ei liitetä tai videokameraa 
käytetään ilman kiinnitettyä akkua. Käytä 
videokameraa akun lataamisen jälkeen. Vaikka 
ladattua akkua ei ladata, se ei kuitenkaan 
vaikuta videokameran käyttöön, jos 
päivämäärää ei tarvitse tallentaa.

Käyttö- ja säilytyspaikat

Säilytä tasaisessa, tuuletetussa paikassa.
Vältä laitteen käyttöä tai säilytystä seuraavissa 
paikoissa.
ˎˎ Liian kuumassa tai kylmässä 
(käyttölämpötila-alue: 0 °C–40 °C)  
Muista, että kesällä lämpötila voi autossa 
olla ikkunat suljettuina helposti yli 50 °C.
ˎˎ Kosteissa ja pölyisissä paikoissa. Paikoissa, 
joissa laite voi altistua sateelle
ˎˎ Paikoissa, joissa on voimakasta tärinää
ˎˎ Lähellä vahvoja magneettikenttiä
ˎˎ Lähellä radio- tai televisiolähetintä, joka 
muodostaa vahvoja sähkömagneettisia 
kenttiä.
ˎˎ Pitkäaikaisesti suorassa auringonpaisteessa 
tai lähellä lämmittimiä

Huomautus lasersäteistä

Lasersäteet voivat vaurioittaa CMOS-
kuvakennoa. Jos kuvaat lasersäteitä sisältävää 
otosta, ole varovainen äläkä anna lasersäteen 
suuntautua kohti laitteen objektiivia. Erityisesti 
lääketieteellisten laitteiden ja muiden 

laitteiden erittäin voimakkaat lasersäteet 
voivat aiheuttaa vaurioita heijastuvan valon ja 
hajavalon vuoksi.

Kannettavista viestintälaitteista tulevan 
sähkömagneettisen häiriön estäminen

Kannettavien puhelinten ja muiden 
viestintälaitteiden käyttäminen tämän 
kameran lähellä voi aiheuttaa toimintahäiriöitä 
sekä ääni- ja videosignaalien häiriöitä. On 
suositeltavaa, että kannettavien laitteiden virta 
sammutetaan tämän kameran lähellä.

Turvallisuusvaroitukset

ˎˎ SONY EI VASTAA MINKÄÄNLAISISTA 
VAHINGOISTA, JOTKA AIHEUTUVAT 
LÄHETYSLAITTEIDEN ASIANMUKAISTEN 
TURVATOIMENPITEIDEN 
LAIMINLYÖNNISTÄ, LÄHETYSMÄÄRITYSTEN 
AIHUETTAMISTA VÄISTÄMÄTTÖMISTÄ 
TIETOVUODOISTA TAI MINKÄÄNLAISISTA 
TURVALLISUUSONGELMISTA.
ˎˎ Käyttöympäristöstä riippuen verkon 
valtuuttamattomat kolmannet osapuolet 
saattavat pystyä käyttämään laitetta. Kun 
liität laitteen verkkoon, muista varmistaa, 
että verkon tietoturva on suojattu.
ˎˎ Viestinnän sisältö saattaa käyttäjän 
tietämättä joutua signaalien läheisyydessä 
olevien valtuuttamattomien ulkopuolisten 
haltuun. Kun käytät langatonta yhteyttä, 
suojaa viestinnän sisältö asianmukaisilla 
turvatoimenpiteillä.
ˎˎ Yhdistä tuote verkkoon suojaustoiminnolla 
varustetun järjestelmän, esimerkiksi 
reitittimen tai palomuurin, kautta. 
Yhdistäminen ilman tällaista suojausta voi 
johtaa tietoturvaongelmiin.
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Tehdasoletusasetukset on lihavoitu (esimerkiksi 1920×1080P (Level A)).

[Huomautuksia]
ˎˎ Lähtömuodon tarkkuutta rajoittavat koko valikon Project-valikon kohtien Rec Format > Frequency, Codec ja Video 

Format asetukset (sivu 82).
ˎˎ Lähtömuodon tarkkuutta rajoittaa myös yhdistäminen S&Q-kuvataajuuteen. Alla olevan SDI OUT- / HDMI 

OUT -liittimen lähtömuodot -taulukon lisäksi HDMI-lähtömuoto muuttuu Full HD:ksi tai alhaisemmaksi, kun kaikki 
seuraavista ehdoista täyttyvät.
–– Shooting-valikossa kohdan S&Q Motion > Setting asetuksena on On
–– Shooting-valikossa kohdan S&Q Motion > Frame Rate asetus on suurempi kuin 60fps
–– Project-valikossa kohdan Rec Format > Codec asetuksena on RAW tai RAW & XAVC-I, tai Monitoring-valikossa 

kohdan Output On/Off > SDI asetuksena on On
ˎˎ Kun edellä mainitut ehdot täyttyvät, HDMI-lähdön vaihtoehdot 4096×2160P ja 3840×2160P Monitoring-valikon 

kohdassa Output Format > SDI/HDMI (sivu 93) näkyvät harmaina eikä niitä voi valita.
ˎˎ Toistettavaa kuvaa ei lähetetä, jos tarkkuus on määritetty toistettavan kuvan tarkkuutta suuremmaksi.

SDI OUT- / HDMI OUT -liittimen lähtömuodot

Järjestelmän 
taajuusasetus
(Project-valikossa 
Rec Format > 
Frequency)

Koodekkiasetus
(Project-valikossa 
Rec Format > 
Codec)

RAW-/
tallennusmuotoasetus
(Project-valikossa Rec 
Format > RAW Output 
Format/Video Format)

Lähtömuoto (Monitoring-valikossa 
Output Format)

SDI HDMI

50/59.94Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 RAW) 4096×2160P

3840×2160P

1920×1080P

1920×1080i

3840×2160(RAW) (3840×2160 RAW) 3840×2160P

1920×1080P

1920×1080i

RAW(HDMI)
RAW(HDMI) & 
XAVC-I

4240×2392(RAW) 1920×1080P 
(Level A)

(4240×2392 HDMI 
RAW)

1920×1080P 
(Level B)

1920×1080i

Järjestelmän 
taajuusasetus
(Project-valikossa 
Rec Format > 
Frequency)

Koodekkiasetus
(Project-valikossa 
Rec Format > 
Codec)

RAW-/
tallennusmuotoasetus
(Project-valikossa Rec 
Format > RAW Output 
Format/Video Format)

Lähtömuoto (Monitoring-valikossa 
Output Format)

SDI HDMI

50/59.94Hz XAVC-I
XAVC-L

4096×2160(Video) 4096×2160P1) 4096×2160P

4096×2160P 1920×1080P

4096×2160P 1920×1080i

3840×2160P 3840×2160P

3840×2160P 1920×1080P

3840×2160P 1920×1080i

1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level A)

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080P 
(Level B)

1920×1080i

1920×1080i 1920×1080i

3840×2160(Video) 3840×2160P 3840×2160P

3840×2160P 1920×1080P

3840×2160P 1920×1080i

1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level A)

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080P 
(Level B)

1920×1080i

1920×1080i 1920×1080i

Lähtömuodot ja rajoitteet
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Järjestelmän 
taajuusasetus
(Project-valikossa 
Rec Format > 
Frequency)

Koodekkiasetus
(Project-valikossa 
Rec Format > 
Codec)

RAW-/
tallennusmuotoasetus
(Project-valikossa Rec 
Format > RAW Output 
Format/Video Format)

Lähtömuoto (Monitoring-valikossa 
Output Format)

SDI HDMI

50/59.94Hz XAVC-I
XAVC-L

1920×1080(Video) 1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level A)

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080P 
(Level B)

1920×1080i

1920×1080i 1920×1080i

(lähtö pysäytetty) 720×480P1) 2)

720×576P1) 3)

25/29.97Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 RAW) 4096×2160P

3840×2160P

1920×1080P

1920×1080i

3840×2160(RAW) (3840×2160 RAW) 3840×2160P

1920×1080P

1920×1080i

RAW(HDMI)
RAW(HDMI) & 
XAVC-I

4240×2392(RAW) 1920×1080P (4240×2392 HDMI 
RAW)1920×1080PsF

XAVC-I
XAVC-L

4096×2160(Video) 4096×2160P1) 4096×2160P

4096×2160P 1920×1080P

3840×2160P 3840×2160P

3840×2160P 1920×1080P

1920×1080P 1920×1080P

1920×1080PsF 1920×1080i

3840×2160(Video) 3840×2160P 3840×2160P

3840×2160P 1920×1080P

1920×1080P 1920×1080P

1920×1080PsF 1920×1080i

1920×1080(Video) 1920×1080P 1920×1080P

1920×1080PsF 1920×1080i

Järjestelmän 
taajuusasetus
(Project-valikossa 
Rec Format > 
Frequency)

Koodekkiasetus
(Project-valikossa 
Rec Format > 
Codec)

RAW-/
tallennusmuotoasetus
(Project-valikossa Rec 
Format > RAW Output 
Format/Video Format)

Lähtömuoto (Monitoring-valikossa 
Output Format)

SDI HDMI

23.98Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 RAW) 4096×2160P

3840×2160P

1920×1080P

3840×2160(RAW) (3840×2160 RAW) 3840×2160P

1920×1080P

RAW(HDMI)
RAW(HDMI) & 
XAVC-I

4240×2392(RAW) 1920×1080P (4240×2392 HDMI 
RAW)

XAVC-I
XAVC-L

4096×2160(Video) 4096×2160P1) 4096×2160P

4096×2160P 1920×1080P

3840×2160P 3840×2160P

3840×2160P 1920×1080P

1920×1080P 1920×1080P

3840×2160(Video) 3840×2160P 3840×2160P

3840×2160P 1920×1080P

1920×1080P 1920×1080P

1920×1080(Video) 1920×1080P 1920×1080P

24Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 RAW) 4096×2160P

1920×1080P

XAVC-I 4096×2160(Video) 4096×2160P1) 4096×2160P

1920×1080P 1920×1080P

1)	 Näyttöä ei voi upottaa.
2)	Kun järjestelmän taajuus on 59.94
3)	Kun järjestelmän taajuus on 50
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Virtalähde

Oire Syy Ratkaisu

Videokameran virta ei 
kytkeydy.

Akkua ei ole asennettu eikä 
DC IN -liittimestä syötetä 
virtaa.

Asenna akku (sivu 17) tai kytke laite 
sähköverkkoon verkkovirtalaitteella 
(sivu 18).

Akku on täysin tyhjä. Vaihda akku täyteen ladattuun akkuun 
(sivu 17).

Virransyöttö katkeaa käytön 
aikana.

Akku tyhjenee täysin. Vaihda akku täyteen ladattuun akkuun 
(sivu 17).

Akku tyhjenee täysin hyvin 
nopeasti.

Ympäristön lämpötila on 
hyvin alhainen.

Tämä johtuu akun ominaisuuksista eikä 
ole vika.

Akku on puutteellisesti 
ladattu.

Lataa akku (sivu 17).
Jos akku tyhjenee nopeasti, vaikka 
lataat sen täyteen, se voi olla 
käyttöikänsä päässä. Vaihda se uuteen.

Tallentaminen/toistaminen

Oire Syy Ratkaisu

Tallentaminen ei ala, vaikka 
painat tallennuksen START/
STOP-painiketta.

Muistikortti on täynnä. Vaihda muistikorttiin, jossa on riittävästi 
tilaa.

Muistikortti on palautettava. Palauta muistikortti (sivu 33).

Äänitys ei ole mahdollista. AUDIO LEVEL (CH1/
CH2) -säätimet on asetettu 
minimitasolle.

Säädä äänitystasoja AUDIO LEVEL (CH1/
CH2) -säätimillä (sivu 47).

Äänitetty ääni on vääristynyt. Äänitaso on liian korkea. Säädä äänitystasoja AUDIO LEVEL (CH1/
CH2) -säätimillä (sivu 47).

Äänitetyn äänen kohinataso 
on liian suuri.

Äänitaso on liian matala. Säädä äänitystasoja AUDIO LEVEL (CH1/
CH2) -säätimillä (sivu 47).
Kun ulkoinen mikrofoni on valittu, säädä 
myös INPUT MIC Reference -asetusta 
Audio-valikon kohdassa Audio Input 
(sivu 96).

Oire Syy Ratkaisu

Leikkeitä ei voida toistaa. Leikettä editoidaan. Leikkeitä ei voida toistaa, jos olet 
muuttanut tiedostonimiä tai kansioita, 
tai jos leike on käytössä tietokoneella. 
Tämä ei ole toimintahäiriö.

Leikettä tallennetaan toisella 
laitteella.

Toiselle laitteella tallennettavia leikkeitä 
ei voida toistaa, tai ne näkyvät väärässä 
koossa. Tämä ei ole toimintahäiriö.

Ulkoiset laitteet

Oire Ratkaisu

Tietokone ei tunnista 
videokameraa.

Irrota USB-kaapeli tietokoneesta ja liitä se huolellisesti uudelleen.

Irrota USB-kaapeli tietokoneesta, käynnistä tietokone uudelleen ja 
tee vaiheet uudelleen oikeassa järjestyksessä.

Yhdistä tietokone ja videokamera toisiinsa asettamalla USB-kaapeli 
joko USB-C-liittimeen tai USB-/multiliittimeen.

Leikkeitä ei voi ladata 
tietokoneella.

Irrota USB-kaapeli tietokoneesta, käynnistä videokamera uudelleen 
ja liitä kaapeli uudelleen.

Sovellusohjelmisto on asennettava, jotta leikkeitä voidaan ladata 
tietokoneelle (sivu 116).

Vianetsintä
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Langaton lähiverkkoyhteys

[Huomautus]
Esteet ja sähkömagneettiset häiriöt videokameran ja langattoman lähiverkon tukiaseman tai päätelaitteen välissä 
tai ympäröivä tila (kuten seinämateriaalit) voivat lyhentää tiedonsiirron kantamaa tai estää yhteydet kokonaan. Jos 
tällaisia ongelmia ilmenee, siirrä videokamera toiseen paikkaan tai tuo videokameraa ja tukiasemaa/päätelaitetta 
lähemmäs toisiaan ja tarkista yhteyden/tiedonsiirron tila.

Oire Ratkaisu

Päätelaite ei saa yhteyttä 
videokameraan.

ˎˎ Tarkista langaton lähiverkkoyhteys (IP-osoite jne.).
ˎˎ Tiedonsiirtoasetus tukiaseman ja asiakaslaitteen välillä voi olla 
virheellinen. Tietoja saat tukiaseman käyttöohjeesta.

Sisäänkirjautuminen 
videokameraan ei onnistu.

Tarkista määrittämäsi käyttäjänimi ja salasana.

Internetyhteys

Oire Ratkaisu

Tiedoston lataaminen 
palvelimelle epäonnistuu.

Palvelimen käyttäjänimi ja salasana voivat olla väärin.
Syötä oikea käyttäjänimi ja salasana.

Tiedoston lataaminen 
palvelimelle ei ole saatavilla.

Signaali voi olla heikko.
Siirry toiseen paikkaan ja yritä uudelleen.

Kun käytetään ND-suodatinta

Oire Ratkaisu

ND-suodatin ei siirry. Voit siirtää suodattimen Clear-asentoon käsin seuraavalla 
menetelmällä.

1	 Siirrä videokameran POWER-kytkin Off-asentoon.

2	 Irrota pyöreä suojus sen alapuolelta.

3	 Aseta ruuvitaltta reikään ja käännä sitä vastapäivään.
ˎˎ ND-suodatin siirtyy Clear-asentoon kääntämällä vastapäivään. Jatka kääntämistä Clear-
asentoon saakka.
ˎˎ Käytä ruuvitalttaa, jonka halkaisija on enintään 2,4 mm. Ruuvitaltta työnnetään noin 
3,0 cm:n syvyyteen.

Reikä ruuvitaltalle
(suojus irrotettuna)

4	 Siirrä ND PRESET/VARIABLE -kytkin (sivu 5) PRESET-asentoon ja aseta ND FILTER 
POSITION -painikkeet ylös/alas (sivu 5) kohtaan CLEAR.

[Huomautuksia]
ˎˎ Älä käytä yllä esitettyä menetelmää normaalissa toiminnassa. Käytä menetelmää vain, jos ND-suodatin ei siirry. ND-

suodatin voi vaurioitua, jos menetelmää käytetään normaalissa toiminnassa.
ˎˎ Sen jälkeen kun yllä esitettyä menetelmää on käytetty, korjauta videokamera ottamalla yhteyttä Sonyn 

palvelukeskukseen.
ˎˎ Jos virheviesti ei häviä, vaikka yllä oleva menettely on tehty, kuvaaminen on silti mahdollista.
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Jos videokameraan ilmestyy varoitus, huomio tai vahvistusta edellyttävä käyttöehto, etsimessä 
näkyy viesti, tallennuksen merkkivalo alkaa vilkkua ja laitteesta kuuluu varoitusääni.
Varoitusääni kuuluu kuulokeliitäntään liitetyistä kuulokkeista.

Virheviestit

Videokamera lakkaa toimimasta, kun seuraavanlainen näyttö tulee näkyviin.

Etsimen viesti Varoitusääni Tallennuk-
sen merkki-
valo

Syy ja ratkaisu

E + virhekoodi Yhtäjaksoi-
nen

Nopeasti 
vilkkuva

Merkitsee poikkeavuutta videokamerassa. 
Tallennus keskeytyy, vaikka etsimessä näkyy 
REC.
Sammuta videokamera ja tarkista, onko liitetyissä 
laitteissa, kaapeleissa tai tietovälineissä ongelmia. 
Jos virhe ei poistu, kun videokamera kytketään 
päälle uudelleen, ota yhteyttä Sonyn 
palveluedustajaan.
(Jos videokamera ei sammu, kun POWER-kytkin 
siirretään OFF-asentoon, irrota akku tai katkaise 
DC IN -syöttö.)
Videokameran tilasta riippuen virhenäyttöä tai 
varoitusääntä ei välttämättä ilmesty.

Varoitusviestit

Jos jokin seuraavista näytöistä tulee näkyviin, noudata annettuja ohjeita.

Etsimen viesti Varoitusääni Tallennuk-
sen merkki-
valo

Syy ja ratkaisu

Battery Near End Jaksottai-
nen

Vilkkuva Akun jäljellä oleva kapasiteetti on vähäinen.
Lataa mahdollisimman pian.

Battery End Yhtäjaksoi-
nen

Nopeasti 
vilkkuva

Akku on tyhjä. Tallennus ei ole käytössä.
Lopeta käyttö ja vaihda akku.

Temperature High Jaksottai-
nen

Vilkkuva Sisäinen lämpötila on korkea.
Sammuta videokamera ja anna sen jäähtyä ennen 
kuin käytät sitä uudelleen.

Etsimen viesti Varoitusääni Tallennuk-
sen merkki-
valo

Syy ja ratkaisu

Media Temperature 
High

Jaksottai-
nen

Vilkkuva CFexpress-muistikortin lämpötila on korkea.
Vaihda kortti tai anna sen jäähtyä ennen kuin 
käytät sitä uudelleen.

Voltage Low Jaksottai-
nen

Vilkkuva DC IN -jännite on alhainen (taso 1). Tarkista 
virtalähde.

Insufficient Voltage Yhtäjaksoi-
nen

Nopeasti 
vilkkuva

DC IN -jännite on liian alhainen (taso 2). Tallennus 
ei ole käytössä.
Liitä jokin muu virtalähde.

Media Near Full Jaksottai-
nen

Vilkkuva Muistikortin jäljellä oleva kapasiteetti on vähissä.
Vaihda mahdollisimman pian.

Media Full Yhtäjaksoi-
nen

Nopeasti 
vilkkuva

Leikkeitä ei voitu tallentaa tai kopioida, koska 
muistikortilla ei ole enää tilaa.
Vaihda heti.

Clips Near Full Jaksottai-
nen

Vilkkuva Muistikortille tallennettavissa olevien 
lisäleikkeiden lukumäärä on vähissä.
Vaihda mahdollisimman pian.

Clips Full Yhtäjaksoi-
nen

Nopeasti 
vilkkuva

Muistikortille tallennettavissa olevien leikkeiden 
enimmäismäärä on saavutettu.
Leikkeitä ei voida tallentaa tai kopioida enempää. 
Vaihda heti.

Last Clip Recording Jaksottai-
nen

Vilkkuva Tällä hetkellä tallennettava leike on viimeinen, 
joka voidaan tallentaa, sillä leikkeiden 
enimmäismäärä on saavutettu.
Valmistele uusi muistikortti.

Media(A)1) Life Near 
End

Jaksottai-
nen

Vilkkuva Muistikortti lähestyy käyttöikänsä päätä. Vaihda 
mahdollisimman pian.

Media(A)1) Life End Yhtäjaksoi-
nen

Nopeasti 
vilkkuva

Muistikortti on saavuttanut käyttöikänsä pään. 
Vaihda heti.

Media(A)1) Near Full Jaksottai-
nen

Vilkkuva Kun käytetään Simul Rec -toimintoa

Media(A)1) Full Yhtäjaksoi-
nen

Nopeasti 
vilkkuva

Kun käytetään Simul Rec -toimintoa

Media(A)1) Clips Near 
Full

Jaksottai-
nen

Vilkkuva Kun käytetään Simul Rec -toimintoa

Media(A)1) Clips Full Yhtäjaksoi-
nen

Nopeasti 
vilkkuva

Kun käytetään Simul Rec -toimintoa

Media(A)1) Last Clip 
Rec

Jaksottai-
nen

Vilkkuva Kun käytetään Simul Rec -toimintoa

Transfer Jobs Near 
Full

– – Rekisteröitävien FTP -tiedostonsiirtotöiden jäljellä 
oleva määrä on alhainen.

Virhe-/varoitusviestit
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Etsimen viesti Varoitusääni Tallennuk-
sen merkki-
valo

Syy ja ratkaisu

Transfer Jobs Full – – Rekisteröitävien FTP -tiedostonsiirtotöiden yläraja 
on saavutettu. Jos haluat lisätä uuden työn, poista 
ensin tarpeettomia töitä.2)

1)	 Näkyvissä on ”(B)” näkyvissä, kun kyse on korttipaikan B kortista.
2)	Voit valita ja poistaa töitä koko valikon Network-valikon kohdassa File Transfer >View Job List (sivu 105). Töitä voi 

poistaa myös CBM-työlistasta.

Huomio- ja toimintaviestit

Seuraavat huomio- ja toimintaviestit voivat ilmestyä näkyviin näytön keskelle. Ratkaise 
ongelma noudattamalla annettuja ohjeita.

Näyttöviesti Syy ja ratkaisu

Battery Error
Please Change Battery

Akussa ilmeni virhe.
Vaihda tilalle normaali akku.

Backup Battery End
Please Change

Vara-akussa jäljellä oleva kapasiteetti ei riitä.
Lataa vara-akku.

Unknown Media (A) 1)

Please Change
Videokameraan asetettu muistikortti on osioitu tai se sisältää 
enemmän leikkeitä kuin videokamera pystyy käsittelemään.
Korttia ei voida käyttää videokamerassa ja se on vaihdettava.

Cannot Use Media (A) 1)

Unsupported File System
Videokameraan asetettu kortti käyttää eri tiedostojärjestelmää 
tai sitä ei ole formatoitu.
Korttia ei voida käyttää videokamerassa ja se on vaihdettava 
tai formatoitava videokameran avulla.

Media Error
Media (A) 1) Needs to be Restored

Muistikortissa ilmeni virhe ja kortti on palautettava.
Palauta muistikortti.

Media Error
Cannot Record to Media (A) 1)

Muistikortti voi olla vaurioitunut eikä sitä voida käyttää enää 
tallentamiseen.
Toistaminen on mahdollista, joten on suositeltavaa kopioida 
muistikortti ja vaihtaa se uuteen.

Media Error
Cannot Use Media (A) 1)

Muistikortti voi olla vaurioitunut eikä sitä voida käyttää enää 
tallentamisen tai toistamiseen.
Korttia ei voida käyttää videokamerassa ja se on vaihdettava.

Media (A) 1) Error
Recording Halted
Playback Halted

Tallentaminen ja toistaminen keskeytettiin, koska muistikorttia 
käytettäessä ilmeni virhe.
Jos ongelma ei poistu, vaihda muistikortti.

Näyttöviesti Syy ja ratkaisu

Media Reached Rewriting Limit
Change Media (A) 1)

Muistikortti on saavuttanut käyttöikänsä pään.
Tee varmuuskopio ja vaihda kortti välittömästi. Jos jatkat 
kortin käyttämistä, kortti ei välttämättä pysty tallentamaan tai 
toistamaan.
Tietoja saat muistikortin käyttöohjeesta.

The specified address is invalid. Määritetty osoite on virheellinen.
Tarkista, että asetus on oikein.

Cannot Use Specified Port Number Määritetty porttinumero on virheellinen.
Tarkista, että asetus on oikein.

Fan Stopped Sisäinen tuuletin sammui.
Vältä käyttöä korkeissa lämpötiloissa, katkaise virta ja ota 
yhteyttä Sonyn palveluedustajaan.

Lens I/F Error(xx:xx) Objektiivivirhe havaittiin objektiivin I/F-tiedonsiirrossa, kun 
E-pidikkeellinen objektiivi kiinnitettiin.
Tarkista liitännän tila E-pidikkeellisen objektiivin kanssa.
Jos ongelma jatkuu, ota yhteyttä Sonyn palveluedustajaan ja 
anna vikakoodi (viisi merkkiä sulkeissa).

This Multi Term. acc is not supported 
by the device and cannot be used.
Please verify the compatibility.

Yhteensopimaton lisävaruste havaittu.
Ainoa laitteen tukema Multi Terminal -lisävaruste on mukana 
toimitettu kauko-ohjainkahva.

Failed Tämä virhe voi ilmestyä, jos osoitetta ei voida saada, kun 
DHCP-asetuksena on On.
Tarkista DHCP-palvelinasetukset.

Addition of auto upload job failed. Siirtotöiden enimmäismäärä on saavutettu.
Tyhjennä kaikki tarpeettomat työt. Alkuperäisten tiedostojen 
tai välityspalvelintiedostojen automaattisen lataamisen 
kohdeasetus voi myös olla virheellinen. Tarkista, että asetus 
on oikein.

<SSID>Not found. Verkkoa (tukiasemaa), jolla on määritetty <SSID>, ei löydy.
Tarkista, että asetus on oikein.

<SSID>Authentication Failed Verkon (tukiaseman), jolla on määritetty <SSID>, yhteyden 
todennus epäonnistui.
Tarkista, että salasana ja muut asetukset ovat oikein.

An IP address conflict has occurred. 
Please check the network settings.

Langattoman lähiverkon, lankaverkon tai USB-yhteydenjaon 
verkko-osoitteissa on ristiriita.
Muuta osoitetta käsin tai muuta verkkoreitittimen asetuksia.

The IP address of the Wireless LAN 
Access Point Mode has been 
changed due to an IP address 
conflict.

Langattoman lähiverkon tukiasematilan IP-osoite muuttui 
langattoman lähiverkon tukiasematilan, lankaverkon tai 
USB-yhteydenjaon verkko-osoitteiden ristiriidan vuoksi.
Tarkista IP-osoiteasetukset.

1)	 Näkyvissä on ”(B)”, kun kyse on korttipaikan B kortista.
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Koko valikon kohteet

Kyllä: Kohde on tallennettu.
Ei: Kohdetta ei ole tallennettu.
–: Ei tallennettu (tilapäinen asetus)

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting ISO/Gain/EI Mode Kyllä Ei

ISO/Gain<H> Kyllä Ei

ISO/Gain<M> Kyllä Ei

ISO/Gain<L> Kyllä Ei

Exposure Index<H> Kyllä Ei

Exposure Index<M> Kyllä Ei

Exposure Index<L> Kyllä Ei

Shockless Gain Kyllä Ei

Base Sensitivity Kyllä Ei

Base ISO Kyllä Ei

ND Filter Preset1 Kyllä Ei

Preset2 Kyllä Ei

Preset3 Kyllä Ei

Shutter Mode Kyllä Ei

Shutter Speed On/Off Kyllä Ei

Shutter Speed Kyllä Ei

Shutter Angle Kyllä Ei

ECS On/Off Kyllä Ei

ECS Frequency Kyllä Ei

Iris Bokeh Control Ei Ei

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Auto Exposure Level Kyllä Ei

Mode Kyllä Ei

Speed Kyllä Ei

AGC Kyllä Ei

AGC Limit Kyllä Ei

AGC Point Kyllä Ei

Auto Shutter Kyllä Ei

A.SHT Limit Kyllä Ei

A.SHT Point Kyllä Ei

Clip High light Kyllä Ei

Detect Window Kyllä Ei

Detect Window Indication Kyllä Ei

Custom Width Kyllä Ei

Custom Height Kyllä Ei

Custom H Position Kyllä Ei

Custom V Position Kyllä Ei

White Preset White Kyllä Ei

Color Temp <A> Kyllä Ei

Tint<A> Kyllä Ei

R Gain <A> Kyllä Ei

B Gain <A> Kyllä Ei

Color Temp <B> Kyllä Ei

Tint<B> Kyllä Ei

R Gain <B> Kyllä Ei

B Gain <B> Kyllä Ei

White Setting Shockless White Kyllä Ei

ATW Speed Kyllä Ei

White Switch<B> Kyllä Ei

Filter White Memory Kyllä Ei

Tiedostoihin tallennetut kohteet
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Offset White Offset White <A> Kyllä Ei

Offset Color Temp<A> Kyllä Ei

Offset Tint<A> Kyllä Ei

Offset White <B> Kyllä Ei

Offset Color Temp<B> Kyllä Ei

Offset Tint<B> Kyllä Ei

Offset White<ATW> Kyllä Ei

Offset Color Temp<ATW> Kyllä Ei

Offset Tint<ATW> Kyllä Ei

Focus AF Transition Speed Kyllä Ei

AF Subj. Shift Sens. Kyllä Ei

Focus Area Kyllä Ei

Focus Area (AF-S) Kyllä Ei

Face/Eye Detection AF Kyllä Ei

Push AF Mode Kyllä Ei

Touch Function in MF Kyllä Ei

AF Assist Kyllä Ei

S&Q Motion Setting Kyllä Ei

Frame Rate Kyllä Ei

LUT On/Off SDI/HDMI Kyllä Ei

VF/Proxy/Stream Kyllä Ei

Internal Rec Kyllä Ei

Noise Suppression Setting(Custom) Kyllä Ei

Level(Custom) Kyllä Ei

Setting(Cine EI) Kyllä –

Level(Cine EI) Kyllä –

Flicker Reduce Mode Kyllä Ei

Frequency Kyllä Ei

SteadyShot Setting Kyllä Ei

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project Base Setting Shooting Mode Kyllä –

Target Display Kyllä –

Rec Format Frequency Kyllä Ei

Imager Scan Mode Kyllä Ei

Codec Kyllä Ei

RAW Output Format Kyllä Ei

Video Format Kyllä Ei

Cine EI Setting Color Gamut Kyllä –

HDR Setting VF SDR Preview Kyllä Ei

SDR Gain Kyllä Ei

Simul Rec Setting Kyllä Ei

Rec Button Set Kyllä Ei

Proxy Rec Setting Kyllä Ei

Audio Channel Kyllä Ei

Chunk Kyllä Ei

Interval Rec Setting Ei Ei

Interval Time Kyllä Ei

Number of Frames Kyllä Ei

Pre-Lighting Kyllä Ei

Picture Cache Rec Setting Kyllä Ei

Cache Size Kyllä Ei

Cache Rec Time – –

SDI/HDMI Rec Control Setting Kyllä Ei

Assignable Button <1> Kyllä Ei

<2> Kyllä Ei

<3> Kyllä Ei

<4> Kyllä Ei

<5> Kyllä Ei

<6> Kyllä Ei

<7> Kyllä Ei

<8> Kyllä Ei

<9> Kyllä Ei

Focus Hold Button Kyllä Ei

Assignable Dial Grip/Remote Dial Kyllä Ei

Grip Dial Direction Kyllä Ei

Handle Dial Kyllä Ei

Handle Dial Direction Kyllä Ei

Multi Function Dial Default Function Kyllä Ei
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project User File Load from Media(B) – –

Save to Media(B) – –

File ID Ei Ei

Load Customize Data Kyllä Ei

Load White Data Kyllä Ei

All File Load from Media(B) – –

Load from Cloud(Private) – –

Load from Cloud(Share) – –

Save to Media(B) – –

Save to Cloud(Private) – –

Save to Cloud(Share) – –

File ID Kyllä Ei

Load Network Data Ei Ei

Paint/Look Scene File Recall – –

Store – –

Delete – –

Preset Recall – –

Base Look Select Kyllä Kyllä

Delete – –

Delete All – –

Import from Media(B) – –

Import from Cloud(Private) – –

Import from Cloud(Share) – –

Input Kyllä Kyllä

Output Kyllä Kyllä

AE Level Offset Kyllä Kyllä

Reset Paint Settings Reset without Base Look – –

Black Master Black Kyllä Kyllä

R Black Kyllä Kyllä

B Black Kyllä Kyllä

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint/Look Knee Setting Kyllä Kyllä

Auto Knee Kyllä Kyllä

Point Kyllä Kyllä

Slope Kyllä Kyllä

Detail Setting Kyllä Kyllä

Level Kyllä Kyllä

Manual Setting Kyllä Kyllä

V/H Balance Kyllä Kyllä

B/W Balance Kyllä Kyllä

Limit Kyllä Kyllä

Crispening Kyllä Kyllä

High Light Detail Kyllä Kyllä

Matrix User Matrix Kyllä Kyllä

User Matrix Level Kyllä Kyllä

User Matrix Phase Kyllä Kyllä

User Matrix R-G Kyllä Kyllä

User Matrix R-B Kyllä Kyllä

User Matrix G-R Kyllä Kyllä

User Matrix G-B Kyllä Kyllä

User Matrix B-R Kyllä Kyllä

User Matrix B-G Kyllä Kyllä

Multi Matrix Setting Kyllä Kyllä

Reset – –

Axis Ei Kyllä

Hue Kyllä Kyllä

Saturation Kyllä Kyllä
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

TC/Media Timecode Mode Kyllä Ei

Run Kyllä Ei

Setting Ei Ei

Reset – –

TC Format Kyllä Ei

TC Display Display Select Kyllä Ei

Users Bit Mode Kyllä Ei

Setting Ei Ei

HDMI TC Out Setting Kyllä Ei

Clip Name Format Title Prefix Kyllä Ei

Number Set Ei Ei

Update Media Media(A) – –

Media(B) – –

Format Media Media(A) – –

Media(B) – –

Monitoring Output On/Off SDI Kyllä Ei

HDMI Kyllä Ei

Output Format SDI Kyllä Ei

HDMI Kyllä Ei

Output Display SDI Kyllä Ei

HDMI Kyllä Ei

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Display On/Off Network Status Kyllä Ei

File Transfer Status Kyllä Ei

Rec/Play Status Kyllä Ei

RAW Output Control Status Kyllä Ei

Tally Kyllä Ei

Battery Remain Kyllä Ei

Focus Mode Kyllä Ei

Focus Position Kyllä Ei

Focus Area Indicator Kyllä Ei

Focus Area Ind.(AF-S) Kyllä Ei

Face/Eye Detection Frame Kyllä Ei

Lens Info Kyllä Ei

Imager Scan Mode Kyllä Ei

Rec Format Kyllä Ei

Frame Rate Kyllä Ei

Zoom Position Kyllä Ei

UWP RF Level Kyllä Ei

SteadyShot Kyllä Ei

Base Look/LUT Kyllä Ei

SDI/HDMI Rec Control Kyllä Ei

Gamma Display Assist Kyllä Ei

Proxy Status Kyllä Ei

Base ISO/Sensitivity Kyllä Ei

Media Status Kyllä Ei

Video Signal Monitor Kyllä Ei

Clip Name Kyllä Ei

White Balance Kyllä Ei

Scene File Kyllä Ei

Focus Indicator Kyllä Ei

Auto Exposure Mode Kyllä Ei

Auto Exposure Level Kyllä Ei

Timecode Kyllä Ei

ND Filter Kyllä Ei
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Display On/Off Iris Kyllä Ei

ISO/Gain/EI Kyllä Ei

Shutter Kyllä Ei

Level Gauge Kyllä Ei

Audio Level Meter Kyllä Ei

Video Level Warning Kyllä Ei

Clip Number Kyllä Ei

Notice Message Kyllä Ei

Marker Setting Kyllä Ei

Color Kyllä Ei

Center Marker Kyllä Ei

Safety Zone Kyllä Ei

Safety Area Kyllä Ei

Aspect Marker Kyllä Ei

Aspect Mask Kyllä Ei

Aspect Safety Zone Kyllä Ei

Aspect Safety Area Kyllä Ei

Aspect Select Kyllä Ei

Custom Aspect Ratio Kyllä Ei

Guide Frame Kyllä Ei

100% Marker Kyllä Ei

User Box Kyllä Ei

User Box Width Kyllä Ei

User Box Height Kyllä Ei

User Box H Position Kyllä Ei

User Box V Position Kyllä Ei

VF Setting Brightness Kyllä Ei

Color Mode Kyllä Ei

Gamma Display Assist Setting Kyllä Ei

Peaking Setting Kyllä Ei

Peaking Level Kyllä Ei

Color Kyllä Ei

Zebra Setting Kyllä Ei

Zebra1 Level Kyllä Ei

Zebra1 Aperture Level Kyllä Ei

Zebra2 Level Kyllä Ei

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Audio Audio Input CH1 Input Select Kyllä Ei

CH2 Input Select Kyllä Ei

CH3 Input Select Kyllä Ei

CH4 Input Select Kyllä Ei

INPUT1 MIC Reference Kyllä Ei

INPUT2 MIC Reference Kyllä Ei

Line Input Reference Kyllä Ei

Reference Level Kyllä Ei

CH1 Wind Filter Kyllä Ei

CH2 Wind Filter Kyllä Ei

CH3 Wind Filter Kyllä Ei

CH4 Wind Filter Kyllä Ei

CH3 Level Control Kyllä Ei

CH4 Level Control Kyllä Ei

CH3 Input Level Kyllä Ei

CH4 Input Level Kyllä Ei

Audio Input Level Kyllä Ei

Limiter Mode Kyllä Ei

CH1&2 AGC Mode Kyllä Ei

CH3&4 AGC Mode Kyllä Ei

AGC Spec Kyllä Ei

1kHz Tone on Color Bars Kyllä Ei

CH1 Level Kyllä Ei

CH2 Level Kyllä Ei

CH3 Level Kyllä Ei

CH4 Level Kyllä Ei

Audio Output Monitor CH Kyllä Ei

Volume Ei Ei

Headphone Out Kyllä Ei

Alarm Level Kyllä Ei

HDMI Output CH Kyllä Ei
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Thumbnail Display Clip Properties – –

Set Clip Flag Add OK – –

Add NG – –

Add KEEP – –

Delete Clip Flag – –

Lock/Unlock Clip Select Clip – –

Lock All Clips – –

Unlock All Clips – –

Delete Clip Select Clip – –

All Clips – –

Transfer Clip Select Clip – –

All Clips – –

Transfer Clip (Proxy) Select Clip – –

All Clips – –

Filter Clips OK – –

NG – –

KEEP – –

None – –

All – –

Customize View Thumbnail Caption Kyllä –

Technical Color Bars Setting Ei Ei

Type Kyllä Ei

ND Dial CLEAR with Dial Kyllä Ei

Tally Front Kyllä Ei

Rear Kyllä Ei

HOLD Switch Setting with Rec Button Kyllä Ei

with Hand Grip Remote Kyllä Ei

Handle HOLD Switch Kyllä Ei

Touch Operation Setting Kyllä Ei

Rec Review Setting Kyllä Ei

Zoom Zoom Type Kyllä Ei

Handle Zoom Setting Kyllä Ei

High Kyllä Ei

Low Kyllä Ei

Menu Settings User Menu Only Kyllä Ei

User Menu with Lock Ei Ei

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Menu Page On/Off Main Kyllä Ei

Camera Kyllä Ei

Audio Kyllä Ei

Project Kyllä Ei

Monitoring Kyllä Ei

Assignable Button Kyllä Ei

Battery Kyllä Ei

Media Kyllä Ei

Network Kyllä Ei

File Transfer Kyllä Ei

Fan Control Setting Kyllä Ei

Lens Zoom Ring Direction Kyllä Ei

Shading Compensation Kyllä Ei

Chroma Aberration Comp. Kyllä Ei

Distortion Comp. Kyllä Ei

Breathing Compensation Kyllä Ei

Distance Display Kyllä Ei

Zoom Position Display Kyllä Ei

Video Light Set Video Light Set Kyllä Ei

APR APR – –

Camera Battery Alarm Low Battery Kyllä Ei

Battery Empty Kyllä Ei

Camera DC IN Alarm DC Low Voltage1 Kyllä Ei

DC Low Voltage2 Kyllä Ei

Network Setup for Mobile App Setup – –

Access Authentication User Name Ei Ei

Input Password Ei Ei

Generate Password – –

Show Settings – –

Wireless LAN Setting Kyllä Ei

WPS – –

NFC – –

MAC Address – –

AP Mode Settings Channel Kyllä Ei

Camera SSID & Password – –

Regenerate Password – –

IP Address – –

Subnet Mask – –
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network ST Mode Settings Camera Remote Control Kyllä Ei

Connected Network

SSID – –

Security – –

Password – –

DHCP – –

IP Address – –

Subnet Mask – –

Gateway – –

DNS Auto – –

Primary DNS Server – –

Secondary DNS Server – –

Scan Networks

SSID – –

Security – –

Password Ei Ei

DHCP Kyllä Ei

IP Address Kyllä Ei

Subnet Mask Kyllä Ei

Gateway Kyllä Ei

DNS Auto Kyllä Ei

Primary DNS Server Kyllä Ei

Secondary DNS Server Kyllä Ei

Manual Register

SSID Kyllä Ei

Security Kyllä Ei

Password Ei Ei

DHCP Kyllä Ei

IP Address Kyllä Ei

Subnet Mask Kyllä Ei

Gateway Kyllä Ei

DNS Auto Kyllä Ei

Primary DNS Server Kyllä Ei

Secondary DNS Server Kyllä Ei

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network Wired LAN Setting Kyllä Ei

Camera Remote Control Kyllä Ei

Detail Settings

DHCP Kyllä Ei

IP Address Kyllä Ei

Subnet Mask Kyllä Ei

Gateway Kyllä Ei

DNS Auto Kyllä Ei

Primary DNS Server Kyllä Ei

Secondary DNS Server Kyllä Ei

Modem Setting Kyllä Ei

Camera Remote Control Kyllä Ei

Device Name – –

IP Address – –

Subnet Mask – –

File Transfer Auto Upload Kyllä Ei

Auto Upload (Proxy) Kyllä Ei

Default Upload Server Kyllä Ei

Clear Completed Jobs – –

Clear All Jobs – –

View Job List – –

Server Settings1/Server Settings2/Server Settings3

Display Name Kyllä Ei

Service Kyllä Ei

Host Name Kyllä Ei

Port Kyllä Ei

User Name Ei Ei

Password Ei Ei

Passive Mode Kyllä Ei

Destination Directory Kyllä Ei

Using Secure Protocol Kyllä Ei

Root Certificate – –

Root Certificate Status – –

Reset – –

Network Reset Reset – –
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Maintenance Language Select Kyllä Ei

Clock Set Time Zone Kyllä Ei

Date Mode Kyllä Ei

12h/24h Kyllä Ei

Date Ei Ei

Time Ei Ei

All Reset Reset – –

Reset without Network – –

Hours Meter Hours(System) – –

Hours(Reset) – –

Reset – –

Version Version Number – –

Version Up – –

Lens Version Number – –

Nimettävien painikkeiden kohteet

Kyllä: Kohde on tallennettu.
Ei: Kohdetta ei ole tallennettu.
–: Ei tallennettu (tilapäinen asetus)

Nimettävän painikkeen valinta All File Scene File

ND Filter Position Kyllä Ei

Auto Iris Kyllä Ei

ATW Kyllä Ei

Focus Setting Kyllä Ei

Display Kyllä –

VF Adjust Kyllä –

Nimettävän säätimen kohteet

Kyllä: Kohde on tallennettu.
Ei: Kohdetta ei ole tallennettu.
–: Ei tallennettu (tilapäinen asetus)

Nimettävän säätimen valinta All File Scene File

IRIS Kyllä Ei

ND Filter Kyllä Ei

Audio Input Level Kyllä Ei
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Ks. asiaan liittyvät kohdat ”Tallennettavan äänen määrittäminen” (sivu 47) ja ”User-valikko” (sivu 75).

Audio Input (CH1&CH2)

Alla on esitetty lohkokaavio yläkahva kiinnitettynä.

INPUT1

L

R

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

CH1

[CH1 Input Select]
INPUT1
Internal MIC
Shoe CH1

[CH2 Input Select]
INPUT1
INPUT2
Internal MIC
Shoe CH2

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

<CH1 LEVEL
   CONTROL>*
AUTO
MAN

<CH1 INPUT LEVEL>
0 ~ 10

[CH1 Wind Filter]
On
O�

[CH2 Wind Filter]
On
O�

CH2

<CH2 LEVEL
   CONTROL>*
AUTO
MAN

<CH2 INPUT LEVEL>
0 ~ 10

[CH1&2 AGC Mode]
Mono
Stereo [Color Bars]

[1kHz Tone on Color
Bars]
On
O�

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,

-9dB, -12dB,
-15dB, -17dB SG

[CH1 Level]
Audio Input Level
Side
Level + Side
Through

[CH2 Level]
Audio Input Level
Side
Level + Side
Through

*	 Asetuksena Manual, kun ääni tulee XLR-sovittimesta.

Lohkokaaviot
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Audio Input (CH3&CH4)

Alla on esitetty lohkokaavio yläkahva kiinnitettynä.

L

R

CH3

[CH3 Level
 Control]*
Auto
Manual

[CH4 Level
 Control]*
Auto
Manual

[CH3 Input Level]
0 ~ 99

CH4

[CH4 Input Level]
0 ~ 99

[CH3&4 AGC Mode]
Mono
Stereo

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,
-9dB, -12dB,
-15dB, -17dB SG

OFF

[CH3 Input Select]
O�
INPUT1
Internal MIC
Shoe CH1

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

[CH3 Wind Filter]
On
O�

[CH4 Wind Filter]
On
O�

[CH4 Input Select]
O�
INPUT1
INPUT2
Internal MIC
Shoe CH2

INPUT1

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

[CH3 Level]
Audio Input Level
CH3 Input Level
Level+CH3 Input Level
Through

[CH4 Level]
Audio Input Level
CH4 Input Level
Level+CH4 Input Level
Through

[Color Bars]
[1kHz Tone on Color
Bars]
On
O�

 
*	 Asetuksena Manual, kun ääni tulee XLR-sovittimesta.
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Audio Output

L

R

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

[VOLUME]
0 ～ 50

[Alarm Level]
0 ～ 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

CH2

CH3

CH4
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Voit päivittää E-pidikkeellisen objektiivin 
ohjelmiston videokameran avulla.
Katso verkkosivustolta tiedot objektiiveista, 
joita ei voi päivittää, ja vastaavat ohjelmistot.

Version tarkistaminen

1	 Kiinnitä E-pidikkeellinen objektiivi 
videokameraan (sivu 22).

2	 Näytä Lens Version Number valitsemalla 
koko valikon Maintenance-valikossa kohta 
Version (sivu 106).
E-pidikkeellisen objektiivin 
ohjelmistoversion numero näkyy 
reunassa.

Ohjelmiston päivittäminen

Määritä videokamera massamuistitilaan 
(sivu 116).
Päivitä ohjelmisto objektiivin ohjelmistossa 
esitetyn menettelyn mukaisesti.

E-pidikkeellisen objektiivin ohjelmiston päivittäminen
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MPEG-4 AVC Patent Portfolio 
-lisenssi

TÄMÄ TUOTE ON LISENSOITU AVC PATENT 
PORTFOLIO -LISENSSIN ALAISENA KULUTTAJAN 
HENKILÖKOHTAISEEN KÄYTTÖÖN JA MUUHUN 
KÄYTTÖÖN, JOSTA EI MAKSETA KORVAUKSIA,
(i)	 VIDEON KOODAAMISEEN AVC-STANDARDIN 

MUKAISESTI (”AVC-VIDEO”) JA/TAI
(ii)	AVC-VIDEON DEKOODAUKSEEN, JOS 

VIDEON ON KOODANNUT KULUTTAJA 
HENKILÖKOHTAISEEN KÄYTTÖÖN JA/TAI SE 
ON HANKITTU VIDEOIDEN TOIMITTAJALTA, 
JOLLA ON LISENSSI AVC-VIDEOIDEN 
LEVITTÄMISEEN.

MUITA KÄYTTÖTARKOITUKSIA VARTEN EI 
MYÖNNETÄ SUORAA TAI EPÄSUORAA LUPAA. 
LISÄTIETOJA ANTAA MPEG LA, L.L.C. KS. 
HTTP://WWW.MPEGLA.COM

GPL-/LGPL-lisenssin alaisen 
ohjelmiston hankkiminen

Tämä tuote käyttää ohjelmistoa, johon 
sovelletaan GPL-/LGPL-lisenssiä. Tämä 
on tiedote siitä, että sinulla on oikeus 
tarkastella, muokata ja jakaa eteenpäin 
näiden ohjelmistojen lähdekoodia GPL-/LGPL-
lisenssin ehtojen mukaisesti.
Lähdekoodi on saatavilla internetissä. 
Käytä seuraavaa URL-osoitetta ja noudata 
latausohjeita.
https://oss.sony.net/Products/Linux/

Toivomme, että et ota meihin yhteyttä 
lähdekoodin sisällön osalta.

Lisenssit (englanniksi) on tallennettu tuotteesi 
sisäiseen muistiin.
Muodosta massamuistiyhteys tuotteen ja 
tietokoneen välille ja lue lisenssit kansiosta 
”PMHOME” - ”LICENSE”.

Jos käytät Macia, kansio ”PMHOME” - 
”LICENSE” ei ehkä ole käytettävissä.
Voit tarkastella tiedostoja jollakin muulla kuin 
Mac-tietokoneella tai käymällä seuraavassa 
URL-osoitteessa.
https://oss.sony.net/License/ILME-FX6/

LOPPUKÄYTTÄJÄN 
LISENSSISOPIMUS

IMPORTANT: 
BEFORE USING THE SOFTWARE CONTAINED IN THE 
SOLID STATE MEMORY CAMCORDER, PLEASE READ THIS 
END USER LICENSE AGREEMENT (“EULA”) CAREFULLY. BY 
USING THE SOFTWARE YOU ARE ACCEPTING THE TERMS 
OF THIS EULA. IF YOU DO NOT ACCEPT THE TERMS OF 
THIS EULA, YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and Sony 
Corporation (“SONY”). This EULA governs your rights 
and obligations regarding the software of SONY and/or 
its third party licensors (including SONY’s affiliates) and 
their respective affiliates (collectively, the “THIRD-PARTY 
SUPPLIERS”) contained in the wireless adapter, together 
with any updates/ upgrades provided by SONY, any 
printed, on-line or other electronic documentation for 
such software, and any data files created by operation of 
such software (collectively, the “SOFTWARE”).

Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user license 
agreement (including, but not limited to, GNU General 
Public license and Lesser/Library General Public License) 
shall be covered by such applicable separate end user 
license agreement in lieu of the terms of this EULA to 

the extent required by such separate end user license 
agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The SOFTWARE is 
protected by copyright and other intellectual property 
laws and international treaties.

COPYRIGHT
All right and title in and to the SOFTWARE (including, 
but not limited to, any images, photographs, animation, 
video, audio, music, text and “applets” incorporated into 
the SOFTWARE) is owned by SONY or one or more of the 
THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the SOFTWARE 
solely in connection with the wireless adapter and only 
for your individual use. SONY and the THIRD-PARTY 
SUPPLIERS expressly reserve all rights, title and interest 
(including, but not limited to, all intellectual property 
rights) in and to the SOFTWARE that this EULA does not 
specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, attempt 
to derive source code, modify, reverse engineer, 
decompile, or disassemble any of the SOFTWARE, 
whether in whole or in part, or create any derivative 
works from or of the SOFTWARE unless such derivative 
works are intentionally facilitated by the SOFTWARE. 
You may not modify or tamper with any digital rights 
management functionality of the SOFTWARE. You 
may not bypass, modify, defeat or circumvent any of 
the functions or protections of the SOFTWARE or any 
mechanisms operatively linked to the SOFTWARE. You 
may not separate any individual component of the 
SOFTWARE for use on more than one wireless adapter 
unless expressly authorized to do so by SONY. You 
may not remove, alter, cover or deface any trademarks 
or notices on the SOFTWARE. You may not share, 
distribute, rent, lease, sublicense, assign, transfer or 
sell the SOFTWARE. The software, network services 
or other products other than SOFTWARE upon which 
the SOFTWARE’S performance depends might be 
interrupted or discontinued at the discretion of the 
suppliers (software suppliers, service suppliers, or 

SONY). SONY and such suppliers do not warrant that the 
SOFTWARE, network services, contents or other products 
will continue to be available, or will operate without 
interruption or modification. 

EXCLUDED SOFTWARE AND OPEN SOURCE 
COMPONENTS
Notwithstanding the foregoing limited license grant, 
you acknowledge that the SOFTWARE may include 
EXCLUDED SOFTWARE. Certain EXCLUDED SOFTWARE 
may be covered by open source software licenses 
(“Open Source Components”), which means any 
software licenses approved as open source licenses by 
the Open Source Initiative or any substantially similar 
licenses, including but not limited to any license that, 
as a condition of distribution of the software licensed 
under such license, requires that the distributor make 
the software available in source code format. If and to 
the extent disclosure is required, please visit www.sony.
com/linux or other SONY-designated web site for a list 
of applicable OPEN SOURCE COMPONENTS included in 
the SOFTWARE from time to time, and the applicable 
terms and conditions governing its use. Such terms 
and conditions may be changed by the applicable 
third party at any time without liability to you. To the 
extent required by the licenses covering EXCLUDED 
SOFTWARE, the terms of such licenses will apply in lieu 
of the terms of this EULA. To the extent the terms of the 
licenses applicable to EXCLUDED SOFTWARE prohibit 
any of the restrictions in this EULA with respect to such 
EXCLUDED SOFTWARE, such restrictions will not apply 
to such EXCLUDED SOFTWARE. To the extent the terms 
of the licenses applicable to Open Source Components 
require SONY to make an offer to provide source code 
in connection with the SOFTWARE, such offer is hereby 
made. 

USE OF SOFTWARE WITH COPYRIGHTED 
MATERIALS
The SOFTWARE may be capable of being used by you 
to view, store, process and/or use content created by 
you and/or third parties. Such content may be protected 
by copyright, other intellectual property laws, and/
or agreements. You agree to use the SOFTWARE only 
in compliance with all such laws and agreements that 
apply to such content. You acknowledge and agree 
that SONY may take appropriate measures to protect 

Lisenssit

https://oss.sony.net/Products/Linux/
https://oss.sony.net/License/ILME-FX6/
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the copyright of content stored, processed or used by 
the SOFTWARE. Such measures include, but are not 
limited to, counting the frequency of your backup and 
restoration through certain SOFTWARE features, refusal 
to accept your request to enable restoration of data, and 
termination of this EULA in the event of your illegitimate 
use of the SOFTWARE. 

CONTENT SERVICE 
PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE 
DESIGNED TO BE USED WITH CONTENT AVAILABLE 
THROUGH ONE OR MORE CONTENT SERVICES 
(“CONTENT SERVICE”). USE OF THE SERVICE AND THAT 
CONTENT IS SUBJECT TO THE TERMS OF SERVICE OF 
THAT CONTENT SERVICE. IF YOU DECLINE TO ACCEPT 
THOSE TERMS, YOUR USE OF THE SOFTWARE WILL 
BE LIMITED. You acknowledge and agree that certain 
content and services available through the SOFTWARE 
may be provided by third parties over which SONY has 
no control. USE OF THE CONTENT SERVICE REQUIRES AN 
INTERNET CONNECTION. THE CONTENT SERVICE MAY BE 
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY 
SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet connection 
for which you are solely responsible. Further, you are 
solely responsible for payment of any third party fees 
associated with your Internet connection, including 
but not limited to Internet service provider or airtime 
charges. Operation of the SOFTWARE may be limited 
or restricted depending on the capabilities, bandwidth 
or technical limitations of your Internet connection 
and service. The provision, quality and security of such 
Internet connectivity are the sole responsibility of the 
third party providing such service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export and re-
export restrictions and regulations of the area or country 
in which you reside, and not to transfer, or authorize 
the transfer, of the SOFTWARE to a prohibited country 
or otherwise in violation of any such restrictions or 
regulations.

HIGH RISK ACTIVITIES

The SOFTWARE is not fault-tolerant and is not designed, 
manufactured or intended for use or resale as on-
line control equipment in hazardous environments 
requiring fail-safe performance, such as in the 
operation of nuclear facilities, aircraft navigation or 
communication systems, air traffic control, direct life 
support machines, or weapons systems, in which the 
failure of the SOFTWARE could lead to death, personal 
injury, or severe physical or environmental damage 
(“HIGH RISK ACTIVITIES”). SONY, each of the THIRD-
PARTY SUPPLIERS, and each of their respective affiliates 
specifically disclaim any express or implied warranty, 
duty or condition of fitness for HIGH RISK ACTIVITIES.

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the SOFTWARE 
is at your sole risk and that you are responsible for use 
of the SOFTWARE. The SOFTWARE is provided “AS IS,” 
without warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) EXPRESSLY DISCLAIM ALL WARRANTIES, DUTIES 
OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY, NONINFRINGEMENT AND 
FITNESS FOR A PARTICULAR PURPOSE. SONY 
DOES NOT WARRANT OR MAKE ANY CONDITIONS 
OR REPRESENTATIONS (A) THAT THE FUNCTIONS 
CONTAINED IN ANY OF THE SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT THEY WILL BE UPDATED, (B) 
THAT THE OPERATION OF ANY OF THE SOFTWARE WILL 
BE CORRECT OR ERROR-FREE OR THAT ANY DEFECTS 
WILL BE CORRECTED, (C) THAT THE SOFTWARE WILL 
NOT DAMAGE ANY OTHER SOFTWARE, HARDWARE OR 
DATA, (D) THAT ANY SOFTWARE, NETWORK SERVICES 
(INCLUDING THE INTERNET) OR PRODUCTS (OTHER 
THAN THE SOFTWARE) UPON WHICH THE SOFTWARE’S 
PERFORMANCE DEPENDS WILL CONTINUE TO BE 
AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND 
(E) REGARDING THE USE OR THE RESULTS OF THE USE 
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, OR OTHERWISE. 

NO ORAL OR WRITTEN INFORMATION OR ADVICE 
GIVEN BY SONY OR AN AUTHORIZED REPRESENTATIVE 
OF SONY SHALL CREATE A WARRANTY, DUTY OR 
CONDITION OR IN ANY WAY INCREASE THE SCOPE OF 
THIS WARRANTY. SHOULD THE SOFTWARE PROVE 
DEFECTIVE YOU ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION. SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF 
IMPLIED WARRANTIES, SO THESE EXCLUSIONS MAY NOT 
APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) SHALL NOT BE LIABLE FOR ANY INCIDENTAL 
OR CONSEQUENTIAL DAMAGES FOR BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, BREACH OF 
CONTRACT, NEGLIGENCE, STRICT LIABILITY OR UNDER 
ANY OTHER LEGAL THEORY RELATED TO THE SOFTWARE, 
INCLUDING, BUT NOT LIMITED TO, ANY DAMAGES 
ARISING OUT OF LOSS OF PROFITS, LOSS OF REVENUE, 
LOSS OF DATA, LOSS OF USE OF THE SOFTWARE OR 
ANY ASSOCIATED HARDWARE, DOWN TIME AND USER'S 
TIME, EVEN IF ANY OF THEM HAVE BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, 
EACH AND ALL OF THEIR AGGREGATE LIABILITY UNDER 
ANY PROVISION OF THIS EULA SHALL BE LIMITED TO 
THE AMOUNT ACTUALLY PAID FOR THE PRODUCT. 
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION 
OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE EXCLUSION OR LIMITATION 
MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL 
INFORMATION, LOCATION DATA, DATA 
SECURITY
You acknowledge and agree that SONY and its 
affiliates, partners and agents may read, collect, 
transfer, process and store certain information 
collected from the SOFTWARE, including but not 
limited to information about (i) the SOFTWARE and 
(ii) the software applications, contents and peripheral 
devices that interact with your wireless adapter and the 
SOFTWARE (“Information”). Information includes, but 
is not limited to: (1) unique identifiers relating to your 
wireless adapter and its components; (2) performance 

of the wireless adapter, the SOFTWARE and their 
components; (3) configurations of your wireless adapter, 
the SOFTWARE and the software applications, contents 
and peripheral devices that interact with the wireless 
adapter and the SOFTWARE; (4) use and frequency of 
use of the functions of (x) the SOFTWARE, and (y) the 
software applications, contents and peripheral devices 
that interact with the SOFTWARE; and (5) location data, 
as indicated below. SONY and its affiliates, partners 
and agents may use and disclose Information subject 
to applicable laws in order to improve its products and 
services or to provide products or services to you. Such 
uses include, but are not limited to: (a) administering 
the functionalities of the SOFTWARE; (b) to improve, 
service, update or upgrade the SOFTWARE; (c) 
improving, developing and enhancing the current and 
future products and services of SONY and other parties; 
(d) to provide you with information about the products 
and services offered by SONY and other parties; (e) 
complying with applicable laws or regulations; and (f) 
to the extent offered, providing you with location-based 
services of SONY and other parties, as indicated below. 
In addition, SONY retains the right to use Information 
to protect itself and third parties from illegal, criminal or 
harmful conduct.

Certain services available through the SOFTWARE may 
rely upon location information, including, but not limited 
to, the geographic location of the wireless adapter. You 
acknowledge that for the purpose of providing such 
services, SONY, the THIRDPARTY SUPPLIERS or their 
partners may collect, archive, process and use such 
location data, and that such services are governed by 
the privacy policies of SONY or such third party. By 
reviewed the privacy policies applicable to such services 
and consent to such activities. 

SONY, its affiliates, partners and agents will not 
intentionally use Information to personally identify 
the owner or user of the SOFTWARE without your 
knowledge or consent. Any use of Information will be 
in accordance with the privacy policies of SONY or such 
third party. 

Please contact applicable contact address of each area or 
country for SONY’s current privacy policy. Please contact 
applicable third parties for privacy policies relating 
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to personally identifiable and other information you 
provide when you use or access third party software or 
services. 

Information may be processed, stored or transferred 
to SONY, its affiliates or agents which are located in 
countries outside of your country of residence. Data 
protection and information privacy laws in certain 
countries may not offer the same level of protection 
as your country of residence and you may have fewer 
legal rights in relation to Information processed and 
stored in, or transferred to, such countries. SONY will 
use reasonable efforts to take appropriate technical and 
organizational steps to prevent unauthorized access to 
or disclosure of Information, but does not warrant it will 
eliminate all risk of misuse of such Information.

AUTOMATIC UPDATE FEATURE
From time to time, SONY or the THIRD-PARTY SUPPLIERS 
may automatically update or otherwise modify the 
SOFTWARE, including, but not limited to, for purposes 
of enhancement of security functions, error correction 
and improvement of functions, at such time as you 
interact with SONY’s or third parties’ servers, or 
otherwise. Such updates or modifications may delete 
or change the nature of features or other aspects of the 
SOFTWARE, including, but not limited to, functions you 
may rely upon. You acknowledge and agree that such 
activities may occur at SONY’s sole discretion and that 
SONY may condition continued use of the SOFTWARE 
upon your complete installation or acceptance of such 
update or modifications. Any updates/modifications 
shall be deemed to be, and shall constitute part of, the 
SOFTWARE for purposes of this EULA. By acceptance of 
this EULA, you consent to such update/modification.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY
This EULA and SONY’s privacy policy, each as amended 
and modified from time to time, together constitute the 
entire agreement between you and SONY with respect 
to the SOFTWARE. The failure of SONY to exercise or 
enforce any right or provision of this EULA shall not 
constitute a waiver of such right or provision. If any part 
of this EULA is held invalid, illegal, or unenforceable, 
that provision shall be enforced to the maximum extent 
permissible so as to maintain the intent of this EULA, 
and the other parts will remain in full force and effect.

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for the 
International Sale of Goods shall not apply to this EULA. 
This EULA shall be governed by the laws of Japan, 
without regards to conflict of laws provisions. Any 
dispute arising out of this EULA shall be subject to the 
exclusive venue of the Tokyo District Court in Japan, and 
the parties hereby consent to the venue and jurisdiction 
of such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this EULA to the 
contrary, you acknowledge and agree that any violation 
of or noncompliance with this EULA by you will cause 
irreparable harm to SONY, for which monetary damages 
would be inadequate, and you consent to SONY 
obtaining any injunctive or equitable relief that SONY 
deems necessary or appropriate in such circumstances. 
SONY may also take any legal and technical remedies 
to prevent violation of and/or to enforce this EULA, 
including, but not limited to, immediate termination of 
your use of the SOFTWARE, if SONY believes in its sole 
discretion that you are violating or intend to violate 
this EULA. These remedies are in addition to any other 
remedies SONY may have at law, in equity or under 
contract.

TERMINATION
Without prejudice to any of its other rights, SONY may 
terminate this EULA if you fail to comply with any of its 
terms. In case of such termination, you must: (i) cease 
all use, and destroy any copies, of the SOFTWARE; (ii) 
comply with the requirements in the section below 
entitled “Your Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND ANY OF THE 
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY 
POSTING NOTICE ON A SONY DESIGNATED WEB SITE, BY 
EMAIL NOTIFICATION TO AN EMAIL ADDRESS PROVIDED 
BY YOU, BY PROVIDING NOTICE AS PART OF THE 
PROCESS IN WHICH YOU OBTAIN UPGRADES/ UPDATES 
OR BY ANY OTHER LEGALLY RECOGNIZABLE FORM OF 
NOTICE. If you do not agree to the amendment, you 
should promptly contact SONY for instructions. Your 
continued use of the SOFTWARE after the effective date 

of any such notice shall be deemed your agreement to 
be bound by such amendment.

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express intended 
thirdparty beneficiary of, and shall have the right to 
enforce, each provision of this EULA with respect to the 
SOFTWARE of such party. 

Should you have any questions concerning this EULA, 
you may contact SONY by writing to SONY at applicable 
contact address of each area or country.

Copyright © 2012 Sony Corporation.

Avoimen lähdekoodin 
ohjelmistolisenssit

Sonyn ja ohjelmiston tekijänoikeuden 
haltijoiden välisten lisenssisopimusten 
perusteella tämä tuote käyttää avointa 
ohjelmistoa.
Vastatakseen ohjelmiston tekijänoikeuden 
haltijoiden vaatimuksiin Sony on velvollinen 
tiedottamaan sinua kyseisten lisenssien 
sisällöstä.
Lisenssit (englanniksi) on tallennettu tuotteesi 
sisäiseen muistiin.
Muodosta massamuistiyhteys tuotteen ja 
tietokoneen välille ja lue lisenssit kansiosta 
”PMHOME” - ”LICENSE”.

Jos käytät Macia, kansio ”PMHOME” - 
”LICENSE” ei ehkä ole käytettävissä.
Voit tarkastella tiedostoja jollakin muulla kuin 
Mac-tietokoneella tai käymällä seuraavassa 
URL-osoitteessa.
https://oss.sony.net/License/ILME-FX6/

https://oss.sony.net/License/ILME-FX6/
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Yleiset

Paino

	 Noin 890 g (vain runko)

	 Noin 2,59 kg (sis. SEL24105G-objektiivi, 

vastavalosuoja, akku (BP‑ 

U35), etsin, yläkahva, kauko-

ohjainkahva)

Mitat

	 Ks. sivu 142.

Tehontarve

	 19,5 V DC (18,0 V–20,5 V)

Virrankulutus

	 Noin 18,0 W (runko, objektiivi, XAVC-I QFHD 

59.94P -tallennus, etsin päällä, ei 

ulkoista laitetta liitettynä)

	 Noin 36,0 W (runko, objektiivi, XAVC-I QFHD 

59.94P -tallennus (S&Q 120 fps), 

etsin päällä, HDMI, SDI, ulkoinen 

laite liitettynä)

Käyttölämpötila

	 0 °C–40 °C

Varastointilämpötila

	 –20 °C–+60 °C

Yhtäjaksoinen käyttöaika

	 Noin 105 minuuttia (käytössä BP-U35) 

(runko, objektiivi, XAVC-I QFHD 

59.94P -tallennus, etsin päällä, ei 

ulkoista laitetta liitettynä)

Tallennusmuoto (video)

	 XAVC Intra

		  XAVC-I 4K/QFHD -tila: 

VBR, bittinopeus 600 Mbps 

(enint.), MPEG-4 AVC/H.264

		  XAVC-I HD -tila: 

CBG, bittinopeus 223 Mbps 

(enint.), MPEG-4 AVC/H.264

	 XAVC Long

		  XAVC-L QFHD -tila: 

VBR, bittinopeus 150 Mbps 

(enint.), MPEG-4 H.264/AVC

		  XAVC-L HD 50 -tila: 

VBR, bittinopeus 50 Mbps (enint.), 

MPEG-4 H.264/AVC

		  XAVC-L HD 35 -tila: 

VBR, bittinopeus 35 Mbps (enint.), 

MPEG-4 H.264/AVC

Tallennusmuoto (ääni)

	 LPCM 24-bittinen, 48 kHz, 4-kanavainen

Tallennuksen kuvataajuus

	 XAVC Intra

		  XAVC-I 4K -tila: 

4096×2160/59.94P, 50P, 29.97P, 

25P, 24P, 23.98P

		  XAVC-I QFHD -tila: 

3840×2160/59.94P, 50P, 29.97P, 

25P, 23.98P

		  XAVC-I HD -tila: 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

	 XAVC Long

		  XAVC-L QFHD -tila: 

3840×2160/59.94P, 50P, 29.97P, 

25P, 23.98P

		  XAVC-L HD 50 -tila: 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

		  XAVC-L HD 35 -tila: 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

Tallennus-/toistoaika

	 XAVC Intra

		  XAVC-I QFHD -tila:

			   59.94P

			   Noin 30 minuuttia  

(käytössä CEA-G160T)

		  XAVC-I HD -tila:

			   59.94P

			   Noin 78 minuuttia  

(käytössä CEA-G160T)

	 XAVC Long

		  XAVC-L QFHD -tila:

			   59.94P

			   Noin 115 minuuttia  

(käytössä CEA-G160T)

		  XAVC-L HD 50 -tila:

			   59.94P

			   Noin 155 minuuttia  

(käytössä CEA-G80T)

		  XAVC-L HD 35 -tila:

			   59.94P

			   Noin 210 minuuttia  

(käytössä CEA-G80T)

[Huomautus]
Tallennus-/toistoaika voi vaihdella käyttöolosuhteista 
ja muistin ominaisuuksista riippuen. Tallennus- ja 
toistoajat käsittävät yhtäjaksoisen tallentamisen yhtenä 
leikkeenä. Todelliset ajat voivat olla lyhyempiä riippuen 
tallennettujen leikkeiden lukumäärästä.

Kamera

Kuvanmuodostuslaite (tyyppi)

	 35 mm:n täysikokoinen, yksisiruinen CMOS-

kuvakenno

Pikselien lukumäärä

	 12,9 milj. (yhteensä)

	 10,2 milj. (teholliset)

Automaattitarkennus

	 Tunnistusmenetelmä: vaiheentunnistus/

kontrastintunnistus

Sisäiset ND-suodattimet

	 CLEAR: OFF

	 1: 1/4ND

	 2: 1/16ND

	 3: 1/64ND

	 Lineaarisesti muuttuva ND: 1/4ND–1/128ND

ISO-herkkyys

	 ISO 800/12800 (Cine EI -tila, D55-valonlähde)

Objektiivinpidike

	 E-pidike

Valotusvara

	 15+ aukkoa

Suljinaika

	 64F–1/8000 s (23.98P)

Suljinkulma

	 5,6°–360°, 2–64 kuvaa

Hidastus ja nopeutus

	 XAVC QFHD: 1 fps–120 fps

	 XAVC HD: 1 fps–240 fps

	 XAVC 4K: 1 fps–60 fps

	 XAVC HD (S35): 1 fps–120 fps

Valkotasapaino

	 2000 K–15000 K

Herkkyysvahvistus

	 –3 dB–+30 dB (1 dB:n välein)

Perusulkoasu

	 S-Cinetone, Standard, Still, ITU709, s709, 

709(800%), S-Log3, HLG Live, 

HLG Natural

Ääni

Näytetaajuus

	 48 kHz

Kvantisointi

	 24 bittiä

Taajuusvaste

	 XLR-tulo MIC-tila: 20 Hz–20 kHz  

(enintään ±3 dB)

	 XLR-tulo LINE-tila: 20 Hz–20 kHz  

(enintään ±3 dB)

Dynaaminen alue

	 XLR-tulo MIC -tila: 80 dB (tyypillinen)

	 XLR-tulo LINE -tila: 90 dB (tyypillinen)

Tekniset tiedot
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Vääristymä

	 XLR-tulo MIC-tila: enintään 0,08% (–40 dBu 

tulotaso)

	 XLR-tulo LINE-tila: enintään 0,08% (+14 dBu 

tulotaso)

Sisäinen kaiutin

	 Monauraalinen

Sisäinen mikrofoni 

	 Monauraalinen

Yläkahvan sisäinen mikrofoni

	 Monisuuntainen stereoelektreettikondensaat-

torimikrofoni

[Huomautus]
Kun yläkahva on kiinnitettynä, vain yläkahvan sisäinen 
mikrofoni aktivoituu.

Tulo/lähtö

Tulot
INPUT 1/2:

	 XLR-tyyppi, 3-nastainen, naaras

	 LINE / MIC / MIC+48V vaihdettava

	 MIC: viite –30 dBu – –80 dBu

TC IN:

	 BNC-tyyppi

Lähdöt
SDI OUT:

	 BNC-tyyppi, 12G-SDI, 6G-SDI, 3G-SDI (Level 

A/B), HD-SDI

Kuulokkeet (stereominiliitin):

	 –16 dBu (lähdön viitetaso, näytön 

enimmäisäänenvoimakkuus, 

16 Ω:n kuorma)

HDMI:

	 Type A, 19-nastainen

TC OUT:

	 BNC-tyyppi

Muut
DC IN:

	 EIAJ-yhteensopiva, 18 V–20,5 V DC

Moniliitäntäkenkä:

	 Erillinen (21-nastainen)

REMOTE:

	 2,5 mm 3-nastainen sub-mini

Kauko-ohjainkahvan liitin:

	 3,5 mm 4-nastainen stereominiliitin (kauko-

ohjainkahvan mukana toimitettu 

liitin)

USB-C:

	 USB 3.2 Gen 1

USB/multi:

	 USB 2.0 -standardin mukainen, micro B 

-tyyppi massamuistia varten (1)

VF:

	 Erillinen (40-nastainen)

Näyttö

Etsin (LCD)
Näytön koko

	 8,8 cm (3,5 tuumaa) lävistäjä

Kuvasuhde

	 16:9

Pikselien lukumäärä

	 1280 (vaaka) × 720 (pysty)

Korttipaikat

CFexpress Type A- / SD-korttipaikka (2)

Langaton lähiverkko

Tuetut standardit

	 IEEE 802.11 a/b/g/n/ac (ILME-FX6V/VK)

	 IEEE 802.11 b/g/n (ILME-FX6T/TK)

Taajuusalue

	 2,4 GHz

	 5 GHz (vain ILME-FX6V/VK)

Tuetut suojausprotokollat

	 WEP/WPA-PSK/WPA2-PSK

Yhteysmenetelmä

	 Wi-Fi Protected Setup™ (WPS) / manuaalinen

Käyttötapa

	 Infrastruktuuritila

Akkulaturi (BC-CU1)

Paino

	 Noin 60 g

Mitat

	 Noin 57 × 26 × 101 mm  

(leveys / korkeus / syvyys)

Tulo

	 19,5 V DC, 26 W

Lähtö

	 16,4 V DC, 1,4 A

Käyttölämpötila

	 0 °C–40 °C

Varastointilämpötila

	 –20 °C–+60 °C

Mukana toimitettavat lisävarusteet

Verkkovirtalaite (1)

Virtajohto (1) 

Akkulaturi (1) 

Akku (1)

Yläkahva (1)

LCD-näyttö (1)

USB-C-kaapeli (1)

Kauko-ohjainkahva (1)

LCD-näytön häikäisysuoja (1)

Varusteliitäntäsarja (1) 

(Varusteliitäntä (1), liitäntäjousi (1), ruuvit (4))

Objektiivinpidikkeen suojus (1)

Yläkahvan liittimen suojus (1)

Ennen laitteen käyttöä (1)

Takuuvihko (1)

Tuotteen malli ja tekniset tiedot voivat 
muuttua ilmoittamatta.
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Huomautuksia
ˎˎ Tee aina koetallennus ja varmista, että 
tallennus onnistui. SONY EI OLE MISSÄÄN 
VASTUUSSA VAHINGOISTA MUKAAN 
LUKIEN, MUTTA EI NIIHIN RAJOITTUEN, 
KORVAUKSET TAI HYVITYKSET AIHEUTUEN 
SIITÄ, ETTÄ TÄMÄ LAITE TAI SEN 
TALLENNUSMEDIA TAI MUUT MEDIAT TAI 
VARASTOJÄRJESTELMÄT EIVÄT TALLENNA 
JOTAKIN SISÄLTÖÄ.
ˎˎ Varmista aina ennen käyttöä, että laite 
toimii kunnollisesti. SONY EI OLE MISSÄÄN 
VASTUUSSA VAHINGOISTA MUKAAN 
LUKIEN, MUTTA EI NIIHIN RAJOITTUEN, 
KORVAUKSET TAI HYVITYKSET TÄMÄN 
LAITTEEN TAKUUKAUDEN AIKAISISTA 
TAI TAKUUAJAN UMPEUDUTTUA 
TAPAHTUNEISTA TOIMINTAHÄIRIÖISTÄ 
AIHEUTUNEIDEN NYKYISTEN TAI TULEVIEN 
TULOJEN MENETYKSISTÄ.
ˎˎ SONY EI OLE MISSÄÄN VASTUUSSA 
LAITTEEN KÄYTTÄJIEN TAI KOLMANSIEN 
OSAPUOLTEN ESITTÄMISTÄ 
VAATIMUKSISTA.
ˎˎ SONY EI OLE MISSÄÄN VASTUUSSA 
SISÄISEEN TALLENNUSJÄRJESTELMÄÄN, 
TALLENNUSVÄLINEILLE TAI MUIHIN 
TALLENNUSVÄLINEISIIN TAI -JÄRJESTELMIIN 
TALLENNETTUJEN TIETOJEN 
MENETYKSESTÄ, KORJAUKSESTA TAI 
KOPIOINNISTA.
ˎˎ SONY EI OLE MISSÄÄN VASTUUSSA TÄHÄN 
LAITTEESEEN LIITTYVIEN PALVELUIDEN 
LOPETTAMISESTA TAI KESKEYTYKSISTÄ, 
JOTKA VOIVAT JOHTUA MISTÄ TAHANSA 
SYYSTÄ.
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Ulkomitat

Yksikkö: mm

UNC 1/4-20, syvyys: 6

UNC 3/8-16, syvyys: 5,5

2-UNC 1/8-20, syvyys: 6

UNC 1/4-20, syvyys: 6 UNC 1/4-20, syvyys: 6

UNC 1/4-20, syvyys: 5,5

98,6

11,9
8-UNC 1/4-20, syvyys: 6

143
60

98,6 89,8

82,5

114

62,8

60,6

258

90,1 60,6

25
25

25

4,9

25

117
228

74116

15326,1

6,9 28

UNC 1/4-20, syvyys: 6

Mitat ovat likiarvoja.
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Tavaramerkit

ˎˎ  on Sony Corporationin tavaramerkki.
ˎˎ XAVC ja  ovat Sony Corporationin 
rekisteröityjä tavaramerkkejä.
ˎˎ Termit HDMI ja HDMI High-Definition 
Multimedia Interface ja HDMI-logo 
ovat HDMI Licensing Administrator, 
Inc.:n tavaramerkkejä tai rekisteröityjä 
tavaramerkkejä Yhdysvalloissa ja muissa 
maissa.
ˎˎ Microsoft ja Windows ovat Microsoft 
Corporationin tavaramerkkejä tai 
rekisteröityjä tavaramerkkejä Yhdysvalloissa 
ja/tai muissa maissa.
ˎˎ Mac ja MacOS ovat Apple Inc.:n 
rekisteröityjä tavaramerkkejä Yhdysvalloissa 
ja muissa maissa.
ˎˎ ”Catalyst Browse”, ”Content Browser Mobile” 
ja ”Content Browser Mobile” -logo ovat 
Sony Corporationin tavaramerkkejä tai 
rekisteröityjä tavaramerkkejä.
ˎˎ iOS on Cisco Systems, Inc.:n ja/tai sen 
tytäryhtiöiden rekisteröity tavaramerkki 
tai tavaramerkki Yhdysvalloissa ja eräissä 
muissa maissa.
ˎˎ Android, Google Play ovat Google Inc.:n 
tavaramerkkejä.
ˎˎ Wi-Fi, Wi-Fi-logo ja Wi-Fi PROTECTED SETUP 
ovat Wi-Fi Alliancen tavaramerkkejä tai 
rekisteröityjä tavaramerkkejä.
ˎˎ N-merkki on NFC Forum, Inc.:n tavaramerkki 
tai rekisteröity tavaramerkki Yhdysvalloissa 
ja muissa maissa.
ˎˎ SDXC-logo on SD-3C, LLC:n tavaramerkki.
ˎˎ CFexpress ja CFexpress Type A -logo ovat 
CompactFlash Associationin tavaramerkkejä.
ˎˎ QR Code on Denso Wave Inc. -yhtiön 
tavaramerkki.

Kaikki muut yritysnimet ja tuotenimet ovat 
omistajiensa rekisteröityjä tavaramerkkejä tai 
tavaramerkkejä. Tavaramerkin alaisia tuotteita 
ei ole tässä asiakirjassa merkitty symboleilla 
™ tai ®.
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